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Welcome to Sourcing
Objectives
The purpose of this handbook is to familiarize administrators and users with the functionality
available in the JAGGAER ONE Sourcing solution. It will help you:

l Understand general administrative tasks such as user management, supplier communication,
and system reporting. In addition, this handbook will help you configure items such as email
templates and supplier/end-user questions that are available in the Sourcing solution.

l Understand administrative tasks related to Sourcing such as work groups, event
management, commodity code management and Diversity classification configuration.

l Understand how both internal users and suppliers can use the application to enter, track and
analyze supplier information.

l Guide suppliers in how to respond to events.

Key Points
This handbook will show you how to perform functions for the Sourcing solution. It is important to
note that much of the how, when, and why the system is used is determined by your
organization’s business practices. We suggest that you supplement this document with your
organization’s business practices, goals, and policies.

It is important to note that some administrators may only have permissions to perform a subset of
the administrative functions. We recommend that each organization has at least one
administrator with full rights to the system.

Sourcing Basics

Sourcing Overview
The JAGGAER ONE sourcing solution is an on-demand bid management solution. Sourcing
provides a single platform for managing traditional sourcing activities such as sealed bids,
requests for quote and invitations to bid.
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Purchasing agents are able to use a number of different methods (e.g. templates, copying
previous events or uploading lists of bulk items) in order to expedite the event creation process.
Once a buyer has created specifications for a bid, suppliers are invited and the customer can
monitor the progress of those responses.

Work Groups & Events

Events are the heart of the Sourcing solution. The functions you perform in nearly every other
area of the application support the events you create and manage in the Events area. Depending
on your access, you create, view, update, copy, and delete existing events in this area. You can
also add attachments to events and invite suppliers to participate in events.

In Sourcing, you will configurework groups that are the larger 'buckets' of work that need to be
done. Work groups may include an office remodeling, building a new facility, upgrading
computers, or ongoing maintenance work. Events are the individual types of work that need to be
done within a work group. For example, with the office remodeling, you may have an event for the
painting, an event for the cubicles to be installed, and an event for the electrical work.

For both work groups and events, you will configure how users may interact with the work group
and/or events.

Inviting Suppliers

For each Sourcing event, you will invite suppliers to respond. Supplier responses may be in the
form of bids or information. You will configure the requirements for the supplier response.

You can configure your organization to only invite suppliers who exist in the JAGGAER database,
or you may allow users to manually invite suppliers with no current supplier record in the
database. You may also search for suppliers by NAICS code. An event can also be configured to
force supplier invitations based on the commodity codes in an event. An appropriate contact
must exist or be provided for the supplier. It may be a supplier with whom you have never done
business before, or a supplier that does not yet have a Supplier Network Portal.

Through the response to the sourcing event, a supplier without a portal will register for a Supplier
Network Portal. Suppliers can register for system access, view events, enter responses and
manage their own profiles through their Supplier Network Portal.

Two Way Event Communication

You can monitor open events in real time to determine which suppliers have viewed a specific
opportunity, which are currently working on responses, and which have actually submitted
responses. You can view suppliers by name, commodity, or special classifications. Throughout
the process, you can create and issue event amendments, answer supplier questions, and
respond to one or all suppliers at once through JAGGAER ONE.

Analyze & Award Events
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Sourcing offers a variety of ways to evaluate responses from the event process. Use a side-by-
side view for comparisons or generate spreadsheets to share with evaluators.

Sourcing Event Process
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Sourcing Terminology
The following list contains definitions of common terms used in the Sourcing solution.

Glossary List

Close Date

The Close Date is the date / time when the bidding period ends and suppliers can no longer
submit a response.

Contacts

Contacts on an event are users whom a supplier may contact for additional information. The
supplier will see the contact information when viewing the event.

Estimated Value

The customer may indicate a total Estimated Value for an event. Workflow may also be
configured based on this value. If the organization does not typically use this information, the field
can be hidden on all events via field management.

Event Creator

An Event Creator can create new events for a work group and assign users to the event. An
Event Creator cannot edit or view events created by other Event Creators of the work group
(unless the user is also an Event Manager). A user must have the Create Events With
Templates, Create/Own Events, orManage Work Group Events permission to be assigned as
an Event Creator.

Event Manager

An Event Manager can create, view, and edit all events created within the work group. A user
must have theManage Work Group Events permission to be assigned as an Event Manager.
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Event Owner

An Event Owner has full control over the event. An Event Owner can be inherited as an Event
Manager on a work group, or can be explicitly set for the event.

Event Price Viewers

When Confidential Pricing is set toOptional for an event, only users added to the Event Price
Viewers access group of an event are able to view the estimated price, target price, historic
prices, minimum, maximum, supplier prices, and for Reverse Auctions, the reserve price and bid
decrement for that event. All other users will see the word Confidential anywhere a price would
be displayed. If a supplier uploads a confidential attachment, users who are not included in the
Event Price Viewers access group for the event can see the file name, but they are unable to
open these attachments. Only users with event access such as a Stakeholder or Event Owner are
eligible to be added to the Event Price Viewers access group.

Event Type

An Event Type is a type of Sourcing Method, or the name of the event methodology you will use.
This could be an auction, a request for proposal, a request for information, etc. With an event
type, you will control what sections of an event are included for the different methods. See "Event
Types" on page 52 for additional information.

Library

A Library is a compilation of different components of the event, such as the description,
questions, or items, that can be reused in events. These can be used to populate both the event,
as well as panel questionnaires. They can also be commodity specific: as you will have different
questions for a food event vs. a construction event. See "Libraries" on page 271 for additional
information.

Manually Invited Supplier

AManually Invited Supplier is one who has been invited to an event but for whom no record
exists in the database currently. This allows organizations to invite new suppliers that do not
currently exist in the database, without creating a record for the supplier if they do not respond.
The supplier is given a link to respond by registering for a portal. Once the supplier responds by
registering for a portal, a record is created for the supplier in the database, and they are in the
system with a supplier profile. They can then respond to the event.



JAGGAER 18 www.JAGGAER.com

Notification Recipients

If buyer notification restriction has been enabled, either at the work group level or system wide,
events will include an access group called Notification Recipients. Only users added as
notification recipients will be eligible to receive system-generated event notifications for events
administered with this control option. The Event Creator and Event Managers are equipped to
manage the Notification Recipients access group.

Open Date

TheOpen Date is the date / time when suppliers can begin responding to the Sourcing event.

Work Group Administrator

AWork Group Administrator can create child work groups and assign access to child work
groups. AWork Group Administrator can also edit the existing work groups where they have
been assigned to the Work Group Administrator access group.

A user must have the Administer Work Groups permission or the Sourcing Configuration
permission to be assigned as a Work Group Administrator.

Work Group

AWork Group is a hierarchical structure to segregate your event content. It can either mimic
your organization’s hierarchy or be driven by a commodity hierarchy. The work group structure
can be used to control access to events as well as event features (public vs. not, allowing
alternate items vs not).

Proxy Bid

A Proxy Bid is created when the customer enters a bid response on behalf of a supplier, using
responses provided by the supplier via mail, email, or phone. This is used when a supplier may not
have or desire access to a supplier portal. A user must be an Event Owner with either
Create/Own Events orManage Work Group Events permission, and also have Create Proxy
Bid in order to enter responses on behalf of the supplier.
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Release Date

The Release Date is optional for an event, and is the date when invitations are sent to suppliers.
Suppliers will be able to view the event in their portal, but cannot submit responses until the event
isOpen.

Sealed Bids

An event that uses Sealed Bidswill not show the supplier bid response until the sealed bid open
date passes. If the customer is entering a proxy bid for a sealed bid event, the sealed bid open
date must pass before entering a proxy response. The events that use sealed bids will be
indicated with an envelope icon in event search results.

Stakeholder

A Stakeholder has view access to all events in the work group. A user must have one of the
sourcing permissions related to events to be assigned as a Stakeholder: View Events,
Create/Own Events,Manage Work Group Events, Approve/Reject Sourcing Event, or
Finalize Award Scenario.

Template and Library Manager

Template and Library Managers can create new libraries with associations to one or more work
groups and one or more event types. The library creator is able to control which work groups can
make use of which libraries and on which event types in those work groups. A user must have the
Create Templates and Libraries permission in order to be added as a Template and Library
Manager.

Template

A Template is the way you will implement your method of sourcing. You may have multiple RFP
templates, depending on what you buy and where you buy. For example, regulatory constraints
may drive some of the prerequisites. These control the structure of the event and what “sections”
(prerequisites, questions, items, attachments etc.) are going to be available to the event creator.
Templates are used in creating events of the same method, so you don't have to manually enter
information for each event. See "Templates" on page 297 for additional information.
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Notifications
You may choose to enable notifications for certain Sourcing activities taking place in your
organization through the application.

Notification preferences can be set at the role or user level. You can choose to receive an email,
an in-application notification, both, or none. See Notification Preferences in the Site Essentials
Handbook or online searchable help and Creating and Managing Roles in the Administration
and Configuration Handbook or online searchable help for additional information.

Sourcing notifications are found in the following Notification Preferences sections:

l Sourcing Director - Contains notifications related specifically to sourcing activities
(supplier intent, sourcing events, panel questionnaires, etc.).

l Shopping, Carts & Requisitions - Contains notifications related to shopping cart and
requisition activities (cart assigned, requisition submitted into workflow, cart rejected or
returned, etc.)

l Catalog Management - Contains notifications related to catalog management (PunchOut
status changed, submission import error, price file approved or rejected, etc.)

l Form Request - Contains notifications related to form request workflow (form request
approved, form request rejected, etc.)

l Administration and Integration - Contains notifications related to administration and
integration (workflow step errors, import/export, etc.).

For a description of a notification, click the associated with the notification, as shown below.

Pending Approval Document Reminders
If Pending Approval Document Reminders are configured, Sourcing Request approvers will
receive a reminder email if a request for which they are responsible has remained in a workflow
step past a certain amount of time. These reminders do not require that a user be opted into a
specific notification, but are based on the organization's approval document reminder
configurations only. Notification preference controls are not available for this email notice. As a
result, approvers cannot opt out of receiving it.
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Sourcing Permissions
The following are permissions related to Sourcing configuration, work groups and events.
Permissions may be configured at the role or user level by an administrator. Note:We
recommend managing permissions through user roles rather than assigning permissions to each
user. Local changes will override user role permissions.

For additional information about enabling permissions at the user level, please see Permission
Settings in the Site Essentials Handbook or online searchable help. For additional information
about enabling permissions at the role level, please see Creating and Managing Roles in the
Administration and Configuration Handbook or online searchable help.

Events Permissions
Permission Permission Description

View Events Users with this permission can be added to a work group or an event as a stakeholder.
When added to a work group, the user gains read-only access to all events created in the
work group. When added to a specific event, the user gains read-only access to that
event so that it is returned in search results and can be viewed. If a user with this
permission has never been added to an access group for an event or work group, when
they perform an event search, they will get a message that no results were found.

Create with
Templates/
Own Events

Users with this permission can create events from a template, but they cannot create a
blank event. Users with this permission can be added to the event creators access group
or the stakeholders access group of a work group. When the user is a member of the
event creators access group, they can create events for that work group, but they must
choose a template during the event creation process.

Create/Own
Events

Users with this permission can be added to a work group as an Event Creator or
Stakeholder. Users with this permission can be added to an event as an Event Owner or
Stakeholder. When added to a work group as an Event Creator, the user is able to create
events in the work group, but cannot see events created by other users in the work
group. When added to a work group as a Stakeholder, the user can search for all events
in the work group and see them in read-only mode. When added to an event as an Event
Owner, the user gains the ability to see the event in search results and edit the event.
When added to an event as a Stakeholder, the user gains the ability to see the event in
search results and view it in read only mode.
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Permission Permission Description

Manage Work
Group Events

Users with this permission can manage all events in a work group when added to a work
group as an Event Manager. The permission allows the user to be added to a work group
as an Event Manager, Event Creator or Stakeholder. The permission also allows a user to
be added to an event as an Event Owner or Stakeholder. When added to a work group as
an Event Manager, the user can see all events in the work group and edit them. The user
can also create new events in the work group. The user will be visible on all events in the
work group as an inherited Event Owner. When the user is added to an event as an event
owner, that allows the user to edit the event. When the user is added to an event as a
stakeholder, that allows the user to view the event in a read-only mode.

Archive
Events

This sourcing permission allows a user to take archive action on events which makes an
event hidden and not available in search results. User with this permission also allows the
ability to include archived events in advanced event search.

Create
Templates &
Libraries

The permission allows the user to create new libraries and collateral in the libraries.
Additionally the user will be able to create event templates. The user will only be able to
create new templates and libraries for projects where the user has been assigned to the
Library Creators access group. The user will be able to create collateral in a library.
Collateral is the term used to collectively refer to pre-configured event type sections like
description, prerequisites, attachments, questions, and items. A library can house a
mixture of collateral types. Give this permission to users with knowledge of how your
organization will phrase things like prerequisites or questions, and which attachments are
appropriate to use in different situations. A library can be associated to multiple work
groups so that event creators in the work group can use the collateral in the library. A
template can be associated to multiple work groups or only one so that event creators in
the work group can use the template. During event creation, the creator will have an
option to select from the library or create from a template.

Manage
Sourcing Cus-
tom Fields

Users with permission to define custom fields are able to set the custom field name and
response type. Depending on the response type selected, users are further able to
choose response options, and whether the field can be used to search for events via the
Advanced Search function. Users are also able to add help text on custom fields if they
so choose.

Close Events
Early

Permission that grants user ability to close a sourcing event early. User must only have
this permission to see the close early action.

Withdraw
Events

Permission that grants user ability to withdraw a sourcing event. User must only have this
permission to see the withdraw action.

Reopen
Events

Permission that grants user ability to Reopen a closed sourcing event. Event Owners who
has "Create/own" or "Manage Event" permission, must have this permission to see the
Reopen action in the closed events.

Create Proxy
Bid

This permission grants a user the ability to enter a Proxy Bid on behalf of a supplier for
sourcing events. Event Owners with either "Create/Own Events" or "Manage Project
Events" permissions, must have this permission in order to submit a Proxy Bid.

Manage Q
and A Board

Users with this permission can post answers to supplier submitted questions on the Q
and A Board.
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Permission Permission Description

Add Supplier
Contact

Permission grants sourcing event user the ability to add supplier contacts from a
sourcing event so that they can add a new sales or corporate contact to a supplier at the
time of the sourcing event creation.

Initiate Con-
tract Process

Users with this permission can initiate / create a contract from a sourcing event and see
the contract details from within the sourcing event as it moves through their Contract
Management solution (TCM or Contract Director).

Sourcing
Event
Requester

Users with this permission can create a Sourcing Request that is submitted to the
Sourcing solution for event creation. Users can access the My Sourcing Event Requests
and Submitted Requests pages, where they can create and manage their own sourcing
requests.

Administration Permissions
Permission Permission Description

Sourcing
Configuration

This permission is meant to be given to the person configuring the Sourcing module for
use by other personnel in the purchasing department. The user with this permission can
create new project trees in the manage projects hierarchical view. Navigate to
Sourcing > Sourcing Administration> Manage Projects - on this page the
permission will allow assigning an administrator and control which users have access to
any work group (parent or child). On this page the permission will allow the adding of
child work groups to parent work groups. This user can also delete work groups that
have no events and no child work groups.

Administer
Work Groups

Users with the Administer Work Groups permission are able to create new child work
groups inside of work groups where they are assigned as Work Group Administrators.
Users must have Administer Work Groups permission in order to be added to a parent
work group as a Work Group Administrator. The only users that can start a new work
group tree are those administrative users that have the Sourcing Configuration
permission. Once the Sourcing Configuration Administrator creates a new tree, then a
Project Administrator can be assigned at the top level to create the rest of the work
group tree structure. The user can Add New Child Work Groups. The Project
Administrator will be able to delete work groups that have no events and no child work
groups.

Manage Public
Site

When turned on, the Manage Public Site setting allows the user to configure the Public
Site settings on the General Sourcing Settings page and Manage Work Groups page.
The Sourcing Configuration permission, located in the Administration permissions, will
also need to be turned on.

Manage
Sourcing Email
Template

This permission allows users to add, edit and/or delete any custom award notification
email templates.
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Permission Permission Description

View Sourcing
Cost Savings
Report

This permission allows users to view all of the organization's Sourcing Cost Avoidance
Reports

View Sourcing
Operational
Reports

A user with this permission can view the cycle time report for sourcing events.

Sourcing Event Approvals Permissions
Permission Permission Description

Approve/Reject Sourcing
Events

Provides the ability to approve or reject a sourcing event within an approver's
approval workflow folder.

Forward Sourcing Events
to Another Approver

Allows an approver to forward a sourcing event to another approver. This
permission displays the Forward to option in the Sourcing Event Approvals
Action lists.

Manage Other Approver's
Sourcing Event Approval
Folders

Provides the capability for a user to view and manage another approver's
personal and shared sourcing event approval workflow folders. With this
permission set ON, the user will be able to search and select approvers within
their department permissions for management. Any action performed on a
sourcing event will have an audit record created stating the user performing
the action on behalf of the approver. Managing another approver's sourcing
event approval folders allows the user to perform the following folder
management actions: Assign / Remove substitute approver Assign the
sourcing event to the user's personal folder Return sourcing event to shared
workflow folders Assign sourcing event from shared workflow folders to
personal folder Forward sourcing event to another approver Put sourcing
event on hold

Assign Substitute For
Sourcing Event Approvals

Provides the user with the ability to assign a substitute for a sourcing event
approvals folder. The user also needs to have the approve/reject sourcing
event permission.

Approve/Reject Sourcing
Events on Behalf of
Another Approver

Provides the ability for a user to approve or close without awarding a sourcing
event currently assigned to another approver's personal workflow folder. The
approval actions are recorded for the user on behalf of the managed
approver. * Please note that the Approve/Close Without Awarding Sourcing
Events permission is also required.
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Permission Permission Description

Put Sourcing Events on
Hold

Allows an approver to put a sourcing event evaluation on hold. A sourcing
event that is on hold will remain in that approver's approvals folder. This
permission displays the Hold option in the sourcing event evaluation Action
lists.

Restart/Skip Sourcing
Event Workflow Steps in
Error

Provides the ability to restart workflow for any pending sourcing event within
an approver's personal approvals folder. This is typically necessary with
workflow that triggers or receives integration messages. If an
acknowledgment message is not received in the allotted time or after the
defined number of retries, the step goes in to error status. This functionality
allows and admin to restart the step, i.e., resend the message.

Expedite Sourcing Event
Approval Workflow
Through All Steps

Provides the capability for the approver to expedite to a workflow step
including the End step (completes workflow). All steps skipped as part of the
expedite will be recorded as part of the sourcing event audit trail.

Expedite Sourcing Event
Approval Workflow

Provides the user with the ability to Expedite a sourcing event through the
approval process. A user with this permission can "pull" a sourcing event
through any pending step (that permit expediting).

Set Approvals Action
Column to Default to
Approve

Site administrators are advised to give this permission with extreme
caution. If an organization's approval process should involve opening a
sourcing event to examine it for correct data before approving, then users
should not be given this permission. This permission allows the user to click
an approve button directly from the approvals page without first assigning
the sourcing event. An approver can approve a sourcing event very quickly
without having to make a careful examination of the sourcing event before
approving it when this permission is turned on for the user profile or role. The
action column on the approvals page normally shows an assign button. When
this permission is on, the action column will show an approve button by
default instead.

Add Ad-Hoc Approver
for Sourcing Approvals

Users with this permission can add ad-hoc approval steps and approvers to
Sourcing Events in the associated Sourcing workflow. Note: The Allow
users to add ad-hoc approvers for Sourcing site setting must be enabled.
See Enabling Ad Hoc Approvals for Sourcing Events, on page 1.

Perform Ad-Hoc
Approve/Reject/Return
of Events

(for Approval Workflow) - Users with this permission can be set as an ad-hoc
approver in the associated Sourcing workflow. Note: The Allow users to
add ad-hoc approvers for Sourcing site setting must be enabled. See
Enabling Ad Hoc Approvals for Sourcing Events, on page 1.

../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
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Sourcing Event - Evaluation Workflow Approvals
Permissions
Permission Permission Description

Approve/Close
Without Awarding
Sourcing Events

Provides the ability to approve or reject a sourcing event within an approver's
evaluation workflow folder.

Create Award
Scenario

This permission grants a user the ability to create and save award scenarios from the
supplier responses to a sourcing event during the evaluation.

Finalize Award
Scenario

This permission grants a user the ability to award a sourcing event to a supplier during
the evaluation.

Forward Sourcing
Events to Another
Approver

Allows an approver to forward a sourcing event to another approver. This permission
displays the Forward to option in the Sourcing Event Evaluation Action lists.

Manage Other
Approver's
Sourcing Event
Approval Folders

Provides the capability for a user to view and manage another approver's personal
and shared sourcing event evaluation workflow folders. With this permission set ON,
the user will be able to search and select approvers within their department
permissions for management. Any action performed on a sourcing event will have an
audit record created stating the user performing the action on behalf of the approver.
Managing another approver's sourcing event evaluation folders allows the user to
perform the following folder management actions: Assign / Remove substitute
approver; Assign the sourcing event to the user's personal folder; Return sourcing
event to shared workflow folders; Assign sourcing event from shared workflow
folders to personal folder; Forward sourcing event to another approver; Put sourcing
event on hold

Assign Substitute
for Sourcing
Event Approvals

Provides the user with the ability to assign a substitute for a sourcing event
evaluation folder. The user also needs to have the approve sourcing event evaluation
permission.

Approve/Close
Without Awarding
Sourcing Events
on Behalf of
Another Approver

Provides the ability for a user to approve or reject a sourcing event currently assigned
to another approver's personal workflow folder. The approval actions are recorded for
the user on behalf of the managed approver. * Please note that the Approve/Reject
Sourcing Events permission is also required.

Put Sourcing
Events on Hold

Allows an approver to put a sourcing event on hold. A sourcing event that is on hold
will remain in that approver's approvals folder. This permission displays the Hold
option in the sourcing event approvals Action lists.
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Permission Permission Description

Restart/Skip
Sourcing Event
Workflow Steps
in Error

Provides the ability to restart workflow for any pending sourcing event within an
approver's personal evaluation approvals folder. This is typically necessary with
workflow that triggers or receives integration messages. If an acknowledgment
message is not received in the allotted time or after the defined number of retries, the
step goes in to error status. This functionality allows an admin to restart the step, i.e.,
resend the message

Expedite
Sourcing Event
Through All Steps
in Evaluation
Workflow

Provides the capability for the approver to expedite to a workflow step including the
End step (completes workflow). All steps skipped as part of the expedite will be
recorded as part of the sourcing event audit trail.

Expedite
Sourcing Event in
Evaluation
Workflow

Provides the user with the ability to Expedite a sourcing event through the approval
process. A user with this permission can "pull" a sourcing event through any pending
steps (that permit expediting).

Set Approvals
Action Column to
Default to
Approve

Site administrators are advised to give this permission with extreme caution. If
an organization's approval process should involve opening a sourcing event to
examine it for correct data before approving, then users should not be given this
permission. This permission allows the user to click an approve button directly from
the approvals page without first assigning the sourcing event. An approver can
approve a sourcing event very quickly without having to make a careful examination
of the sourcing event before approving it when this permission is turned on for the
user profile or role. The action column on the approvals page normally shows an
assign button. When this permission is on, the action column will show an approve
button by default instead.

Add Ad-Hoc
Approver for
Sourcing
Approvals

Users with this permission can add ad-hoc approval steps and approvers to Sourcing
Events in the associated Sourcing workflow. Note: The Allow users to add ad-hoc
approvers for Sourcing site setting must be enabled. See Enabling Ad Hoc
Approvals for Sourcing Events, on page 1.

Perform Ad-Hoc
Approve/Close
Without Award-
ing Sourcing
Events

(for Evaluation Workflow) - Users with this permission can be set as an ad-hoc
approver in the associated Sourcing workflow. These users are not responsible for
awarding the associated Sourcing event. Note: The Allow users to add ad-hoc
approvers for Sourcing site setting must be enabled. See Enabling Ad Hoc
Approvals for Sourcing Events, on page 1.

Note:When the organization's configuration allows ad-hoc approval for form requests, users
with the appropriate permission can add an ad-hoc approver to a Sourcing Request
workflow process (User Profile > Permission Settings > Approvals: Form Request
Approvals) .

../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
../../../../../../../../1. Indirect/6. Sourcing/14. Administrative and Setup/h. Sourcing Workflow and Approval/Enabling Ad Hoc Approvals.htm
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l Users must have Add Ad-Hoc Approver for Request approval permission in order
to add an ad-hoc approver.

l Users must have Perform Ad-Hoc Approve/Reject/Return Request permission in
order to be selectable as an ad-hoc approver.

Sourcing Director Permissions
These permissions are located in Permissions Settings > Orders > Sourcing Director.

Permission Permission Description

Create and Man-
age Sourcing
Events

This permission allows users to send items out to bid as well as to view information
about sourcing events. Access to Sourcing Director is required for this permission.

Request Approvals Permissions
These permissions are located in Permissions Settings > Approvals > Form Request
Approvals.

Permission Permission Description

Approve/Reject
Form Requests

Provides the ability to approve or reject requests in a user's own or assigned
approval folders.

Forward Form
Requests to
Another Approver

Allows an approver to forward a request to another approver. This permission
displays the Forward option in the approval's Action list.
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Permission Permission Description

Manage Other
Approver's Form
Request Approval
Folders

Provides the capability for a user to view and manage another approver's personal
and shared form request workflow folders. With this permission set ON, the user
will be able to search and select approvers within their department permissions for
management.

This permission allows the user to perform workflow management actions for
requests assigned to the designated approvers, including Assign/Remove sub-
stitute approver; Assign the form request to the user's personal folder; Return form
requests to shared workflow folders; Assign form requests from shared workflow
folders to personal folder; Forward form requests to another approver; Place form
requests on hold.

Any action performed on a form request will have an audit record created stating
the user performing the action on behalf of the approver.

Assign Substitute
For Form Request
Approvals

Provides the user with the ability to assign a substitute for a form request approval
folder. The user also needs to have the approve permission.

Approve/Reject
Form Requests on
Behalf of Another
Approver

Provides the ability for a user to approve or reject a request currently assigned to
another approver's personal workflow folder. The approval actions are recorded for
the user on behalf of the managed approver.

Put Form
Requests on Hold

Allows an approver to put a request on hold. A request in this status will remain in
that approver's folder. . This permission displays the Hold option in the form request
approvals Action lists.

Restart/Skip Form
Request Workflow
Steps in Error

Provides the ability to restart workflow for any pending request within an approver's
personal approvals folder. This is typically necessary with workflow that triggers or
receives integration messages. If an acknowledgment message is not received in
the allotted time or after the defined number of retries, the step goes into an error
status. This functionality allows the user to restart the step, i.e. resend the message.

Expedite Form
Requests
Approval Work-
flow Through All
Steps

Provides the ability for the approver to expedite to a request workflow step,
including the End step (completes workflow). The user will also be able to expedite
past any workflow steps configured as "do not allow bypass". All steps skipped as
part of the expedite will be recorded as part of the request audit trail.

Expedite Form
Requests
Approval Work-
flow

Provides the ability to expedite a request through any pending workflow steps that
permit expediting.
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Permission Permission Description

Set Approvals
Action Column
Default to
Approve

Site administrators are advised to enable this permission with extreme caution. If an
organization's approval process should involve opening a supplier request to exam-
ine it for correct data before approving, then users should not be given this per-
mission. Only users with the Administration and Edit All User
Profiles/Roles/Permissions permissions are allowed to enable or disable this per-
mission.

This permission allows the user to click an Approve button directly from the
approvals page without first assigning the request. An approver can approve a
request quickly without having to make a careful examination of the information.
The action column on the Approvals page normally shows an Assign button. With
this permission enabled, the Action column will show an Approve button by default.

Return to
Requester

Allows the user to return the request to the requester.

Edit Pending
Requests (My
Form Request
Approvals)

Provides the ability to edit and update any pending requests within the approver's
folders.

Edit Pending
Requests (All
Form Request
Approvals)

Provides the ability to edit and update any pending requests within any approval
folder.

Add Ad-Hoc
Approver for
Request approval

Allows a request approver to send the document to a user who is not in the regular
approval workflow for a one-time approval. Users with the permission can select,
change, or delete an ad-hoc approver while they are an approver assigned to a
request. They cannot modify other fields unless they also have editing permissions.
This permission is only visible if the organization has the Form Request Ad-Hoc
Approver feature enabled. 

Perform Ad-Hoc
Approve/Reject/
Return Request

Allows users to accept or reject requests only as an ad-hoc approver and at no other
time. Users with this permission can subscribe to the Form Request Pending Ad-Hoc
Workflow Approval notification to alert them that they have been assigned to a
request as an ad-hoc approver. This permission is only visible if the organization has
the Form Request Ad-Hoc Approver feature enabled.
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Access & Navigation

Sourcing Events Home Page
The Sourcing Events Home page provides quick access to key tasks and activities related to the
administration of sourcing events from one location. A default sourcing events dashboard is
supplied by JAGGAER, but organizations can create their own version and replace it.

Access the Sourcing Events Home by navigating to

Default Dashboard
The default dashboard on the Sourcing Events Home page is provided by JAGGAER and allows
you to view a summary of event information in a graphic format, perform an event search, use
quick links, and view events with key event dates occurring in the previous or next seven days.
What you see on the Sourcing Events Home page may be different if your organization has
customized the dashboard.

Customizing the Sourcing Events Home Page
Organizations can create custom versions of the Sourcing Events Home page and make them
available to users who have access to the page. Organizations can define what information is
displayed on a custom dashboard by adding or removing widgets.

Users with appropriate permissions can create custom dashboards by clicking the Configure
This Dashboard link on the Sourcing Events Home page. See Configurable Dashboards in the
Site Essentials Handbook or online searchable help for details.

Sourcing Widgets
There are several widgets available for organizations that use the Sourcing solution. These
widgets allow users to perform sourcing tasks and access sourcing information directly from the
dashboard.
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Key Event Dates Widget

The Key Event Dateswidget provides a list of sourcing events with upcoming release, open or
close dates.

Adding the Widget to a Dashboard:

1. Select the Key Event Dateswidget from the All or Sourcing Category categories. The
Key Event Dates window displays.

2. In the Name field, enter a meaningful name for the widget.
3. To automatically size the widget to the content when displayed on the dashboard, click the

Yes radio button for the Auto-size field.
4. In the Show Filters field, determine if you would like the filters to display on the widget in

the dashboard. Please see steps 5 and 6 for information about the filters. Select Yes to
allow the filters to be changed on the dashboard. Selecting Nowill prevent the filters from
being displayed on the widget.

5. In the Date Range field select the range of days from which the list of event dates should
display.

6. Select a value in the Include Draft and Pending Events field. Selecting Yeswill include
these event types

7. Click Save Changes.

Using the Widget on a Dashboard

l The widget displays the key event dates in a list. If the widget is configured to show filters,
you can filter the list by date range or to show or hide draft and pending events.

l The list is sortable by each column. TheOwners column includes the name of the sourcing
event owner. If there are multiple owners, a link may be displayed in the column that notes
the number of owners. Clicking on the link activates an overlay that displays all of the
owners.

l The Event Number for each key event date is a clickable link. Clicking on the link opens the
sourcing event.

l The widget displays the key event dates in a list. If the widget is configured to show filters,
you can filter the list by date range or to show or hide draft and pending events.

l The list is sortable by each column. TheOwners column includes the name of the sourcing
event owner. If there are multiple owners, a link may be displayed in the column that notes
the number of owners. Clicking on the link activates an overlay that displays all owners.

l The Event Number for each key event date is a clickable link. Clicking on the link opens the
sourcing event.
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Sourcing Event Search Widget

The Sourcing Event Search widget allows the user to search for sourcing events directly from the
dashboard. Users can perform a simple product search right from the widget or access the
advanced search screen.

Adding the Widget to a Dashboard:

1. Select the Sourcing Event Searchwidget from the All or Sourcing category. The
Sourcing Event Search window displays.

2. In the Name field, enter a meaningful name for the widget.
3. Click Save Changes.

Using the Widget on a Dashboard

l To perform a simple search from the widget, enter the search criteria in the text field and
click the search icon.

l To perform an advanced search, click the Advanced Search link. You will be taken to the
Advanced Search screen.

Sourcing Events Summary Widget

The Sourcing Events Summary widget displays a summary of the organization's sourcing events.
The summary is a bar graph and can be sorted by event type, event owner, status or supplier.

Adding the Widget to a Dashboard

1. Select the Sourcing Event Summarywidget from the All or Sourcing category. The
Sourcing Event Summary window displays.

2. In the Name field, enter a meaningful name for the widget.
3. Select a value in the View Sourcing Events By field. This value selected in this field

determines how the information on the bar graph will be sorted. The value selected when
the widget is created is the default value. End users are able to change the view.

4. Select a value in the Sourcing Events field. All Events will display all events for the
organization. My Events will display only the events for the user viewing the dashboard.
Note: If you selected Owner in the View Sourcing Events By field, All Events is the only
option in this field.

5. Click Save Changes.

Using the Widget on a Dashboard
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l The bar graph is categorized by the value selected in the View Sourcing Events By field. To
change the categories, select a different option in that field.

l The sourcing events included in the summary are based on the value selected in the
Sourcing Events field. All Events displays all sourcing events for the organization. My
Events displays only the sourcing events for the user who is viewing the dashboard. To
change the summary, select a different option in that field. Note: If the View Sourcing
Events By field is set to Owner, you are only able to select All Events in this field.

l Clicking on a bar on the graph executes a search for the sourcing events in that category.

l The bar graph is categorized by the value selected in the View Sourcing Events By field. To
change the categories, select a different option in that field.

l The sourcing events included in the summary are based on the value selected in the
Sourcing Events field. All Events displays all sourcing events for the organization. My
Events displays only the sourcing events for the user who is viewing the dashboard. To
change the summary, select a different option in that field. Note: If the View Sourcing
Events By field is set to Owner, you are only able to select All Events in this field.

l Clicking on a bar on the graph executes a search for the sourcing events in that category.

Event Search
Navigate to Sourcing > Sourcing Events > Search Events to use simple or advanced search
for sourcing events. When searching for events, you are only shown events to which you have
access to view or edit.

When searching with Supplier Name as a criteria, the search results will include manually invited
suppliers.

Note: Manually invited suppliers must be entered in the Supplier Name filter. They will not be
found using autocomplete or the search functionality.

Simple Search

Navigate to Sourcing > Sourcing Events > Search Events to use the Simple Search to find
events by an Event Number, Event Title, or supplier on the event. You may also select a date
criteria in simple search from the drop-down. You may also useQuick Search by selecting the
search icon in the upper right navigation and select to search for Sourcing Event.
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Advanced Search

From the Sourcing Events Home:

1. Navigate to the Sourcing Events Home: Sourcing > Sourcing Events > Sourcing
Events Home.

2. In the Search Eventswidget enter an Event Number or a term from the Event Title.

3. Click the Search button.

4. Results display according to your criteria.

From the Sourcing Events Search:

1. Navigate to Sourcing > Sourcing Events > Search Events.

2. Use the simple search to search by the Event Number of a term from the Event Title. You
may select a date filter to see events created in a specific date range.

3. Click the advanced search hyperlink to see advanced search options and enter criteria in
any of the appropriate fields:

a. Sourcing Event Identification: Enter a specific Event Number, Event Title or Stage
Title.

b. Sourcing Event Information:

i. Begin entering an Event Type and select from available options or select the
search icon and choose one or more event types.

ii. Date: Select the type of date and corresponding date criteria.

iii. Work Groups: Search by work group(s).

iv. Event Creator: Search by event creator(s).

v. Stakeholder: Search by stakeholder(s).

vi. Supplier Name: Enter all or part of a supplier name.

vii. Select to search for events using your organization Commodity Codes.
Results will be returned with commodity codes associated to the event or
items.

viii. Select to see events with one or more Participants. Enter a user's name,
username, or email.
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ix. Select one or more Event Status options. Events in any of the selected status
will be returned.

x. Select to see events by Public Visibility. If your organization uses the Public
Site, select to see events that are Public only, Private only, or either.

xi. Select to see events by Bid Strategy: Both Sealed and Non-sealed Bids,
Sealed Bids Only, or Non-sealed Bids Only.

xii. Select from Auction Events to see all, live, or mock auction events.

xiii. Select if you would like to Include Archived Events in the search results.

c. Custom Fields - Enter your search criteria for any custom fields that have been
enabled for advanced search.

d. Workflow:

i. Begin entering a Current Workflow Step - Approve Event or select the
search icon to see all options.

ii. Begin entering a Current Workflow Step - Evaluation or select the search
icon to see all options.

e. Panel Questionnaire - Search by the Questionnaire Status, the user's role on the
questionnaire, or for your particular questionnaires in a specific status.

f. When done entering criteria, click Go to search.

g. Search results display according to your criteria.

From Quick Search in Top Right Navigation:

1. Select the search icon in the top right navigation.

2. Select Sourcing Event from the left drop-down. In the search box, enter your sourcing
event criteria such as name or number.

3. Click the search icon.

4. Sourcing Event results display with the event number and name. Select the appropriate
result to navigate to that event.

Event Search Results
Once you have entered your search criteria, search results for events you have access to see/edit
will display. Included on the search results page:
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l Back to Edit search / Start New Search - Select these hyperlinks to either add to your
current search criteria or start with a new search.

l Filtered By panel - Indicates the criteria you used for the search results.

l Refine Search Results filters - Various filters are available to further refine your results,
including Date Range, Supplier, Bid Strategy, Event Type, Event Status, Work Groups, and
Amend Status. Select a value to see results meeting the desired filter criteria. Select the
[more] hyperlink to see additional filter criteria where not all values are displayed.

l Save Search - You can save a search that you will execute on a repeated basis. For
example, if you routinely search for events of a certain status, you could save that search
and access it from your saved searches page instead of having to enter the criteria again.

l Export Search - Select to export your search results to a Summary report or Supplier
Participation report. See Export Event Search Results below for additional information.

l Search Results - Event search results are displayed with basic information about the
event. You can select an Event Number to see the event details.

l Results per page - Set the number of event results you want to see per page.

l Sort by - The default sort is Event Status in Ascending order. Choose from other
options to sort the results differently.

l Pagination - Select a page number or click the left/right arrows to move to the
next/previous page.

l Event Information - the following summary information is displayed for each event:

l Event Status - an Icon will indicate if the event uses Sealed Bid, is an
Amended event, a Draft, or is a Public Event.

l Event Details, including the Event Name as well as:

l Event number

l Event type

l Key dates (displayed in the user's time zone, if configured)

l Bid response information

l Click on the Event Name to view the event details, or selectManage Event.

In order to have view-only access to events, you must be listed as a Stakeholder to a work group
or a specific event. As a Stakeholder on a work group, the user will have access to view all events
associated with the work group. As a Stakeholder for a specific event, the user will have view
access to that event only.
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In order to be added as a Stakeholder, you must have one of the following Sourcing Permissions:
View Events, Create/Own Events,Manage Work Group Events, Approve/Reject Sourcing
Events, or Finalize Award Scenarios.

Viewing an Event within Search Results

When you click on an Event Number from search results, you are taken to the event details. A
banner across the top provides a hyperlink Back to Search results to return to your results list.
You may also click through the result list, or select from the Event Number drop-down to
navigate to another event in the result set.

Export Event Search Results
Users with access to view events may choose to export event information into a Summary Report
or a Supplier Participation Report.

1. Search for sourcing events and view results.

2. Select the Export Search button in the left panel. A Document Search Export overlay
displays.

3. Enter a File Name for the export. This field is required.

4. Enter an optional description for the export, such as "Events Under Evaluation".

5. Choose a Request Export Template:

a. Summary - A summary of information about the events in search result, including
event title, type, dates, items, and other basic configuration settings.

b. Supplier Participation - Information about the supplier responses for the events in
search results, including basic event information, progress in responding to each
event, and supplier contact information. Note that not all events will be included in
this report:

l Only those events to which suppliers have the ability to respond will be
included. For example, draft events would not be included in this report, even
if draft events are displayed in the event search results.

l Sealed events cannot be exported until the sealed bid open date.

6. Optionally choose to include custom field data on the export by selecting the Include
Custom Fields checkbox.

7. Click Submit.
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8. A confirmation message displays that the request has been submitted, with directions for
navigating to the page where the file may be accessed. You may close the message, or
select the button to navigate to download the export.

9. On the Sourcing > Sourcing Events > View Exports - Searches page, all search
exports the user has requested are listed. When the status indicates the request has
completed, a file link is available for download.

Early Access Participation for the New Sourcing Search
Experience
Users who opt into Early Access Participation - Enable New Search Experience have access to the
Beta version of Sourcing search. This search functionality continues JAGGAER's steady advance
toward providing customers with the opportunity to more easily locate and analyze their Sourcing
data.

Users who opt into the new search interface can access more than a dozen new Status Flags
that enable searching by such options as multi-stages, prices, scoring, and workflow. These
users can also find two new Post-Search Filters that enable them to limit their search retrieval
by buyer participants and assigned commodity codes.

Enabling the New Search Experience

Follow these steps to enable the new search experience. If you do not have permission to edit
your own profile, you will need to request access from your administrator.

1. Click on your profile icons in the upper right corner and select View My Profile.

2. In the left sidebar, navigate to User Profile and Preferences > Early Access
Participation.

3. Select Edit Section.
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4. Set Enable new search experience toOverride and Yes. To disable the new search
experience, select Default, or alternatively, selectOverride and No.

If the new search experience is enabled, you can toggle between the new search interface and
the existing search interface by clicking the Choose Your Experience button in the lower right
corner of the screen. Make your selection and click Save to instantly switch formats.

New Search User Interface

The new Sourcing search uses an updated UI but returns the same results as the existing search.
In the new experience, all searches are performed directly on this screen, and the list of events is
displayed at all times. The list is displayed with a default filter of Created Date: Last 90 Days.
There are a number of major UI elements on this screen:



JAGGAER 41 www.JAGGAER.com

1. Quick Filters/My Searches Panel toggle - Toggle the button to hide or view the
Quick Filters/My Searches panel on the left. This panel is displayed by default.

2. Quick Filters- Select a value to see results meeting the desired filter criteria.

3. My Searches - Users can click to access and manage their searches and sourcing events,
evaluations, and approvals. See additional details below.

4. Created Date Filter - Select a drop-down option to see All searches, searches created
within the Last 90 Days (default), or Between a date range.

5. Quick Search - A panel forQuick Search displays above the event list.

6. Save As - This drop-down has been expanded to include the options available through the
My Searches panel suchManage Searches,My (Document Type), andMy Recent
Approvals to give users an alternate method for accessing these options.

7. Pin Filters - This drop-down contains the options to Pin Filters and Pin Columns. Users
can use these options to save the screen configurations and searches that they use
frequently. When a filter or column configuration is pinned, it becomes the default layout
for new searches each time the user returns to the Sourcing Events search page.

8. What's Beta? - Contains information about the current status of the new search
experience.

9. Got Feedback? - Enables users to provide feedback on the beta experience.

10. Export All - This drop-down allows users to export the entire search retrieval to Excel, or
to manage the contents and scheduling of exports.

11. Add Filter - This drop-down contains a list of all available filters. As with other search
results pages, simply select or deselect options from the filter list to refine results.
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12. Show Completed Stages - When selected, this filter exposes all completed stages of
multi-stage events on the search results page.

l Another method, allowing users to expose and access completed stages of a
specific multi-stage event, is available in the functional drop-down list next to each
returned multi-stage event. Expand the ...menu beside a multi-stage event and
select Show All Stages.

l A screen-overlay listing the event's completed stages appears. Click View beside
the event stage that will be displayed on-screen.

13. Include Archived - Select this checkbox to include archived events in search results.

14. Clear All Filters - Resets all quick search settings.

15. ... drop-down - Expand this drop-down to access all the user actions available to that user
for each corresponding entry in the returned event list.
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16. Event Number - Regardless of what search parameters have been set, if any, click on the
Event Number to access the corresponding event document. Users who access a
sourcing event through the Beta search interface will be navigated directly to the
appropriate page within the event based on the event's status.

17. Up and Down Arrows - Whether or not a search has been performed, the list of events
can be quickly sorted by clicking the arrows next to the column names. An up arrow
indicates ascending order. A down arrow indicates descending order.

18. Configure Columns - Click the gear icon , located in the right corner above the events
list, to define which columns are displayed on the search screen and the order in which
they appear.

l Columns are added or removed using the checkmark toggles on the left.

l Columns are reordered using the up and down arrows on the right. Columns towards
the top will appear further left in the list, while columns towards the bottom will
appear further right.

l Click the trash can icon to remove columns from display. This is the same
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functionality as unselecting a column with the checkmark toggle.

Note: The Event Number column cannot be removed from the search screen. 

l Click Apply to save changes. 

19. ### Per Page - Expand this drop-down to select how many events are displayed per page.
The minimum is five and the maximum is 200. 

My Searches

The following new pre-defined searches are available under theMy Searches tab:

l My Sourcing Events - Displays events created by the user within the last 90 days.

l Sourcing Event Evaluations Recently Approved by Me - Displays events approved by
the user within the last 30 days.

l Sourcing Events Recently Approved by Me - Displays events approved by the user
within the last 30 days.

Status Flag Options

The following Status Flags are available:

l Multi-stage enabled

l Invite by Commodity Code

l CPQP Enabled

l Best Value Enabled

l Panel Questionnaire Enabled
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l Split item Enabled

l Max and Price Enabled

l Min Price enabled

l Auto Score Enabled

l Cost Analysis Enabled

l Proxy Bid Enabled

l With Ad Hoc Approvals

l With Evaluation Error

l Workflow Error

Only the first 10 status flags appear on-screen. Click Show More to access the full list of Status
Flags.
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Other Post-Search Filter Changes

The following new quick filter options have been added for the new search interface:

l Participants

l Commodity Code
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The All Auctions filter has been excluded from the post-filter options. To search for all auctions,
select both the Live and theMock options.

The Current Workflow Step post-filter option now includes both Approval and Evaluation
workflow steps.

Sourcing Event Summary Widget

When the new search interface is enabled, the following changes appear in the Sourcing Event
Summarywidget:

1. Event Owner has been added as an option in the View Sourcing Events By filter.

2. On Creation Date has been added as an option in the Date Range filter.

3. The # per page upper limit has been reduced from 50 to 20 to ensure better viewing.

To access this widget, navigate to Sourcing > Sourcing Events > Sourcing Events Home.

Event Export with the New Sourcing Search Experience
Users who opt into Early Access Participation - Enable New Search Experience have access to
the Beta version of Sourcing search. This search functionality continues JAGGAER's steady
advance toward providing customers with the opportunity to more easily locate and analyze their
Sourcing data.

When the new search interface is enabled, two new type options, Summary and Supplier
Participation, are available for search result export files. Users may choose the following options
in the Type drop-down:
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l Screen Layout - Exports the current search configuration and results displayed on the
screen.

l Summary - Exports event information based on the applied search results, not just those
displayed on screen. With this option, users may choose to include all custom fields, not
only the custom fields used as search criteria, by selecting the Include Custom Fields
checkbox that appears on the Export Sourcing Events screen overlay.

l Supplier Participation - Exports supplier information based on the applied search results.
This export file contains two datasheets:

l Supplier Participation: Supplier response information per event

l Invited Contact: Supplier contact information per event

l The following events are excluded from Supplier Participation export files:

l Sealed bid events that are not unsealed

l Events that do not have one of the following statuses:

l Released

l Open

l Under Evaluation

l Under Evaluation Error

l Awarded

l Closed No Award

l Stage Complete

Export results can be found on the Manage Export Requests page. Access this page through one
of the following methods:
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l Click the link that appears in the message box at the top of the page after a search export
has been performed.

l Expand the drop-down beside Export All and selectManage Search Exports.

l Click the user icon in the top right corner and selectManage Search Exports.
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Public Sites
A Public Site is a branded site where customers can publicly display sourcing bid opportunities
without specifically inviting suppliers through the application. Customers can determine what
parts of the bid collateral and award data will be displayed on the Public Site. Any supplier may
search and view publicly posted events.

You must contact JAGGAER to enable the ability to enable Public Site for your organization. Once
enabled, administrators can configure their Public Site settings and branding on the General
Sourcing Settings page. See "General Sourcing Settings" on page 315 for additional information.
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Navigating a Public Site
The Public Site page displays events organized into tabs. For the events in each tab, click on the
button to navigate to the event in the portal or to complete a registration for the customer prior to
viewing the event. You may also click to open or download a PDF file of the event information by
selecting the View as PDF hyperlink.

l Open for Bid - this is the default page displayed, and shows events that are in an Open
status.

l Upcoming - displays released events that are not yet open.

l Closed - displays events that have been closed or canceled. AMore Options hyperlink is
available to filter results by a specific status.

l Awarded - displays events that have been awarded if you have configured your site to
display awarded event information.

l All - displays all sourcing events available to the public site, in all statuses. AMore Options
hyperlink is available to filter results by a specific status. If an event has been Withdrawn,
the PDF will not be generated on the Public Site.

Available Actions
When selecting the action button (Respond Now, View, Preview):

l If a supplier is already logged into their portal, the user will be directed to the requested
Sourcing Event in the portal.

l If a supplier has a portal but is not logged into their portal, the user will be directed to the
Portal Login page. Upon login, they will be directed to the requested Sourcing Event.

l If the supplier does not yet have a portal, they can register on the Portal Login page by
selecting Create Account. Upon confirmation of account creation, the user can log in and
be directed to the requested Sourcing Event.



JAGGAER 52 www.JAGGAER.com

Create and Configure an Event

Event Types

Standard Event Types
Sourcing includes four standard event types:

l Request for Information (RFI) - An RFI is used to gather initial information such as product
brochures, specification sheets, or other details that may help your organization weigh
options and develop a more detailed sourcing activity. For example, a buyer working to
purchase vehicles for an organization’s fleet might request that several automobile
dealerships provide general information on various models of cars they sell. Collecting this
initial information might help the buyer outline detailed specifications for a formal bidding
process. An RFI may not include a request for pricing on specific items, and the information
collected generally is not used as the basis for a final purchasing decision.

l Request for Proposal (RFP) - An RFP outlines a problem or need that your organization
must address and asks bidders to provide formal proposals on how they can meet the
need. While an RFP may request pricing on specific items, some elements of the proposal
may be left to the discretion of potential suppliers. In addition to the proposal, an RFP
typically requests or requires suppliers to upload detailed information about their history,
capabilities, and references.

l Request for Quotation (RFQ) - An RFQ is intended to gather final pricing proposals,
usually based on detailed specifications that are outlined in the event details. The end goal
of an RFQ is to compare quotes and award a bid. Ideally, the information in the results of
the RFQ should have enough detail to transfer directly into a contract if needed. An
example of an RFQ would be to ask a select group of car dealerships for final pricing based
on buying 50 blue mid-sized sedans with GPS navigation, cloth seating, V6 engines, front
wheel drive, and automatic transmissions.

l Quick Quotes - Quick Quote events enable you to apply default selections to key event
control parameters such as event Open, Close and Q&A Submission Close date settings. It
is possible to pre-set a preferred award scenario for immediate application when an event
closes. Other Quick Quote controls that can be applied during event construction include
the invitation of a selected Supplier Group and the automatic distribution of Award
notification emails. If necessary, you can override template-applied defaults when
administering a draft event. See Create a Quick Quote Event in "Event Creation " on
page 76.

1. Indirect/6. Sourcing/8. Events/e3. Quick Quote Events.htm
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Note: Not all organizations will implement all event types. Contact your System
Administrator for information about which event types your organization is using.

Adding an Event Type
You may design custom events for your organization. Permission(s) required: Sourcing
Configuration.

1. Navigate to Sourcing > Sourcing Administration > Manage Event Types.

2. Click Create New.

3. Enter an abbreviation or short name for the Event Type. The value must be between 3 and 7
characters.

4. Enter a Name for the Event Type.

5. Click Save. The Create New Event Type overlay closes and the event type details are
displayed.

6. On the About tab, select the appropriate option for Active.

a. If you want to begin using this Event Type immediately, select Yes (this is the default
selection).

b. If you want to have additional time to configure the Event Type and would not like it
used immediately, select No.

7. Select the appropriate option for Require a template to create an event?

a. If you want to require a template to create an event for this type, select Yes.

b. If you do not want to require a template to create an event for this event type, select No
(this is the default selection).

8. Select the appropriate option for Configure as an Auction?. This option appears only for
organizations with the Auction module.

a. If you want to perform auctions with the event type, select Yes.

b. If you do not want to perform auctions with the event type, select No (this is the default
selection).

9. If you have selected to configure the event type as an auction type, the Auction Type
dropdown will appear. Select Standard English Reverse.

10. Select to save changes.
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11. If Restricted User Access on the General Sourcing Settings page has been set toOptional,
the User Access tab will appear. On the User Access tab, select the appropriate option for
Control Event Creation.

a. If you want to limit event creation for the event type to selected users, roles,
departments, and business units (based on configuration), select Yes. If you select Yes,
click the Edit Users button to select the individual users, roles, and/or departments you
want to limit event creation to.
Note: If you select Yes but do not add any users, no one will have access to the event.

b. If you do not want to limit event creation for the event type to selected users, roles,
departments, and business units, select No (this is the default selection).

c. Select to save changes.

12. On the Visibility tab, users are able to hide all or part of the following Setup sub-sections:
Commodity Codes, Payment, Bid and Evaluation, Display and Communication, and Dates
while the event is in Draft status. Users can also hide all or part of the following Additional
Sections: Prerequisites, Buyer Attachments, Supplier Attachments,Questions, Price
Components, and Additional Item Fieldswhile the event is in Draft status.

a. Select and deselect the Setup sub-sections as appropriate. Click the icon beside each
sub-section to expand the listed options.

b. All event types include Setup, Users, Description, Suppliers, and Review and Submit
sections. Options to include these sections are indicated as read-only and are not
configurable.

13. Review and edit, if appropriate, then enter the text for Instructions to Supplier on Review
and Submit.

14. Select additional sections to include on this event type. For each selected section,
review/edit the Instructions to the Supplier text for the step. Select from:

a.  Prerequisites

b. Buyer Attachments

c.  Supplier Attachments

d.  Questions

e.  Items

15. An event's type determines the custom fields that will appear on it. Select the Custom Data
tab to add custom fields to the event type.
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16. Click the Add Group button to add a group for custom fields. The Add Group overlay
displays.

i. Enter a Group Name. This is the name that will appear as a header for the included
fields on the Setup step of events.

ii. Optionally, select Yes for Insert Page Break Before. Page breaks cause the custom
fields listed under them to appear on separate pages listed under the Setup step of
events. Groups appearing before a page break will appear on the Setup page for an
event.

iii. Select the Display Order for the group.

iv. Click Save to save the group and close the overlay.

17. Click the Add Field button under a group to open the Add Field to Group overlay.

i. Search for and select the field you want to add to the group.

ii. Optionally, choose to make the field mandatory by selecting the Response is
Required checkbox.

iii. Select the Display Order for the field.

iv. Click Save to add the custom field to the group and close the overlay.

Configuring Reverse Auction Event Types
Reverse auctions allow buyers to obtain compressed pricing on products and services, as
suppliers compete in real-time to provide those items at lower and lower price points.

Organizations with the Sourcing - Auctions license can establish an auction event type.

Both standard and custom event types can be configured as auction event types. Select Yes for
the Configure as an Auction? option to make an event type an auction event type on the About
tab.

When Yes is selected, the fields available on the event type About tab will change. Select
Standard English Reverse from the Auction Type drop-down.

The Auction Settings step is also added to the list of Event Creation Wizard steps.

Edit an Event Type
Permission(s) required: Sourcing Configuration
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An organization may want to edit an event type. When an event type is edited, none of the
changes apply to existing events of that type. The change will only apply to new events of that
type.

Note: The event type Title itself cannot be changed. If the event type title is no longer valid,
disable the event type and create a new one.

1. Navigate to Sourcing > Sourcing Administration > Manage Event Types.

2. Select the Event Type to edit from the list.

3. To disable the event for use, select No for Active.

4. Edit any other information for the Event Type under the About, User Access (if enabled),
Visibility, and Custom Data tabs. If custom data is edited, changes will appear on new
sourcing events. Existing events do not have their custom fields changed.

5. Click Save Changes.

6. Changes to event types are viewed by selecting the History hyperlink for event types.

a. By default, history for all event types is displayed.

b. Select the Show History Filters hyperlink in the history window to view history for
specific criteria.

Limiting User Access to Event Types
Organizations can decide whether all event creators can use any active event types during event
creation.

To activate this feature, a user with the Sourcing Configuration permission navigates to

Sourcing > Sourcing Administration > General Sourcing Settings and changes
Restricted User Access toOptional. This will make a tab called User Access available on each
event type. From this tab, a user is then able to activate Control Event Creation. The user can
then add the specific users or groups of users that will be allowed to use the event type during
event creation.

Managing Event Types

Navigate to Sourcing > Sourcing Administration > Manage Event Types. Click an existing
event type listed in the Event Types list on the left side of the page to edit this event type
configuration, or click the Create New link beside the Event Types list header.
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You will automatically land on the About tab, where you can configure general information about
the event type such as the name, whether the type is active, and whether is template is required
to create events of this type.

Visibility of Elements in Event Types
As you create or edit event types, you are given the opportunity to customize which sections
show for the defined event type.

On the Setup section of the Visibility tab, users are able to hide all or part of the following Setup
sub-sections: Commodity Codes, Payment, Bid and Evaluation, Display and Communication,
and Dateswhile the event is in Draft status.

All events contain the following sections. These sections are described in greater detail in the
chapter entitled "Configure an Event" on page 91.

l Users - The Users page allows you to configure what users will have what type of access
for the event.

l Description - The Description page contains the basic description of the event that is
shown to suppliers.

l Suppliers - This page is where you will add suppliers to the event or see what suppliers
have been invited to respond to the event.

l Review and Submit - For draft events, this page shows the status of all the event detail
pages and alerts the user if required information is not completed. If all required
information for the event is satisfied, the user will see a button to Submit for Approval.

You may configure other elements to be included for certain event types:

l Auction Settings - If your organization has Sourcing - Auctions and your event is an
auction, the Auction Settings page is used to set basic information about your auction.

l Prerequisites - The Prerequisites page contains any information and/or documents you
want the supplier to review as part of responding to the event.

l Buyer Attachments - This page is used to include attachments, such as a diagram or
additional information, that would be helpful to the supplier.

l Supplier Attachments - You may include this page to allow suppliers to add attachments
to supplement their bid response.

l Questions - You may ask specific questions related to the event. You will configure the
type of response such as a Yes/No selection, text box, file upload, etc.
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l Additional Item Fields - You may create up to 20 additional item fields to collect additional
information from suppliers. You may ask specific questions regarding individual products
and services being bid on by suppliers responding to the event and configure the type of
response, such as a Yes/No selection, text box, file upload, etc. These fields may be used
for internal purposes, or they can be made visible to suppliers to share information or
gather additional information from suppliers.

l Items - If the event is for specific products or services, you may list out the items on this
page.

l Price Components - These fields support an itemized view of price factors, such as fixed
freight costs and import duties, that affect the total bid prices submitted against sourced
items.

Work Groups

Overview
Work Groups and sub-work groups are groupings that allow administrators to organize and
control access to your organization's events. Organizations create work groups that will be
associated with individual events sent to suppliers for goods or services. Work Groups are flexible
and meant to be used based on your business needs.

Work Groups are designed around a hierarchical structure: parent, child, grandchild, etc. There is
no limit to the number of sub-levels you can add beneath a parent work group. Examples of sub-
work groups include separation by the type of purchase (office supplies, chemicals, etc.) or by
procurement group within an organization.

Note: A user who has access to a particular work group also has access to all sub-work
groups beneath that work group by default, but a user assigned access only to a sub-work
group does NOT have access to parent work groups above it.

Every event created in a system must be associated with a work group or sub-work group at the
time of creation, and users are given access to these same work group access groups. If you
create a new event, such as a Request for Information to purchase fax machines, you might
associate that event with the Office Supplies work group, thereby giving access to your event to
all users in the Office Supplies work group. This would determine who can view and update your
event. What functions users can perform for any given event are also dictated by their assigned
permissions. The person creating or updating an event has the ability to open access to the event
to other users.
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Create or Edit a Parent Work Group
Permission(s) required: Sourcing Configuration .

When creating a work group, you will create a parent work group or a child work group. A parent
work group is the top work group in a new work group tree. Any settings in the parent work group
will be inherited by a child work group. A child work group is created when there may be a few
differences from the parent work group, such as the users associated or specific configuration
settings.

Note: Some configuration options may not be available, depending on your organization
settings.

1. Navigate to Sourcing > Sourcing Administration > Manage Work Groups.

2. If making edits to a current work group, select the work group from the list.

3. To add a new work group, select the Create New hyperlink. A Create Work Group overlay
displays.

a. Enter a Name for the work group. This field is required.

b. Enter aWork Group Code. This field is required and may be included in the number
wheel for events associated with this work group.

c. Enter a Description of this work group (optional).

d. Click Save Changes.

4. On the About tab:

a. Edit the Name or Description as appropriate. Click Save Changes.

b. AddWork Group Administrators by selecting the Edit Users button. Note:
Administrators for a work group can create, view, and edit their work group
hierarchy.

i. Search for users to add individually, or add by role, department, or business
unit. Click the Search icon in each field to see additional search options.

ii. Select each user, role, department, and business unit you want added as work
group administrators.

iii. Only users with appropriate permissions for the role will be displayed. Adding
a department or business unit does not give every included user access to the
work group. It only gives access to users with the correct permissions on their
user profiles.
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iv. To remove a user, role, department, or business unit, click the X beside the
name in the overlay.

v. When finished adding and removing users, click the Save Changes button on
the Edit Users overlay.

c. When finished with the configurations on the About tab, click Save Changes.

5. Select the Event Users tab to add users that will be inherited by each event created for the
work group. See "Sourcing Terminology" on page 16 for details on the types of users. Note:
Users may be added to individual events; however, any users designated at the work
group level cannot be removed for events within the work group.

a. For each type of user (Event Managers, Event Creators, Stakeholders, Template and
Library Manager, Notification Recipients, Event Price Viewers), click the Edit Users
button.

i. Event Managers can create, edit, and view events within the work group.

ii. Event Creators can create events within the work group.

iii. Stakeholders can view events in the work group.

iv. Template and Library Managers can add, edit, or remove collateral in this
work group.

v. Notification Recipients can receive system-generated event notifications if
buyer notification restriction has been enabled.

vi. Event Price Viewers can view an event's confidential pricing including
estimated price, target price, historic prices, minimum, maximum, supplier
prices, and for Reverse Auctions, the reserve price and bid decrement for that
event.

b. Search for users to add individually, or add by role, department, or business unit.
Click the Search icon in each field to see additional search options.

c. Select each user, role, department, and business unit you want added as work group
administrators.

d. Only users with appropriate permissions for the role will be displayed. Adding a
department or business unit does not give every included user access to the work
group. It only gives access to users with the correct permissions on their user
profiles.

e. To remove a user, role, department, or business unit, click the X beside the name in
the overlay.

f. When finished adding and removing users, click the Save Changes button on the
Edit Users overlay.
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6. Select the Event Setup tab to configure additional settings that will be inherited by events
created for this work group. Many of the settings that display on this page are determined
by your organization settings:

a. Event Number: The current event number format displays, with the option to edit.

i. To keep the default number wheel, no action is required.

ii. To change to a different number wheel format, select Yes for Select a
Different Format.

l Select from the configured number wheel formats for Number Format
to Use.

l Once selected, confirm the number format as displayed for the Sample
Number Format field.

Note: Availability of this edit option depends upon site configuration.

b. Multi Stage: Configure theMulti Stage Setting for work group.

i. Optional - All events are allowed to have multiple stages. It is optional to
create a new stage from an event in this work group.

ii. Disabled - No event is allowed to have multiple stages. You will not have the
option to create a new stage for any events in this work group.

c. Event Creation: Configure the Create from templates setting for a work group.

i. Optional - Sourcing events can be created as blank events or from a
template.

ii. Required - Sourcing events must be created from a template. You will not be
able to create a sourcing event without a template.

d. Configure Bid and Evaluation settings. Some settings may be configured at the
organization level. The organization setting is inherited for all work groups. If the
organization setting isOptional, each of the following settings may be configured at
the work group level.

i. Select a Sealed Bid Setting.

l Optional - Events may be sealed or unsealed. The selection is made on
each event for this work group.

l Required - All events for this work group will be sealed. This cannot be
changed at the event level.
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l Disabled - No events in this work group will be sealed. This cannot be
changed at the event level.

ii. Select a Proxy Bid Setting.

l Optional - Events may allow proxy bid. The selection is made on each
event for this work group.

l Required - All events must allow proxy bid, and therefore will have the
option of designating suppliers for proxy bids.

l Disabled - No events will allow proxy bid.

iii. Select a Confidential Pricing Setting

i. Optional - Events choose to enforce Confidential Pricing. The selection
is made on each event for this work group.

ii. Required - Confidential Pricing is enforced for all events. This cannot
be changed at the event level, but the panel questionnaire must be
configured for use.

iii. Disabled- Confidential Pricing is not available for any events. This
cannot be changed at the event level.

iv. Select a Panel Questionnaire Setting.

i. Optional - Events choose to use a panel questionnaire. The selection is
made on each event for this work group.

ii. Required - Panel Questionnaires are available for all events. This
cannot be changed at the event level, but the panel questionnaire must
be configured for use.

iii. Disabled- Panel questionnaires are not available for any events. This
cannot be changed at the event level.

v. Select a Cost Per Quality Point Setting.

l Optional - Cost Per Quality Point evaluation may be used for all events
in this work group. Selection is made at the event level.

l Required - Cost Per Quality Point evaluation is required for all events in
this work group.

l Disabled - Cost Per Quality Point evaluation will be disabled for all
events in this work group.
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vi. Select a Best Value Setting

l Optional - Best Value evaluation may be used for all events in this work
group. Selection is made at the event level.

l Required - Best Value evaluation is required for all events in this work
group.

l Disabled - Best Value evaluation will be disabled for all events in this
work group.

vii. Select an Auto Score Setting.

l Optional - Events choose to use auto scoring. The selection is made on
each event for this work group.

l Required - Auto scoring is available for all events. This cannot be
changed at the event level, but the auto score criteria must be
configured for use.

l Disabled- Auto scoring is not available for any events. This cannot be
changed at the event level.

viii. Select a Cost Analysis Setting.

l Optional - Events choose to use cost analysis. The selection is made
on each event for this work group.

l Required- Cost analysis is available for all events. This cannot be
changed at the event level, but the cost analysis criteria must be
configured for use.

l Disabled- Cost analysis is not available for any events. This cannot be
changed at the event level.

ix. Select an Alternate Items Setting.

l Optional - Events may allow alternate items. The selection can be
made for each event. If enabled for the event, each item must be
configured to allow alternates or not.

l Required - All events must allow alternate items. Each item must be
configured to allow alternates or not.

l Disabled - Events do not allow alternate items.

x. Select a Split Item Quantity Setting. For more information about split item
quantity awards, see "Split Award Options" on page 228.
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l Optional - Allow split quantity is optional for all events in this work
group. It may be configured at the event level, and is optional for use if
enabled for the event.

l Required - Allow split item quantity will be enabled for all events in this
work group. It is optional for use.

l Disabled - Allow split item quantity will be disabled for all events in the
work group.

e. Supplier Invitation: Configure how supplier invitations by commodity code and
manual invitations should be handled for events in the work group.

i. Select a Force Supplier Invitation by Commodity Code setting.

l Optional - Users can specify at work group level.

l Required - All suppliers with a specified commodity code will be invited
to the sourcing event.

l Disabled - Prevents the use of Force Supplier Invitation by Commodity
Code.

ii. Select aManual Supplier Invitations setting.

l Optional - Events allow Manual Supplier Invitations.

l Required - Provides the ability for new suppliers to be sent an
invitation to a sourcing event.

l Disabled - Prevents Manual Supplier Invitations.

f. Configure Display and Communication settings:

i. Select a Visible to Public Setting if your organization is configured to use
Public Site.

l Optional - Events may be public or private. Therefore, the selection will
be made on each event for this work group.

l Required - Events are visible to the public. This cannot be changed at
the event level.

l Disabled - Events are not visible to the public. This cannot be changed
at the event level.
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ii. View the options for Award Notification Emails. The award notifications
enabled for the organization show as enabled for the work group. If you do
NOT want to allow users to send suppliers a particular type of award
notification for the work group events, you may deselect options at the
organization level.

7. Click the Save Changes button to save configuration.

Create a Child Work Group
Work Groups can have many levels. Settings for user access, event number format, and most
other configurations on a top-level work group are inherited by child work groups.

A user with the Sourcing Configuration permission can complete this task for any work group. A
user with Administer Work Groups permission who is assigned to a parent work group can
create a child work group.

1. Navigate to Sourcing > Sourcing Administration > Manage Work Groups.

2. Select work group in the list for which the child work group should be created.

3. Click the hyperlink Add Child Work Group. A Create Work Group in [Project Name]
overlay displays.

Child work groups are configured as described above for parent work groups. The following
modifications can be made to child work groups:

l Adding users: You cannot remove work group Administrators and other Event Users who
are assigned at the parent work group level. You can select Add Users to add new users
as a work group Administrator or any other Event Users. Users added to the child work
group will have access to events in the child work group only.

l Event Number Format: You can select a different number format for the work group, if
desired.
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l Multi Stage Setting: If the parent work group is set toOptional for multi stage events, you
may keep the Allow setting on the child work group, or change it to Disabled.

l For the following settings, ifOptional is selected for the parent work group, a
different option may be selected for the child work group. Otherwise, the child work
group inherits the parent work group setting, and it cannot be changed.

l Create from Templates Setting

l Sealed Bid Setting

l Proxy Bid Setting

l Confidential Pricing Setting

l Panel Questionnaire Setting

l Cost Per Quality Setting

l Best Value Setting

l Auto Scoring Setting

l Cost Analysis Setting

l Alternate Items Setting

l Split Item Quantity Setting

l Force Supplier Invitation by Commodity Code Setting

l Manual Supplier Invitations Setting

l Visible to Public Setting

l Award Notification Emails: Award Notifications are set at the organization level and do
not differ by parent or child work groups.

Edit a Work Group
Users who are assigned as work group Administrators to a work group may change work group
settings which include:

l Name

l Description

l Work Group Administrators

l Event Users: Managers, Creators, Stakeholders, Template and Library Managers,
Notification Recipients, and Event Price Viewers.
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l Event setup options, which will depend on the organization's default settings for many of
these configurations:

l Event number format

l Multi Stage setting

l Event Creation

l Supplier invitation preferences

l Bid and evaluation settings related to sealed bids, proxy bids, Confidential pricing,
panel questionnaires, auto score and cost analysis, alternate items, and split item
awards

l Public site and award communication settings

If the work group code for an existing work group is no longer valid, you must delete the work
group and create a new one with the appropriate code.

Regarding permissions for managing work groups:

l A user with Administer Work Groups permission who is assigned as a work group
Administrator can delete a top-level work group, add child work groups, add users, and
edit settings to the work group they are assigned.

l A user with the Sourcing Configuration permission can manage a work group without
being an assigned work group Administrator. This user can create/delete new top-level
work groups, add/delete child work groups, add users, and edit settings of any work group.

View the history of work group settings by selecting the History hyperlink on the work group. A
separate window lists the details of edits to the work group settings, including date, user, field,
etc. History filters are available to see specific audit records, and you can also select to Export
CSV file of the history log.

Making Bulk Changes to Work Groups
Note: Changes to work groups in Sourcing affect both the Sourcing and Contracts+ modules.
Clients with both modules should consider the impact of their changes on both Sourcing and
Contracts+ before modifying work groups.

Prepare an Excel File
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1. Navigate to Sourcing > Sourcing Administration > Manage Work Groups.

2. Expand the Create New drop-down at the top of theWork Groups navigation bar on the
left side of the page. Select Import/Export. A Work Group Import/Export overlay opens.

a. Action - Export is selected by default. Keep this selection.

b. Description - This export action can be documented with up to 100 characters.

c. Click Submit.

3. Click Go to Page: Download Export Files. A Work Group Import/Export Results page
opens.

4. Click the appropriate link in the File column to open the requested file. If the file status is
Pending, click Refresh to update the request status and access the file.

5. Update the data on the following tabbed workbook pages as necessary:
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l Work Group - Contains the workgroup name, code, parent code, and description.

l An Action column contains options to Add or Update the corresponding work
group.

l If the Parent Work Group Code column is blank, the workgroup is located at
the root level of the hierarchy. Codes within this column identify a child
workgroup of the corresponding parent workgroup.

l Work Group Administrators - Contains the workgroup name, code, record type,
and value.

l If a work group does not have an assigned administrator, it will not appear on
this page.

An Action column contains options to Add or Removework group
administrators.

l The Record Type column contains options for defining the workgroup
administrator: User, Role, Department, or Business Unit (if configured for an
organization).

l The Value column contains the userID, role, etc., to identify that work group's
administrator.

l Sourcing Event Setup - Contains the number wheel configuration and the event
formatting options that are accessible to administrators through the UI.

l The Number Wheel Over-Ride field indicates whether the number wheel
default has been over-ridden (Yes/No).

l Fields with a gray background are informational-only and cannot be changed
via Excel import.

l Sourcing Event Users - Contains data concerning sourcing administrators,
sourcing managers, and stake holders.

l An Action column contains options to Add or Removework group
administrators.

l The User Type column defines the type of user as configured on the Event
Users tab in the UI (Event Managers, Event Creators, Stakeholders, Template
and Library Managers, Notification Recipients, Event Price Viewers).
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l The Record Type column contains options for defining the user: User, Role,
Department, or Business Unit (for stakeholders only).

l To change an existing user's role, select Remove for the user in the current
role and create a new row to Add this user in their new role.

Note: Tabs for Contract Setup and Contract Users are also available in
this workbook for configuring changes to work groups in the Contracts+
module.

6. Save the changes.

Import an Excel File

1. Return to Sourcing > Sourcing Administration > Manage Work Groups.

2. Expand the Create New drop-down at the top of theWork Groups navigation bar on the
left side of the page. Select Import/Export. A Work Group Import/Export overlay opens.

a. Action - Expand the drop-down and select Import.

b. Description - This import action can be documented with up to 100 characters.

c. File Name - Use standard JAGGAER functionality to select a file to import.

d. Click Submit. A Request Submitted screen overlay appears.

e. Click Close to close the overlay or click Go to Page: Download Export Files to be
redirected to the Work Group Import/Export Results page. The uploaded file and
upload details can be accessed on this page.

Delete a Work Group
A user with the Sourcing Configuration permission can complete this task for any work group. A
user with Administer Work Groups permission who is assigned as work group Administrator can
complete this task for their assigned work group only. Also, the work group must not have any
child work groups or events associated.

1. Navigate to Sourcing > Sourcing Administration > Manage Work Groups.

2. Select work group in the work group list that meets the following criteria:

a. The work group has no child work groups.

b. The work group has no events associated.

c. The work group has no associated workflow rules.
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3. Select the hyperlink Delete This Work Group.

4. A confirmation overlay appears asking if you are sure you want to delete the work group.
Select Yes.

View Work Group History
A user must have access to the work group in order to access the work group settings and view
history. A user with the Sourcing Configuration permission can complete this task for any work
group. A user with Administer Work Groups permission who is assigned as work group
Administrator can complete this task for their assigned work group only.

1. Navigate to Sourcing > Sourcing Administration > Manage Work Groups.

2. Select a work group from the list on the left.

3. Select the History hyperlink. A new window opens.

4. The following information displays:

a. Date - the date and time the change was made.

b. User - the user who made the edit.

c. Work Group Name - the work group name that was edited.

d. Action - the action for the edit (Created, Modified, Deleted, etc.).

e. Context - The product associated with the action.

f. Section - the section of the work group that was edited.

g. Field - the field that was edited.

h. Old Value - the previous value for the field before the change.

i. New Value - the updated value for the field.

5. Sort results by Date, User, Work Group Name, Action, Section or Field by selecting the sort

icon that appears beside the column title.

6. Set the number of results per page by selecting the (#) Per Page drop-down that appears
in the to-right corner above the history list.

7. Display additional pages by clicking the right & left arrows that appear in the bottom-left
corner below the history list.
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8. Select the Show History Filters hyperlink in the top-left corner above the history list to
see filter options:

a. Enter or select a Start Date to see audit records beginning on a specific date.

b. Enter or select an End Date to see audit records before a specific date.

c. Select from the Action drop-down to see audit records for a specific action.

d. Select from the Section drop-down to see audit records for a specific section of the
work group.

e. Select from the Field drop-down to see audit records for a specific field on the work
group.

f. After selecting criteria, click Apply to see results meeting those criteria.

9. Select the Export CSV hyperlink to export the audit log to a CSV file. You may select to
open or save the file.

10. When finished reviewing history, close the window.

Sourcing Requests
Administrators can create sourcing request forms within JAGGAER ONE for the purpose of
gathering all data necessary for the creation and administration of an event by a sourcing
specialist.

The ability for anyone within the buyer's organization to submit a sourcing request, by filling out a
request with all information necessary for the creation and administration of an event, ensures
that the organization's sourcing procurement framework is available to meet the needs of all
users and departments across the organization.

Users with access to the Request Form and the Add Ad-Hoc Approver permission can add an
ad-hoc approver anywhere in the workflow. Only users with the Perform Ad-Hoc
Approve/Reject/Return Request permission user right can be selected as ad hoc approvers.

To view your sourcing event requests, navigate to Sourcing > Requests > My Sourcing
Event Requests. Click the Filter Sourcing Event Requests link to view a list of request statuses,
select which ones to view, and click Apply. Event requests with the matching status are
displayed. Click the Filter Sourcing Event Requests link to access filters for viewing approved,
rejected, and completed requests.
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To view all submitted sourcing requests that have completed workflow, navigate to Sourcing
> Requests > Submitted Requests. Access to this page requires the View Organization Form
Requests permission (Permission Settings > Administration). Click the Filter Sourcing Event
Requests link to access filters for viewing approved and completed requests.

l Additional Item Fields - Collapsed if required data is complete. Expanded if required fields
must be addressed.

l Items - The Item Details section of the Edit Product Line Item overlay is collapsed.

Create a Sourcing Request

1. Navigate to Procure to Pay > Procurement. Note: The Sourcing Event Requester
permission (Permissions > Sourcing) is required for users to submit sourcing event
requests.

2. Navigate to Sourcing > Requests > Request Sourcing Events. The Initiate Sourcing
Request overlay displays.

3. Enter a Sourcing Request Title and select a Sourcing Request Template.

4. ClickOpen Request Form.

5. Complete the Details, Instructions, Attachments,Questions, Product Line Items,
Service Line Items, and Suppliers steps of the wizard. You may enter product line items
manually or select them from catalogs or your Favorites folders.

6. When the request is complete, navigate to the Review and Submit step on the wizard and
click Submit. You cannot submit a request until all other wizard steps are complete.

Once you submit the request, it enters workflow, where appropriate review and approvals are
obtained.

Note: A Print Request button is available at the top of the Sourcing Request pages for users'
convenience.

Search for Sourcing Requests

Navigate to Sourcing > Requests > Search Sourcing Requests.



JAGGAER 74 www.JAGGAER.com

1. The search defaults to requests created in the last 90 days. You may accept this date
range or expand the drop-down to select All dates or to enter a range of dates to search
Between.

2. You may also search for a request by entering search criteria in theQuick Search box.

3. You can retrieve more targeted search results by expanding the Add Filter drop-down to
see a list of filters that can be applied to the search results. Click the checkbox next to a
filter to apply it. Click the Clear All Filters button to remove all filters and start again.

4. Click the magnifying glass search icon to execute the search. The search results
display.

5. Click a Form Name to open it.

Save your search results, or initiate actions, by applying one or more of these options:

l Configure columns - Click the configure columns icon to choose which columns are
displayed in the search results. The overlay shows a list of columns related to the area that
you are in, and you can choose which ones you want to display or hide on the search
results page.

l Sort columns - Click the sort icons on a column heading to sort data in ascending or
descending order.

l Save search as a favorite - Click the Save As button at the top of the page (next to the
title) and select Save As to save your search as a favorite. Click the show and hide
icons near the top of the left sidebar to display a list of your favorite searches.

l Pin filters and columns - Under the Save As button, select Pin Filters and Pin Columns
to save settings and they will be selected by default the next time you access the page.
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l Actions - Action icons are displayed to the left of records in the search results if you
have the appropriate permissions. You can initiate an action for a single record or for
multiple records at once.

l Single records - Click the action icon next to a record and select an action from
the drop-down menu.

l Multiple records - The action icon in the column header works as a toggle to show
or hide the multiple selection option. First, click the icon in the column header and
select Show Multiple Selection. Checkboxes are displayed next to each record.
Select the checkbox next to each record you want to initiate the action for, then
click the action icon a second time and select an action from the drop down menu.
Select Hide Multiple Selection from the menu to return to row selection.

l Export search results - Click the Export button to export the filtered search in a format
that you can use for reporting.

View Your Sourcing Requests

1. Navigate to Sourcing > Requests > My Sourcing Event Requests.

2. Click the Filter Sourcing Event Requests link to access filters for viewing Approved,
Rejected, or Completed requests. Select the filters to apply.

3. Click Apply. Event requests with the matching status are displayed.

To view all submitted sourcing requests that have completed workflow:

1. Navigate to Sourcing > Requests > Submitted Requests.

Note: Access to this page requires the View Organization Form Requests
permission (Permission Settings > Administration).

2. Click the Filter Sourcing Event Requests link to access filters for viewing Approved and
Completed requests.

Export Sourcing Requests

Sourcing requests may be exported using a Screen Layout (Excel) format, which provides a data
export of the columns that appeared on the page, or a Full Export (CVS) format, which includes
three separate zipped files containing approval history, request questions, and request data.
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1. Search for Sourcing requests.
2. When desired results are displayed, select the Export button.
3. In the overlay, expand the Type dropdown and select either Screen Layout (default) or

Full Export.
l The Format field is read-only:

l When Type = Screen Layout, the Format is Excel
l When Type = Full Export, the Format is CSV

l The export is available on theManage Exports page. The Full Export format is
provided in a .zip archive containing three separate CSV files:

l Approval History
l Request Questions
l Request Data

Event Creation

Required Permissions
In order to create an event, you must be listed as an Event Manager or an Event Creator within a
work group. If you are not listed as an Event Manager or Event Creator, you will see a message
upon selecting to Create New Event, indicating you must contact your Site Administrator.

You must have permission to Create/Own Events orManage Work Group Events in order to be
added as an Event Creator. You must have the Manage work group Events permission to be
added as an Event Manager.

Create an Event
When creating an event, the options that are present by default may differ depending on the type
of event and/or work group selected.

1. You can navigate to create a new event by any of the following ways:

a. Navigate to Sourcing > Sourcing Events > Create New Event.

b. From the Sourcing > Templates and Libraries > Event Templates page, select
the Edit button for a published event to which you have work group access, and
select Create Event From Template. In this case, much of the information will be
populated with template information. For more information on templates, see
"Templates" on page 297.
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2. Enter an Event Title such as "Supply of Fleet Vehicles" or "RFI for Procurement of Safety
Cameras."

3. Select aWork Group. You may search work groups to view selections.

4. Click Next.

5. Select an Event Type.

6. If you would like to use a template to create the sourcing event, select a Template.

7. If you have more than one currency listed in your profile, select your Currency.

8. Select any, or all, business units for which an event is being created via the Identify
Related Business Units field. The field is only exposed to users who have access to more
than one business unit within an organization.

l For users with multiple business unit access, who have a business unit assignment
designated within their user profile, the Identify Related Business Units field will be
populated, by default, with that user's profile business unit assignment. The user will
then be able to add-to or change that assignment as desired.

9. Click Create Sourcing Event in order to complete additional event details.

10. The Event has been created, and is in Draft status. Additional details may be added.

Create a Sourcing Event from a Sourcing Request
Depending on workflow configuration, sourcing specialists will be able to either initiate
associated events in an appropriate step of the workflow, or will be able to do so after the request
has completed the workflow process.

1. Locate a Sourcing Request in an appropriate step of Workflow. Click the Sourcing Event
Request Name link to open the request.

2. Expand the Request Actions drop-down and select Create Sourcing Event.

3. Enter the following information in the Event Creation wizard:

l Event Title

l Work Group

l Items- Options are All Marked for Sourcing or Let Me Pick. The Let Me Pick
option expands a checkbox list of the items for selection.

l Suppliers - Options are All or Let Me Pick. The Let Me Pick option expands a
checkbox list of the suppliers for selection.
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4. Click Next and fill in the next page of the Event Creation wizard:

l Event Type

l (Optionally) select a sourcing event template to Create from Template

l Currency

l Choose whether to Approve Form Workflow Step. The default selection is No. This
option is available only to users with Approve/Reject Requisitions or
Approve/Reject Requests permission.

If the approval process fails, the sourcing event will be created and the user will see
an error notification "Unable to approve source document".

l Choose whether to Go to Event After Creation. The default selection is Yes. If Yes
is selected, you will be navigated to the sourcing event upon event creation. If No is
selected, you will remain on the Request page.

l Identify Related Business Units

5. Click Create Sourcing Event.

Create a Sourcing Event from a Requisition

Note: The ability to initiate a sourcing event from a purchase requisition needs to be
configured for your organization

For organizations that use the eProcurement solution, approvers of a purchase requisition with
line items that need to be sourced can initiate a sourcing event for those items directly from the
requisition. The appropriate workflow must be in place for users to initiate a sourcing event from
flagged requisition line items.

When a selected PR line item has been integrated into a sourcing event, that item is adjusted to a
$0.00 amount on the original requisition. Once that sourcing event is awarded, a new requisition
is created for administering the procurement of that line item.

The Approve/Reject Requisitions and the Approve/Reject Requests permissions are required
to perform this task.

1. Open the requisition that contains the line items that need to be sourced. The PR must be
on a Requires Sourcingworkflow step, you must be an approver on the step, and the PR
must be assigned to you.

2. Select the checkbox next to each line item you want to source.
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3. Expand the For selected line items field and select Initiate Sourcing Event, then click
Go. The Create Sourcing Eventwindow opens and the selected line items are listed at the
bottom of the window.

4. Complete these fields in the first page of the wizard:

a. Event Title - Enter a title for the event.

b. Work Group - Select a work group for the event.

5. Click Next and complete these fields in the second page of the wizard:

a. Event Type - Select the event type.

b. Create from Template (optional) - Select the template you want to use for the
sourcing event from the drop down list. Templates contain pre-configured settings
for different types of events. Only templates associated with the selected work
group are available for selection.

c. Currency - Select the currency for the event.

d. Approve PR Workflow Step - Select Yes to instruct the system to approve the
original requisition out of the current workflow step at event creation, so that all the
other items on the requisition can continue through the standard procurement
process. When the selected PR line items have been integrated into a sourcing
event, those items are adjusted to a $0.00 amount on the original requisition. Once
that sourcing event is awarded, a new requisition is created for administering the
procurement of those line items.

e. Go to Event after Creation - Select Yes if you want to be directed to the sourcing
event when the event is created. Select No if you want to stay on the purchase
requisition when the event is created. No is the default setting.

f. Export Ship-To-Address to Event? - Select Yes if you want to display the line
item's Ship To address as a read-only field next to the line item on the event.

6. Click the Create Sourcing Event button. The sourcing event is created. Depending on the
option selected on the Go to Event after Creation field, you will either stay on the
requisition or be directed to the event's Setup page.

7. (optional) Click the sourcing event or requisition number in the top left "sticker" area of
the PR record to view information about the sourcing event or related requisitions. Users
with appropriate permissions will see Go to Sourcing Event or Go to Requisition links on
the overlay that will take them to the related artifact.

Create a Sourcing Event with a Proforma Contract Question
You must select Request for Information or Request for Proposal event type.
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1. Navigate to Sourcing > Sourcing Events > Create New Event....

2. Enter an event title.

3. Select an event template if you are using one.

4. Select either Request for Information or Request for Proposal as the event type.

5. Select aWork Group.

6. Click Add Event.

7. Complete event information as usual. This includes setup, description, items, suppliers etc.

8. ClickQuestions in the left menu.

9. Click Add Question > Add New Question (or select from the library if a proforma question
exists as a library item).

10. In theQuestion Text field, request that the supplier review and upload the proforma
contract, for example, "Please download and review attached proforma contract. Make
changes as needed and upload the redlined version. Answers may be taken into
consideration as part of the evaluation process."

11. In the Response Type field, select Proforma Contract. Note: The Supplier Response Is
Required checkbox is selected and disabled, as using the proforma option requires a
response from the supplier.

12. Select Attach Proforma File and download the proforma contract using one of the
following options:

l Select Import from Contract if you have a set of dedicated proforma contracts
ready for use. Search for and select a proforma contract and click Select Contract.

l Select Upload My Own if you have another document you want to use for the
proforma contract. Enter a name for the file, click Choose File, search for and select
the file, then click Save Changes.

13. Once you have the file uploaded, click Save Changes.

14. In the left menu select Review and Submit, then Submit for Approval.

Create a Quick Quote Event
If configured, Quick Quote events enable you to apply default selections to key event control
parameters such as eventOpen, Close andQ&A Submission Close date settings. It is possible
to pre-set a preferred award scenario for immediate application when an event closes. Other
Quick Quote controls that can be applied during event construction include the invitation of a
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selected Supplier Group and the automatic distribution of Award notification emails. If necessary,
you can override template-applied defaults when administering a draft event.

Options for Creating Quick Quote Events

1. You can selectQuick Quote as the Event Type, or navigate to Sourcing > Sourcing
Events > Create New Quick Quote Event to create Quick Quote events directly from the
primary Sourcing module menu.

2. You can initiate a Quick Quote event from a Sourcing Event Request by navigating to
Request Actions > Initiate Quick Quote Event. The screen overlay for configuring these
events contains additional choices for Items and Suppliers.

3. You can initiate Quick Quote events from purchase requisitions by navigating to Selected
Line Item Actions > Initiate Quick Quote Event.

a. When a template is selected, the default Work Group and Supplier Group associated
with that template will load.

b. You may change the pre-selected entries in the screen overlay, including approving
the PR workflow, navigating to the event after creation, and exporting the ship-to
address to the event.

c. Select Automatically Create Awarded PR to have a purchase requisition auto-
generate from an awarded Quick Quote event. Note: PRs can only be generated
from awarded events that were initiated from a PR. For more information, see
Create a Sourcing Event from a Requisition or Create a Quick Quote Event from
a Requisition in "Event Creation " on page 76 or in the eProcurement Shopping
and Ordering Handbook for Users and Administrators.

4. When creating a Quick Quote event, users with Approve/Reject Requisitions or
Approve/Reject Requests permission can select an option to Approve Workflow Step on
the Create Quick Quote Sourcing Event overlay to automatically approve the request out
of the current workflow step when the event creation process is launched.

5. Click Create Sourcing Event to navigate to the Review and Submit page of the Quick
Quote sourcing event, or click Create and Submit to WF to move the event into your
workflow.

Create a Quick Quote Event from a Sourcing Request

Note: At least one active Quick Quotes template must be available in order to perform this
action. See "Templates" on page 297 for additional information.
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1. Locate a Sourcing Request in an appropriate step of Workflow. Click the Sourcing Event
Request Name link to open the request.

2. Expand the Request Actions drop-down and select Initiate Quick Quote Event.

3. Enter the following information in the Quick Quote Creation wizard:

l Event Title

l Create from Template - Select the appropriate Quick Quote template. Note: This
step is mandatory. At least one active Quick Quotes template must be available for
selection.

l Work Group

l Currency

l Identify Related Business Units

l Choose whether to Approve Form Workflow Step. The default selection is No. This
option is available only to users with Approve/Reject Requisitions or
Approve/Reject Requests permission.

If the approval process fails, the sourcing event will be created and the user will see
an error notification "Unable to approve source document".

l Choose whether to Go to Event After Creation. The default selection is Yes. If Yes
is selected, you will be navigated to the Quick Quote event upon event creation. If
No is selected, you will remain on the Request page.

l Items - Options are All Marked for Sourcing or Let Me Pick. The Let Me Pick
option expands a checkbox list of the items for selection.

Note: all items, both products and services, that are added to a Quick Quote
event have a default setting of Unit Price is Required. This default setting is
effective whether items are added via requisitions, form requests, shopping
carts, libraries, or through manual creation, with the exception of items added
to Quick Quote via templates or regular item import. You can change this
default setting for all items in your created events.

l Suppliers - Options are All or Let Me Pick. The Let Me Pick option expands a
checkbox list of the suppliers for selection.
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4. Click an action button to complete event creation:

l Create & Submit to WF - A Quick Quote workflow must be configured. If your
organization does not have a Quick Quote workflow configured, you will receive an
error message indicating that a Quick Quote workflow is needed.

l Create Sourcing Event

If Yeswas selected for Go to Event After Creation, you will be taken directly to the Review and
Submit page of the Quick Quote sourcing event. The following configuration pages and sections
are collapsed for Quick Quote events with Draft status:

l Pages with administrative data - Collapsed if required data is complete. Expanded if
required fields must be addressed.

l Setup - All sections are collapsed except for Dates.

l Description - The Stage Description section is collapsed.

l Questions - Groups are collapsed.

l Additional Item Fields - Collapsed if required data is complete. Expanded if required fields
must be addressed.

l Items - The Item Details section of the Edit Product Line Item overlay is collapsed.

Create a Quick Quote Event from a Requisition

Note: The ability to initiate a Quick Quote event from a purchase requisition must be enabled
for your organization. Contact JAGGAER for assistance.

For organizations that use the eProcurement solution, approvers of a purchase requisition with
line items that need to be sourced can initiate a Quick Quote sourcing event for those items
directly from the requisition. The appropriate workflow must be in place for users to initiate a
Quick Quote event from flagged requisition line items.

When a selected PR line item has been integrated into a Quick Quote event, that item is adjusted
to a $0.00 amount on the original requisition. Once that Quick Quote event is awarded, a new
requisition is created for administering the procurement of that line item.

The Approve/Reject Requisitions and Approve/Reject Requests permissions are required to
perform this task.
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1. Open the requisition that contains the line items that need to be sourced. The PR must be
on a "Requires Sourcing" workflow step, you must be an approver on the step, and the PR
must be assigned to you.

2. Select the checkbox next to each line item you want to source.

3. Expand the For selected line items field and select Initiate Quick Quote Event, then click
Go. The Create Quick Quote Sourcing Eventwindow opens and the selected line items
are listed at the bottom of the window.

Note: all items, both products and services, that are added to a Quick Quote event
have a default setting of Unit Price is Required. This default setting is effective
whether items are added via requisitions, form requests, shopping carts, libraries, or
through manual creation, with the exception of items added to Quick Quote via
templates or regular item import. You can change this default setting for all items in
your created events.

4. Complete these fields:

a. Event Title - This field is auto-populated with "QQ" plus the requisition number and
date. Change if needed.

b. Create from Template - Select a quick quote template. Active, published templates
with the same work group as the logged in user are available for selection.

c. Work Group - Select a work group for the event. Only work groups that are
associated with the selected template are available for selection.

d. Supplier Group - Select the supplier group for the event if applicable.

e. Currency - Select the currency for the event.

f. Approve PR Workflow Step - Select Yes to instruct the system to approve the
original requisition out of the current workflow step at event creation, so that all the
other items on the requisition can continue through the standard procurement
process. When the selected PR line items have been integrated into a sourcing
event, those items are adjusted to a $0.00 amount on the original requisition. Once
that sourcing event is awarded, a new requisition is created for administering the
procurement of those line items.

g. Go to Event after Creation - Select Yes if you want to be directed to the event
when it is created. Select No if you want to stay on the purchase requisition when
the event is created. No is the default setting.

h. Export Ship-To-Address to Event - Select Yes if you want to display the line item's
Ship To address as a read-only field next to the line item on the event.
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5. Once all the fields are completed, click one of the following buttons:

a. Create & Submit to WF - Click to create the event and immediately submit it into
the sourcing approval workflow. All required event data will be captured from the
pre-configured template and work group defaults during the creation process.

b. Create Sourcing Event - Click to create the event, but it will not be submitted into
the sourcing approval workflow.

Depending on the option selected on the Go to Event after Creation field, you will
either stay on the requisition or be directed to the event's Review and Submit page.
For a quick quote event, the open and close dates are auto-populated and the
preferred award scenario is auto-applied because the event was created using a
quick quote template.

6. (optional) Click the sourcing event or requisition number in the top left "sticker" area of
the PR record to view information about the sourcing event or related requisitions. Users
with appropriate permissions will see Go to Sourcing Event or Go to Requisition links on
the overlay that will take them to the related artifact.

Copy an Event
If an existing event has many of the characteristics needed for a new event, you may select to
Copy an Event to save the manual entry of many of the event specifics.

1. Navigate to Sourcing > Sourcing Events > Search Events.

2. Search for and select an event.

3. At the top right of the event, select the drop-down button Event Actions, and select Copy.

4. The Copy Sourcing Event wizard displays.

a. Edit the Event Title for the copied event.

b. Select a different Event Type, if appropriate.

c. Select aWork Group for the event.

d. Select any, or all, business units for which an event is being created via the Identify
Related Business Units field. The field is only exposed to users who have access to
more than one business unit within an organization.

l For users with multiple business unit access, who have a business unit
assignment designated within their user profile, the Identify Related Business
Units field will be populated, by default, with that user's profile business unit
assignment. The user will then be able to add-to or change that assignment as
desired.
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e. Select the Copy button.

5. The copied event is now in Draft status.

6. Edit the Event Title, Event Number, and any other criteria for the event as appropriate.
Select each section of the event to make changes.

7. Click to Save Progress, or select Next to proceed to the next page.

8. When edits are completed for the event, select Submit for Approval on the Review and
Submit page.

Create a New Event from the Manage Templates Page
Permission(s) required:Manage Templates and Libraries, Create/Own Events, assigned to
work group(s) associated with the template as an Event Creator.

The template must be Published.

1. Navigate to Sourcing > Templates and Libraries > Event Templates.

2. Select a template to which you have work group access and are assigned as an Event
Creator. Select the Edit dropdown, and click Create Event from Template.

3. The Add Sourcing Event overlay displays.

4. Enter a title, select a template if applicable, and the work group(s) associated, and click to
create the event.

5. The page refreshes on the Event Setup page.

6. Proceed with entering details for the event.

a. Some fields will be pre-populated with the information from the selected template.

b. Some fields will not be editable if the template used to create the event is set as
Protected.

Event Settings Pages
The pages and options that show for an event depend on the associated work group and Event
Type. Options will also depend on your organization's configuration for the components that are
allowed as part of each event, such as being available on a Public Site, or allowing for auto
scoring options.
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Navigation
The following image shows an event in Draft status on the Event Setup page.

Note: Some options, such as Respond by Proxy, Sealed Bid, and Public Site, will only show if
your organization and work group are configured to allow them on events.
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1. Sourcing Event Identification. You will see the name of the event, event number, event
type and event status. If the event has multiple stages, the stage name will display with a
link to View Event Stages.

2. Settings and Content. This section displays the detail section of the event. Sections
configured for the event type display. A green checkmark indicates required elements
of the section are completed. A number indicates the number of items/documents in the
section. Note: Sections vary according to the event type. Not all sections or settings
will show on every event.

a. Setup - The Event Setup page contains the basic information such as event name,
type, associated work group, commodity codes, specific bid and public site settings,
and dates. See "Configure an Event" on page 91 for additional information.

b. Users - The Users page shows the users assigned to the event as Creator, Owners,
Contacts and Stakeholders. Users are inherited from the associated work group but
may be edited on the specific event. A user with appropriate permissions can make
edits to assigned users. If Confidential Pricing is enabled, users can also be
assigned to the event as Event Price Viewers. See for additional information.

c. Description - The Description page contains the basic description of the event that
is shown to suppliers. For multi-stage events, a Stage Description is also available.
See for additional information.

d. Prerequisites - The Prerequisites page contains any information and/or documents
you want the supplier to review as part of responding to the event. See for
additional information.

e. Buyer Attachments - This page is used to include attachments, such as a diagram
or additional information, that would be helpful to the supplier. See for additional
information.

f. Supplier Attachments - You may include this page to allow suppliers to add
attachments to supplement their bid response. See for additional information.

g. Questions - You may ask specific questions related to the event. You will configure
the type of response such as a Yes/No selection, text box, file upload, etc. See for
additional information.

h. Additional Item Fields - You may create up to 20 additional item fields to collect
additional information from suppliers. See for additional information.

i. Price Components - Price component fields support an itemized view of price
factors, such as fixed freight costs and import duties, that affect the total bid prices
submitted against sourced items. You have the option to create price component
fields from scratch or to select them from a library, and to apply the price
components at the individual item level or restrict them to specific item groups. See
for additional information.
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j. Items - If the event is for specific products or services, you may list out the items on
this page. See for additional information.

k. Suppliers - This page is where you will add suppliers to the event or see what
suppliers have been invited to respond to the event. See for additional information.

l. Review and Submit - For draft events, this page shows the status of all the event
detail pages and alerts the user if required information is not completed. If all
required information for the event is satisfied, the user will see a button to Submit
for Approval. See for additional information.

3. Evaluations. This section of the event displays sections to use as tools in evaluating
supplier responses.

a. Supplier Responses - You will see this page when the event has Closed and is
Under Evaluation. See "Supplier Responses" on page 202 for more information.

b. Auto Score - If you enabled this option for the event or event line items, you can
click here to configure the Auto Score values for supplier responses. See "Auto
Score Values for Events and Event Line Items" on page 192 for more information.

c. Cost Analysis - If you enabled this option for the event or event line items, you can
click here to configure the Cost Analysis values for the supplier responses. See
"Cost Analysis Values for Events and Event Line Items" on page 196 for more
information.

d. Evaluation Calculation Options - Select what evaluation options to include. This
option is most helpful when the event has multiple stages, and you would like to use
certain scoring options for specific stages. See "Evaluation Calculation Options" on
page 199 for more information.

4. Panel Questionnaire. In this section you will set up the panel questionnaire to be used in
evaluating supplier responses. You will configure the panelists, questions, weights, and
suppliers, and select to publish the questionnaire at the appropriate time. See "Panel
Questionnaires for Events" on page 152 for more information.

5. Tools. In this section of the event, you can add Internal Notes for the event, view exports
and imports from the event, manage the Q&A board, and see the approval workflow. You
can also review award notifications if you have them configured for events.

a. Internal Notes - Users can add internal notes to the event that are seen only by
organization users, and not by suppliers.

b. Exports and Imports - Any exports or imports from the Questions or Items pages
will show here.

c. Q&A Board - This interactive Question & Answer board is available for customers to
see questions from suppliers, respond to those questions, and also to include their
own questions to be answered by suppliers.
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d. Approvals - This page shows the approval workflow the event either will enter or is
in currently, depending on the event status.

e. Award Notifications - If your organization has award notifications enabled, you will
have the option to select a template, customize the email, and send it to suppliers
from this page. You may also choose to add a comment to an awarded event PDF
that is shown for public events.

6. Page Details. For the selected page, the details for the page appear (and may be edited, if
applicable) here.

7. Event Actions. Select the Event Actions drop-down to see options depending on your
permissions and the Event status. Event Owners and Evaluators are able to toggle the
hiding and showing of prices from the Event Actions dropdown menu on events by
selecting Hide Event Prices.

8. Event History. Select to see the audit log for the event.

9. Once an event is Released, a banner message displays with the event information, and
Workflow Actions are available, such as to Withdraw or Amend the Event, or to Close it
early.

Note: Currency and other numeric fields in sourcing events are displayed in the
international number format that is associated with the Country selected in your user's
profile. If you do not have a Country selected in your user's profile, numbers are displayed in
the format associated with the United States. International number formatting extends to all
areas of Sourcing events except the Event History area.

Configure an Event

Setup Page
On the event Setup page, you will define the basics of the event such as Event Title, Event
Number, Commodity Codes, Payment Terms, Dates, and more.

Configure the Event Setup when you Create an Event, or you may edit the Event Setup page
while the Event is in Draft status. Some fields, such as Estimated Value and Payment Terms,
may be hidden by an administrator via Field Management. Required fields are indicated with a
star ( ).
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Note: Not all settings show or are configurable for the event, depending on the organization,
event type, and work group settings.

1. You can edit the Event Title at any time. The event type and work group cannot be
changed once the event is created, and are shown as read-only.

2. An Event Number is listed based on your organization configuration. Click on the edit icon
to modify the Event Number.

3. If events in this work group are configured to allow multiple stages, you may enter a Stage
Title. If you are not sure if the event will require multiple stages, you may leave this field
blank until the next stage is created.

4. Custom Data - Depending on custom field configuration for the event, additional fields
may appear below the event information section on the Setup page, or as separate pages
listed under the Setup page. Complete these fields as needed.

5. In the Commodity Codes section, associate commodity codes utilized by your
organization:

a. Select a Reporting Commodity Code that is used for reporting purposes. Select the
Edit button and choose from your organization's commodity codes. Only one
reporting commodity code may be selected.

b. Select Additional Commodity Codes to associate with the event. Select the Edit
button and choose from the organization's commodity codes. Multiple codes may be
selected.

c. If any commodity codes are associated with individual items, Item Commodity
Codes are displayed as read only in this section.

d. Select if the event should have Forced Supplier Invitation by Commodity Code. If
Yes is selected, suppliers with commodity codes in their supplier profile that match
any of the event commodity codes will automatically be sent an invitation to the
event.

Note: If your organization does not use commodity codes or you otherwise do
not want these fields to show, you can hide them via Field Management. See
Field Management in the online searchable help for more information.

6. In the Payment section:

../../../../../../../../Content/Indirect/Administration/Site Config Options/fieldmanagement.htm
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a. The Currency for the event is displayed. This is not editable.

b. Enter an Estimated Value for the event (if displayed). This field may be either
mandatory or optional.

c. Select from the available Payment Terms (if displayed) configured by your
organization.

Note: If you do not utilize Estimated Value or Payment Terms, you can hide
them via Field Management. See Field Management in the online searchable
help for more information.

7. In the Bid and Evaluation section, view or edit options that are configured at the
organization and/or work group level. Not all options will be configurable.

a. View or edit the Sealed Bid option.

i. If your organization and work group are configured to allow Sealed Bids as an
option for specific events, you will select Yes or No. If you select Yes, you will
configure Sealed Bid date options in the Dates section for the event.

ii. If your organization or work group is configured to make all events use the
Sealed Bid process, you will see a read-only value of Yes and this value
cannot be changed for the event. You will configure Sealed Bid date options
in the Dates section for the event.

iii. If your organization or work group is configured to not use the Sealed Bid
process on any events, you will see a read-only value of No and this value
cannot be changed for the event.

b. Respond by Proxy

i. If your organization and work group are configured to allow Proxy Bids as an
option for specific events, you will select Yes or No. If you select Yes, you will
have the opportunity to designate the suppliers for proxy bids on the
Suppliers page.

ii. If your organization or work group is configured to allow all events to use
Proxy Bids, you will see a read-only value of Yes and this value cannot be
changed for the event. You will have the opportunity to designate the
suppliers for proxy bids on the Suppliers page.

1. Indirect/9. Setup and Configuration Tasks/General/Field Management/fieldmgmt.htm
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iii. If your organization or work group is configured to not use Proxy Bids for any
events, you will see a read-only value of No and this value cannot be changed
for the event.

Note: For additional information about this performing a proxy bid, see
"Supplier Responses" on page 202.

c. When set asOptional or Allowed at the work group level, an option for Cost Per
Quality Pointwill display in the Bid and Evaluation section of the Event Setup page.

i. Yes - If Yes is selected, the system will calculate CPQP for each supplier's
submitted response, using the Total Bid for required items and the average
panel questionnaire rating for the supplier.

ii. No - CPQP will not be calculated for the event.

Note: For additional information about this setting, see the section for
Cost Per Quality Point for Events (located below).

d. When set asOptional or Allowed at the work group level, an option for Best Value
will display in the Bid and Evaluation section of the Event Setup page:

i. Yes - Best Value: Best value will be used as a measure for evaluating the
event. Choose the percentage weight for price versus quantity for the
calculation, using the slider.

ii. No - Best Value will not be calculated for the event.

Note: For additional information about this setting, see the section on
Best Value for Events (located below).

e. View or edit the Use Panel Questionnaire option.

i. If the work group is configured to allow Panel Questionnaires as an option for
specific events, you will select Yes or No. If you select Yes, a Panel
Questionnaire section will display in the event navigation for configuration.

ii. If the work group is configured to allow Panel Questionnaires for specific
events, you will see a read-only value of Yes and this value cannot be
changed for the event. You will have the opportunity to configure a panel
questionnaire.

iii. If the work group is configured to not allow a Panel Questionnaire on any
events in the work group, you will see a read-only value of No and this value
cannot be changed for the event.
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f. View or edit the Auto Score option.

i. If the work group is configured to allow Auto Score as an option for specific
events, you may select Yes or No. If Yes is selected, an Auto Score sub-
section will show under the Evaluations section of the event navigation.
Choose where to enable auto-scoring:

l Select Default all questions to use Auto Score to enable auto-
scoring for event questions.

l Select Apply Auto Score at the individual line level to enable auto-
scoring for event line items.

ii. If the work group is configured to allow all events in the work group to use
Auto Score, you will see a read-only value of Yes. This value cannot be
changed for the event, but you may choose to enable auto-scoring for events
or event line items as indicated above.

iii. If the work group is configured to never use Auto Score for any events in the
work group, you will see a read-only value of No. This value cannot be
changed for the event.

g. View or edit the Cost Analysis option.

i. If the work group is configured to allow Cost Analysis as an option for specific
events, you may select Yes or No. If Yes is selected, If enabled, a Cost
Analysis sub-section will show under the Evaluations section of the event
navigation. Choose where to enable cost analysis:

l Select Default all questions to use Cost Analysis to enable cost
analysis for event questions.

l Select Apply Cost Analysis at the individual line level to enable cost
analysis for event line items. If this checkbox is selected, maximum cost
adjustment and bid threshold limits can be defined:

l Set maximum Cost Adjustment per line item - Enter the
maximum cost adjustment allowed for product or service-type
event line items.

Note: If maximum limits are not defined here, no limits will be
applied at either the event level (Questions) or item level
(Additional Item Fields). If maximum limits are defined, they are
honored at both event and additional item levels.



JAGGAER 96 www.JAGGAER.com

l Products - Enter the maximum cost adjustment allowed
for product-type line items, either by dollar value or
percentage amounts.

l Services - Enter the maximum cost adjustment allowed
for service-type line items either by dollar value or
percentage amounts.

l Apply upper Bid threshold cost adjustment application limits
- Enter upper bid thresholds for cost adjustments in the following
fields in dollar amounts. Threshold limits are applied against the
total bid value of products or services, and/or against the bid
value of a single item within an event:

l Product: Single Unit Bid threshold - Enter the upper bid
threshold allowed for a cost adjustment to a single
product-type line item on an event.

l Product: Total award Bid threshold - Enter the upper bid
threshold allowed for the total of all product-type line
items on an event.

l Service: Annual Item Bid threshold - Enter the upper bid
threshold allowed for a cost adjustment to a single
service-type line item on an event.

l Service: Total award Bid threshold - Enter the upper bid
threshold allowed for the total of all service-type line
items on an event.

ii. If the work group is configured to allow all events in the work group to use
Cost Analysis, you will see a read-only value of Yes. This value cannot be
changed for the event, but you may choose where to enable cost analysis for
events or event line items as indicated above.

iii. If the work group is configured to never use Cost Analysis for any events in
the work group, you will see a read-only value of No. This value cannot be
changed for the event.

h. View or edit the Alternate Items option.

i. If your organization and work group are configured to allow Alternate Items as
an option for specific events, you will select Yes or No. If you select Yes, you
will select to allow Alternates for each individual item in the Items section of
the event.
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ii. If your organization or work group is configured to allow all events to use the
Alternate Items, you will see a read-only value of Yes and this value cannot be
changed for the event. You will select to allow Alternates for each individual
item in the Items section of the event.

iii. If your organization or work group is configured to not allow Alternate Items,
you will see a read-only value of No and this value cannot be changed for the
event. You will not have the option of allowing alternates for each item.

i. View or edit the Allow Split Item Quantity in Evaluations option.

i. If the work group is configured to Allow Split Item Quantity in Evaluations
as an option for specific events, you will select Yes or No. If you select Yes,
the event award may be split among multiple suppliers.

ii. If the work group is configured to Allow Split Item Quantity in Evaluations
for all events in the work group, you will see a read-only value of Yes and this
value cannot be changed for the event. It is optional to actually split item
quantities during the evaluation/award process.

iii. If the work group is configured to not Allow Split Item Quantity in
Evaluations for any events in the work group, you will see a read-only value
of No and this value cannot be changed for the event.

Note: See "Split Award Options" on page 228 for additional details on
how awarding may be split.

j. View or edit the Enforce Minimum Price option.

i. If the event type includes an items section, you will select Yes or No. If you
select Yes, you will be able to set minimum prices for item bids. If enabled, a
Minimum Price field will appear on the Add Item pop-up to set the minimum
price for the item.

k. View or edit the Enforce Maximum Price option.

i. If the event type includes an items section, you will select Yes or No. If you
select Yes, you will be able to set maximum prices for item bids. If enabled, a
Maximum Price field will appear on the Add Item pop-up to set the maximum
price for the item.

l. If Confidential Pricing is enabled for the event:

i. Select Yes or No. Selecting Yes adds a new access group, Event Price
Viewers, to the Users section of the event. If you do not want to use
Confidential Pricing for the event, select No.
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8. In the Display and Communication section, view or edit options that are configured at the
organization and/or work group level. Not all options will be configurable.

a. View or edit the Visible to Public setting.

i. This option appears only if your organization is configured to use a Public Site
to display sourcing events.

ii. If your organization or work group is configured to make Public Site visibility
optional, you will select Yes or No. If Yes is selected, you will be given the
option to add a short description of up to 200 characters for the public event.

iii. If your organization or work group is configured to make all events visible to
the public, you will see a read-only value of Yes and this value cannot be
changed for the event. You will be given the option to enter a short
description of up to 200 characters for the public event.

iv. If your organization or work group is configured to not make any events visible
on the public site, you will see a read-only value of No and this value cannot
be changed for the event.

b. View or edit the Restrict Buyer Notification setting. When this option is enabled, an
access group called Notification Recipientswill appear in events, and only users
included in that group will receive system-generated buyer notifications.

i. If your organization and work group are configured to allow restricted buyer
notifications as an option for specific events, you will select Yes or No.

ii. If your organization or work group is configured to always restrict buyer
notifications, you will see a read-only value of Yes and this value cannot be
changed for the event.

iii. If your organization or work group is configured to not never restrict buyer
notifications, you will see a read-only value of No and this value cannot be
changed for the event.

9. In the Dates section, you may enter dates directly or select the date picker to select the
appropriate date. Times are available in the dropdown next to the date:

a. Select the appropriate Time Zone.

b. If appropriate, enter a Release Date and time.

c. Enter anOpen Date and time. The Open Date must be later than the Release Date.

d. Enter a Close Date and time. The Close Date must be later than the Open Date.
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e. If Sealed Bid is being used for the event:

i. Select if you want the Sealed Bid Open Date to be the Same as Close Date.
If not, uncheck the option and select an appropriate date from the Date
picker.

ii. Select if you want to Show Sealed Bid Open Date to Supplier.

f. Select if you want theQ&A Submission Close Date to be the Same as Close Date.
If not, select an appropriate date from the Date picker.

10. Click Save Progress and Next to continue event configuration.

Cost Per Quality Point for Events
Cost Per Quality Point (CPQP) is an evaluation method that combines quality and price for an
event. When configured at the event level, the Cost Per Quality Point is calculated using the Total
Bid for required items and the average panel questionnaire rating.

CPQP can be configured at the organization, work group, and event level. When set asOptional
or Allowed at the work group level, an option for Cost Per Quality Pointwill display under the
Bid and Evaluation section of Event Setup page. Select one of the following:

l Allow - All work groups are allowed to use Cost per Quality Point in event evaluation. You
will have additional configuration options at the work group level.

l Disallow - No work groups are allowed to use the Cost Per Quality Point in event
evaluation. No options are available to configure at the work group level.

If the work group setting is set to always use CPQP, the setting will show as Yes on the Event
Setup and cannot be changed. If the work group setting is set toOff, the CPQP option will not
display.

Note: CPQP requires the use of Panel Questionnaire on an event, as the calculations use the
Average Panel Questionnaire Score. If you do not configure and have at least one completed
response to a Panel Questionnaire, the CPQP score will not display.

When enabled for an event, the side-by-side evaluations page will display a row for Cost Per
Quality Score for each supplier. For example, if a supplier submits a total bid for required items in
the amount of $200,000, and their average questionnaire rating is 550 points, they will have a
CPQP score of 364 (200,000 / 550). When evaluating this score for suppliers, a lower score is
better. Buyers are able to split award scenarios by lowest (best) CPQP score.

Changes to the Cost Per Quality Point Setting are logged in history, available by selecting the
History hyperlink on the page.
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Best Value for Events
When Best Value is configured at the event level, buyers select a percentage of value they want
placed on the average panel questionnaire rating versus the normalized required items bid price.
This configuration is used along with the average panel questionnaire rating and normalized
required items bid price to calculate the Best Value score.

Best Value can be configured at the organization, work group, and event level. When set as
Optional or Allowed at the work group level, an option for Best Valuewill display under the Bid
and Evaluation section of Event Setup page.

l Yes - If yes is selected, you will choose the percentage weight for price versus quantity for
the calculation, using the slider.

l No - Best Value will not be calculated for the event.

If the work group setting is set to always use Best Value, the setting will show as Yes on the
Event Setup and cannot be changed. The Panel Questionnaire setting will also be set to Yes. If
the work group setting is set toOff, the Best Value option will not display.

Note: Best Value requires the use of Panel Questionnaire on an event, as the calculations
use the questionnaire points. If you do not configure and have at least one completed
response to a Panel Questionnaire, the CPQP score will not display.

When enabled for an event, the side-by-side evaluations page will display a row for Best Value for
each supplier. When evaluating this score for suppliers, a higher score is better. Buyers are able
to split award scenarios by highest (best) Best Value score.

Example of Best Value Calculation

The following is an example of how Best Value would be calculated:

1. The event is configured with a Panel Questionnaire Total Point Value of 1000, and a Best
Value percentage of 20% price and 80% quality.

l Cost Score: % Price * (Max Available Quality Points / % Quality)
0.20 * (1000 / 0.80), or 250.
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2. The supplier submitted a bid price for required items in the amount of $200,000.

3. The supplier's average questionnaire rating is 550 points.

4. Best Value is calculated using the Cost Score plus the Quality Points: 250 + 550 = 800.

Users Page
After the initial Event Setup, you will select users and designate the type of access they will have
for the event on the event Users page. Some Event Users are inherited from the work group and
these users cannot be removed from an event.

1. Select the Add Users button for the appropriate access group, and choose from users with
appropriate permissions for the role. The access groups are:

l Event Creator - An Event Creator can create new events for a work group and
assign users to the event. An Event Creator cannot edit or view events created by
other Event Creators of the work group (unless the user is also an Event Manager). A
user must have the Create Events With Templates, Create/Own Events, or
Manage Work Group Events permission to be assigned as an Event Creator.

Note: The Event Creator cannot be edited.

l Event Owners - An Event Owner has full control over the event. An Event Owner
can be inherited as an Event Manager on a work group, or can be explicitly set for
the event.
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l Contacts - Contacts on an Event are users who a supplier may contact for additional
information. The supplier will see the contact information when viewing the event.

l Stakeholders - A Stakeholder has view access to all events in the work group. A
user must have one of the sourcing permissions related to events to be assigned as
a Stakeholder: View Events, Create/Own Events,Manage Work Group Events,
Approve/Reject Sourcing Event, or Finalize Award Scenario.

l Notification Recipients - If buyer notification restriction has been enabled, either at
the work group level or system wide, events will include an access group called
Notification Recipients. Only users added as notification recipients will be eligible
to receive system-generated event notifications for events administered with this
control option. The Event Creator and Event Managers are equipped to manage the
Notification Recipients access group.

l Event Price Viewers - When using confidential pricing, only users added to the
Event Price Viewers access group of an event are able to view the estimated price,
target price, historic prices, minimum, maximum, supplier prices, and for Reverse
Auctions, the reserve price and bid decrement for that event. All other users will see
the word Confidential anywhere a price would be displayed, including PDF and
evaluation exports. If a supplier uploads a confidential attachment, users who are
not Event Price Viewers can see the file name, but they are unable to open these
attachments. Only users with event access such as a Stakeholder or Event Owner
are eligible to be added to the Event Price Viewers access group.

2. Search for users. Only users with the appropriate permission for the type of role in the
event will be displayed. You may select Advanced Search for additional search options.

3. Select the Add User button for each user to be added to the role.

4. When done selecting users, click the Close button.

5. To remove a selected user from a role, click the Remove icon .

6. When all users have been added or removed, select Save Progress or Next to continue
modifying the event.

7. Click Save Progress and Next to continue event configuration.

Auction Settings Page
When creating an event using an Auction event type, you must configure the Auction Settings
for that event. Auction control settings can be amended until the auction cut-off time, which is
set for 10 minutes prior to the auction launch.
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1. Navigate to an auction event.

2. Select the Auction Settings page in the event navigation.

3. Configure the following fields in the Auction Settings section of the Auction Settings
page:

a. Event Mode - Select Live orMock. Mock auctions can be used as practice runs with
bidders.

b. Auction Start Date - The time the auction opens to bidders. Note: The date/time
specified must be after the event open date. Enter this date by typing it in the field or
using the date and time selectors.

c. Auction End Date - The time the auction stops accepting new bids, unless
configured automatic extensions are triggered. Use one of these options to enter
this date:

l Type the date into the field.

l Use the date and time selectors.

l Select the Auction End Date Same as Event Close Date checkbox. When
this checkbox is selected, the auction end date is the same as the event close
date set on the Setup page and the Auction End Date field entry methods
are hidden.

d. Enforce Reserve Price - Allows one to establish maximum price points that you are
willing to pay for the goods or services being sought via the auction. Choose Yes or
No.

e. Initial Bid Required Time - Enter how long, once the auction phase of an event
begins, that suppliers have to enter their initial bid (in minutes). If this field is
configured, then suppliers must enter an initial bid within that timed window of
opportunity, or they will be prevented from further participation in the event. If no
value is configured, there are no restrictions on when a supplier must enter an initial
bid.

f. Apply Bid Decrement Policy - Bid decrement is the minimum amount suppliers
must bid below a previous bid. Select Yes if you would like to require suppliers to bid
a certain amount below a previous bid. If Yes is selected, you will enter additional
information regarding bid decrement.

i. Bid Decrement Default Value - This value is auto-applied to items being
sought via the event, but this default value can be edited/adjusted at the item
level.

ii. Apply Bid Decrement To - Select how to apply the bid decrement. Choices
are Supplier's Own Bid, Leading Bid, or All Bids.
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4. Configure the following fields in the Supplier Display Controls section of the Auction
Settings page. Choose Yes or No to display the following to suppliers in their view of the
Auction Console:

a. Show Rank - If Yes is selected, each supplier can see where their bids rank in an
auction.

b. Show Low Bid Amount - The current lowest bid in an auction. You will choose
whether to show bids for all items, whether to show bids only for items on which the
supplier has bid, or whether no low bid amounts will be displayed.

c. Show Low Bid Supplier Alias - If Yes is selected, each supplier can see the alias
name of the current lowest bidder in an auction.

d. Show Bid Decrement - If Yes is selected, the amount suppliers must bid below a
previous bid is displayed. This field shows if you have selected to apply a bid
decrement policy.

5. Configure the following fields in the Automatic Extension Controls section of the Auction
Settings page.

a. Enable Extensions - Enable you to extend the event if certain conditions are met
near the end of the auction phase of an event. For example, if a new best bid or any
new bid has been submitted. Choose Yes or No to Enable Extensions for the event.
If Yes is selected, configure the following additional settings:

i. Extension Duration - Enter the amount of time the auction will be extended if
trigger conditions are met (maximum 30 minutes).

ii. Extension Trigger Period - Enter the window of time (in minutes), before the
scheduled Auction End date/time, where, if an extension triggering event
occurs, an extension to the auction phase will be applied.

iii. Max Number of Extensions - The number of extensions that can be granted.

iv. Trigger Rule - Choose to trigger extensions with the introduction of a New
Best Bid or Any New Bid.

6. Click Save Progress.

Description Page
On the event Description page, you will enter any descriptive text you want the supplier to see
about the event. The Description is required, and should give basic information about the service
or products you need. You can include the specifics of the request, budget parameters, date/time
information such as opening and closing date, award date and much more.
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Formatting tools are available to format your text, including images and hyperlinks. A description
can contain up to 2500 characters.

Alternatively, you can copy a pre-existing description from your organization's library. Click the
Copy from Library button to access this option.

l You will be prompted to select from libraries associated with the event's work group and
event type.

l Select the library and then select an appropriate description text. The selected description
text is pasted into the Description text box.

A Stage Description is available if the event is one with multiple stages. This is optional for use.
The same formatting tools are available in this text box.

When finished adding the Description, select the Save Progress button, and the Next button to
continue.

Prerequisites Page
You can choose to add Prerequisite information to an event if it is important to you that a supplier
reviews information about your company and/or the event prior to proceeding with their
response.

You can enter text about the prerequisite, and select if you want to enter the content of the
prerequisite on the page or attach a file with the appropriate information. Prerequisites can be
optional, or it may be required that the supplier certify they have reviewed it prior to viewing the
entire event or submitting a bid. You can also ask that a supplier upload a file if you provide the
directions to do so.
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1. On the Prerequisites page, click the Add Prerequisite button and select Add New
Prerequisite or Add from Library.

2. To Add New Prerequisite you will enter information into the Add Prerequisitewizard.

a. Enter Instructions to Supplier to show on the Prerequisites page, to let the
supplier know more about the prerequisite.

b. Select how you would like to display your Prerequisite Content:

i. Enter text directly (or copy and paste) - The supplier will see the text
directly on the Prerequisites page. If this option is selected, an Edit button is
displayed in order to enter the appropriate text.

ii. Attach file - The supplier will select to open/download the attachment from
the Prerequisites page. If this option is selected, a Select File button displays
in order to attach the file. The maximum upload file size is 50.0MB. Enter a
Display Name and any Comments for the prerequisite.

c. Select the Type of Prerequisite:

i. Optional - The supplier is not required to view this prerequisite in order to
view or bid on the event.

ii. Required to View Event - The supplier will be required to certify they have
reviewed this prerequisite in order to view the event.

iii. Required to Enter Bid - The supplier will be required to certify that they have
reviewed this prerequisite in order to bid on the event. They are not required
to review the prerequisite simply to view the event details.

d. Enter Certification Text. Default text is provided, but you may edit it as appropriate
for your organization.

e. Select the option for Supplier Must Also Upload a File if appropriate.

f. Click Save Changes.

3. When selecting Add from Library:

a. You will be prompted to select from libraries associated with the event's work group
and event type.

b. Select the library and then select an appropriate prerequisite (s). When finished
selecting, click Add Selected Prerequisites.

c. The selected prerequisites are added to the event.

4. You can select to Edit or Delete prerequisites, or continue to add by selecting Add
Prerequisite.
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5. You can download attachments by selecting Download from the Actions drop-down
beside each attachment.

6. You can select to Upload New Version of file prerequisites. This will upload a new version
of the prerequisite’s file attachment but will not allow user to edit details of the
prerequisite. To edit the prerequisite you have to use Edit. Suppliers will see only the latest
version of the file attached. Previous versions are not visible to the supplier.

a. You will be prompted to optionally update the display name and add comments.

b. Select the new version of the file to be uploaded using the Select File button.

7. You can select to view Version History for prerequisites with multiple versions.

8. When finished adding Prerequisites, select the Save Progress button, and the Next button
to continue.

Applying Confidentiality to Supplier Files

Buyers can apply the Sourcing module's Confidential Pricing functionality to documents
uploaded by suppliers. This feature is available for supplier responses to supplier attachments,
prerequisites, and questions in Sourcing events, templates, and libraries.

To apply this feature to supplier upload documents, select the checkboxes for Vendor Must Also
Upload a File and Enable Confidential Mode on the creation or edit screen overlays for
Prerequisites orQuestions:
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When these flags are activated, they will be associated with each file uploaded in response to the
correlating Attachment, Prerequisite orQuestionwithin the event. Confidential fields and
upload documents are designated with the pre-existing icon that denotes confidentiality.

The existing confidential pricing setting dictates which users have access to the file. Buyer users
who do not have permission to View Pricing Data and who are not members of the event's Event
Price Viewers access group can see that a response document exists, but they cannot view or
download the document contents.

To ensure that buyers have the option to Hide Event Pricing for supplier attachments, the
checkbox to enable confidential functionality will always appear on buyer pages and the option to
Add Pricing Filewill always appear on supplier upload pages, even if confidentiality has not been
enabled for an event. Supplier files that are uploaded in response to event prerequisites that have
been flagged as confidential are managed as confidential files if at least one of the following
conditions applies to the event:

l The Confidential Pricing setting is enabled for the event.

l The Hide Event Prices function is enabled for the event.

Buyer Attachments Page
You can provide attachments for an event on the Buyer Attachments page. Attachments may be
uploaded files or URL links.

When you opt to Add Attachment, you can choose to add an attachment from your
organization's library or to add a new attachment to the event.

1. On the Buyer Attachments page, click the Add Attachment button and select Add New
Attachment or Add from Library.

2. When selecting Add New Attachment, you may select to upload multiple files or include a
link.

a. If selecting File as the Attachment Type:

i. Click Select Files to access a file selector from which multiple files can be
selected, or drag and drop files to the gray box surrounding the Select Files
button.

ii. The selected files are displayed in the overlay. Optionally, edit the file name
entries so that the field contains a preferred file display name.

iii. Enter Comments for the attachment.
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iv. Click Save Changes.

Note: To define different file display names for attachment files after
upload is complete, expand the Action drop-down that corresponds to a
file and select Edit Properties. You can replace the entry in the Display
Name field with the appropriate display name.

b. If selecting Link as the Attachment Type:

i. Enter an optional Name for the link.

ii. Provide the URL for the link.
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c. If more than one attachment is listed on the page, you may choose the display order
for any new attachments.

3. When selecting Add from Library:

a. You will be prompted to select from libraries associated with the event's work group
and event type.

b. Select the library and then select an appropriate attachment (s). When finished
selecting, click Add Selected Attachments.

c. The selected attachments are added to the event.

4. You can select to Edit or Delete the attachment, or continue to add by selecting Add
Attachment.

5. You can download attachments by selecting Download from the Actions drop-down
beside each attachment.

6. You can select to Upload New Version of buyer attachments. Suppliers will see only the
latest version of the file attached. Previous versions are not visible to the supplier.

a. You will be prompted to optionally update the display name and add comments.

b. Select the new version of the file to be uploaded using the Select File button.

7. You can select to view Version History for prerequisites with multiple versions.

8. When finished adding Buyer Attachments, select the Save Progress button, and the
Next button to continue.

Supplier Attachments Page
Customers may choose to include a section for suppliers to provide attachments to supplement
their bid response. There are no requirements for a customer to include this section. If included
for the event type, it is included as part of all events of that type.

There is no configuration needed for this page. It exists for suppliers to provide attachment
information they believe is helpful to their bid response. It is also available for buyer users who are
performing proxy bidding on behalf of suppliers.

Suppliers have the option of providing a file attachment or external link with supporting
information for their bid response. When viewing a supplier response, buyers may download the
file or click the link.
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Applying Confidentiality to Supplier Files

Buyers can apply the Sourcing module's Confidential Pricing functionality to documents
uploaded by suppliers. This feature is available for supplier responses to supplier attachments,
prerequisites, and questions in Sourcing events, templates, and libraries.

To apply this feature to supplier upload documents, select the checkboxes for Vendor Must Also
Upload a File and Enable Confidential Mode on the creation or edit screen overlays for
Prerequisites orQuestions:

When these flags are activated, they will be associated with each file uploaded in response to the
correlating Attachment, Prerequisite orQuestionwithin the event. Confidential fields and
upload documents are designated with the pre-existing icon that denotes confidentiality.

The existing confidential pricing setting dictates which users have access to the file. Buyer users
who do not have permission to View Pricing Data and who are not members of the event's Event
Price Viewers access group can see that a response document exists, but they cannot view or
download the document contents.

To ensure that buyers have the option to Hide Event Pricing for supplier attachments, the
checkbox to enable confidential functionality will always appear on buyer pages and the option to
Add Pricing Filewill always appear on supplier upload pages, even if confidentiality has not been
enabled for an event. Supplier files that are uploaded in response to event prerequisites that have
been flagged as confidential are managed as confidential files if at least one of the following
conditions applies to the event:
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l The Confidential Pricing setting is enabled for the event.

l The Hide Event Prices function is enabled for the event.

Questions Page
In the eventQuestions section, you can enter questions to which the supplier should respond.
Questions can be organized into groups and/or pages.

You can enter questions in the UI, or via an import file. A template is available to enter questions,
or you may export questions out of one event to import into another event.

For each question you will indicate if certain information is required. If no information within a
question is required, the supplier will see the question but will not be required to submit a
response to it in order to respond to the event.

You may also attach a file to the question, if appropriate. If you have configured the event to use
Auto Score or Cost Analysis, you will have the option to assign parameters to questions for those
configurations. Depending on the response type used, you may also add conditional questions,
which will be exposed based on responses to the parent question.

When adding or editing a question, you will enter:

l Question Text - Up to 1000 characters. This is the question to which you will expect a
supplier response.

l Response Type - Select the type of response for the question. If you are asking for a date,
select Date. If you want to provide a range of options, select if you want them to be able to
select one or many, and in what format. Conditional questions are available to be added to
questions using the yes/no, dropdown list (pick one), and multiple choice (pick one)
response types. See the Event Question Response Types section below for an
explanation of all the response types.

l Supplier Response is Required - Enable this option if you want to require the supplier to
provide an answer to this question in order to submit a bid response for the event. If this is
not selected, the question will still show to the supplier, but they will not be required to
answer it in order to submit the bid response.

l Use Response in Auto Score - This option is displayed if you have configured the event
to use Auto Score and if the response type is one of the following: Numeric Text Box,
Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many),
or Date. If selected, scoring values are added to each response in the Response Options
section.
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l Use Response in Cost Analysis - This option is displayed if you have configured the
event to use Cost Analysis and if the response type is one of following: Numeric Text Box,
Yes/No, Dropdown List (Pick One), Multiple Choice (Pick One), Multiple Select (Pick Many),
or Date. If selected, cost adjustments are added to each response in the Response Options
section.

l Set Disqualifying Response - This option is displayed if the response type is one of the
following: Numeric Text Box, Yes/No, Dropdown List (Pick One), Multiple Choice (Pick
One), Multiple Select (Pick Many), or Date. Enable this option if you want to configure a
response that will disqualify a supplier if they select it when answering an event question. If
selected, the disqualifying response(s) are selected under Response Options.

l Response Options - If you have selected a field type that requires response options to
be defined, enter each response that can be selected on the field, assign auto-score and
cost analysis values, and disqualifying response options.

Note: The fields displayed in this section will vary based on the field type. For
example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis, or Set
Disqualifying Response checkboxes have been selected. If the Use Response in
Auto Score checkbox is selected, a Score column is displayed and can be used to
assign auto score points to a response option. If the Use Response in Cost Analysis
checkbox is selected, a Cost Adjustment column is displayed and can be used to
assign cost adjustment values to a response option. If the Set Disqualifying
Response checkbox is selected, a Disqualify column is displayed and can be used to
select a response that will disqualify a supplier if they select it.

l Attach File - You may upload a file with supporting information for the question.

Event Question Response Types

An event question may be configured to be any of the following type of responses:

l Text (Single Line) - The supplier response is a single line of text, up to 100 characters.

l Text (Multi-Line) - The supplier response is text, and is entered into a text box that can
accept up to 2000 characters.

l Numeric Text Box - The supplier response must be a number. If configured for the event,
you may select to use the response in auto scoring or cost analysis.

l Yes/No - The supplier response is to select Yes or No for the question. If configured for
the event, you may select to use the response in auto scoring or cost analysis. Can have
conditional questions added to it.
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l Dropdown List (Pick One) - You will configure several different values for the supplier
response, the supplier will access the options via a dropdown list. The supplier can select
one option from the list. If configured for the event, you may select to use the response in
auto scoring or cost analysis. Can have conditional questions added to it.

l Multiple Choice (Pick One) - You will configure several different values for the supplier
response, and the supplier may select only one of the values as a response. The choices
are displayed as radio buttons. If configured for the event, you may select to use the
response in auto scoring or cost analysis. Can have conditional questions added to it.

l Multiple Select (Pick Many) - You will configure several values for the supplier response,
and the supplier may select one or more of the values as a response. The choices are
displayed as radio buttons. If configured for the event, you may select to use the response
in auto scoring or cost analysis.

l File Upload - The supplier must upload a file as a response. An example may be asking for
a list of references, background about the company, or other information that is in the form
of a file.

l Date - The supplier response is a date. An example may be when they can begin work. If
configured for the event, you may select to use the response in auto scoring or cost
analysis.

l Proforma Contract - Allows the supplier to include a proforma contract with their
response. If this option is selected, the event manager attaches a draft proforma contract
to the question and suppliers bidding on the event download the proforma contract, make
additions and changes (redline), then upload the redlined document and send it with their
response.

The actions available on theQuestions page include:

l Add or Import - Add a question page, add a page from a library, import questions or get
the import question template.

l Export Questions - Export the questions into a file.

The event actions available on each question page include:

l Page indication

l Add or Import - Add a question page, a question group, add from a library, import, or get
the import template.

l Export Questions - This action will export all questions, not just those on the page.

l Group information and ability to Manage Group - Select to add a new question to the
group, add questions from library, edit or delete the group.

l Add Question - Add a new question or a question from the library to the group.
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l Edit Questions - The Edit dropdown is available on draft events for you to edit or delete
the question information.

l Delete Selected Questions - A hyperlink that enables you to select and delete multiple
questions.

Create a Question in the User Interface

1. The page will initially be displayed with a single Group for questions. Select theManage
Group hyperlink drop-down to:

a. Add New Question - To add a question to this group of questions.

b. Add Questions from Library - To add a question from a library associated with the
work group.

c. Edit Group - To change the name of the group or to add user instructions for the
questions that are presented in the group

d. Delete Group - To remove the group of questions.

2. To add a new group for questions, select from the following options:

a. Select the Add or Import button, then select Add Question Group. Enter a Page
Title and select the position of the page.

b. Select the Add or Import button, then select Add from Library, thenQuestion
Group. Select the library associated with the work group that contains the group,
theQuestion Page andQuestion Group, then select Add Selected Group.

3. To add a new page for questions, select from the following options:

a. Select the Add or Import button, then select Add Question Page. Enter a name for
the group and select the group position on the page.

b. Select the Add or Import button, then select Add from Library, thenQuestion
Page. Select the library associated with the work group that contains the group, the
Question Page, and click Add Selected Page.
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4. You may add a new question to a group by selecting the Add Question button in the
group, and select to Add New Question.

a. Enter the Question Text. This is displayed to suppliers.

b. Select a Response Type for the question (the format of the answer).

c. Indicate if a Supplier Response is Required.

d. If Auto Response or Cost Analysis is configured for the event, you will see the
option to use the question for one or both features. If selected, you will have the
option to enter criteria. See the Configure Auto Score Values and Configure Cost
Analysis Values for details.

e. Click the Set Disqualifying Response checkbox to configure a response to an
event question that, if selected, will disqualify a supplier. If selected, the
disqualifying response is selected under Response Options.

f. Depending on the response type for the question, configure Response Options for
the field.

g. Select the Upload button if you would like to attach a file to the question.

h. If more than one question is provided, indicate the Display Order for the question.

i. Select Save Changes to add the question to the group/page.

5. Conditional questions can be added to questions using the yes/no, dropdown list (pick
one), and multiple choice (pick one) response types. Conditional questions only appear
when suppliers select the value the question is conditional upon.

a.  Click the dropdown arrow on an applicable question and select Create Conditional
Follow Up. The Add Question overlay displays.

b. Make a selection in the Conditional Upon Value field. Only suppliers who select this
value on the parent question will see the conditional question.

c. Complete the rest of the question creation as normal. Click the Save Changes
button to save the question and close the Add Question overlay.

6. You may select to add questions from a library by:

a. Select the Add Question button, then select Add Questions from Library. Select
the Library, Page and Group to see a list of questions. Select the appropriate
questions, choose the group to display and display order, and click to Add Selected
Questions.
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b. Click the Add or Import button, then select Add from Library, then Individual
Questions. Select the Library, Page and Group to see a list of questions. Select the
appropriate questions, choose the group to display and display order, and click to
Add Selected Questions.

7. You may select to add questions from Supplier Profile Content by:

a. Select the Add Question button, then select Add a Question with Supplier Profile
Content. Click into the Supplier Profile Field drop-down to see a list of questions.
Select the appropriate question, edit theQuestion Text if necessary, and display
order, and click to Save Changes.

b. You can add grouped questions by opening the Add or Import drop-down at the top
of theQuestions section and selecting Add Block Questions with Supplier Profile
Content.

i. A pop-up box containing a pick-list of the available Supplier Profile Field
block question choices will appear. After you select a block of questions to
include, you can select the Display Order in which the block will appear.

ii. The entire set of fields that are contained in the block of questions will appear
onscreen. Use the Delete Selected Questions link to remove any irrelevant
questions. You can also use the Edit option located beside each question to
customize theQuestion Text and its required status for the event.

Note: Users who have the Edit Company Profile permission can update a vendor's
Supplier Profile data for select questions from within an event. See Updating Supplier
Profiles Through Event Responses in "Supplier Responses" on page 202 for details.
Changes to Supplier Profiles from within a sourcing event are subject to the usual
review process.

8. You may select to Edit or Delete individual questions. You can delete multiple questions by
selecting the checkbox on the right side of each question and choosing the hyperlink
Delete Selected Question(s).

9. When done adding questions, pages, and groups, select the Save Progress button, and
the Next button to continue.

Export Questions from Event

Users can export a blank template or current questions associated with a sourcing event. This
allows the user to make changes in bulk to all the questions for an event.
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1. Search for an event and select the appropriate Event Number from search results.

2. Navigate to theQuestions page of the event.

3. To Export Questions:

a. Select the Export Questions button. An Export Questions overlay displays.

b. Enter a Description for the export request.

c. Select if you want to receive an Email When Export Is Ready or not. Depending on
the selection for the Sourcing - Exports Notification Preference in your user profile,
Yes or No will be selected for you, but can be changed for this export request.
Select theWhat's This hyperlink in the overlay for more information.

d. Click Submit.

4. To get theQuestions Template:

a. Select the Add or Import button, then select Import from File > Get Template. A
Get Template overlay displays.

b. Enter a Description for the requested template.

c. Click Submit.

5. A confirmation displays that the request has been submitted, and the user is navigated to
the Exports and Imports page under the Tools section of the event.

6. The requested file status will display. You may select to Refresh this Page until the status
is Completed. Download and open the file to review. The best practice is to save the file to
your computer/network.

7. Click the Delete link for the file if you would like to remove it from the page.

Edit and Import Questions for an Event

Users may edit an export file or blank template for questions associated with a sourcing event
and import the updated file to the event. This allows the user to make changes in bulk to all the
questions for an event.

Note: The Import feature is available for Questions and Items if the Event is in Draft status,
and the user must be an Event Owner. The feature is available for Events in Pending status
to approvers who have edit access to the event.

Prepare the file
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1. Open the questions Export file or Questions Template for the event.

2. Select the Enable Editing button in the spreadsheet.

3. Review and follow the instructions on the Import Instructions page of the file.

4. You may edit the Page Name. For example, instead of "Page: 1", you may enter "Page:
Legal Information".

5. Add a new group by selecting Group as the Type on the appropriate page and entering the
group title in the Group Title or Question Text column.

6. To modify a group, edit the group title in the Group Title or Question Text column.

7. To add a new question:

a. Select the valueQuestion from the options in the Type column.

b. Enter the question text in the Group Title or Question Text column.

c. Indicate Yes or No for Response Required for this question. If Yes, a supplier must
respond to the question in order to submit a response to the event.

d. Select the type of response you expect for this question, such as a date, numeric
value, option list, etc.

e. If you selected a response type that involves a list (Dropdown List or Multiple
Choice), configure the options below the question.

i. Select the valueOption from the selections in the Type column.

ii. Enter the option value in theOptions Suppliers Can Pick From column.

iii. Continue adding options as appropriate.

f. If the question should use Auto Score or Cost Analysis, you may configure ranges
and values along with the score and cost adjustment. You also may designate an
option as a disqualifying response for suppliers on appropriate response types. Enter
the appropriate values for each row whereOption is the Type for the row.

8. When all questions have been entered, save the file in .xls or .xlsx format. Note that the
information in the file will completely replace any questions information currently in the
event.

Validate / Import the File
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1. Search for an Event and select the appropriate Event Number from search results.

2. Navigate to theQuestions page of the event.

3. Select the Add or Import button, then Import from File > Import. An Import Questions
overlay displays.

a. Select an Import Action. Import is the default action, and will import the questions
into the event if there are no errors in the file. You may choose to Validate only,
which will simply check the file for errors and will not import the file.

b. Browse and select a File Name.

c. Enter an optional Description for the import.

d. Select if you want to receive an Email When Import Is Ready or not. Depending on
the selection for the Sourcing - Imports or Sourcing - Validate Notification
Preference in your user profile, Yes or Nowill be selected for you, but can be
changed for this request. Select theWhat's This hyperlink in the overlay for more
information.

e. Click Submit to import (or validate) the file.

f. A confirmation displays, reminding the user that the file information will replace all
existing data in this section of the sourcing event. Click Yes to confirm.

g. A confirmation message displays that the questions have been submitted for import,
and the user is navigated to the Exports and Imports page under the Tools section
of the event.

h. The requested file status will display. You may select to Refresh this Page until the
status is Completed. If there are any errors, you may download and open the file to
review. If there are no errors, you will simply see the request completed.

i. Once the request completes the import process, you may view the updated
questions in theQuestions section of the event.

j. Event History captures new and edited questions.

Automatic Supplier Disqualification

Administrators creating an event can configure a response to an event question that, if selected,
will disqualify a supplier. When suppliers participating in the event select the response, they will
be automatically disqualified from award consideration when the event closes.

The following Response Types support disqualifying responses:
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l Numeric Text Box
l Yes/No
l Dropdown List (Pick One)
l Multiple Choice (Pick One)
l Multiple Select (Pick Many)
l Date

To configure automatic disqualifying responses for event questions:

1. Open the event.

2. In the left menu, selectQuestions under Settings and Content. TheQuestions page
opens.

3. Click Add Questions or click Edit next to the question you want to change. The Add
Question or Edit Question overlay opens.

4. Select a Response Type that can be used for a disqualifying response (for event
questions) or Field Types (for additional item fields) support disqualifying responses:

5. Select the Set Disqualifying Response checkbox.

6. Under Response Options, configure a disqualifying response:

l Select the checkbox in the Disqualify column for each response option that will
disqualify suppliers, otherwise leave the checkbox blank.

l Click Add Response. Yes is displayed in the Disqualify column to indicate that
suppliers selecting that response will be automatically disqualified if they select it.
No indicates that suppliers selecting that response will not be disqualified.

l To change the Disqualify settings on a response option:

l Open a response option row by clicking Yes or No in the Disqualify column.

l Select or clear the checkbox on the top row (selected = disqualify), then click
the green checkmark immediately to the right of the checkbox to Update the
settings and save changes. Click the red Cancel icon to return to the original
setting.

7. Click Save Changes.
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Custom Fields

Customers can add Custom Fields to sourcing events, sourcing request templates, and sourcing
request forms that are created from those templates. These fields are used to capture and report
on additional information that is unique to their business and to their event administration
process. Content within these fields is available to support the routing of events within the
workflow process and can be used to logically categorize their sourcing events and to search for
specific events.

Custom fields are associated with specific Event Types. The custom fields associated with an
event or template via its event type are displayed in the event's Questions page. If necessary,
custom fields can be edited, added, or deleted from events:

Supplier Access to Custom Fields

An option to allow Supplier Access to custom sourcing event fields appears on the Custom
Field Creation page and the Custom Field Edit pages:

1. Navigate to Sourcing > Templates and Libraries > Custom Fields.

2. Click Create Custom Field or search and click Edit to modify an existing custom field.

3. Locate Supplier Access on the create or edit screen overlay. The default selection is No
Visibility.
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4. Click to change the setting to View Only. Suppliers will have read-only access to this
custom field data in their user interface and in supplier-side PDF export files.

5. Click Save.

Applying Confidentiality to Supplier Files

Buyers can apply the Sourcing module's Confidential Pricing functionality to documents
uploaded by suppliers. This feature is available for supplier responses to supplier attachments,
prerequisites, and questions in Sourcing events, templates, and libraries.

To apply this feature to supplier upload documents, select the checkboxes for Vendor Must Also
Upload a File and Enable Confidential Mode on the creation or edit screen overlays for
Prerequisites orQuestions:
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When these flags are activated, they will be associated with each file uploaded in response to the
correlating Attachment, Prerequisite orQuestionwithin the event. Confidential fields and
upload documents are designated with the pre-existing icon that denotes confidentiality.

The existing confidential pricing setting dictates which users have access to the file. Buyer users
who do not have permission to View Pricing Data and who are not members of the event's Event
Price Viewers access group can see that a response document exists, but they cannot view or
download the document contents.

To ensure that buyers have the option to Hide Event Pricing for supplier attachments, the
checkbox to enable confidential functionality will always appear on buyer pages and the option to
Add Pricing Filewill always appear on supplier upload pages, even if confidentiality has not been
enabled for an event. Supplier files that are uploaded in response to event prerequisites that have
been flagged as confidential are managed as confidential files if at least one of the following
conditions applies to the event:

l The Confidential Pricing setting is enabled for the event.

l The Hide Event Prices function is enabled for the event.



JAGGAER 125 www.JAGGAER.com

Additional Item Fields Page
Buyers can configure additional fields for product and service items in an event. An additional
field may be used for internal purposes or you may make it visible and/or required for suppliers.
You can choose to apply the fields to product and/or service items and also choose to limit a field
to specific item group(s).

Auto-Score and Cost Analysis Settings

If auto-score and cost analysis settings for event line items have been enabled for the work
group and event, auto-score and cost analysis rules can be applied at the line item level, allowing
organizations to request information about individual products and services being bid on by
suppliers responding to the event. Auto-scoring and cost adjustment values (which are used for
cost analysis) are enabled and assigned to response options on additional item fields. The
answers provided are included in scenario calculations, so that event administrators can take
them into consideration when analyzing results and awarding events.

Here is a summary of how auto score and cost analysis rules are applied to event line items:

l Options on the event Setup page are used to both activate the use of auto-score and cost
analysis for event line items and to set maximum cost adjustment and bid threshold limits
for cost analysis.

l Auto-scoring and cost adjustment values (which are used for cost analysis) are enabled
and assigned to response options on additional item fields. Additional item fields tagged
as visible to the supplier will be displayed on event line items in the supplier portal.

l Once the event is open, suppliers enter the requested information in additional item fields
when they bid on an item.

l Additional item field values entered by suppliers for an item are displayed in the sourcing
event on the Items page of each supplier response.

l Calculated line item auto-score and cost analysis results are displayed on the event
Evaluation page, where users can view a breakdown of auto-score and cost analysis
calculations. They also have the ability to disallow an applied cost adjustment.

l Libraries, templates, andmulti-stage events also accommodate auto-scoring and cost
analysis for event line items.
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Ship-To-Address

If a sourcing event has been created from a requisition, a read-only Ship-To-Address additional
item field is automatically created by the system and displayed on the Additional Item Field page.
Clicking View next to the item displays address information from the requisition.

Field Types

An additional item field may be configured to be any of the following type of responses:

l Text (Single Line) - The supplier response is a single line of text, up to 100 characters.

l Text (Multi-Line - The supplier response is text, and is entered into a text box that can
accept up to 2000 characters.

l Numeric Text Box - The supplier response must be a number. If this field type is selected,
you may choose to use the response in auto-scoring or cost analysis.

l Yes/No - The supplier response is to select Yes or No for the question. If this field type is
selected, you may choose to use the response in auto-scoring or cost analysis.

l Dropdown List (Pick One) - You will configure several different values for the supplier
response, the supplier will access the options via a dropdown list. The supplier can select
one option from the list. If this field type is selected, you may choose to use the response in
auto-scoring or cost analysis.

l Multiple Choice (Pick One) - You will configure several different values for the supplier
response, and the supplier may select only one of the values as a response. The choices
are displayed as radio buttons. If this field type is selected, you may choose to use the
response in auto-scoring or cost analysis.

l Multiple Select (Pick Many) - You will configure several values for the supplier response,
and the supplier may select one or more of the values as a response. The choices are
displayed as radio buttons. If this field type is selected, you may choose to use the
response in auto-scoring or cost analysis.

l Date - The supplier response is a date.

Configure Additional Item Fields

Follow the steps below to configure additional item fields for an event. Buyers may configure
additional fields for product and service items in an event. An additional field may be used for
internal purposes, or you may make it visible and/or required for suppliers. You can choose to
apply the fields to product and/or service items and also choose to limit a field to specific item
group(s).
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1. Navigate to an event.

2. In the left menu, click Settings and Content, then Additional Item Fields. The Additional
Item Fields page opens.

Note: If the event has been created from a requisition, a read-only Ship-To-Address
additional item field created by the system may be displayed on this page. Click View
next to the item to display address information from the requisition. The address is
visible to suppliers participating in the event as a read-only field on the Items page.

3. Choose one of the following options:

l To create an additional item field, click the Create Additional Field button and
select Create Additional Field.

l To add an additional item field from the library to the event, select Add Field From
Library.

l To create a conditional field, click the Create Additional Field button and select
Create Conditional Follow Up, then select the appropriate additional item field.

l To update an additional item field, click Edit next to the additional item field you
want to change.

l For events that are not in Draft status, click View next to an additional item field to
display field values in read only mode.

4. If you selected Create Additional Field, Create Conditional Follow Up, or Edit, complete
the following fields:

a. If you are creating a conditional field, select the value from the parent field that will
cause the field you are creating to be displayed in the Conditional Upon Value field.

Note: This field is only displayed when the Additional Item Fields > Create
Conditional Follow Up option has been selected.

b. Enter a Name for the field. This is the question you expect a supplier to answer by
completing the field.

c. Enter an optional Description for the field.

d. In the Applicable To field, select if the field is applicable to product line items,
service line items, or both. If you are creating a conditional field this will be a read-
only field that displays what has been selected on the parent field.
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e. In the Supplier Can Respond field, select Yes or No to indicate whether or not
suppliers are able to respond to the field. If you are creating a conditional field,
choose Yes. Additional checkboxes are displayed depending on your selection:

l Visible to supplier - Displayed if you select No. Select to allow suppliers to
view the field even when response is disabled. If not selected, only internal
users can view and edit the field.

l Supplier response is required - Displayed if you select Yes. Select the
checkbox to make it mandatory that suppliers complete the field before they
can submit a bid.

f. Select a Field Type.

Note: The following field types support auto-scoring, cost analysis, and
disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One),
Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

l Text (Single Line) - The supplier response is a single line of text, up to 100
characters.

l Text (Multi-Line) - The supplier response is text, and is entered into a text
box that can accept up to 2000 characters.

l Numeric Text Box - The supplier response must be a number.

l Yes/No - The supplier response is to select Yes or No for the question.

l Dropdown List (Pick One) - You will configure several different values for
the supplier response, the supplier will access the options via a dropdown list.
The supplier can select one option from the list.

l Multiple Choice (Pick One) - You will configure several different values for
the supplier response, and the supplier may select only one of the values as a
response. The choices are displayed as radio buttons.

l Multiple Select (Pick Many) - You will configure several values for the
supplier response, and the supplier may select multiple values as a response.
The choices are displayed as checkboxes.

l Date - The supplier response is a date.

g. The Set Disqualifying Response checkbox is displayed if Yes is selected for
Supplier Can Respond and the appropriate Field Type is selected. Enable this
option if you want to configure a response to an item-level question that, if selected,
will disqualify a supplier. The disqualifying response is defined under Response
Options.
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h. Select the following checkboxes to configure auto-scoring or cost analysis for the
field:

l Use Response in Auto Score - Select to use supplier responses to additional
item fields for auto-scoring. If selected, scoring values are added to each
response in the Response Options section.

l Use Response in Cost Analysis - Select to use supplier responses to
additional item fields for cost analysis. If selected, cost adjustments are
added to each response in the Response Options section.

Note: These checkboxes are displayed if auto-scoring and cost analysis have
been enabled for the event and set to be applied at the individual line level, and
the field type chosen supports auto-scoring and cost analysis.

i. If you have selected a field type that requires Response Options to be defined,
enter each response that can be selected on the field, assign auto-score and cost
analysis values, and identify disqualifying responses.

Note: The fields displayed in this section will vary based on the field type. For
example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis,
or Set Disqualifying Response checkboxes have been selected. If the Use
Response in Auto Score checkbox is selected, a Score column is displayed
and can be used to assign auto score points to a response option. If the Use
Response in Cost Analysis checkbox is selected, a Cost Adjustment column
is displayed and can be used to assign cost adjustment values to a response
option. If the Set Disqualifying Response checkbox is selected, a Disqualify
column is displayed and can be used to select a response that will disqualify a
supplier if they select it.

j. If more than one additional item field is provided, indicate the Display Order for the
field.

k. Click Save Changes.

5. If you selected Add Field From Library:

a. Select the library you would like to add the additional item fields from the dropdown.

b. Click the checkbox beside each additional item field you would like to add.

c. Click the Show Display Position Options link and choose a display order for the
selected additional item fields.

d. Click Add Selected Item Fields. Additional item fields are displayed.
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e. (optional) To modify an additional item field, expand the Editmenu next to the field
and select Edit, Delete, or Create Conditional Follow Up.

f. If the additional item field from the library has the Use Response in Auto Score or
Use Response in Cost Analysis checkboxes selected, click Edit to assign auto-
score or cost adjustment values to response options.

Note:Most settings on additional item fields from event libraries or templates
are carried to the sourcing events they are added to; however, if an additional
item field from the library has auto-scoring and cost analysis settings, scoring
and cost adjustment values on response options must always be configured on
the sourcing event.

Associate Additional Line Items to Groups

You may assign additional line items to specific item groups within an event. If the additional
items have been made visible to suppliers, the additional line items will only appear to suppliers
within the item group(s) to which these additional line items are associated.

1. To associate an existing additional item field to specific groups, expand the Edit drop-
down menu next to the appropriate additional item field and select Restrict Item Group.

2. When this option is selected, the Select Item Groups overlay appears. The overlay
contains a list of all item groups available within the event. Select the checkboxes beside
the groups that will be associated with the additional line item.

a. If a custom field has a conditional relationship with other Item fields, the related
children and grandchildren are automatically restricted to the same group as their
parent.

b. Group associations are identified in the following ways:

i. A Restricted to Groups column has been added to the Additional Item
Fields page to identify group associations.

ii. Additional item fields that are not applicable to an item are grayed-out in that
item's row in event PDF export and Item export files.
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iii. If import files contain values that are not applicable to items in the file, those
values will not be imported.

Configure Conditional Visibility Controls for Additional Item Fields

Conditional visibility controls can be added to additional item fields so that organizations can
define the sequence in which additional item fields are displayed on event line items, or hide
fields until they are needed. They assist suppliers in responding to the event as they only see the
fields they need to complete, in the order in which they need to complete them. For example,
organizations can design a conditional visibility hierarchy where a second field is only displayed if
Yes is selected as a response in the first field.

The Create Conditional Follow Up option allows users to either create a new additional item
field with conditional visibility, or apply conditional visibility settings to an existing additional item
field. At least one additional item field must exist before Create Conditional Follow Up is
displayed. The option is not available if the field selected is at the grandchild level in a conditional
visibility hierarchy.

A maximum of three levels of conditional visibility controls are supported in one hierarchy (i.e.,
parent, child, grandchild). An additional item field can only belong to one hierarchy. For example,
you cannot use one additional item field for three different conditional visibility hierarchies.

Follow the steps below to configure conditional visibility for additional item fields:

1. Navigate to a sourcing event.

2. In the left menu, click Settings and Content, then Additional Item Fields. The Additional
Item Fields page opens.

3. Choose one of the following options:

l To create a conditional field, click the Create Additional Field button, select
Create Conditional Follow Up, then select the additional item fieldwhose
response will dictate whether the new child field will be exposed, and that will be
immediately above the field you are creating in the conditional visibility hierarchy.

l To apply conditional visibility controls to an existing additional item field, expand the
Editmenu next to the appropriate additional item field and select Create
Conditional Follow Up.

Note: The Create Conditional Follow Up option is not available if the field
selected is at the grandchild level in a conditional visibility hierarchy.
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l To update a conditional field, click Edit next to the field you want to change.

l For events that are not in Draft status, click View next to a conditional field to
display field values in read-only mode.

4. Complete the following fields in the Create Conditional Field or Edit Conditional Field
overlay:

l Conditional Upon - This field is read only and displays the name of the field that is
parent to the field you are currently creating (i.e., immediately above it in the
hierarchy).

l Conditional Upon Value - Select the value from the parent field that will cause the
field you are creating to be displayed.

l Name - Enter the name of the additional item field you are creating. This is the
question you expect a supplier to answer by completing the field, for example, "Do
you deliver?".

l Description - Enter an optional description for the field.

l Applicable To - This is a read only field populated from the Applicable To setting
on the parent field. It will display Product, Service, or Both.

l Supplier Can Respond - This must be set to Yes to indicate that suppliers are able
to respond to the field.

l Supplier response is required (optional) - Select the checkbox to make it
mandatory that suppliers complete the field before they are able to submit a bid.

l Field Type - Select one of the following field types: Yes/No, Dropdown List (Pick
One), Multiple Choice (Pick One), Multiple Choice (Pick Many).

Note: The following field types support auto-scoring, cost analysis, and
disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One),
Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

l Enable the Set Disqualifying Response checkbox if you want to configure a
response to an item-level question that, if selected, will disqualify a supplier. The
disqualifying response is defined under Response Options.
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l Select the following checkboxes to configure auto-scoring or cost analysis for the
field:

l Use Response in Auto Score - Select to use supplier responses to additional
item fields for auto-scoring. If selected, scoring values are added to each
response in the Response Options section.

l Use Response in Cost Analysis - Select to use supplier responses to
additional item fields for cost analysis. If selected, cost adjustments are
added to each response in the Response Options section.

Note: These checkboxes are displayed if auto-scoring and cost analysis have
been enabled for the event and set to be applied at the individual line level, and
the field type chosen supports auto-scoring and cost analysis.

l Response Options - If you have selected a field type that requires Response
Options to be defined, enter each response that can be selected for the field, assign
auto-score and cost analysis values, and identify disqualifying responses.

Note: The fields displayed in this section will vary based on the field type. For
example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis,
or Set Disqualifying Response checkboxes have been selected. If the Use
Response in Auto Score checkbox is selected, a Score column is displayed
and can be used to assign auto score points to a response option. If the Use
Response in Cost Analysis checkbox is selected, a Cost Adjustment column
is displayed and can be used to assign cost adjustment values to a response
option. If the Set Disqualifying Response checkbox is selected, a Disqualify
column is displayed and can be used to select a response that will disqualify a
supplier if they select it.

l Display Order - If more than one additional item field is provided, indicate where the
field you are creating appears on the page in this field. At least one additional item
field must exist before the Display Order field is visible.

5. Click Save Changes.

Please notes the following:

l To keep track of conditional visibility controls, a Conditional Upon column on the
Additional Item Fields page shows the name of the field that is immediately above it in a
conditional visibility hierarchy.

l In a sourcing event, the values entered by suppliers in additional item fields with
conditional visibility controls are displayed on the Items page of each supplier response.
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l When additional item fields on a sourcing event are included in the Evaluation Actions >
Export All Responses document, conditionality between fields is not included.

l If deleting conditional visibility fields, grandchild and child fields in the hierarchy must be
deleted before a parent field can be deleted.

l Conditional visibility settings on additional item fields in event libraries and templates are
carried into sourcing events. When adding a set of additional item fields with conditional
settings from a library or template to a sourcing event, only the top-level additional item
fields (parent) are displayed for selection, but all fields in the hierarchy (child and
grandchild) are added to the event.

Configure Disqualifying Responses for Event Line Items
(Additional Item Fields)
Administrators creating events can configure responses to additional item fields that, if selected,
will disqualify suppliers when they respond to an item-level question. When suppliers
participating in the event select the response, they will be automatically disqualified from award
consideration when the event closes. Disqualifying response options on additional item fields in
event templates and libraries are included when they are copied into an event.

The following Field Types support disqualifying responses:

l Numeric Text Box
l Yes/No
l Dropdown List (Pick One)
l Multiple Choice (Pick One)
l Multiple Select (Pick Many)
l Date

To configure disqualifying responses for Event Line Items (Additional Item Fields)

1. Open the event.

2. In the left menu, click Additional Item Fields under Settings and Content. The Additional
Item Fields page opens.

3. Click Create Additional Field or click Edit next to the additional item field you want to
change. The Add Additional Item Field or Edit Additional Item Field opens.

4. Click Yes in the Supplier Can Respond field.

5. Select a Field Type that can be used for a disqualifying response.

6. Select the Set Disqualifying Response checkbox.
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7. Under Response Options, configure a disqualifying response:

l Select the checkbox in the Disqualify column for each response option that will
disqualify suppliers, otherwise leave the checkbox blank.

l Click Add Response. Yes is displayed in the Disqualify column to indicate that
suppliers selecting that response will be automatically disqualified if they select it.
No indicates that suppliers selecting that response will not be disqualified.

l To change the Disqualify setting on a response option:

l Open a response option row by clicking Yes or No in the Disqualify column.

l Select or clear the checkbox on the top row (selected = disqualify), then click
the green checkmark immediately to the right of the checkbox to Update the
settings and save changes. Click the red Cancel icon to return to the original
setting.

8. When finished configuring the disqualifying response(s), click Save Changes.

Price Components Page
Price component fields support an itemized view of price factors, such as fixed freight costs and
import duties, that affect the total bid prices submitted against sourced items. As a result, price
components provide pricing details that are useful in the deconstruction of submitted bids during
event evaluation.

A Price Components tab is available for configuring price-impacting fees and allowances that
enable users to compare the total landed cost of sourced items. Buyers have the option to create
price component fields from scratch or to select them from a library, and they can apply the price
components at the individual item level or restrict them to specific item groups. The price
components that are configured for event items will apply to alternate items submitted by
suppliers. Buyers are presented with a more granular view of supplier bids when they leverage
price component fields.

If suppliers are unable to break down their bids for any event items to the level specified by the
price component fields, they can bypass the price components and submit an All-In bid for those
items. Suppliers can also propose up to 5 alternates for each item that is configured with price
components.

When buyers evaluate supplier bids, pricing comparisons are based on the Total Calculated
Price for each item. The Total Calculated Price is equal to the Unit Price plus Price
Componentsmultiplied by the item quantity.

Note: Price component fields are not available for use in reverse auction events.
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Creating Price Components from Scratch

1. Navigate to an event that has pricing components enabled in the event's Settings and
Content.

2. Click Pricing Components in the event's Settings and Content to open the page.

3. Expand the Create Item Price Component drop-down and select Create Item/Header
Price Component.

4. Fill in the components Name (mandatory).

5. Optionally, fill in a Description for the price component.

6. If a Supplier Response is required, select this checkbox.

7. Expand the Adjustment Type drop-down and choose whether the price component is a
Fee(debit)or an Allowance (credit). Expand the drop-drop located to the right of this field
and choose whether the adjustment is measured in the event currency or as a% of the
price.

8. Select the appropriate Applicable To button to indicate if the price component applies to
Product Line Item, Service Line Item, or Both.

9. Click to Save Changes.

Creating Price Components from a Library

1. Navigate to an event that has pricing components enabled in the event's Settings and
Content.

2. Click Pricing Components in the event's Settings and Content to open the page.

3. Expand the Create Item Price Component drop-down and select Add Price Component
From Library. The Add Price Components from Library overlay opens.

4. Expand the Library drop-down and select the library that contains the appropriate price
component(s).

5. Select the checkboxes for the price component(s) that will be added.

6. Click the Add Selected Price Components button.

Restricting Pricing Components to Item Groups

Pricing components can be restricted so they apply to some of the event items, but not to others.
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1. Expand the Edit drop-down beside the appropriate price component and select Restrict
to Item Groups. A Select Item Groups overlay appears.

2. Select the checkbox(es) for the appropriate item group(s) on the overlay.

3. Click Save Changes.

Creating Price Components for Alternate Items

l Alternate Item fields are independent from group-level price component controls. This
accommodates any unique qualities that may be assigned to alternate items. An All-In
Price checkbox is available when alternate items are configured to define if each alternate
item will have this pricing feature available:

Items Page
On the Items page, you can add up to 2000 specific product line items and/or service line items
associated with the event. Suppliers can then indicate their price for the item and other details
such as when they can deliver the item.

You can add items via the UI, or via an import file. You may choose to organize the items in
different groups. For example, if you were furnishing conference rooms, you may have a group for
"Furnishings" and a group for "Accessories".
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Alternate Items

If an event is configured to allow alternate items, you will select whether or not alternate items will
be allowed for each product or service line item you add to the event. If enabled for an item, a
supplier will have the opportunity to submit an alternate item in addition to or instead of the
specific item you list in the event. The option for Allowing Alternate Items can be configured at
the organization, work group, and event level. See the Alternate Items Setting section in the
"General Sourcing Settings" on page 315 for more information.

Create and Manage Groups Via the User Interface

The page will initially display with a single Group for items on the Product Line Items and Service
Line Items tabs. Select theManage Group hyperlink drop-down to:

1. Add New Item - To add an item to this group.

2. Add Item From Library - To add an item from a library to this group.

3. Edit Group - To change the name of the group or to add user instructions for the questions
that are presented in the group.

4. Delete Group - To remove the group of line items.

You may also choose to Add Group to create a new group for items.

Add Items Via the User Interface

1. The default landing tab for items is the Product Line Items tab. To add a service item, click
the Service Line Items tab to access this page.

2. Add a new item through one of these methods:

a. Click the Add Product Line Item / Add Service Line Item button and choose Add
New Item.

b. Expand theManage Group drop-down and select Add New Item.

3. Fill in the following fields on the Edit Product Line Item / Edit Service Line Item pop-up
screen:

a. Name - Enter the name of the product or service.

b. Brand (optional for Product Line Items only) - If this feature is enabled for your
organization, type a brand name in the field. The system will check to see if the
name matches brands in the system. If there is a match, the name is added to the
Brand field. If it does not match, the message Try Searching Again is displayed.
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c. Description - Enter an optional description for the item, up to 2500 characters.

d. Catalog Number (optional for Product Line Items only) - If there is a specific
catalog number for the product, you may enter it here.

e. Quantity - Enter a quantity for the item. Alternatively, you can make the Quantity
field a vendor-supplied field using the following checkbox:

i. Make Quantity a Supplier Response Field - Selecting this option allows
suppliers to enter an amount in theQuantity field. You will be prevented from
entering data in theQuantity field if you makeQuantity a supplier response
field.

f. Unit of Measure - Select from the drop-down. This field is required for product line
items, and optional for service items.

g. Requested Delivery - the following options are available:

i. Date - choose this radio button if you would like the supplier to provide a
specific date for expected delivery of the item. You may choose to enter a
requested delivery date or select a date using the date picker, for the
supplier's information.

ii. Days after award - Choose this radio button if you would like the supplier to
indicate the number of days after the award that the item can be delivered.
You may choose to enter a numeric Days after award value for the supplier's
information.

h. Choose the following options as appropriate:

i. Unit Price is Required - If this option is selected, the supplier cannot submit a
bid response without entering this information.

ii. Estimated Delivery Date is Required (optional for Product Line Items only)
- If this option is selected, , the supplier cannot submit a bid response without
this information.

iii. Alternate Items are Allowed - If the event is configured to allow alternate
items, you may indicate if you will accept alternates for this specific item. If
enabled, suppliers will have the ability to submit alternate item information
instead of or in addition to the listed item.

i. Commodity Code - If your organization uses commodity codes, you can click the
Edit button to search for and associate a commodity code with the item. If any items
have commodity codes associated, you will see them displayed as Item Commodity
Codes. Only one commodity code may be selected for each item.

j. Historical Unit Price- If entered, this value is used to calculate the Cost Savings
Report.
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k. Ship-To-Address (optional for Product Line Items only) - If the sourcing event was
created from a requisition, the Ship-To-Address from the requisition is displayed as
a read-only field on items populated from the requisition. On additional product line
items introduced to the PR-generated event, a blank Ship-To-Field allows buyer
users to enter an address.

l. Target Price - Optionally, enter a target price to be used for evaluation. The supplier
will not see this value.

m. Bid Decrement - If the event type is an Auctionwith a bid decrement enabled,
enter the amount suppliers must bid below a previous bid.

n. Minimum Price - If you have chosen to use minimum prices, you may enter a
minimum price for the item. If a supplier's bid is less than the set minimum bid
amount, the error message The submitted bid is less than the established minimum
price for this item will display.

o. Maximum Price - If you have chosen to use maximum prices, you may enter a
maximum price for the item. If a supplier's bid is greater than the set maximum bid
amount, the error message The submitted bid is more than the established
maximum price for this item will display.

p. Additional item Fields - These fields may appear as configured on the Additional
Items Fields page. For more information, see the section on the Additional Item
Fields Page (located above).

q. Attach File - You can attach a file to the item by selecting Upload, entering a title
for the file, and selecting the appropriate file to attach.

r. Show Display Position Options - This section appears if more than one item is
listed. New items are defaulted to the last position in the list. Click to expand this
section and access options to change the display order:

i. Show in Item Group - Select the appropriate group from the drop-down.

ii. Display Order - Select the item's placement in the list from the drop-down.

4. Click to Save Changes.

Add Items from a Library Via the User Interface
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1. The default landing tab for items is the Product Line Items tab. To add a service item, click
the Service Line Items tab to access this page.

2. Add items from a library by selecting one of the following:

a. Click the Add Product Line Item / Add Service Line Item button and choose Add
Item from Library.

b. Expand theManage Group drop-down and select Add Item from Library.

c. Add from Library drop-down, then Individual Items. Add a group of items from a
library by selecting Add from Library, then Items Group

3. Select the Library. A filter box is provided to assist you in locating the appropriate library.

4. Select the Line Items Group the items are in. The items contained in the selected group
will display.

5. You can select the checkboxes for individual items or select the checkbox in the column
header to select all items in the group.

6. Select which Item Group the items will be part of.

7. Select the Display Order for these items.

8. Click to Add Selected Items.

Add Items from a Catalog Via the User Interface

1. The default landing tab for items is the Product Line Items tab. To add a service item, click
the Service Line Items tab to access this page.

2. Click the Add Product Line Item / Add Service Line Item button and choose Add from
Catalog.

3. Search for the item in the Shop overlay that appears.

4. Enter the quantity of the item to add and click Add to Document.

5. When finished, close the screen overlay.

Note: In most cases, the supplier associated with the catalog item will also be added
to the event. In cases where this does not occur, the supplier can be added manually
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on the event's Suppliers page.

6. When finished entering items, select the Save Progress button, and the Next button to
continue.

Export Items for an Event

Users can edit an export file or blank template for items associated with a Sourcing event and
import the updated file to the event. This allows the user to make changes in bulk to all the items
for an event. Up to 2000 items may exist for an event. The export feature is available for events in
any status.

1. Navigate to the Items page of the event.

2. To Export Items:

a. Select the Export Items button. An Export Items overlay displays.

b. Enter a Description for the export request.

c. Select if you want to receive an Email When Export Is Ready or not. Depending on
the selection for the Sourcing - Exports Notification Preference in your user profile,
Yes or No will be selected for you, but can be changed for this export request.
Select theWhat's This hyperlink in the overlay for more information.

d. Click Submit.

3. To get the Items Template:

a. Select the Add or Import button, then select Import from File > Get Template. A
Get Template overlay displays.

b. Enter a Description for the requested template.

c. Click Submit.

4. A confirmation displays that the request has been submitted, and the user is navigated to
the Exports and Imports page under the Tools section of the event.

5. The requested file status will display. You may select to Refresh this Page until the status
is Completed. Download and open the file to review. The best practice is to save the file to
your computer/network.

6. Click the Delete link for the file if you would like to remove it from the page.
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Import Items for an Event

Users can edit an export file or blank template for items associated with a Sourcing event and
import the updated file to the event. This allows the user to make changes in bulk to all the items
for an event. Up to 2000 items may exist for an event.

Note: The Import feature is available for Questions and Items if the event is in Draft status,
and the user must be an Event Owner. The feature is available for events in Pending status
to approvers who have edit access to the event.

Prepare the file

1. Open the items Export file or Items Template for the event. See the Export Items task.

2. Select the Enable Editing button in the spreadsheet.

3. Review and follow the instructions on the Import Instructions page of the file.

4. Worksheets show the Product Line Items and Service Line Items.

5. Add a new group by selecting Group as the Type on the appropriate worksheet and
entering the group title in the Name column. To edit a group, simply edit the Name.

6. To add a new item to Product Line Items:

a. On the Product Line Itemsworksheet, select the value Item from the options in the
Type column.

b. Enter a Name for the item.

c. (optional) If enabled for your organization, type a name in the Brand field. This must
be a brand loaded in your system.

d. (optional) Enter a Description for the item, up to 2500 characters.

e. If there is a specific Catalog Number for the product, you may enter it in this field.

f. Enter theQuantity of the item needed.

g. Enter a Unit of Measure by selecting from the dropdown list.

h. Commodity Code - If your organization uses commodity codes, select the
appropriate value to associate with the item from the dropdown list.

i. You may choose to enter a Target Price for the item. It will be used during the
evaluation.
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j. Alternates Allowed? - If the event is configured to allow alternate items, select Yes
if you will accept alternates for this particular item. If you do not want to accept
alternates for this item, leave the value as No.

k. For Requested Delivery Option:

i. Choose Date if you would like the supplier to enter a specific Date for
estimated delivery. You may enter a specific Requested Delivery Date value.

ii. Choose Days if you would like the supplier to provide a number of days after
the award when the item will be delivered. You may also enter a value for
Requested Delivery Days. This is the number of days after the award that
you would like delivery of the item.

l. Unit Price Required? - If the supplier must submit a price for this item, select Yes.

m. Delivery Date Required? - If the supplier must provide a Requested Delivery Date
or Requested Delivery Days value, select Yes.

n. Historical Unit Price - Optionally, enter a Historical Unit Price. This is used to
calculate the Cost Savings Report.

o. Minimum Price - If the event is using minimum item prices, enter the minimum bid
price.

p. Maximum Price - If the event is using maximum item prices, enter the maximum bid
price.

q. Enter optional Comments for the item. These are in the file only, and not added to
the item information.

7. To add a new item to Service Line Items:

a. On the Service Line Itemsworksheet, select the value Item from the options in the
Type column.

b. Enter a Name for the item.

c. Enter an optional Description for the item, up to 2500 characters.

d. Enter theQuantity of the item needed.

e. Enter a Unit of Measure by selecting from the dropdown list.

f. Commodity Code - If your organization uses commodity codes, select the
appropriate value to associate with the item from the dropdown list.

g. You may choose to enter a Target Price for the item. It will be used during the
evaluation.
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h. Alternates Allowed? - If the event is configured to allow alternate items, select Yes
if you will accept alternates for this particular item. If you do not want to accept
alternates for this item, leave the value as No.

i. For Requested Delivery Option:

i. Choose Date if you would like the supplier to enter specific start and end
dates for the service to be provided. You may enter specific Requested Start
Date and Requested End Date values.

ii. Choose Days if you would like the supplier to provide a number of days after
the award when the service will be delivered. You may also enter a value for
Requested Delivery Days. This is the number of days after the award that
you would like delivery of the service item.

j. Unit Price Required? - If the supplier must submit a price for this item, select Yes.

k. Historical Unit Price - Optionally, enter a Historical Unit Price. This is used to
calculate the Cost Savings Report.

l. Minimum Price - If the event is using minimum item prices, enter the minimum bid
price.

m. Maximum Price - If the event is using maximum item prices, enter the maximum bid
price.

n. Enter optional Comments for the item. These are in the file only, and not added to
the item information.

8. When all items have been entered, save the file in .xls or .xlsx format. Note that the
information in the file will completely replace any items currently in the event.

Validate / Import the file

1. Search for an Event and select the appropriate Event Number from search results.

2. Navigate to the Items page of the event.

3. Select the Add or Import button, then Import from File > Import. An Import Items
overlay displays.

a. Select an Import Action. Import is the default action. Selecting it will import the
items into the event if there are no errors in the file. You may choose to Validate
only, which will simply check the file for errors and will not import the file.

b. Browse and select a File Name.

c. Enter an optional Description for the import.
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d. Select if you want to receive an Email When Import Is Ready or not. Depending on
the selection for the Sourcing - Imports or Sourcing - Validate Notification
Preference in your user profile, Yes or No will be selected for you, but can be
changed for this request. Select theWhat's This hyperlink in the overlay for more
information.

e. Click Submit to import (or validate) the file.

f. A confirmation displays, reminding the user that the file information will replace all
existing data in this section of the sourcing event. Click Yes to confirm.

1. A confirmation message displays that the items have been submitted for import, and the
user is navigated to the Exports and Imports page under the Tools section of the event.

2. The requested file status will display. You may select to Refresh this Page until the status
is Completed. If there are any errors, you may download and open the file to review. If
there are no errors, you will simply see the request completed.

3. Once the request completes the import process, you may view the updated items in the
Items section of the event.

4. Event History captures new and edited items.

Suppliers Page
On the Suppliers page, you will search for suppliers to add to your event. In order to invite the
supplier, the supplier's profile must contain a corporate or sales contact.
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Inviting Suppliers Through the UI

1. To add suppliers to the event, select the Add Suppliers to Event tab:

a. Search for the supplier by name or ID, contact, relationship, postal code, commodity
code(s), or NAICS code or Brand (if enabled for your organization). You can also
choose to search suppliers only in your network, out of network, or all suppliers in
the JAGGAER database.

i. Click the icon in the NAICS Code search box to open a list of selectable NAICS
codes to search by.

ii. If the Brand feature is enabled for your organization, select a value in the
Brand supplier search filter to return a list of suppliers that have an indication
within their supplier profile that they can source goods available from the
identified market brand and may be potential providers of the targeted goods.
Click the Search icon to display a list of brands that can be selected.

b. If a more specific search is required, click Show Advanced Search to access
additional search options including, Class, country Of Origin, and Payment Method.
The Relationship drop-down defaults to All suppliers, but additional choices are In
Network and Out of Network.

c. If a supplier does not exist in the organization's database, users with appropriate
permission may choose toManually Invite Suppliers to the event. Refer to the
Manually Invite Suppliers task for details.

d. As suppliers are invited to the event, they are displayed on the Event Suppliers tab.

2. To add suppliers from the group, select the Add Suppliers From Group tab:

a. Click the Add All to Event button beside each group to add all suppliers from the
group to the event.

b. Click the drop-down arrow beside the Add All to Event button and click Add
Selected to Event to open a pop-up where you can select individual suppliers from
the group. Click Add Selected to add the selected supplier contacts.

3. If the event is configured to Forced Supplier Invitation by Commodity Code:

a. Suppliers who will be invited because of a matching Commodity Code to one in the
event are listed on the Suppliers Invited by Commodity Code tab.

b. You may invite other suppliers to the event on the Add Suppliers to Event tab (see
step a. above). Suppliers who are added via a user invitation are displayed on the
Additional Suppliers tab.
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4. On any of the tabs where invited suppliers are listed, if no contact is available or the
appropriate contact is not listed:

a. If you have the Add Supplier Contact permission, you may choose to Add Contact
for a supplier from the page. You may also update a current contact's information.

b. If you do not have the Add Supplier Contact permission, you may navigate to the
supplier's profile by selecting the supplier's name. Add the appropriate contact
information on the Contacts tab.

5. When finished adding suppliers, select the Save Progress button, and the Next button to
continue.

Suppliers added to the event show on the Event Suppliers tab. If you would like to remove a
supplier from the list, click the Remove button.

When the Event is approved and released, suppliers will receive the Sourcing Supplier Invitation
email. This email, and other system emails, are managed in the System Emails menu, available at

Administer > Email Management > System Emails. You may edit the email if appropriate.
See Email Management for more information on managing system emails for your organization.

Manually Invite Suppliers

Customers may invite suppliers who are not currently in the supplier master database to
participate in a sourcing event. A supplier record is not created unless a supplier responds to the
invitation. Customers may manually add suppliers to the event through the UI, or via an import
process.

The organization and the work group must be configured to allow manually inviting suppliers in
order for the option to show on the Events page.

Manually Adding a Supplier Via the UI

1. Select theManually Invite Suppliers button, then Add Supplier to Event. An overlay
displays.

2. Enter a Supplier Name (required).

3. Enter an optional Sales or Corporate Contact Name.

4. Enter a valid Email address (required).

5. Select to Save to return to the Add Suppliers to Event page. Select Save and Add Another
to invite additional suppliers.

6. Manually invited suppliers show on the Event Suppliers tab without a hyperlink to the
supplier profile, since the supplier record is not created unless the supplier responds to the
invitation.
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Manually Adding Suppliers Via Import

To add many suppliers in bulk, an Import template is available that includes instructions for the
format and process for uploading the file. The user may select Get Import Template to download
the file with instructions. Select Import to upload a file with the appropriate supplier information
for the manual invitations.

1. To access the import template:

a. Select theManually Invite Suppliers button, then Get Import Template. Select to
open or save the file.

b. Click the Enable Editing button in the spreadsheet.

c. Review the Instructions worksheet in the file.

2. Enter the appropriate information in the Import Data worksheet.

a. Supplier Name is required.

b. You may enter an optional Sales or Corporate Contact Name.

c. A valid Contact Email address is required.

Note: Each contact requires a unique email address. When importing suppliers
to a sourcing event, contacts found to be duplicates will be removed so that
only valid sales and corporate contacts are added to an event.

3. When all suppliers to manually invite are entered, save the spreadsheet in .xls or .xlsx
format.

4. On the Add Suppliers to Event tab of the Suppliers page in the event, selectManually
Invite Suppliers button, then select Import. An overlay displays.

a. Select an Import Action. Validate is the default action, which will simply check the
file for errors and will not import the file. Select Import to import valid supplier rows
into the event.

b. Select if you want to receive an Email When Import Is Ready or not. Depending on
the selection for the Sourcing - Import or Sourcing - Validate Notification
Preference in your user profile, Yes or No will be selected for you, but can be
changed for this request. Select theWhat's This hyperlink in the overlay for more
information.

c. Browse and select a File Name.

d. Click Submit to import (or validate) the file.

e. A confirmation message confirms that the suppliers have been submitted.
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f. Navigate to the Exports and Imports page of the event under the Tools section of
the event. The requested file status will display. You may select to Refresh this
Page until the status is Completed. If there are any errors, you may download and
open the file to review. Rows without errors are processed.

g. Once the request completes the import process, you may view the updated
suppliers on the Event Suppliers tab on the Suppliers page. Manually invited
suppliers show without a hyperlink to the supplier profile, since the supplier record is
not created unless the supplier responds to the invitation.

h. Event History captures the suppliers added to the event.

Add Supplier Contacts from Event Suppliers Page

When creating a sourcing event, suppliers may be invited if a supplier contact exists for the
customer. If an appropriate supplier contact is not available, the user may navigate to the
supplier's profile and add the contact. However, if a user has the Add Supplier Contact
permission, a user may add a new supplier contact directly from the Suppliers page of the event.

On the Suppliers page of a sourcing event, when viewing a list of supplier results on the Add
Suppliers to Event tab, users with the appropriate permission will see one or both of the following
options:

l Add to Event - This button is displayed in the Action column if the supplier has a valid
contact displayed. Clicking this button will add the supplier and displayed contact to the
Event Suppliers tab.

l Add Contact - This button is displayed in the Sales and Corporate Contacts column, at
the end of the list of existing contacts for each supplier. It is available for all supplier
results. This is the only action available if no contact currently exists for the supplier, or if
the listed contact has already been added to the event. This action is available along with
the Add to Event action if there is already a contact, but you would like to invite a different
supplier contact to the event.

When a user selects Add Contact from the Event Suppliers tab or the supplier results page, they
can: select from other current contacts for the supplier, edit current contact information, or select
the radio button The contact I am adding is not listed and enter information for the new
contact. The contact information is added / updated to the Supplier Profile on the Contacts tab.
History for the supplier profile indicates the contact was created/edited.

Note that when contacts are added/edited:
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l A new contact is added as a Sales Contact type by default. The user has the option, when
creating the new contact, to also make the contact a corporate contact type.

l When an existing contact is added to the event that is not a sales or corporate contact, the
system will create a sales contact, using the same information from the existing contact.
You will then see two contacts with that information in the supplier profile. One will be the
original, and the other will be the newly added sales contact.

l Each contact requires a unique email address. Messages will indicate when an email
address is in use and direct you to pick a different contact or enter a different email
address.

Inviting Suppliers Based on Commodity Code

A configuration for Forced Supplier Invitation by Commodity Code is available at the
organization, work group and event level. When enabled for an event, a tab showing Suppliers
Invited by Commodity Codewill display on the Suppliers page in Event Settings and Content.
The tab displays suppliers in the customer's network that have a commodity code associated
with the supplier profile matching any of the event commodity codes. This includes Reporting and
Additional Commodity Codes listed on the Event Setup page, as well as the item level commodity
codes.

l When an item that has been configured with a commodity code is added to a Sourcing
event, the commodity code is automatically transferred to the event along with the other
item information. If the Forced Supplier Invitation by Commodity Codes setting has
been activated and the event is in Draft status, the supplier count will be updated
automatically to reflect the addition of the commodity code to the Sourcing event.
l If the library item is added to a Sourcing event through the amendment process, the
amendment reconciliation process must finish running before the supplier count is
updated automatically and new supplier invitations are issued.

l If the library item is added in a subsequent stage of a multi-stage event, the supplier
count will not be updated and new supplier invitations will not be issued
automatically for that event.

l A message will display if there are no registered suppliers in your organization's network
that match event commodity codes. A message will also display if you have not associated
any commodity codes to the event.

l Buyers may add new contacts for the listed suppliers if appropriate.

l If a supplier has an associated Exclude from Sourcing Event supplier class associated,
they will not be included automatically in the suppliers invited by commodity code.

You may search for and add other suppliers to the event on the Additional Suppliers tab. The
number of unique suppliers invited to the event will show in the left navigation for the Suppliers
page.
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Resending Supplier Invitations

Up until the time the event is closed, you may re-invite suppliers who have not responded to the
event. Navigate to Evaluations > Supplier Responses and select to Resend Supplier Invite to
suppliers who have not responded. When selecting to resend, the invitation will be sent to each of
the supplier's contacts added to the event.

Review and Submit Page
Once you have configured Event Details, you will navigate to the Review and Submit page to
confirm all required information is present and Submit for Approval. If any required items are not
completed, such as a date or description, you cannot submit the event for approval. Hyperlinks
are available on the actions needed for easy navigation to the appropriate page.

1. On the Review and Submit page, note if any required items are not completed, and correct
as appropriate.

2. Select View Approval Steps to see the steps the configured event will pass through in
order to be approved for release.

3. When all required items are completed, click Submit for Approval.

4. A page displays confirming the event was submitted for approval.

Once you submit the event for approval, it enters Event Workflow and must be approved before it
is released to suppliers.

Tools

Panel Questionnaires for Events
Sourcing clients can choose to incorporate a Panel Questionnaire into an event for use as a tool
during the evaluation process. When enabling a panel questionnaire for an event, the event owner
indicates what criteria is most important, supplier responses that are most important, and
panelists who will complete the questionnaire. The panelists do not have to have permission to
edit an event. They will be given a view of the supplier responses and questionnaire according to
their permissions and access settings. The use of panel questionnaires is configured at the work
group and event level.
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When the event is configured to include a panel questionnaire, a section for Panel Questionnaire
is available in the navigation for the event. The questionnaire is made up of questions/supplier
responses from the event, as well as custom questions that the buyer can set up that are only
present on the questionnaire. The idea is that each panelist can rate different supplier responses
to questions. For example, if the question is “How long is the warranty for this item/work?”, the
panelist might rate a 1-year warranty as a 3 out of 5 and a 2-year warranty as a 5.

Note: Cost Per Quality Point (CPQP) requires the use of Panel Questionnaire on an event, as
the calculations use the Average Panel Questionnaire Score. If you do not configure and
have at least one completed response to a Panel Questionnaire, the CPQP score will not
display. See Cost Per Quality Point for Events for additional information about CPQP.

The Panel Questionnaire is configured in a wizard format. A best practice is to keep in mind how
you will assign panelists to the questionnaire as you configure the questions and groups.

Configure Panel Questionnaire

Note: Some actions cannot be performed until the event closes and suppliers have
responded.

1. Navigate to an event for which a Panel Questionnaire has been enabled.

2. Select the Panel Questionnaire section in the event navigation. The Panel Questionnaire is
configured in a wizard format. The following sections are available for configuration:

3. Configure Setup options:

a. Enter a Point Value - The total number of points that can be earned by a supplier if
they were to receive a perfect rating from all panelists.

b. Select an option for Assign Weights Using: Points or Percentages. When
configuring weights for the questions, you will use the total Point Value if Points is
selected, and 100% if Percentage is selected.

c. Enter aQuestionnaire Close Date and time. This is the date by which panelists
must submit their questionnaire responses.

d. Select if you would like to Anonymize Supplier Information, so that panelists will
not see actual supplier names associated with the bid responses.

e. Select if you would like the questionnaire to display a Single Supplier Response
Per Page in the UI and in the exported questionnaire file. If not enabled, up to 5
suppliers show on a page in the UI, and all suppliers will show on a single sheet in the
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exported questionnaire file.

f. Enter values for the questionnaire Rating Scale, which defines each rating value.
You may enter the top and bottom ratings only, if desired. For example, 1 = Bad, 5 =
Excellent.

4. Configure Panelists for the event:

a. Select Add Panelist and search from any user who can view an event in the User
Search overlay:

i. Select the Add Panelist button next to each user in search results who should
serve as a panelist for the event.

ii. When finished adding panelists, click to Close the overlay.

b. Selected panelists will show on the page. Once the questionnaire is in process, you
will see panelist response progress.

c. Select the Action button next to a panelist to:

i. Edit Group Assignment to assign a panelist to specific questions or groups
of questions to the panelist as optional or required.

ii. Remove Panelist from the questionnaire.

iii. The panelist's Assigned Question Group is displayed on the page.

d. View all group assignments by selecting the Group Assignment Overview button
on the panelist page.

5. ConfigureQuestions to include in the questionnaire:

a. You may select from the event questions and include groups and pages.

b. Once in a group, you may also add a manual question.

c. Configure specific scoring options for each question.

d. You may add questions from a library, if available.

e. You may add new questions specifically for the panel questionnaire (that are not
included as an event question).

6. ConfigureQuestion Weight:

a. Weights are a breakdown of the how the point value is distributed across all
questions. Select the appropriate weight for each question. Use the total Point Value
configured for the questionnaire, or 100% as a percentage.

b. Note that:
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i. You can enter weights at the page and group levels, then click the action link
called Auto Assign Question Weights to have the system allocate individual
question weights equally within each group of questions. You can adjust
these weight assignments manually as needed.

ii. Questions within a group must equal the total Point Value or 100%.

iii. Groups on a page must equal the total Point Value or 100%.

iv. Pages must equal total Point Value 100%.

c. Example: If you allocate 100 points to the questionnaire:

i. The total number of points for pages must add up to 100. For example, if there
are 3 pages in the questionnaire, the total weight of those three pages must
equal 100. In this example we will allocate 25 points to the first page.

ii. Now that we have 25 points allocated to the first page, the total of all groups
within Page One must equal 25. This means, if there are 4 groups on the page,
the total weight of all the groups must equal 25. For this example, we will
allocate 10 points to Group One.

iii. The total of all questions within a group must equal the total assigned to that
group. This means if there are 5 questions in the group, and you have 10
points assigned to the group, you must allocate 10 points among the
questions within that group.

7. Add Suppliers to be evaluated with the questionnaire. Note that suppliers cannot be
added until they have responded to the event. You may add suppliers either of these ways:

a. On the Supplier Responses page, select the appropriate suppliers, and from
Evaluation Actions, choose Add Selected to Panel Questionnaire; or

b. On the Suppliers page of the Panel Questionnaire, select the Add Supplier button.
Only those suppliers who have submitted a response to the event and are not
already present on the questionnaire will display.

c. As panelists complete the questionnaire for a supplier, the supplier's rating is
displayed on this page. You may also select to remove a supplier from the
questionnaire.

8. Review and Publish - Note any sections of the questionnaire that require attention. Once
you have completed required information, you may choose to Publish Questionnaire.
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9. After the questionnaire is published, a panel questionnaire administrator can continue to
add new panelists and suppliers to the questionnaire. If questions or weights must be
changed, however, the questionnaire must be withdrawn to make edits, and republished.

a. SelectWithdraw Questionnaire to make the questionnaire a draft form. You may
make edits to the configuration and then select to publish.

b. Select Close Early to close the questionnaire before the configured close date. This
may be because you have already received all the panelist responses, so there is no
reason to leave the questionnaire open.

c. Select Extend Questionnaire to change the close date for panelist responses.

d. Select Reopen Questionnaire from the Event Actions drop-down menu to reopen
and extend the close date of a closed panel questionnaire.

10. Manage questionnaire imports and exports as a panelist or panel administrator on the
Panel Exports and Imports page.

Once the questionnaire is published, panelists receive an email to complete the questionnaire. A
panelist can complete the questionnaire in the UI or by exporting/importing the questionnaire. A
panel administrator can export questionnaires and import questionnaire responses on behalf of
panelists.

Response Overview
Once an event is closed and the questionnaire has been configured and published, panelists will
receive an email and an in-application notification indicating they have a questionnaire to
complete. Panelists may navigate to the event from the email or within the application, and begin
completing the requested information. The Panel Questionnaire page will be available to any
user who has been designated as a panelist, even if that user is not specifically assigned to the
work group or event. A user with only view event permissions will see a limited view of the event,
allowing them to only respond to the questionnaire. Those users will only see the Panel
Questionnaire page when accessing the event. The panelist must complete their response by
the Questionnaire Close Date.

On the Panel Questionnaire page, a panelist may select View Questionnaire to be taken to the
first supplier response, or go to a specific supplier by selecting Go to Supplier on Questionnaire.
The panelist may also choose to Export or Import the questionnaire. This is helpful if the panelist
would like to edit the questionnaire in an Excel file format, and then import the responses back
into the application.
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l If a panelist is assigned to a group of questions, the panelist will see what questions are
optional or required.

l If a panelist is not assigned to specific groups/questions, the panelist is only required to
complete one group of panel questions for each supplier before submitting their panel
response. However, all questions within a single group must be completed.

Note: A validation process checks for unrated questions and shows a list of required
questions that have not been rated and which require a response rating. Panelists can
click on a question link to navigate directly to the question for the express purpose of
completing the missing assessment. Once such a question has received the panelist's
response rating, it is removed from the list.

l Panelists enter a score for the supplier's responses to the questions according to the rating
scale.

l Once the panelist has submitted their response, the panel questionnaire administrator can
see the average rating for all the suppliers from the panelist. Note that average ratings will
only appear after at least one complete questionnaire has been submitted.

l A panel administrator can choose to export/import a panelist questionnaire on their behalf.

l The Average Questionnaire Response score shows when evaluating event responses.

Email a panelist receives when a questionnaire is published



JAGGAER 158 www.JAGGAER.com

View to a user who only has Panelist access to event

When select to View Questionnaire - see all the responses at once
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When select to View a specific supplier - Option to page through other
responses

Panel Questionnaire Completed - Ready to Submit

Complete a Panel Questionnaire
1. Navigate to an event for which you are designated as a Panelist:

a. Respond via the link in an email you received as a Panelist for an event.

b. Search for an Event using Advanced Search, with the criteria being your role as a
Panelist in the Panel Questionnaire section of Advanced Search. Select the
appropriate event.

2. Select theMy Response page from the Panel Questionnaire section of event navigation.
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3. To view the questionnaire for all suppliers at once, select the View Questionnaire
button. Proceed to step 5.

4. To view the questionnaire for a single supplier, select Go to Supplier on Questionnaire
for the appropriate supplier. You may navigate to other supplier questionnaires by
selecting the Next and Previous buttons when viewing a single supplier questionnaire.
Proceed to the next step.

5. Review the supplier's responses to the questions.

a. From the drop-down below the supplier's answer, select your score for the
supplier's response, based on the organization's configured rating scale for the
event.

b. Enter an optional comment about your score or the supplier's response.

c. You do not have to provide a score to all questions in the questionnaire, but you
must answer all questions within the same group of questions, or within your
assigned group of questions.

Note: A validation process checks for unrated questions and shows a list of
required questions that have not been rated and which require a response
rating. Panelists can click on a question link to navigate directly to the question
for the express purpose of completing the missing assessment. Once such a
question has received the panelist's response rating, it is removed from the list.

6. Click Save to save your responses.

7. To return to the event, select Back to Event.

8. When finished providing scores for all supplier responses, a confirmation shows that All
Suppliers have been rated, and you may submit the panel questionnaire or continue
editing. Select Submit.

9. You may select toWithdraw your panel questionnaire response if you would like to make
changes prior to the questionnaire close date.

Export / Import My Questionnaire
A panelist can complete questionnaire responses in the UI, or they may choose to export the
questionnaire for completion offline. The panelist can then import the completed questionnaire
into the application.

Export the Questionnaire
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1. Navigate to an event for which you are designated as a Panelist:

a. Respond via the link in an email you received as a Panelist for an event.

b. Search for an Event using Advanced Search, with the criteria being your role as a
Panelist in the Panel Questionnaire section of Advanced Search. Select the
appropriate event.

2. Select theMy Response page from the Panel Questionnaire section of event navigation.

3. Select to Export Questionnaire from any of the following locations:

a. FromMy Response page, select Export or Import, then Export Questionnaire.

b. FromMy Response page, select View Questionnaire to view the questionnaire in
the UI. You may select the Export Questionnaire button on that page.

c. FromMy Response page, select a specific supplier and click Go to Supplier on
Questionnaire. Click Export Questionnaire on the page.

4. An overlay displays for Export Questionnaire.

a. A default Description is provided. Edit the description of the file, if needed.

b. Click Submit.

c. A confirmation message displays indicating the export request has been submitted.
You may select the message hyperlink to navigate to the Panel Imports and
Exports page, or select to close the overlay.

5. On the Panel Imports and Exports page, note the status of your requested file.

a. Select the button to Refresh this Page until the status for your export request
shows as Completed.

b. Click the File name to open the file in Excel.

Editing the Questionnaire File

6. Click the Enable Editing button in Excel to allow editing of the file.

7. Note the instructions for completion on the first worksheet of the file.

8. If the questionnaire is configured to show a single supplier response per page, you will see
each supplier listed on a separate tab. If the questionnaire is configured to show all
suppliers at once, you will see a tab with your panelist name that contains all suppliers for
the questionnaire.

9. Select the appropriate supplier or the panelist name to begin completing the questionnaire
responses.
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10. Select a rating from the dropdown for each required question/group. You must complete
questions/groups according to your group assignment. If a panelist is not assigned to a
group, then the questions within a single group must be completed.

11. When finished entering responses, save the file.

Import the Questionnaire Responses

12. Navigate to the event, and theMy Response page from the Panel Questionnaire section.

13. Select the Export or Import button, then Import Questionnaire Responses.

a. Select Browse / Choose File, and select the file to import.

b. A default File Description is provided. Edit if appropriate.

c. Select if you would like to Submit questionnaire response when import
completes?

Note: If you select Yes but not all required elements of the questionnaire are in
the file, the responses are imported but the file is not submitted. The panelist
will receive an email indicating the questionnaire could not be submitted.

A validation process checks for unrated questions, allowing the system to show
a list of any required questions that have not been rated and which require a
response rating. On the View Questionnaire or Go to Supplier on
Questionnaire page, panelists can click on a question link to navigate directly
to the question and complete the missing assessment. Once such a question
has received the panelist's response rating, it is removed from the list.

d. Click Submit.

e. A confirmation message displays indicating the import request has been submitted.
You may select the message hyperlink to navigate to the Panel Imports and
Exports page or select to close the overlay.

14. On the Panel Imports and Exports page, note the status of your imported file. Select the
button to Refresh this Page until the status for your import request shows as Completed.

Export / Import A Questionnaire on a Panelist's Behalf
A panel questionnaire administrator can export and import questionnaire responses on behalf of
another panelist. This may be helpful if the panelist is unable to access the application. A panel
administrator can export the file on their behalf and email the file to the panelist. The panelist
returns an edited file to the administrator and the administrator import the panelist responses on
their behalf.
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Export the Questionnaire

1. Navigate to an event for which you are a panel questionnaire administrator.

2. Select the Panelists page from the Panel Questionnaire section.

3. Select Export or Import, then Export Questionnaire for Panelist.

4. An overlay displays for Export Questionnaire for Panelist.

a. A default File Description is provided. Edit the description of the file, if needed.

b. Choose the Panelist for whom you want to export their questionnaire. You may sort
panelists by name or by progress.

c. Click Submit.

d. A confirmation message confirms that the export request has been submitted. You
may select the message hyperlink to navigate to the Panel Imports and Exports
page or select to close the overlay.

5. On the Panel Imports and Exports page, note the status of your requested file.

a. Note that the requested file will have the panel questionnaire administrator as the
Requested By column, and the panelist selected in the Requested For column.

b. Select the button to Refresh this Page until the status for the export request shows
as Completed.

c. Click the File name to open the file in Excel.

Editing the Questionnaire File

6. Send the file to the panelist for editing or enter the responses as appropriate for the
panelist.

7. When you receive the completed file back from the panelist, save it for importing. If you
have completed the panelist responses, save the file.
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Import the Questionnaire Responses

8. Navigate to the event and select the Panelists page from the Panel Questionnaire
section.

9. Select the Export or Import button, then Import Questionnaire Responses for Panelist.

a. Select Browse / Choose File and select the file to import.

b. A default File Description is provided. Edit if appropriate.

c. Choose the Panelist for whom you want to import their questionnaire responses.
You may sort panelists by name or by progress.

d. Click Submit.

e. A message displays indicating that all current questionnaire responses for the
selected panelist will be replaced with the import file information. Select to confirm.

f. A confirmation message confirms that the import request has been submitted. You
may select the message hyperlink to navigate to the Panel Imports and Exports
page or select to close the overlay.

g. If the imported file contains all of the required information for the questionnaire, it is
automatically submitted.

10. On the Panel Imports and Exports page, note the status of your imported file. Select the
button to Refresh this Page until the status for your import request shows as Completed.

View Panel Questionnaire Responses
An evaluator may review panelist responses at the point the panelists begin entering those
responses. Once the panel questionnaire closes, the evaluator can view average score
information as well as the individual panelist's responses.

Additionally, the Panel Questionnaire Details tab provides a detailed view of panel questionnaire
ratings and results. The tab is only exposed after the panel questionnaire questions have closed
and associated values are calculated. Clicking the Export button also provides access to an Excel
spreadsheet export of the questionnaire results to allow further analysis of the data outside of the
system.
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1. Navigate to an event that is Under Evaluation and for which the Questionnaire Close
Date has passed.

2. Select the Panelists page from the Panel Questionnaire section of event navigation.

a. Select the button to View Panelist Response for each panelist response you want
to review.

b. Scroll through the panelist score and comments for each question. Use the
pagination within the questionnaire pages to see all suppliers and questions rated.
Expand and collapse questions, pages and groups as needed.

c. Select Back to Event to return to the Panelists page and select another panelist
response to review.

3. Select the Suppliers page from the Panel Questionnaire section of event navigation. Note
the Average Rating from Submitted Panelists.

4. Select the Supplier Responses page of the Evaluation section of event navigation.

Extend or Re-open a Questionnaire
Event managers can re-open a panel questionnaire and extend the close date to ensure all
possible input is captured.

1. Open the sourcing event with the closed panel questionnaire.

2. Select Panel Questionnaire > Setup in the left menu.

3. Expand the Event Actionsmenu and select Reopen Questionnaire.

4. Enter a new close date and time in theQuestionnaire Close Date field.

5. Click Save.

The revised date is displayed in theQuestionnaire Close Date field on the panel questionnaire's
Setup page and notification is sent to users who have opted into the A Panel Questionnaire has
been published notification.
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Sourcing Event Advanced Search - Panel Questionnaire
The Sourcing Event Advanced Search option includes a section for Panel Questionnaire criteria.
Users may search for sourcing events based on Questionnaire status, the logged-in user's role as
a panelist or not, and for questionnaires they have started or submitted.

Internal Notes
In the Tools section of an event, a user may enter the Internal Notes area of the event to
facilitate and archive discussion threads between buyer users. Discussions and attachments
entered into this area are not shared with the suppliers. Users such as stakeholders who normally
have view-only access to an event can participate fully in the event discussion threads. Because
the Internal Notes page serves as a historical record of the event, users cannot delete discussion
threads in this area.

Add a Discussion Thread to an Event
1. Navigate to Tools > Internal Noteswithin a Sourcing event.
2. Click Add Note or Attachment to initiate a new discussion thread:

3. Enter a Subject for the thread, enter the message text in the Note box, and, if relevant,
select attachments.
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4. Expand the Send Notification To drop-down to select the message recipients. Users who
are associated with the event, such as stake holders or members of the affiliated work
group, appear in the selection list:

5. Click Save Changes to send the message and close the screen overlay.

Accessing Internal Communications
A notification appears in the top toolbar when users receive an internal communication. When the
notification is expanded, users can:

l Click a link to open a page containing all of their notifications.
l Click the notification text to be redirected directly to the related Sourcing event
internal note.
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Message recipients are also notified via email when new communications have been posted. A
link within the email alert navigates users to the discussion thread

Users can also navigate directly to the Tools > Internal Notes page within a Sourcing event to
access all discussion threads in which they are participants.

Responding Via the User Interface
1. Click Reply to open a screen overlay on which a response or attachment can be entered.

The Reply button is available for each collapsed discussion thread and also at the top of
each expanded message:
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2. A screen overlay appears with options to add text in the Note field and to upload
documents in the Attachment field. All recipients of the initial message are selected by
default for the response. The recipient list can be edited by removing names or searching
and selecting new names.:

3. Click Save Changes to send the message and close the screen overlay.

Managing and Archiving Internal Discussion Threads
Edit buttons are accessible to buyers to enable them to edit their messages within an event.
However, because the Internal Notes page serves as a historical record of the event, users
cannot delete discussion threads in this area.

The Internal Note's page communication content is integrated into the buyers' event PDF export
file to ensure that the content is accessible for review.
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Exports and Imports
Customers can perform several different types of exports and imports within a sourcing event.
The results of the export and import requests are stored on the Exports and Imports page,
available under the Tools section for the event.

A message on the page indicates how long files will be stored on the page before they are
deleted. This setting is managed in the General Sourcing Settings. See "General Sourcing
Settings" on page 315 for additional information. You may also choose to delete a file by selecting
the Delete hyperlink.

Types of Files
Access files on this page via the various imports and exports requested in the Sourcing Event,
such as:

l Validate or import a file for manually inviting suppliers

l Request an export of questions, or an export of items

l Request to validate/import questions, or validate/import items

There are several Notification preferences related to exports and imports. A user can select to be
notified with the request has processed. See "Notifications" on page 20 for more information.

For information about exporting an event as a PDF file, see "Export Event Information" on
page 263.

Note that imports and exports related to the panel questionnaire are on the Panel Imports and
Exports page in the "Panel Questionnaires for Events" on page 152 section of the event.

Q&A Board
Each event has a Question & Answer (Q&A) Board available to enhance communication between
buyers and suppliers. Access the Q&A Board by selecting the Tools link on an event and selecting
theQ&A Board. In the Q&A Board:
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l Customers can...

l Monitor, review, select, and answer questions submitted by suppliers.

l Respond publicly to all suppliers or privately to specific suppliers.

l Submit questions directly to a supplier, or group of suppliers.

l Define the allowable time frame for event question submissions.

l Add an attachment to a Q & A entry to supplement information provided during the
exchange.

l Suppliers can...

l Submit questions to customers.

l Review responses to questions that they have submitted, and review Q&A entries
that have been made public to all suppliers.

l Ask follow-up questions to customer responses.

l Respond to customer submitted questions.

l Add an attachment to a Q & A entry to supplement information provided during the
exchange.

Questions can be posted by suppliers until the configured Q&A Submission Close Date of the
event. The customer's Q&A Board is organized into four tabs:

1. Unanswered Questions - Contains event questions that have not been answered by the
customer. The customer can select Answer Question, Decline to Answer, or Post a
Question Like This.

2. Public Q&A - Contains event questions/answers that have been made public by the
customer. A customer can see who provided the answer to the question, edit the answer,
make the Q&A private, add or remove an attachment, or post a similar question. All
suppliers who have access to the event can see questions, answers and attachments that
have been made public. Questions, answers, and attachments that are not made public are
only seen by the supplier who submitted the question. Customers responding publicly to a
supplier question with an attachment have the option to both edit the content of the
question (to generalize the verbiage) and remove the supplier attachment before posting
publicly.

3. Questions from Suppliers - Lists event questions sent from suppliers.

4. Questions sent to Suppliers - Lists event questions sent to suppliers from the buyer.
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Access the Q & A Board on an Event
By default, administrators of an event (Event Managers, Creators and Owners) have full access to
the Q&A Board and the ability to respond to supplier-submitted questions. Other users with
access to the Event (Stakeholders) must have theManage Q&A Board permission in order to
respond to questions.

Suppliers and buyers can add an attachment to Q&A entries to supplement the information
provided during the exchange. There is a maximum of one attachment per question or answer.

Anyone who can view a question or answer on the Q&A Board can also view, upload, or download
its attachment. When a buyer responds publicly to a supplier question that has an attachment, the
buyer has the option to remove the supplier attachment before posting publicly.

Questions can be submitted until the configuredQ&A Submission Close Date for the event.

1. Search for an event and select an event you own or manage.

2. Expand the Tools section in the left menu.

3. Select theQ & A Board link.

Customers can search for questions from specific suppliers. They can sort Q&A entries by the
date the question or answer was submitted, or the number of follow up questions. The ability to
submit a new question is available to all invited suppliers until the designatedQ&A Submission
Close Date indicated for the event. Suppliers can, however, continue to respond to customer
submitted questions beyond the designatedQ&A Submission Close Date.

A customer may choose to enable the notification for Supplier has submitted an Event-related
question to be alerted when a supplier submits a question. See "Notifications" on page 20 for
details.

View Questions and Responses
Questions are sorted into Unanswered Questions, Public Q&A, Questions from Suppliers, and
Questions sent to Suppliers tabs. Select the appropriate tab to view the questions listed under
it.

You can use standard JAGGAER search, filter, and sort functionality on the supplier selection
page on any of the tabs in the Q&A Board:
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a. Bid submission progress filter

Note: Progress is an indication if the supplier has viewed the event, declared an intent
to bid, is in the process of responding or has submitted a response. You may select to
sort responses on this field.

b. Supplier name search bar

c. Sortable Supplier Name column

d. Sortable Progress column

e. Single checkbox selection for the entire filtered supplier list

On any tab, you can select to sort by the various options in the drop-down list.

Respond to a Question
On the Unanswered Questions tab, unanswered questions are highlighted with the message No
answer yet. The question, supplier, supplier user, date and time of the question is noted.

1. Click Answer Question. The Answer overlay opens.

2. Enter the Answer to the question, up to 5000 characters.

3. (optional) Upload a file in the Attachment field. A link to the file will be displayed next to
the answer on the Q&A Board.
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4. In the Post to Public Q&A field, select Yes (public response) if you want all suppliers with
access to the event to see the supplier's question, along with your answer and its
attachment. Select No (private response) if you want only the supplier who asked the
question to see your answer and its attachment.

5. If Yes is selected in the Post to Public Q&A field, complete the Delete Supplier's
Attachment? field. Select Yes to remove the attachment submitted by the supplier. Only
the supplier's question, along with your answer and its attachment will be displayed to the
public. Select No to publish the attachment submitted by the suppler. The supplier's
question and attachment, along with your answer and its attachment, will be displayed to
the public.

Note: This is a one-time option. Once Post Answer is clicked, the supplier
attachment is either removed or published, but cannot be changed. The question and
answer thread can be made private.

6. Click the Post Answer button. The answer time, date, and user who submitted the answer
is noted.

Decline to Answer
1. Click the drop-down arrow next to Answer Question and select Decline to Answer.

2. A confirmation message asks if you are sure. Click Confirm.

3. The response is sent as a private response to the supplier who asked the question, with a
messageWe decline to provide an answer to this question. The response may be
edited later.

Take Action on a Response
1. Navigate to the appropriate question/response.

2. Click the Actions dropdown button, and select from the following options:

a. Select to Edit this Q&A Entry to update the response.

b. For a public response, select toMake this Q&A Public. For a private response,
select toMake this Q&A Private.

c. Select to Post a Question Like This to post a similar question and provide an
answer.
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Post a Question/Answer
1. Click the Submit Question dropdown and select Post a Question. A Post a Question

overlay displays.

2. Enter a Subject for the question.

3. Enter theQuestion text, up to 5000 characters.

4. Optionally, select the Supplier Response Disabled checkbox. When this checkbox is
selected, the Ask a Follow-Up Question button is hidden on the supplier interface.

5. Enter the Answer text, up to 5000 characters.

6. (optional) Upload a file in the Attachment field. A link to the file will be displayed next to
the answer on the Q&A Board.

7. Click the Post Question button.

8. The question and answer will show in the Public Q&A tab and is visible to all suppliers with
access to the event.

9. After the question/answer is posted, you may select from the Actions button on the
question to choose to edit the entry, make it private, or post a similar question.

Ask a Question
Buyers can submit questions directly to event-participating suppliers using the Q&A Board.

1. Click the Edit button on the Send To field to change the recipient from all suppliers in the
event, to only selected suppliers.

2. Click the Submit Question dropdown and select Ask a Question. The Ask a Question
overlay displays.

3. Enter a Subject for the question.

4. Enter theQuestion text, up to 5000 characters.

5. (optional) Upload a file in the Attachment field. A link to the file will be displayed next to
the answer on the Q&A Board.

6. Click the Submit Question button.

7. After the question is posted, you may select from the Actions button on the question to
choose to edit the entry, make it private, or post a similar question.
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Approvals

Types of Approvals
Events will go through two types of approvals:

l Event Approval: The event will be approved by someone in your organization so that it can
be released to suppliers.

l Evaluation Approval: Once suppliers have submitted responses and the close date has
passed, the event will enter Evaluation workflow in order to award a supplier the business
for the event.

Users can access the current or future approvals process for an event or evaluation by selecting
the Tools link in an event and selecting the Approvals page. A user must have permission to view
the event.

When selecting the Approvals page, the user can see the process flow for the event and
evaluation.

Award Notifications
Customers can configure the option to send award notifications to suppliers after an event has
been awarded. When enabled, an Award Notifications page shows in the Tools section of the
event's navigation. The customer can view the email by clicking Preview Email, and then select
to send the default system notification, customize the email before sending, or select another
template from the organization's Sourcing Email Templates.
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Additionally, an Award Comment is available for public events by default. If configured and
published, this message will display in the PDF available to suppliers when accessing a public
event.

Note: If no notifications are selected in the General Sourcing Settings, the Award
Notifications section will not show for events. For information about configuring new
sourcing email templates, see Sourcing Email Templates in "Templates" on page 297.

The actions available for Award Notifications depend on the status of the event:

Event has not yet been awarded:

l If an event has not yet been awarded, the Award Notifications page will display the
enabled notifications, with a link to Select New Template. A user may select a different
template from the organization's Sourcing Email Templates for the award notification, but
they cannot customize the Default template email or send it to any suppliers.

l When choosing to Select New Template, an overlay displays the current template, with an
option to select a different template. At this status, the actual text of the email may not be
edited. However, if the underlying template should be edited, the user may navigate to
System Emails for the default template, or to Sourcing Email Templates for organization
sourcing templates.
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Event has been awarded:

l Once the event is in Awarded status, a user can choose to Select New Template to simply
select a different template for the email or choose to Preview and Send the email to make
additional changes.
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l When Preview and Send is selected, an overlay will display for the selected template,
allowing the user to:

l Change the template to another organization configured sourcing email template or
the system Default for the type of notification

l Modify the subject line

l Add attachments

l Edit the text of the email

l Note that any changes to the email text, subject and attachments from this page do not
change the underlying template. The changes are effective for the specific award
notification only. Changes to templates are done through managing the Sourcing Email
Templates or Default System Emails.

Sending the Award Notification
1. Navigate to an event.

2. Navigate to the Award Notifications page in the Tools section of the event navigation.

3. If the event has not yet been awarded:

a. You may choose to Select New Template and select a different template from the
organization's Sourcing Email Templates.

b. If the event is a Public Event, you may edit the Award Comment to be published
within the public site Event PDF.
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4. If the event is in Awarded status

a. You may choose to Select New Template to select a different template for the
email.

b. To send an email, choose Preview and Send the email to make additional changes.
An overlay shows the current selected template. You may:

i. Change the template to another organization configured sourcing email
template or the system Default for the type of notification.

ii. Modify the subject line.

iii. Add attachments.

iv. Edit the text of the email.

c. Note that any changes to the email text, subject and attachments from this page do
not change the underlying template. The changes are effective for the specific
award notification only. Changes to templates are done through managing the
Sourcing Email Templates or Default System Emails.

5. When the appropriate template has been selected and all edits made, select to Send
Email. The status for the notification is updated.

6. Options are available to View Email Message and View Recipients for the notifications.

Note: An audit log of emails and recipients is available by selecting the History
hyperlink for the event, and select the Email History tab.
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Publish Attachments with Award Notifications to the Public
Site
Attachments can be published with notifications to the public site. With this feature, buyers can
publish intent to bid documents prior to awarding an event, and depending on site configuration,
publish any required award notice attachments when the event is under evaluation or after the
award has occurred.

Events must be public, closed, and in the Under Evaluation status in order for attachments to be
uploaded and published.

l To upload attachments, navigate to Tools > Award Notifications on a public event in
Under Evaluation status.

l  Click the Add Attachment button under the Public Site Award Attachments heading:
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l The Add Attachment pop-up will open. Choose File or Link as the attachment type.

l File attachment - Drag and drop the files you would like to add as attachments to
the Files field, or click the Select files button and select the attachments to be
uploaded. Click Save Changes.

l Link attachment - Add a URL, and optionally name and description for your link. If at
least one attachment has already been added, you will need to select the Display
Order for the attachment. Click Save Changes.

l Click the dropdown beside an attachment and click Publish to publish it to the public site.

Sourcing Reports

Supplier Award Summary
In addition to exporting event search results into a Summary or Supplier Participation report

format, you can also view a Supplier Award Summary via the Sourcing > Reportsmenu.
Information is displayed for each supplier, indicating the number of bids the supplier has
submitted, events awarded and amount awarded.

1. Navigate to Sourcing > Reports > Supplier Award Summary.

2. Select a date range for the report from the drop down Awarded Within field.

3. To filter by Supplier, enter a supplier name to see potential matches, or select the list icon

to search for suppliers. You may select multiple suppliers for the report.

l The supplier search returns both organizational suppliers as well as manually invited
suppliers who did not respond to the event. An Invitation Type radio button allows
you to toggle between searching for Registered Suppliers andManually Invited
Suppliers.

l Up to 20 organizational suppliers plus manually invited suppliers are presented in the
search results for this field.

4. To filter byWork Group, begin entering a work group name, or select the list icon to
select from or search the work group tree. The work group tree displays both the work
groups where you have work group level permission as well as those you have been
granted explicitly through sourcing event access. If you have access to a child work group
but not a parent, you will see the parent level is not selectable, but can be expanded in
order to select child work groups to which you have access.
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5. To filter by Diverse Supplier, begin by entering a specific diversity classification, or click

the list icon to view and select from the list of federal, state, and other diversity
classifications as available.

6. To filter by Supplier Class, select an option from the drop-down list. Otherwise, leave the
field empty (default).

7. Click Run Report.

8. Results display by supplier, sorted by number of bids submitted. Only results for events
you have access to will be returned. If you would like to see the details for a particular
supplier/row, select the hyperlink for Total Events.

9. To return to the Supplier Award Summary, click Back to Supplier Award Summary
Report.

10. To export the results into an Excel file, select the Export hyperlink on the Supplier Award
Summary page.

a. When prompted, enter a File Name for the export request.

b. If desired, edit the Description for the file.

c. Click Submit.

d. A confirmation message displays, with a link to navigate to the file for download.

11. Navigate to the Sourcing > Sourcing Events > View Exports > Reports tab.

a. For your requested export, note the status. If the status is Not Completed, select the
Refresh This Page hyperlink.

b. Once the status is Completed, select the File Name to save the file or open in Excel.

c. The Filter tab of the file displays any criteria provided for the report.

d. The Report tab of the file displays the data from the Supplier Award Summary
Report.

Note: Suppliers that are award recipients of a Sourcing event can access a Your Award
Summary page containing details of the items, quantities, and prices that have been
awarded to them in a sourcing event. The Your Award Summary page link appears beneath
theMy Exports and Imports link in the left navigation bar within the Sourcing event. Data
from the Your Award Summary page is not included in the supplier event pdf export file.
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If the control setting called Show Supplier's Award Summary Page in the Bid Settings
section of the General Sourcing Settings page is set to No, the Your Award Summary page
is hidden from suppliers within the supplier user interface of each event after the event is
awarded.

Cost Savings Summary Reports
Customers use the concept of cost savings or cost avoidance to show that they were able to
reduce the amount they would have paid without the event.

The Cost Savings Summary report shows a graph and displays a summary of events’ cost
savings/avoidance on required items. Cost savings and cost avoidance calculations are based on
target/benchmark price, historical price, or average bid price. Users have the ability to view report
information by various criteria, including dates, work group, event types, commodity codes,
buyer, and more. If you have the Auctionsmodule, information related to auction events will also
display. For Reverse auctions, cost savings/avoidance are determined by First Bid minus Last Bid,
Reserve Price and Historical Price.

You can select an event from the Cost Savings Summary report and drill down to the Cost
Savings Detail report. This provides additional details specifically related to the event, such as
the average, target, and historical bid amounts for each item.

Note: Users must have the View Sourcing Cost Savings Report permission to access
these reports.

Cost Savings Summary Report

1. Navigate to Sourcing > Reports > Cost Savings Summary.

2. Select a date range for the report from the drop down Awarded Within field.

3. If additional options are hidden, select the Show Options link.

4. To filter byWork Groups, begin entering a work group name, or select the list icon to
select from or search the work group tree.

5. To filter by Sourcing Event Type, begin entering an event type name, or select the list icon
to select from or search the event type tree. If this field is left blank, the report will return all
event types.

6. To filter by Reporting Commodity Codes, begin entering a commodity code, or select the
list icon to select from or search the commodity code tree.
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7. To filter by Sourcing Event Creator, begin entering an event creator name, user name, or
email, or select the list icon to select from or search all event creators.

8. Under Show Columns, select or deselect the following columns for display on the report,
these are sortable when the report is run:

l Sourcing Event Type

l work group Code

l work group Name

l Sourcing Event Creator

l Reporting Commodity Code

l Awarded Amount

l Average Bid

l Target

l Historical

l First - Last Bid

l Reserve

l Award Date

l Estimated Value

l Award Recipient

9. Click Run Report.

10. A graph shows the average bid and awarded amount cost savings and a detailed report
displays below.

11. In the Details section, note the information in columns you have selected to include.

a. Sort the information by any of the included columns.

b. Select the Sourcing Event Number to view Cost Savings Detail for the event.
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12. To export the Cost Savings Summary results into an Excel file, select the Export hyperlink
on the Supplier Award Summary page.

a. When prompted, enter a File Name for the export request.

b. If desired, edit the Description for the file.

c. Click Submit.

d. A confirmation message displays, with a link to navigate to the file for download.

13. Navigate to the Sourcing > Sourcing Events > View Exports > Reports tab.

a. For your requested export, note the status. If it is Not Completed, select the Refresh
This Page hyperlink.

b. Once the status is Completed, select the File Name to save the file.
Alternatively,open it in Excel.

c. The Filter tab of the file displays any criteria provided for the report.

d. The Report tab of the file displays the data from the Supplier Award Summary
Report.

Cost Savings Detail Report

1. Click the event number of an event appearing on the Cost Savings Summary report to
view the Cost Savings Detail report for that event.

2. The report displays the items in the event, as well as the quantity, supplier, awarded
amount, average bid, target price, and historical price for those items. Click the heading of
any column to sort by that column.

3. Click each item name to view the awarded unit price, average bid, target price, and
historical price for that item.

4. Click the supplier name for each item to view detailed information for that supplier.

5. To export the Cost Savings Detail results into an Excel file, select the Export hyperlink on
the Cost Savings Details page.

a. When prompted, enter a File Name for the export request.

b. If desired, edit the Description for the file.

c. Click Submit.

d. A confirmation message displays, with a link to navigate to the file for download.
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6. Navigate to the Sourcing > Sourcing Events > View Exports > Reports tab.

a. For your requested export, note the status. If it is not completed, select the Refresh
This Page hyperlink.

b. Once the Status is Completed, select the File Name to save the file. Alternatively,
open it in Excel.

c. The Filter tab of the file displays any criteria provided for the report.

d. The Report tab of the file displays the data from the Supplier Award Summary
Report.

Cycle Time Summary Report
This report allows buyers to judge the efficiency of their sourcing processes by measuring how
quickly events get created and awarded. From the report, a user is able to review information on
how long their events are in various statuses, including draft, pending, and under evaluation.
Report viewers are able to filter on the final status of events and event completion dates within a
set range.

A Reports sub-menu is available by navigating to Sourcing > Reports > Cycle Time
Summary. Users must have the View Sourcing Operational Reports permission to access this
report.

The Cycle Time Summary report runs automatically when you visit the Cycle Time Summary page
for sourcing event completion dates within the fiscal year-to-date. Graphs displaying the
Complete Cycle Time By Final Status, Average Cycle Time By Status, Cycle Time By Status,
and Pending Statuswill display in the Graphs section and detailed Cycle Time By Status and
Cycle Time By Final Status information is displayed in the Details section.

1. Navigate to Sourcing > Reports > Cycle Time Summary.

2. Select a date range for the report from the drop down Sourcing Event Completion Date
field.

3. If additional options are hidden, click the Show Options hyperlink.

4. To filter byWork Groups, begin entering a work group name, or select the list icon to
select from or search the work group tree.

5. To filter by Sourcing Event Type, begin entering an event type name, or select the list icon
to select from or search the event type tree. If this field is left blank, the report will return all
event types.
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6. From theMultistage Sourcing Events dropdown, choose to include, exclude, or only
report on multistage sourcing events.

7. Use the Sourcing Event Final Status to filter by a particular event final status, or do not
select any to include all of them.

8. To filter by Reporting Commodity Codes, begin entering a commodity code, or select the
list icon to select from or search the commodity code tree.

9. To filter by Event Creator, begin entering an event creator name, user name, or email, or
select the list icon to select from or search all event creators.

10. Click Run Report.

11. Graphs displaying the Complete Cycle Time By Final Status, Average Cycle Time By
Status, Cycle Time By Status, and Pending Statuswill appear in the Graphs section.

12. Select and deselect status labels in the legend of each graph to see different results.

13. Detailed Cycle Time By Status and Cycle Time By Final Status reports will appear below
the graphs.

l The Cycle Time By Status report displays a list of time ranges counted in days and
the number of events falling in each time range for each status. The report has
columns for draft, pending, approved, released, open, and under evaluation
statuses. Each number can be clicked to view the sourcing event numbers and
names.

l The Cycle Time By Final Status report displays a list of complete cycle time ranges
counted in days and the number of events falling in each time range for each status.
The report has columns for awarded, closed without awarding, canceled, withdrawn,
and rejected statuses. Each number can be clicked to view the sourcing event
numbers and names.

Benchmarking via SmartProcure
JAGGAER has partnered with SmartProcure to give customers access to benchmarking data. An
add-on license is available that will allow users with the appropriate permission to access the
SmartProcure website to view Benchmarking data.

A user must have the View Benchmarking via SmartProcure permission to access the
SmartProcure site. The permission is available in the Administration > System
Administration section of the user profile and user roles. When the permission is enabled, a

hyperlink is available on the Sourcing Events Home in theQuick Links
Section. Upon selecting the link, users are navigated to the SmartProcure website.
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Evaluate an Event

Evaluations Overview
From the Supplier Responses page, you will select specific or all suppliers to be included in an
evaluation. You are then navigated to a summary page of all the selected responses, also referred
to as the Side by Side Evaluations page.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

Hide Event Prices
If necessary, Event Owners and Evaluators can toggle the hiding and showing of prices from the
Event Actions dropdown menu on events.

When event prices are hidden, they are hidden for all users, and users see the words Event
Prices Hidden in place of prices.

1. Navigate to an event in any status.

2. When viewing an event, select Event Actions, then Hide Event Prices.

3. To show event prices again, select Event Actions, then Show Event Prices.

Evaluation Options
When evaluating supplier responses, customers have the ability to:

l View responses side-by-side.

l Sort responses by various criteria.

l If an event is multi-stage, choose the evaluation options to use for different event stages.

l Choose alternate items, if configured, to evaluate as part of the response.
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l If configured for the event, use cost per quality point score, best value score, panel
questionnaires, auto scoring and cost analysis as tools for evaluating responses.

l If configured for event line items, the calculated line item, auto-score, and cost analysis
results are displayed, and users can view a breakdown of auto-score and cost analysis
calculations. They also have the ability to disallow an applied cost adjustment.

l Load and run different award scenarios.

l Add comments to the supplier responses.

l Rank responses.

l Disqualify suppliers.

l Export evaluation information to an Excel file for more complex analysis.

Evaluation Workflow
After an event has closed, it moves into Evaluation workflow, and the status of the event is Under
Evaluation. The customer will then evaluate the supplier responses to the event to see which one
best fits their needs. Typically, a customer will be evaluating the best price along with other
factors important for the event. A user must have certain permissions to perform different
workflow approval actions. See "Sourcing Permissions" on page 21 for details.

When a user has selected the Finalize Award scenario for a particular event, that information is
passed along to approvers reviewing the evaluation in Evaluation Workflow. Evaluation approvers
will review evaluations to ensure the award was made to the appropriate supplier response.

Once an event is in a state of Under Evaluation, any user with access to take action on supplier
responses will see an option to Approve or Assign to Myself. Once the Evaluation is assigned to
you, you have different options depending on your user permissions and the state of the event.

l Approve - This approves the event with the designated awarded supplier.

l Close Without Awarding - This closes the event without awarding it to any supplier.

l Forward to - Select another approver to forward the evaluation to for review.

l Put on Hold - This keeps the evaluation assigned to the current user and cannot be
modified by any other approver.

l Return to Shared Folder - This returns the evaluation to the appropriate shared folder
where another user can assign it or take action. It will no longer show in your My Approvals
folder.
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l Return to evaluator - For organizations with this feature configured, this option will return
the recommended award scenario to the evaluator. The finalized status of the original
recommended scenario is removed, but all previously created award scenarios are
retained. The evaluator can then re-evaluate the scenario and submit a different award
scenario recommendation for approval. The action cannot be performed if contracts have
been created from the previously submitted award scenario.

l Reopen- This reopens the event so that suppliers can respond.

An event remains Under Evaluation until it completes workflow by an approver selecting to
approve a finalized award, to close without awarding or reopening the event.

The last step in evaluation workflow must be the automated step to perform the awarding to the
selected supplier. Without the automated step, the event will not be awarded.

Finalized Award Pending Workflow Approval

An Event Under Evaluation showing Approval Actions available
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A User's My Approvals page showing Pending Evaluations

Awarding a Quick Quote Event

When a Quick Quote event with a default award scenario closes, the supplier(s) that meet the
award criteria are automatically given Pending Award status. You can take the following actions:

1. The defaulted award strategy can be manually approved and moved forward in the
Evaluation workflow (Workflow Actions > Approve).

2. You can cancel the defaulted award strategy in favor of a completely different award
strategy if necessary (Evaluation Actions > Evaluate All Responses >Remove Finalized
Award).

3. If event administrators are confident that the default award scenarios will consistently
work for their Quick Quote events, then their Evaluation workflow can be constructed to
allow an automatic flow-through of an event, after its closure, into an awarded state.

Auto Score Values for Events and Event Line
Items
The Auto Score option may be enabled at the work group and event level, allowing customers to
assign an 'automatic score' to different supplier responses to event questions and event line
items, and use when evaluating supplier responses.
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If auto scoring is enabled, auto score values are initially assigned to questions in the Questions
section of event Setup, and to additional item fields in the Additional Item Field section. Questions
and additional item fields with auto score enabled are displayed in the Auto Score sub-section of
the Evaluations section (see below).

Configure Auto Score Values for Event Questions
1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which

questions exist.

2. Select theQuestions page in the Settings and Content section of event navigation.

3. Click Edit next to the question you want to change. Note that Auto Score may only be
configured for questions with specific response types.

4. In the Edit Question overlay, select the Use Response in Auto Score checkbox.

5. Depending on the response type for the question, you may now configure a numeric range,
date range, or the specific options for suppliers to choose from and assign a score to each
of those values. For example,

a. For a numeric value, you may provide a score for "0 - 10", and a score for "11-20",
etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a score.

c. For a date field, you may provide a range of dates with one score, and a different
range of dates with another score.

d. As you add each score, select the green checkmark to add the configuration to the
question.

6. When finished adding the auto score values, click Save Changes.

Configure Auto Scores for Event Line Items (Additional Item
Fields)

1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which
additional item fields exist.

2. Select the Additional Item Fields page in the Settings and Content section of event
navigation.

3. Click Edit next to the additional item field you want to change. Note that Auto Score may
only be configured for additional item fields with specific response types.
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4. In the Edit Additional Field overlay, select the Use Response in Auto Score checkbox.

5. Depending on the response type for the additional item field question, you may now
configure a numeric range, date range, or the specific options for suppliers to choose from
and assign a score to each of those values. For example,

a. For a numeric value, you may provide a score for "0 - 10", and a score for "11-20",
etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a score.

c. For a date field, you may provide a range of dates with one score, and a different
range of dates with another score.

d. As you add each score, select the green checkmark to add the configuration to the
additional item field.

6. When finished adding the auto score values, click Save Changes.

Edit Assigned Auto Score Values
Note: Changes can't be made to locked items that have been added to an event from locked or
protected templates.

1. Navigate to an event that has Auto Score enabled on the Event Setup, and for which the
auto score option is enabled for event questions or event line items.

2. Select the Auto Score page in the Evaluations section of event navigation.

3. Expand the Event-Level Questions heading to view event questions with auto score
enabled. Expand the Line-Level Questions heading to view additional item fields with
auto score enabled.

4. Select Edit Question Details under the question or additional item field you want to
change.

5. Depending on the response type for the question, you may now configure a numeric range,
date range, or the specific options for suppliers to choose from and assign a score to each
of those values. For example,

a. For a numeric value, you may provide a score for "0 - 10", and a score for "11 - 20",
etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a score.

c. For a date field, you may provide a range of dates with one score, and a different
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range of dates with another score.

d. As you add each score, select the green checkmark to add the configuration to the
question.

6. When finished adding the auto score values, click Save Changes.

If changes do affect supplier responses (such as a change to the questions), the supplier
responses for the items affected are discarded. If the changes do not affect existing supplier
responses (such as a change to the response scoring), then previously submitted supplier
responses are not discarded.

Evaluating Auto Score Responses
Administrators can view and edit auto-score values for both event-level questions and line-level
questions. The two types of questions are grouped under the following headings:

l Expand the Event-Level Questions heading to see a list of event questions that have
been added to the Questions page of the event.

l Expand the Line-Level Questions heading to see a list of event line item questions that
have been added via Additional Item Fields on the event. These are grouped into Product
and Services categories.

You can expand a question to view or change auto-score assignments, or view a summary of
responses to the question:

l An Edit Question Details button is displayed when events are in Draft status, allowing
users with the appropriate permission to change auto-score or cost analysis assignments.
The changes are saved to the original event question or additional item field.

l A View Question Details button is displayed when events are in any other status (e.g.,
Under Evaluation, Closed, or Canceled). Users can view information about the question,
but changes are not allowed.

Changing Auto-Score Assignments
Line level auto-score assignments can be amended from the Evaluations page on released
events so that corrections and adjustments can be made:

l If changes do affect supplier responses (such as a change to the questions), the supplier
responses for the items affected are discarded.

l If the changes do not affect existing supplier responses (such as a change to the response
scoring), then previously submitted supplier responses are not discarded.
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l Amendments can't be made to locked items that have been added to an event from locked
or protected templates.

Cost Analysis Values for Events and Event
Line Items
The Cost Analysis option may be enabled at the work group and event level, allowing customers
to assign cost adjustments to different supplier responses to event questions and event line
items, and use when evaluating supplier responses.

If cost adjustments is enabled, cost adjustments values are initially assigned to questions in the
Questions section of event Setup and to additional item fields in the Additional Item Field section.
Questions and additional item fields with cost adjustments enabled are displayed in the Auto
Score sub-section of the Evaluations section (see below).

Configure Cost Analysis for Questions
1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which

questions exist.

2. Select theQuestions page in the Settings and Content section of event navigation.

3. Click Edit next to the question you want to change. Note that Cost Analysis may only be
configured for questions with specific response types.

4. In the Edit Question overlay, select the Use Response in Cost Analysis checkbox.

5. Depending on the response type for the question, you may now configure a numeric range,
date range, or the specific options for suppliers to choose from and assign a cost
adjustment (positive or negative) to each of those values. The cost adjustment may be a
dollar or percentage value. For example,

a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 -
10", and a cost adjustment of -$50.00 for "11-20", etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a cost adjustment.

c. For a date field, you may provide a range of dates with one adjustment, and a
different range of dates with another adjustment.

d. As you add each cost adjustment, select the green checkmark to add the
configuration to the question.
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6. When finished adding the cost analysis values, click Save Changes.

Configure Cost Analysis for Additional Item Fields (Event
Line Items)

1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which
additional item fields exist.

2. Select the Additional Item Fields page in the Settings and Content section of event
navigation.

3. Click Edit next to the additional item field you want to change. Note that Cost Analysis may
only be configured for additional item fields with specific response types.

4. In the Edit Additional Field overlay, select the Use Response in Cost Analysis checkbox.

5. Depending on the response type for the question, you may now configure a numeric range,
date range, or the specific options for suppliers to choose from and assign a cost
adjustment (positive or negative) to each of those values. For example,

a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 -
10", and a cost adjustment of -$50.00 for "11-20", etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a cost adjustment.

c. For a date field, you may provide a range of dates with one adjustment, and a
different range of dates with another adjustment.

d. As you add each cost adjustment, select the green checkmark to add the
configuration to the question.

6. When finished adding the cost analysis values, click Save Changes.

Edit Cost Analysis Values
Note: Changes can't be made to locked items that have been added to an event from locked or
protected templates.

1. Navigate to an event that has Cost Analysis enabled on the Event Setup, and for which the
cost analysis option is enabled for event questions or event line items.

2. Select the Cost Analysis page in the Evaluations section of event navigation.

3. Expand the Event-Level Questions heading to view event questions with cost analysis
enabled. Expand the Line-Level Questions heading to view additional item fields with cost
analysis enabled.
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4. Select Edit Question Details under the question or additional item field you want to
change.

5. Depending on the response type for the question, you may now configure a numeric range,
date range, or the specific options for suppliers to choose from and assign a score to each
of those values. For example,

a. For a numeric value, you may provide a cost adjustment of $100.00 or 2% for "0 -
10", and a cost adjustment of -$50.00 for "11-20", etc.

b. For a multi-select list, select each of the options you have available for suppliers and
assign a cost adjustment.

c. For a date field, you may provide a range of dates with one adjustment, and a
different range of dates with another adjustment.

d. As you add each cost adjustment, select the green checkmark to add the
configuration to the question.

6. When finished adding the cost analysis values, click Save Changes.

If changes do affect supplier responses (such as a change to the questions), the supplier
responses for the items affected are discarded. If the changes do not affect existing supplier
responses (such as a change to the response scoring), then previously submitted supplier
responses are not discarded.

Evaluating Cost Analysis Responses
Event questions and additional item fields with cost analysis enabled are displayed on the Cost
Analysis page under the Evaluations section of the event. It allows event administrators to view
or edit auto-score values for both event-level questions and line-level questions. The two types
of questions are grouped under the following headings:

l Expand the Event-Level Questions heading to see a list of event questions that have
been added to the Questions page of the event.

l Expand the Line-Level Questions heading to see a list of event line item questions that
have been added via Additional Item Fields on the event. These are grouped into Product
and Services categories.

You can expand a question to view or change cost analysis assignments, or view a summary of
responses to the question:
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l An Edit Question Details button is displayed when events are in Draft status, allowing
users with the appropriate permission to change cost analysis assignments. The changes
are saved to the original event question or additional item field.

l A View Question Details button is displayed when events are in any other status (e.g.,
Under Evaluation, Closed, or Canceled). Users can view information about the question,
but changes are not allowed.

Changing Cost Analysis Assignments
Line level cost analysis assignments can be amended from the Evaluations page on released
events so that corrections and adjustments can be made:

l If changes do affect supplier responses (such as a change to the questions), the supplier
responses for the items affected are discarded.

l If the changes do not affect existing supplier responses (such as a change to the response
scoring), then previously submitted supplier responses are not discarded.

l Amendments can't be made to locked items that have been added to an event from locked
or protected templates.

Evaluation Calculation Options
Evaluation Calculation Options are primarily configured for multi-stage events. This page allows
for specific evaluation options to be included from all or different stages of the event. The
selected options are displayed on the side-by-side evaluations page. For example, an event may
have an initial stage that is a "Supplier Qualifying Round". The buyer may review the responses
and simply select suppliers to proceed to the next stage, and therefore choose to not include
some scores from the initial stage in the final evaluation.

The default selection is to Include All Stages and Scoring Options and the page displays the
scoring options as read-only. Select Let Me Pick to edit which scoring options to use in the
different stages for the event.

You can edit the Evaluation Calculation Options for the current stage only. Once a stage is
complete (when a subsequent stage is created), you cannot edit the calculation options for the
completed stage.
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Configure Evaluation Calculation Options
1. Navigate to the current stage for an event that has multiple stages.

2. Select the Eval. Calculation Options page in the Evaluations section of event navigation.

3. By default Include All Stages and Scoring Options is selected. This will allow Auto Score,
Cost Analysis, and Average Questionnaire Rating (as those options are configured for the
event) will display on the side-by-side evaluations page for the event.

4. If you would like to include specific options from different stages, select the Let Me Pick
radio button.

a. For each stage, select which options you would like to include on the side-by-side
evaluations page.

b. Select Submit when finished with selections.

Changes When the Event Is Under Evaluation
If the event calculation options change after the event has saved scenarios, a notification may be
sent to evaluators notifying them that a change has been made. Also, when viewing saved
scenarios for an event, a message will indicate that event calculation options have changed.

Impact of Price Components and Alternate
Items on Evaluations and Awarding

Price Components
Note: Primary bid pricing comparisons consider the Total Calculated Price for each item.

l Total Price = (Unit Price + Price Components) * Item Quantity
l Total Calculated Price = Unit Price + Price Components

On the Items page, the text "All-In Pricing Used" appears in the Price Components header to
identify items for which All-In pricing was used. If the supplier's bid contains itemized price
components, the Price Components header is empty and the section is expanded to display the
price component fields.
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Details of Price Component configuration are available during event evaluation on the Price
Components page. Price components can be copied from one stage to the next in multi-stage
events.

Price components are included in Evaluation export files.

Price component fields comply with Confidential Pricing and Hide Event Prices settings.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

Price components are not displayed on the Scenario Evaluator page. The Total Unit Price is
used throughout this page for comparisons. When necessary, buyers can click on an item to
launch a screen overlay that contains comparative data for all of that item's pricing fields.

A Price Components drop-down section appears on the Scenario Savings page only for events
in which price component fields are configured. This section contains all the price component
fields that have been configured for the event. All price component fields are deselected.

l When price component fields are selected, a column is added for each field selected. If
suppliers submitted responses to price component fields, the responses are displayed
within the appropriate column; otherwise, the column shows a dash.

The Total Unit Price is used in the Supplier Award Summary report and the Cost Savings
report. It is transferred to contracts, purchase requests, and shopping carts that are created from
sourcing events configured with price components.

Alternate Items
If alternate items are allowed for the event, a Choose Alternate indication displays for the
configured items when the item information is expanded.

When the Choose Alternate button is selected, you may choose which item to use in the
evaluation. Any Auto Score and Cost Analysis results are recalculated.

If an alternate item is selected in a scenario and is the item being evaluated, an ALT indication
appears next to the item. Also note that the item numbering indicates it is an alternate item.
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Supplier Responses
Suppliers may begin responding to an event upon the event Released Date. As a user with
permission to see the event, you may review supplier responses at any time. A Supplier
Responses page will display in the Event Navigation under the Evaluations section.

Once the Close Date for the event passes (or if the event is closed early), the event enters
Evaluation workflow. You may then evaluate responses in comparison to each other using
evaluation tools, and a response may be awarded.

Supplier Responses Page

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

Additionally, Event Owners and Evaluators can toggle the hiding and showing of prices from the
Event Actions dropdown menu on events. When the event prices are hidden, they are hidden for
all users, and users see the words Event Prices Hidden in place of prices.

All invited suppliers are shown on the page with information about the supplier's response status:

l Progress - An indication if the supplier has viewed the event, declared an intent to bid, in
the process of responding or has submitted a response. You may select to sort responses
on this field.

The status of a manually added supplier shows as Invitation Unaccepted. Once the supplier
has registered the status will update to Event Not Viewed.

l Response % Complete - Displays how much of the required information for the event the
supplier has completed. A number displays once a supplier has viewed the event. Click the
number to see details of the required information completed. A value is NOT shown if the
event is sealed and still in the Open status. The sealed date must have passed to see a
value. The pop-up also displays with a count of viewed attachments on the Buyer
Attachments, Prerequisites, Items, andQuestions pages of a sourcing event.
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l  In determining the required information:

l Required Prerequisites are marked as either required to view the event or
required to bid on the event.

l Required Questions are those event questions that have Supplier Response
is Required enabled.

l Required Product and Service Items are those items that have Unit Price Is
Required enabled. A product item is not considered required if only a delivery
date is required without requiring a unit price.

l Supplier Name - The supplier who submitted the response. Clicking on the name will allow
you to navigate to the supplier's profile.

l Select the icon next to the Supplier Name to see the invited contact names and
email addresses.

l Icons indicate if the supplier responded via the public site: , and if the supplier is
included on the Panel Questionnaire (if configured)

l Total Bid - The total bid from the supplier for the event (if applicable). Some event
responses do not include bids. If the event has both required and optional items for bid,
two columns are displayed: Required Items Total Bid andOptional Items Total Bid, with
the appropriate values showing for each.

l View Response - Click on this button to view the details of the supplier's response. If the
event is in Under Evaluation status, a Disqualify option on the drop down menu can be
used to disqualify suppliers.

l Evaluate Selected Responses - If you do not want to evaluate all responses from the
Evaluations Actions drop-down, you can select specific supplier responses and click this
hyperlink to include only those suppliers in the evaluation.

l Resend Supplier Invite - If the supplier has not responded to the invitation, you may
select to resend it to the appropriate supplier contacts.

Once an event closes and it is in Under Evaluation status, a drop-down of Evaluation Actions is
available that allows you to configure the suppliers to include in your evaluation. Disqualified
suppliers are excluded from evaluation action results.

l Evaluate All Responses- To navigate to a summary page of all responses and take further
actions on each response, make recommendations, or select to award.

l Evaluate Selected Responses - This option shows only if you have selected one or more
responses on the page. Selecting this option after selecting specific supplier responses will
take you to the side-by-side navigation with only the selected suppliers.

l Export All Responses - To export the information to an Excel file for further analysis.
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l Add Selected to Panel Questionnaire - This option is only available if you have selected
one or more of the supplier responses and you have a panel questionnaire configured for
the event. Select to add the suppliers to the panel questionnaire.

l Tag Supplier(s) for next stage - If you are creating another stage for the event, you may
select suppliers that will be added to the next stage.

l Untag supplier(s) for next stage - If you have tagged suppliers for the next stage of an
event, you may select suppliers to untag so they will not be moved to the new stage.

If you have saved any evaluation scenarios, a Load Saved Scenario button displays. Select and
choose which scenario you would like to view. You can also delete scenarios from this page
unless they are Finalized.

Note: Saved scenarios with disqualified suppliers cannot be loaded. A warning message at
the top of the Load Saved Scenario page will indicate that there are scenarios with a
disqualified supplier. The affected scenario will not have a Load button. Instead, an
information icon is displayed and when clicked, will show the message "This scenario has
a disqualified supplier".

Event Actions are available to copy or export the event. If the event is configured to allow proxy
bids, you will also see the option to Designate Suppliers for Proxy Bidding in the Event Actions
drop-down.

Event Owners and Evaluators are able to toggle the hiding and showing of prices from the Event
Actions dropdown menu on events by selecting Hide Event Prices.

If you are an approver, you will see a drop-down forWorkflow Actions where you may choose
from options appropriate for your user permissions and status of the event. See for additional
information.

Specific Supplier Response Pages
When you have selected the View Response button from the Supplier Responses page, you
may see the responses provided by the specific supplier. Select any of the pages to see details
for the supplier's response. You may view and download attachments provided by the supplier.
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On the Items page, select the View Details hyperlink to see additional information for the item. If
alternate items were submitted, they are indicated with ALT numbering under the original item.
The item considered for evaluations by default is indicated with an icon .

View Evaluations Page
When an event is closed, you may begin the evaluations process. You must have the Finalize
Award Scenarios or Create Award Scenarios permission in order to navigate to evaluations.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

1. Search for an event with a status of Under Evaluation.

2. Select the appropriate event number you would like to evaluate to open the event details.

3. Select the Supplier Responses page for the event.

4. From the Evaluations Actions drop-down, select Evaluate All Responses. Alternatively,
select specific supplier responses, and select Evaluate Selected Responses from the
Evaluations Actions drop-down.

5. Click the View Scenario drop-down and select from one of the common scenarios. View
results.

6. Select to Sort Bids by various selections.
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7. Expand the product or service line items to see individual items.

8. If comments are present, select See full comment hyperlink to see the complete text.

9. If you would like to return to the event to see other details of the supplier's response, select
Back to Event hyperlink.

Supplier Response Actions
The action to Pin or Remove Response from the Evaluation view is available by selecting the
drop-down next to the supplier name. The actual award action is done through the Actions for
Selected Items drop-down:

l Tag Supplier - This action is available if the event is configured to allow multiple stages.
Selecting this option will tag the supplier to move to the next stage of the event, when
created. Tagged suppliers show with an icon .

l Untag Supplier - This action removes tag on a supplier that would place them on the next
stage of an event, when created.

l Pin - This action moves the response to the beginning of the responses behind any
Recommended or Awarded responses. The response location will not move through
pagination of additional responses. This essentially "locks" the response into a column
location.

l Unpin - This action removes the response from a designated column and the normal
sorting for the evaluation responses applies.

l Remove Response - This will remove a response from the current evaluation view. This
does not remove the response from the event - it only removes it from this particular
analysis of the evaluation responses.

l Remove Award From Supplier - This action will remove the award indication for each item
marked for the supplier as Pending Award. Upon confirming this action, any items marked
as awarded to the supplier in the scenario will be marked as Unawarded.

l Disqualify - A supplier can be manually disqualified from an award scenario by expanding
the supplier name at the top of the column and selecting Disqualify. The supplier is
removed from the award scenario, and they are excluded from the Evaluate All
Responses and Export All Responses evaluation actions.

Once an action is chosen, you will be asked to Save the Evaluation if has not been previously
saved. Any actions such as award or recommend that are placed on a supplier response are
available for the approver to see as the evaluation moves through workflow.
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Updating Supplier Profiles Through Event Responses
If suppliers amend retrieved response data in select fields, users with the Edit Company Profile
permission have the option to commit these changes to their Supplier Profile directly from within
the event.

1. When a supplier clicks the Yes I Intend to Participate option, questions that are linked to
Supplier Profile fields are automatically be populated with the data contained in the
associated fields within that vendor's Profile. If there are attachment questions, the
attachments are copied from the Supplier Profile in real time.

a. The questions associated with any empty fields in a supplier's Profile will remain
blank. The supplier can manually enter data to answer these questions. If the empty
field has an associated drop-down list in the Supplier Profile, suppliers will choose
their answer from this drop-down list. Suppliers can also edit any of the data in the
questions that were populated automatically from their Supplier Profile.

b. When grouped insurance fields are included, the platform selects the first match it
encounters for the Group name when auto-populating the associated event
questions for a participating supplier. If there is more than one group with the same
name in a supplier's organization, a link labeled Change Groupwill appear beside
the grouped field header. Clicking this link will allow users to select the proper group
whose data should be used for the associated event question responses.

c. The following field information can be updated from within the event:
i. Number of Employees
ii. DUNS Number
iii. Website
iv. Business Description

d. Supplier users with the Edit Company Profile permission will see an Update Profile
button located directly beneath the fields that can be updated from within the
Questions section of a Sourcing event. When they click this button, their data
changes are sent to their Supplier Profile.

Designate Proxy Bid Suppliers
Organizations may choose to receive proxy bids from suppliers for sourcing events. The proxy bid
allows the supplier to mail, email, or phone in a bid to the buyer. The buyer may then access the
sourcing event as a supplier would see it in their portal, thereby making it easier to complete the
bid information online on the supplier's behalf. The organization may also choose to allow or not
allow proxy bidding on sealed events.
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Once the event isOpen, a user with the Create Proxy Bid permission and who is an Event
Creator or Owner will designate for which suppliers a proxy bid may be provided on the Supplier
Responses page. If proxy bids are allowed for sealed bid events, suppliers cannot be designated
for proxy bid until the sealed bid open date has arrived. Proxy Bids can be designated up until the
event is Awarded. Event suppliers who are available for selection are as follows:

l Event suppliers who have not yet submitted a bid are available.

l Manually invited suppliers who have not responded by registering for a supplier portal will
not show. If a manually invited supplier has registered and has a supplier portal, they will
show.

l If a proxy bid has already been started, the supplier name will show as read-only and the
proxy bid designation cannot be removed.

To designate proxy bid suppliers:

1. Navigate to anOpen sourcing event.

2. Select the Supplier Responses page of the Evaluation section on the event.

3. From the Event Actions drop-down, select the option to Designate Suppliers for Proxy
Bidding. An overlay displays Event Suppliers to mark for proxy bidding.

4. Select from the available suppliers. Select to Save Changeswhen done.

5. The selected suppliers will be shown with the Proxy Bid icon. A button will be available to
Enter Proxy Bid. Once the bid response has begun, the button will display as Continue
Proxy Bid.

6. History for the event captures suppliers that are designated for proxy bid, and if the
designation is removed.

Once designated as a proxy supplier, an icon is displayed next to the supplier name for easy
identification. A button displays for Enter Proxy Bid or Continue Proxy Bid. You can choose to
deselect a supplier for proxy bid if a response has not been started. Manually invited suppliers
who have not registered as a supplier cannot be selected.

Respond to an Event via Proxy Bid
Once a supplier has been designated for a proxy bid, a user with appropriate permission may
access the event information on the Supplier Responses page by selecting Enter Proxy Bid or
Continue Proxy Bid. In order to submit a proxy bid on behalf of the supplier, the user must be an
Event Owner with either the Create/Own Events permission orManage Work Group Events
permission, as well as the Create Proxy Bid permission. The supplier will receive an email
indicating that the customer has started a proxy bid for the supplier's response to the event.



JAGGAER 209 www.JAGGAER.com

Upon selecting to enter or continue a proxy bid, the user is navigated to a view of the event in the
same format as a supplier would enter information. A banner message displays, notifying the user
they are entering a proxy bid on behalf of the supplier. The customer user must accept
prerequisites and declare the intent to bid depending on the event requirements.

1. Search for an Event with a status of Open or Under Evaluation that allows Proxy Bids and
has suppliers designated for proxy bids.

2. Navigate to the Supplier Responses page under the Evaluations section of the event
navigation.

3. Expand the drop-down menu beside the appropriate supplier and select Enter Proxy Bid
or Continue Proxy Bid.

4. If the intent to bid has not been set, declare your Intent To Bid. You can do this either of
two ways:

a. Click the button in the banner, Yes I Intend to Bid or No Bid.

b. In the left navigation for the event, click the edit icon next to the Intent to Bid, and
choose I intend to bid on this event or No Bid.

c. If you choose No Bid, then no further action is needed.

5. If Prerequisites are required to view or respond to the event:

a. Click the Proceed to Prerequisites button, or click on the Prerequisites link in the
left navigation panel for the event. You are navigated to the Prerequisites page for
the event.

b. Follow the instructions on the page. This may include selecting a checkbox to
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confirm you have read and agreed to the terms, and/or uploading a file.

c. When finished completing the requirements on the page, click the button to Save
Progress.

6. View Buyer Attachments, if provided.

a. Navigate by selecting Buyer Attachments in the left panel for the event, or by
selecting the Next button when on the Prerequisites page.

b. Download and view attachments as needed.

7. View the Supplier Attachments section, if provided. If additional information should be
included to support the bid response, Click Add New Attachment and select one of the
following options:

l Add New Attachment
l If you select File as the Attachment Type, you will be prompted to select
from your local files. You may click Select Files to access a file selector from
which multiple files can be selected, or drag and drop files to the gray box
surrounding the Select Files button.
l The selected files are displayed in the overlay. Optionally, edit the file name
entries so that the field contains a preferred file display name.

l If more than one attachment is listed on the page, you may choose the display
order for any new attachments.

l If you select Link as the Attachment Type, you can provide a name for the
link and enter the URL address.

l Add Confidential Attachment
l You will be prompted to select from your local files. You may click Select
Files to access a file selector from which multiple files can be selected, or
drag and drop files to the gray box surrounding the Select Files button.
l The selected files are displayed in the overlay. Optionally, edit the file name
entries so that the field contains a preferred file display name.

l If more than one attachment is listed on the page, you may choose the display
order for any new attachments.

8. AnswerQuestions as provided. Note that questions may be on multiple pages and
grouped on each page.

a. Navigate by selectingQuestions in the left panel for the event, or by selecting the
Next button when on the Attachments page.

b. Required questions are indicated with a star, and must be answered in order to
submit your response.
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c. Answer other questions as appropriate to give the customer complete information.
For information on providing responses via import, refer to the guide in the
application by selecting the Import Options drop-down button, and select Get
Import Instructions.

d. Navigate to each page by selecting the page hyperlink under theQuestions section
in the left navigation panel for the event.

e. On each page, click to Save Progress or click the Next button to save and proceed
to the next page.

f. Some questions may require you to upload a file attachment. If the attachment
contains sensitive information, it can be designated as such by selecting the Add
Price File Attachment from the Add New Attachment drop-down:

s

9. Provide Item data, if appropriate.

a. Navigate by selecting the Items in the left panel for the event, or by selecting the
Next button when on the lastQuestions page.

Note: Items are listed on the Product Line Items page and/or Service Line
Items page. Items may be grouped within the same page.
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Note: You may choose to import item responses by using the export/import
feature. Download the Bid Response Import/Export Guide by selecting the
Import Options drop-down button, and Get Import Instructions. Follow the
instructions in the document to submit item responses via import.

b. For product line items and service line items, enter a Unit Price. If a unit price is
required for an item, the field will be noted with a star, and a price must be provided
in order to submit the bid response.

c. For Product Line Items, enter an Estimated Delivery Date or days after award when
delivery is expected. If an estimated delivery date is required, the field will be noted
with a star, and a date / days must be provided in order to submit a response.

d. For Service Line Items, enter estimated service start/end dates or days after award
when the service will be delivered. Entering this information is optional.

e. Enter a comment for each item, if appropriate.

f. Click Respond to Item and complete questions or enter information requested by
the buyer. Required fields are indicated with a star and must be completed in order
to submit a response. Click Save Changeswhen done.

g. If an item is configured to allow alternates, select the Add Alternate Item if you
would like to provide a similar item in your bid response. This may be in addition to or
instead of the response to the original item. You may enter up to five alternates per
item.

i. Provide a Name for the item. This field is required.

ii. Enter an optional Description for the item.

iii. Enter an optional Catalog Number for the item.

iv. TheQuantity, Unit of Measure, and Requested Delivery information must
be the same as the original item, and therefore is read-only.

v. Enter a Unit Price for the item. This field may be required.

vi. Enter an Estimated Delivery (date or days after the award). This field may be
required.

vii. Enter optional Comments about the alternate item.

viii. When finished, click Save Changes.

ix. The page will refresh, indicating the ALT item below the original item.
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h. On each page, click to Save Progress or click the Next button to save and proceed
to the next page.

10. Review and Submit your response for the event.

a. Select the Review & Submit hyperlink in the left navigation for the event.

b. Any incomplete items are indicated with a warning message, with a hyperlink to
navigate to the appropriate area.

c. You do not have the option to certify or submit a response if you have not completed
all required items.

d. Once required items are completed:

i. Select the checkbox certifying the statements you've made to be true.

ii. Click Submit Response.

11. The page refreshes with a confirmation that your response was submitted.

Please note the following:

l The response status shows as Draft (by Proxy).

l The customer may navigate back to the supplier responses page at any time by selecting
Back to Supplier Responses.

l Customer responses are reflected in the Event History. A supplier may continue to respond
to the event via the customer portal. A supplier will see an audit log of responses provided
by the customer.

l Upon completing all required information, the customer can submit the bid response on
behalf of the supplier. The response is evaluated with all other supplier responses.

Adding Proxy Bidding for Suppliers in the Evaluation Stage
of an Event
Occasionally, supplier bids that are hand-delivered, or mailed-in, arrive after the event has
already closed and is under evaluation. In these situations, if the event has been configured to
allow proxy bidding, event managers can add suppliers to the event and proxy bid for these
vendors.

Registered suppliers who are invited during the event evaluation period cannot respond to the
event through their portal, the client user must proxy bid for suppliers invited at this stage.



JAGGAER 214 www.JAGGAER.com

Note: This functionality is not available for auctions. In multi-stage events, this capacity is
only available for the initial stage of the multi-stage event.

Review Supplier Documents
A new document administration page is available for events in Under Evaluation status. This page
enables buyers to review and administer supplier documents.

1. Navigate to the Evaluations > Supplier Responses page.

2. Expand the Evaluation Action drop-down and select Evaluate Response Attachments.

3. Expand the Supplier drop-down and select the appropriate vendor. All suppliers that have
submitted a completed response are listed in the Supplier drop-down.

4. Expand the Attachment Type drop-down and select one of the following options:
l Prerequisites
l Questions
l Vendor Attachments

5. Click Submit.

Confidential Documents

Attachments are grouped by Question Group. TheQuestion Response column indicates
whether the buyer, supplier, or both have tagged the attachments as confidential.

l = Confidential Mode Enabled (by buyer)

l = Confidential Response (by supplier)
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Users who are not members of the Event Price Viewers access group can see the file names of
suppliers' confidential attachments, but they do not have access to a link to open these
documents and view the contents within the user interface or via evaluation exports.

Confidentiality Toggle
A Toggle Confidentiality button is accessible to event managers who are in the Price Visibility
group. This button is only available for attachments that have been designated as confidential by
suppliers only.

l A Confirmation page appears before the confidentiality status can be changed.
l Changes to attachment confidentiality are recorded as part of the sourcing event
audit trail.

Export Evaluation Documents

Export All Responses for an Event
When evaluating responses, you may choose to export all responses to an Excel file for further
analysis. You must have the Finalize Award Scenarios or Create Award Scenarios permission
in order to navigate to evaluations.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

When additional item fields on a sourcing event are included in the Evaluation Actions > Export
All Responses document, conditionality between fields is not included.

1. Search for and select a sourcing event with a status of Under Evaluation.

2. Navigate to the Supplier Responses page for the event.

3. To export from the Supplier Responses page, select Export All Responses from the
Evaluations Actions drop-down. Proceed to step 6.

4. To export from the Evaluations page, select Evaluate All Responses from the
Evaluations Actions drop-down. Then, select the Export button, and Export All
Responses.
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5. Enter a Description for the Export file, and click Submit.

6. A confirmation indicates your export request has been submitted. Click the hyperlink
message to navigate to the Sourcing > Sourcing Events > View Exports >
Evaluations page.

7. Select the file name to open in Excel.

Export an Evaluation Spreadsheet
This export file consists of three worksheets containing flattened, unfiltered event data in
individual columns that can be filtered and manipulated by users within their Excel software. The
three worksheets are comprised of:

l Summary: A cover page containing event details to identify the corresponding
event

l Items: Supplier bid information
l Questions: Event questions and responses from participating suppliers

1. Search for and select a sourcing event with a status of Under Evaluation.

2. Navigate to the Supplier Responses page for the event.

3. Select the checkboxes for each supplier that will be included in the data export.

4. Select Export Evaluation Spreadsheet from the Evaluations Actions drop-down. Then,
select the Export button, and Export All Responses.

5. An Evaluation Export screen overlay appears. Users may accept the default Description,
which is the Event Title, or they may enter a new Description and click Submit.

6. A confirmation indicates your export request has been submitted. Click the hyperlink
message to navigate to the Sourcing > Sourcing Events > View Exports >
Evaluations > Sourcing Evaluation Exports page.

7. Select the file name to open in Excel. Note: If the requested export file is not available
immediately, a Refresh this Page link is available on the Sourcing Evaluation Exports
page.
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Compare Selected Supplier Scorecards

Scorecard Elements
For users with access to the Supplier Management solution, comparative scorecard data can be
integrated into Sourcing event evaluations. Evaluators can also disqualify suppliers from event
award consideration when reviewing the scorecard comparison data.

Scorecard evaluations consist of the following elements:

l Graphs displays a bar chart of the suppliers' performance based on the metrics contained
in the Details area.

l Details consist of the percentage grade for each supplier in the selected scorecard time-
frame(s) and the supplier's Average grade overall, which is meaningful in the analysis of
multiple reporting periods. These columns can be sorted by clicking the down arrow in the
column header.

l Underlying supplier scorecards can be accessed by clicking the associated percentage
score within the Details columns. Entries in these columns are a link to the associated
scorecards.

l A Disqualify / Re-Qualify toggle button is available for each supplier in the Details
section, giving evaluators the option to disqualify any suppliers from award consideration if
it should happen that such a decision can be made based on the data presented in the
performance comparison.

Compare Scorecards
1. Search for and select a sourcing event with a status of Under Evaluation, Awarded, or

Closed Without Awarding status.

2. Navigate to the Supplier Responses page for the event.

3. Select the checkboxes for each supplier that will be included in the scorecard comparison.

4. Select Compare Selected Supplier Scorecards from the Evaluations Actions drop-
down.
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5. A Supplier Scorecard Comparison page opens from which evaluators may make
selections from the following drop-downs:

l Scorecard (mandatory) - Select the type of scorecard to evaluate.

l Reporting Period - Use the defaultMost Recent option, or if the selected
scorecard is a reoccurring scorecard, select the number of reporting periods to
include.

l Category - Select a category within the scorecard.

l KPI - Select a KPI within the scorecard.

6. When configuration is complete, click Compare.

Supplier Disqualification
Event Administrators can remove (i.e., disqualify) suppliers from consideration when awarding a
sourcing event. Suppliers can be disqualified automatically or manually:

l Automatically - Administrators creating an event can configure a response to an event
question or additional item field that, if selected, will disqualify a supplier. When suppliers
participating in the event select the response, they will be automatically disqualified from
award consideration when the event closes. For additional information about configuring
these fields, see and .

l Manually - Suppliers can be manually disqualified during the evaluation process of an
event. Event managers, creators, and owners with access to an event can manually
disqualify suppliers once the event is Under Evaluation. Stakeholders with view only
access to the event cannot disqualify suppliers.

There is no indication to suppliers that a response will disqualify them, or notification that they
have been disqualified during the evaluation process.

Suppliers can interact with an event while it is open. The Disqualified status is only applied to
suppliers once an event closes, and disqualified suppliers are not eligible for award consideration
during the evaluation phase of an event.

Supplier disqualifications and reinstatements are recorded in the Event History tab of the
History page. The disqualification history can also be accessed from the Supplier Responses
page by clicking the information icon next to a supplier and then the Link to Disqualification
History link.
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Manually Disqualify a Supplier
Event administrators, creators, or owners with access to an event can manually disqualify and
requalify suppliers. Suppliers cannot be disqualified from a pending award or a finalized award.
They must be removed from the award before they can be disqualified.

1. Open an event that is in Under Evaluation status.

2. Expand the Evaluations section in the left menu and click Supplier Responses.

3. Choose one of the following options:

l From the Supplier Responses page - Expand the View Responsemenu next to the
supplier you want to remove from award consideration and select Disqualify.

l From an Award Scenario - Click the Evaluate All Actions button and select
Evaluate All Responses. Click the supplier name at the top of the column and select
Disqualify.

4. Enter a Comment.

5. Click Continue.

Comments regarding supplier disqualifications and reinstatements are displayed in the Notes
column on the Events History page.

The disqualified supplier is excluded from the Evaluate All Responses and Export All
Responses evaluation actions. The Evaluate Selected Response checkbox on the Supplier
Response page is removed for that supplier. Saved scenarioswith disqualified suppliers cannot
be loaded. Suppliers do not receive notification that they have been disqualified.

Find Disqualified Suppliers in Sourcing Events
Suppliers are disqualified after an event closes and when it is in the Under Evaluation status:

l For automatic supplier disqualifications, opening the Supplier Responses page after an
event has closed will cause the system to run an analysis to find disqualifying supplier
responses. This process will take a few seconds and the Supplier Responses page will
display a message indicating that a supplier disqualification check is in progress.
Disqualified is displayed next to disqualified suppliers when the analysis is finished.

l Formanual supplier disqualifications, the Disqualify option is available on supplier
responses and award scenarios after the event is closed.

A Disqualified status is displayed next to disqualified suppliers on the Supplier Responses page.
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l The supplier is excluded from the Evaluate All Responses and Export All Responses
evaluation actions.

l The Evaluate Selected Response checkbox on the Supplier Response page is removed
for that supplier.

l Saved scenarioswith disqualified suppliers cannot be loaded. A warning message at the
top of the Load Saved Scenario page will indicate that there are scenarios with a
disqualified supplier. The affected scenario will not have a Load button. Instead, an
information icon is displayed, and when clicked, will show the message "This scenario
has a disqualified supplier".

Suppliers cannot be disqualified from a pending award or a finalized award. They must be
removed from the award before they can be disqualified.

Reinstating a Supplier
Disqualified suppliers can be reinstated from the Supplier Responses page by clicking View
Response, then Re-Qualify. Suppliers do not receive notification that they have been reinstated.

1. Open an event that is in Under Evaluation status.

2. Expand the Evaluations section in the left menu and click Supplier Responses.

3. Expand the View Responsemenu next to the disqualified supplier you want to return to
award consideration and select Re-Qualify.

4. Enter a Comment.

5. Click Continue.

The supplier is returned to the evaluation process. Suppliers do not receive notification that they
have been reinstated.

Award Scenarios

Managing Award Scenarios
Once you have selected to evaluate all or selected responses from the Supplier Response page
on an event, you are navigated to a summary page of all the responses, the Award Scenario
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page, also referred to as the Side by Side Evaluations page. The page displays up to 5
responses by default on the first page of results. If more than 5 responses are being evaluated,
the user will have the ability to transition to the next page of responses. At the top right of the
page, the user can specify how many results to display 3 to 5 results per page.

Users with the Create Award Scenarios permission have the ability to run scenarios and save
them. Whatever awards are made in a scenario become the "recommendations" for that scenario.
Users with the Finalize Award Scenarios permission review the scenarios and can select
Finalize Award for the appropriate scenario.

The follow tabs display on the Award Scenario page:

l You are on the Scenario Navigator tab when you are evaluating and running scenarios.
When a scenario is run or saved, an Awarded Scenario column will show the supplier
selected for the award for each line item.

l The Scenario Breakdown tab shows where you can "preview" what the awarded scenario
will look like.

l The Scenario Savings tab allows evaluators to view cost savings data (relevant to
historical price points) for defined award scenarios. With this information, users can
perform event-level cost savings assessments and comparisons between award
scenarios.

The Scenario Savings tab displays a tabled line-by-line summary of an award scenario,
including columns for historical prices, bids, extended spend, and savings vs. historical.
Users can customize this Scenario Savings report by selecting fields from the Additional
Item Fields section to ensure that the report contains all of the relevant information
needed to evaluate the savings impact of each considered award option.

l The Panel Questionnaire Details tab provides a detailed view of panel questionnaire
ratings and results. The tab is only exposed after the panel questionnaire questions have
closed and associated values are calculated. Clicking the Export button also provides
access to an Excel spreadsheet export of the questionnaire results to allow further analysis
of the data outside of the system.

The Award Scenario page includes the following button options:
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l View Scenario - Run common scenarios (selections vary depending on the event
configuration), including:

l Lowest Bid Price (Single Supplier)

l Best Questionnaire Rating (Single Supplier)

l Lowest Bid (Split Award)

l Best Auto Score

l Lowest Cost

l Lowest Cost per Quality Point

l Highest Best Value Score

l Load Saved Scenario - Allows you to select from scenarios you have saved.

l Save As - When you have designated awards to suppliers or individual items, click Save As
to save the scenario.

l Reset - Reset the page so that no scenarios are loaded.

l Export - Export all responses or export the loaded scenario.

l Finalize Award - This button displays when you are reviewing a saved scenario to users
with the Finalize Award Scenario permission. Selecting this button will award the event to
the suppliers/items as indicated in the loaded scenario. The scenario name is listed with a
Finalized button.

To sort responses, choose the sort criteria and then select Ascending or Descending.
Show Supplier Response Notes is on by default. It allows users to display/enter comments in
the Response Notes field for each supplier displayed on the page. When this checkbox is
disabled, the Response Notes field will not show. The available sort criteria are:

l Total Bid

l Product Line Items

l Service Line Items

l Supplier Name

l Supplier Response Completeness

l Auto Score
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l Cost Analysis

l Cost Per Quality Point

l Best Value Score

l Average Questionnaire Rating

View the details for product and service line items by clicking the item. An overlay displays
additional item information.

When viewing product line items and service line item information, you will see a Choose
Alternate indication if the item is configured to accept alternates and the supplier has submitted
an alternate item.

l Select the button to view information about the alternate item. You may choose to base
your evaluation/award on the alternate item or the original item.

l See Alternate Items on the for additional information.

Use the Scenario Award Actions after you have selected items and choose from the following
options:

l An option exists to Award To [Supplier Name] for each supplier contained in the
Evaluation.

l An option exists for No Award.

l When you have items selected and choose one of the options from the drop-down, the
item(s) is marked accordingly and the appropriate supplier is displayed for the item in the
Awarded Scenario column. The supplier column shows as Pending Award for any
suppliers that were awarded any of the line items for the scenario.

Add a response rank on scenarios: You choose to Rank Awarded Responses for any suppliers
Pending Award in the scenario. This allows users to add a preferred supplier, which is especially
helpful in situations where more than one supplier has been marked for awarding. When selected:

l From the Scenario Award Actions, choose Rank Awarded Responses.

l An overlay for Response Ranking displays, and users may enter a rank for the suppliers.
Ranks cannot be skipped or contain duplicates. You may choose to sort the ranked
suppliers in ascending/descending order in the overlay.

l When the ranking is saved, the suppliers are displayed on the page according to your rank.
The Rank is indicated beside each supplier name.

l The rank is saved and displayed on the Scenario Breakdown page.
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Remove award from supplier on scenarios: An action for Remove Award From Supplier is
available for each supplier on the Scenario Navigation page when viewing a scenario that has
suppliers marked as Pending Award. Select the drop-down next to the supplier name to see the
option

l When selecting Remove Award From Supplier, you will be asked to confirm if you want to
remove all awards from the supplier in the scenario. If you do, the scenario updates with
the supplier no longer being marked as Pending Award.

l Any items that were awarded to the supplier in the scenario will now be marked as
Unawarded. If multiple suppliers were awarded the item, the supplier who was selected to
have the awards removed will no longer be listed as an awarded supplier for those items.

When a scenario is finalized, a Finalized button appears next to the scenario name. When viewing
all saved scenarios for the event, a Finalized button shows for the scenario that has been
finalized, and it cannot be deleted from the Load Saved Scenario page. A finalized scenario can
only be removed when viewing the scenario.

The Cost Per Quality Point row is displayed if configured for the event. The supplier must have
an average questionnaire rating for this value to show.

The Best Value Score row is displayed if configured for the event.

The Average Questionnaire Rating is displayed for each supplier if configured for the event. The
rating will show as Pending until the Questionnaire Close Date has passed, at which point the
average rating will show for each supplier.

An Auto Score row is displayed if auto-scoring is configured for event questions or additional line
items. To view auto-scores:

l Each supplier's total Auto Score for the bid is shown in bold under the appropriate supplier
column.

l Expand theQuestions row to view Auto Score Points assigned to suppliers based on
responses to event questions.

l Expand theQuestions: Line Items row to view Auto Score Points assigned to suppliers
based on responses to line item questions.

l Expand the Product Line Items or Service Line Items rows to view auto scores for all
product items or all service items.
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If Cost Analysis is configured for event questions or event line items, you may view a summary of
cost adjustments based on cost analysis configurations.

l Each supplier's Total Adjusted Bid is shown in bold under the appropriate supplier column.
It shows the sum of the supplier bid with cost adjustments from event questions and line
level questions applied.

l Expand theQuestions row to view cost adjustments assigned to suppliers based on
responses to event questions.

l Expand theQuestions: Line Items row to view cost adjustments assigned to suppliers
based on responses to line item questions.

l Expand the Product Line Items - Adjusted Bid row to view the sum of all product line
items with cost adjustments applied.

l Expand the Service Line Items - Adjusted Bid row to view the sum of all service line items
with cost adjustments applied.

l A Disallow/Reapply option, next to cost adjusted values, works as a toggle switch to allow
event evaluators to override cost adjustments. Changes to the setting cascade down to all
related values affected by the change:

l Click Disallow next to a cost adjusted value to remove a cost adjustment from an
item. Disallowedwill be displayed on all related items instead of the cost adjusted
value.

l Click Reapply next to a cost adjusted value to reapply a cost adjustment to an item.
Cost adjustments will be recalculated and displayed.

l Comments entered when a cost adjustment is disallowed or reapplied are recorded
in the history.

l An information icon will display next to an item when maximum values or bid thresholds
have been exceeded and an expected cost adjustment has not been applied. Click the
information icon next to an item to view details.

Award Scenarios for Multi-Stage Events
Options are selected on the Evaluation Calculation Options page to designate which scoring
options are available to be evaluated for the different stages. The configured options are then
displayed on the Scenario Navigator page.
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Perform Multiple Award Scenarios on an Event
You may select run different scenarios on supplier responses to an event and save those
scenarios for review by others before a final decision is made. You must have the Finalize Award
Scenarios or Create Award Scenarios permission in order to navigate to evaluations.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

1. Search for an Event with a status of Under Evaluation.

2. Select the appropriate event number you would like to evaluate to open the event details.

3. From the Supplier Responses page, select the Evaluation Actions dropdown, and select
to Evaluate All Responses. Alternatively, you may select specific suppliers on the page,
and select the link to Evaluate Selected Responses.

4. Click the View Scenario drop-down, and select from one of the common scenarios. View
results.

5. Click to Reset the page to have no scenarios.

6. Select to Sort Bids by various selections.

7. If Cost Per Quality Point (CPQP) was configured for the event, note the Cost Per Quality
Point score for each supplier. You may choose to sort the responses by lowest Cost Per
Quality Point score, or view a scenario for Lowest Cost Per Quality Point Score.

8. If Best Value scoring was configured for the event, note the Best Value Score for each
supplier. You may sort the responses by highest Best Value Score, or view a scenario for
Highest Best Value Score.

9. If a Panel Questionnaire was configured and the Questionnaire Close Date has passed,
note the Average Questionnaire Rating for each supplier.

10. Note the Auto Score and Cost Analysis information, if configured for event or event line
items. You may see the individual question score and cost adjustments when expanding
the question or item information.

11. Pick one of the suppliers and in the drop-down next to the supplier name, select to Pin it to
move it to the beginning of the table. You can select Unpin if desired.

12. Expand the product or service line items and evaluate responses on individual items. Select
the link for an item to view additional item details.
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13. Expand question information and evaluate responses.

14. Select one or more product and/or service line items, select the Actions for Selected
Items drop-down, and select one of the options.

a. The page refreshes with Pending Award noted for the supplier you selected for the
items.

b. The Award Scenario column displays the name of the supplier awarded for the
items.

c. The Scenario Breakdown tab now shows, where you can see the results of this
scenario.

15. Click the Save As... button and enter a name for the Scenario you just created.

16. You may select to Export the Scenario, or All Responses.

17. When satisfied with a scenario, click Finalize Award.

Export a Saved Scenario for an Event
When evaluating responses, you may choose to export a particular scenario view to share with
others or for further analysis. You must have the Finalize Award Scenarios or Create Award
Scenarios permission in order to navigate to evaluations.

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

1. Search for an event with a status of Under Evaluation.

2. Select the appropriate event number you would like to evaluate to open the event details.

3. Select the Supplier Responses page for the event.

4. Select the Load Saved Scenario button. From the list of Saved Evaluations, select the
Load button for the desired scenario view.

5. Once viewing the evaluation, click the Evaluation Actions drop-down and select Export
this Evaluation.

7. A confirmation indicates your export request has been submitted. Click the hyperlink
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message to navigate to the Sourcing > Sourcing Events > View Exports page.

7. A confirmation indicates your export request has been submitted. Click the hyperlink
message to navigate to the Sourcing > Sourcing Events > View Exports page.

8. Select the file name to open in Excel.

Return to Evaluator
The Return to Evaluatorworkflow action allows approvers of an event's recommended award
scenario to return that scenario back to the evaluator. The evaluator can re-examine the event
and submit a different award scenario for approval. The Approve/Close Without Awarding
Sourcing Events permission is required to perform this action.

The Return to Evaluator feature must be configured for your system.

1. Open the sourcing eventwith the award scenario to be returned.

Note: The event must be in the Under Evaluation status, have a finalized award
scenario, and be in a folder assigned to the appropriate approver. The action cannot
be performed if contracts have been created from the award scenario.

2. Click theWorkflow Actions and select Return to Evaluator.

3. Enter a comment in the open field and click Return to Evaluator.

The recommended award scenario is returned to the evaluator. A notification is sent to the
evaluator if they have opted into the Sourcing Event - Returned to Evaluation notification.

The finalized status of the original recommended scenario is removed, but all previously created
award scenarios are retained. The evaluator can then re-evaluate the scenario and submit a
different recommendation for approval.

Split Award Options

Note: The split-item award feature is disabled for an item when itsQuantity field is supplier-
controlled, as each vendor's submission is a stand-alone option for the buyer's
consideration.
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Split Awards Among Different Suppliers
Awards can be split by products or items among several different suppliers. Split Award is
available on all events, but it is optional for a user to award across supplier responses or to a
single supplier. Users may select item types, item groups or individual items for award to a
supplier.

l When an event is under evaluation and a user is evaluating supplier responses, an action is
available to Award to [Supplier Name], with an option available for each supplier being
evaluated.

l The evaluator will have the ability to select product line items and service line items
for the award option. For example, Product Line Item 1 may be selected to be
awarded to Supplier ABC, while Product Line Item 2 may be selected to be awarded
to Supplier FGH.

l No Award may be selected for one or more items. Line items that are not selected
for an award will be shown with a status of Unawarded. The evaluator must select
No Award or Award to [Supplier Name] for each item in order to complete the
event evaluation process.

l $0 Award - When the event does not have items to award the user may select
Award to [Supplier Name] which will award the event to the supplier in that
scenario. If the event has items, the user has the option to Award to [Supplier
Name] without selecting any items. This action will prompt the user to convert the
scenario into a No Item Award scenario. This scenario when awarded will award the
supplier(s) the event but not any items.

l From the View Scenario drop-down, the user can select to run the Lowest Bid Price Split
Award scenario, or the Lowest Cost Per Quality Point or Highest Best Value Score Split
Award scenarios if those features are in use for the event.

l This will automatically mark individual items as being awarded to the supplier with
the lowest bid, lowest cost per quality point, or highest best value score on that
item.

l If you have not included all suppliers in the current evaluation scenario, you will be
prompted to confirm if you want to run the scenario on all suppliers or only on the
selected suppliers in the evaluation. If you select to Run on All, the remaining
suppliers will be added to the evaluation scenario.

l When the award is split among different suppliers, each line item will show the supplier who
has been awarded the event in the Awarded Scenario column on the Evaluations page.
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Split Item Quantity Among Multiple Suppliers
The configuration to allow split item quantity awards is available at the work group and event
levels. For events that allow split awards, the Side-by-Side Evaluation page will include the
option to Split Between Suppliers. An overlay then allows the user to indicate the quantity of the
selected item(s) to award to each supplier being evaluated.

l Work Group configuration - Split Item Quantity Setting under the Work Groups Event
Setup tab, in the Bid and Evaluation section.

l Optional - Allow split item quantity is optional for all events in this work group.
Selection may be made at the event level. This is the default selection.

l All - Allow split item quantity will be enabled for all events in the work group. All
events in the work group will have the option enabled, but it is still optional for use in
the actual award process.

l Off - Allow split item quantity will be disabled for all events in this work group. No
events in this work group will have the option enabled, and the setting cannot be
changed on the event.

l Events configuration - Allow Split Item Quantity in Evaluations setting under Bid and
Evaluation section of Event Setup page:

l If the work group setting isOptional, the event may be configured as Yes or No. If
Yes is selected, split item quantities may be awarded for the event.

l If the work group setting is Yes, the event will display a read-only setting of Yes. It is
optional for use in an award scenario.

l If the work group setting is No, the event will display a read-only setting of No. You
will not have the option to split item quantities among suppliers.

When the event is configured to allow split items, an option to Split Between Suppliers is
available in the Scenario Award Actions dropdown list on the Scenario Navigator tab.

l When Split Between Suppliers is selected, a Split Item overlay displays. In this overlay,
you may assign a quantity for each supplier in the scenario. Once you save the assigned
quantities, the page displays the number of suppliers awarded for the item in the Awarded
Scenario column. You may click on the number of suppliers indication to see the details of
which suppliers were awarded specific quantities.

l  You do not have to award the exact quantity of the item listed. You may award more or
less. The quantity awarded displays as you enter values.
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Split Item Quantities by Percentage Among Multiple
Suppliers
Buyers have the option to split awards by quantity count or quantity percentages. This option is
performed with the link called Allow Split by Percentage, which appears on the Split Item screen
overlay. When this link is selected, a column to assign award percentages appears on the Split
Item overlay. Note:When percentage splits are activated, the link changes to Disallow Split by
Percentage. Clicking this link removes the Assigned % column and deletes any entries in the
column.

Follow these steps to split award quantities by percentages:

1. Navigate to the Supplier Responses page in an event that has been configured to
Allow Split Item Quantity in Evaluations and that has supplier responses to
evaluate.

2. Select the suppliers to evaluate.
3. Expand the Evaluation Actions drop-down and select an evaluation option.
4. Select a split award scenario option from the View Scenario drop-down.
5. Select the appropriate items.
6. Expand the Scenario Award Actions drop-down and select Split Between

Suppliers.
7. Click the Allow Split by Percentage link on the Split Item overlay and enter the

appropriate percentages into the Assigned % column. If applicable, click Next and
repeat this process until all items have been awarded.

l When percentages are entered into the Assigned % column, the
Assigned Quantity is automatically calculated and entered into the
appropriate column. The Assigned Quantity numbers are always
rounded to a whole number, which can result in an adjustment in the
percentage allocation entries to ensure that percentages match the
quantity allocation.
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l Percentage allocations cannot add up to a total greater than 100%. If
the number of items awarded is greater than the number of items
defined in the Sourcing event configuration, awarding must be
managed with Assigned Quantity.

l Dynamic messaging appears above the item list on the Split Item
overlay to keep users updated about the total percentages allocated
and the remaining percentages to be awarded.

8. Click Save and Close.

Award a Single Item to Multiple Suppliers
This option is available on the side-by-side evaluation page for all events. No configuration is
required to have this option.

Once an item has been awarded to a supplier and the item is selected to be awarded to a
different supplier, an overlay indicates Item(s) have already been awarded. You then have the
option of confirming the item award to the additional supplier or changing the award to only the
newly selected supplier.

Creating Carts and Requisitions from
Sourcing Events

Configuration
The eProcurement section of General Sourcing Settings contains two configuration options for
sourcing events with requisitions:

l The Awarded Event Creation Setting controls the options a user will have when selecting
to initiate an eProcurement process from an awarded event.

l Carts and Requisitions - The default selection, which will allow users to create
either a Cart or Requisition from an awarded sourcing event.

l Carts Only - Will give the user the option to create a cart from a Sourcing Event, and
no option to create a requisition.
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l The Default Procurement Request (PR) allows special handling of the created
Requisition. Items will be mapped from the sourcing event to the new requisition via the
form, and appear as a line item within the requisition.

l If a Default form is not used, you may choose one of your own organization PRs as
the form that will be populated with the appropriate sourcing event item information
(including product description, unit of measure, quantity, and unit price). Forms
available for selection include your organization requests that have the following
properties:

l they are active

l they do not have Limit Supplier Selection enabled

l they are not multi-line

l You do not have to select a request. If you do not select a default form, all of the
referenced items will show in the requisition as non-catalog items.

Initiating the Procurement Process
When a Sourcing Event has been awarded to one or more suppliers, a user may choose to Initiate
Procurement Process from the Event Actions drop-down.

If the sourcing event originated from a purchase requisition, the user may have the option of
creating a purchase requisition OR a shopping cart, depending on the organization's Award
Event Creation Setting. If the event originated from Sourcing, the user can create a shopping
cart, without the option of creating a purchase requisition. You will also be given the opportunity
to designate a different Prepared by/For user.

The appropriate document will be created in eProcurement with details from the sourcing event
such as item information, awarded supplier, and delivery dates, according to the configured
Default Procurement Form. The Sourcing Event will display, within the event navigation panel,
appropriate identification information for carts or requisitions created in eProcurement.

Event-awarded items that are part of a requisition will display an icon to visually indicate that
the items were awarded from a sourcing event.

When a requisition has line items that require sourcing and items that do not, then all non-sourced
items are included in the created Purchase Order, and all sourced items will continue through the
fulfillment process.

l A purchase order will be created that includes only the non-sourced items, and the original
Requisition will be marked as Complete.

l The sourced items will be managed through the assigned sourcing event, and ultimately be
procured through a new requisition.
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You may search for requisitions and events based on their relationship to each other and where
the document originated.

Users may want to enable the notification preference for PR created from an Awarded
Sourcing Event in order to receive an email and/or in-application notification when a PR is
created from an awarded event.

Create a Cart or Requisitions
For a sourcing event that originated from Sourcing

1. Access the Awarded event and navigate to the Supplier Responses page.

2. From the Event Actions drop-down, select Initiate Procurement Process.

a. An overlay displays confirming you will be creating a shopping cart.

b. If appropriate, select a different user for whom the cart will be created, and click
Continue.

3. The page refreshes, indicating the created document number in the event information.

4. You may navigate to the cart in eProcurement and note the Sourcing Event reference.

5. Finish adding any appropriate details to the cart and submit for approval.

For a sourcing event that originated from an eProcurement Requisition

1. Access the awarded event and navigate to the Supplier Responses page.

2. From the Event Actions drop-down, select Initiate Procurement Process.

a. An overlay displays, allowing you to choose to create a shopping cart or requisition
(if your organization allows either document).

b. If your organization only allows the creation of shopping carts, you will not see an
option to choose.

3. The page refreshes, indicating the created document number in the event information.

4. You may navigate to the document in eProcurement and note the Sourcing Event
reference.

5. Finish adding any appropriate details to the cart and submit for approval.
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Note: A Quick Quote template setting called Automatically Create Awarded PR provides
users with the option to have a purchase requisition auto-generate from an awarded Quick
Quote event. PRs can only be generated from awarded events that were initiated from a PR.

Initiating Contracts for Awarded Events
Organizations can take advantage of an integration between the Sourcing and Contract Director
solutions that allows users to initiate contracts in Contract Director from within a sourcing event.
When this integration is in place, Sourcing users with the Initiate Contract Process permission
can initiate a contract from a sourcing event and monitor contract details from within the sourcing
event as it moves through the Contract Director workflow. Users may choose to enable the
Notification Preference for An Event-initiated CD Contract status has changed in order to be
notified when changes occur with a contract associated with one of their sourcing events.

Once an event has reached an Under Evaluation status, and a finalized Award Scenario exists,
users with the permission will see a link to Initiate Contract Process on the Scenario
Breakdown page for each supplier awarded in the scenario.

l Upon selecting the link, the user enters a Contract Title, chooses a template or contract
option, confirms the assigned Contract Manager, verifies the second party (the supplier),
and selects the event items to be included in the contract. If the event items are irrelevant
to the contract, you can select None instead of selecting items.

l All items to be delivered by a specific supplier can be associated on a single contract, or
items can be distributed across multiple contracts. Each item can be associated with only
one contract.

l Once the parameters for the contract creation are chosen, the user selects the Add
Contract button. This initiates a contract within the Contract Director application.

A column for Contract Number & Status shows on the Scenario Breakdown page. The status
will show as Pending until the contract has been created in Contract Director.

Once the contract has been created, the user can see the status of the contract as it moves
through the Contract Director workflow.

l Contract numbers show as links on the Scenario Breakdown page. Selecting a link allows
the user to see the status and basic information about the related contract from within the
event. Information displayed includes Contract Number, Title, Type, Contract Manager,
2nd Party/Supplier ID, Contract Status, and Start/End Dates.

l Users with the appropriate permission will also see a link in the overlay to Go to Contract
within Contract Director. When selected, the user is navigated to the contract in the
Contract Director application.
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The following line item information is passed from the sourcing event to the contract: Item Name,
Description, Catalog Number, quantity, unit of measure, commodity code, unit price, total
price, customer requested delivery date, supplier's estimated delivery date, and start/end
dates for service items. In addition to item information, some supplier attachments provided to
the event are passed to the contract as attachments within Contract Director.

Initiating the Contract Process on the Scenario Breakdown
Page
Once the basic contract information is added, a new column displays on the Scenario
Breakdown tab, indicating Contract Number & Status.

Once the contract has been initiated in Contract Director, a contract number is displayed on the
page. Select the contract number to see an overlay with basic contract information, including
status in Contract Director. Users with the appropriate permission will see a link in the overlay to
Go to Contract within Contract Director to navigate to the Contract Director application.

If errors occur during the contract initiation process, users can navigate to Find and Fix Errors >
Contract Director Contract Initiation Exports. This page allows users to monitor and respond
to issues related to the creation of Contract Director contracts that are initiated from Sourcing.

Contract Status
The following contract status indicators will display on the Scenario Breakdown page for a
contract initiated from Sourcing:

l Pending - The contract has been initiated, but has not yet been created within Contract
Director.

l In Process - The contract has been successfully created in Contract Director and is
currently being managed through the Contract Director workflow process.

l Fully Executed - The contract has successfully completed the Contract Director workflow
process.

l Canceled - The contract negotiation process either failed or was terminated within
Contract Director.

l Error - The contract has been initiated from Sourcing, but the contract creation process
failed within Contract Director.



JAGGAER 237 www.JAGGAER.com

The Contract Status displayed on the Scenario Breakdown page is different from the client-
defined contract status in the Contract Director application. The client-defined status is
displayed in the Detailed Contract Status field when viewing the basic contract information
from Sourcing.

Initiating Contract Director Contracts from Sourcing
If your organization has the Contract Director solution, then you may choose to initiate a contract
from an event. You must have the Initiate Contract Process permission to perform this task. This
task assumes you have a saved Scenario for the event.

1. Search for an event with a status of Under Evaluation.

2. Select the appropriate event number.

3. Select the Supplier Responses page for the event.

4. View a scenario breakdown by either of these methods:

a. If the banner message indicates You may view the scenario breakdown, select
the scenario breakdown hyperlink to navigate directly to the scenario breakdown
page.

b. Click Load Saved Scenario and select the appropriate Scenario to view. Once you
are viewing the appropriate Award Scenario, select the Scenario Breakdown page.

5. When the selected Award Scenario has been finalized, a link to Initiate Contract Process
is listed for each supplier with an award in the scenario. Select the hyperlink.

a. Enter a Contract Title.

b. Select the appropriate Contract Option.

c. Note the default Contract Manager to be assigned to administer the contract within
Contract Director. If this default assignment is inappropriate, select a different
contract manager to replace the default option.

d. Verify the 2nd Party (supplier) for the contract. This information is read only.

e. Select the Items to Include in Contract

i. Select All Items to be Awarded to this Supplier if you want to include all the
items in the contract.

ii. Select Let Me Pick if specific items from the award should be on the contract.
You will then have the option to select from the list of items to be awarded to
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the supplier.

iii. Select None if the contract to be generated has no relevance to items being
sourced.

6. Select Add Contract.

7. The page refreshes, exposing the new Contract Number & Status column. Once a
contract number is generated in Contract Director, a contract number and status will
display in the column.

8. Click the Contract Number to see a summary of the contract information and status.

Initiating Contracts+ Contracts for Awarded Events
If your system is integrated with the JAGGAER ONE Contracts+ solution, you can create contracts
from a Sourcing event. Once the contract creation process is initiated in Sourcing, a contract will
be automatically created in Contracts+. Contracts include event attachments submitted by the
buyer and supplier from Sourcing (in the file format), and line items that are part of the event
negotiation.

When this integration is in place, Sourcing users can initiate a contract from a sourcing event, and
monitor contract details from within the sourcing event as it moves through the Contracts+
workflow. Users require the Initiate Contract Process permission, appropriate Contracts
permissions, and to be added as users on the Contract Users tab of the appropriate Sourcing
Work Group.

You can create a contract that contains all items from an event, multiple contracts for an event
(each contract containing one or more items), or contracts with no items. As items are added to a
contract, they are removed from selection, so that an item from an event can only be included
once in a contract.

In Sourcing, contract creation must be initiated when an event is in Under Evaluation status. Click
the Finalize Award button on an Under Evaluation contract and the Create Contract link will
appear. Click the Create Contract link next to the Supplier Total field on the right side of the
screen to open the Create Contract wizard.

Initiating Proforma Contracts with Contracts+
Proforma documents are first drafts of contracts. A proforma contract contains the basic
elements of a contract and outlines the terms and conditions that a supplier must adhere to if
they are selected, but it does not include specific details. Proforma contracts are attached to a
question in an event. Suppliers can download and review the potential agreement and make
changes that may eventually be a part of the official contract.
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When proforma contracts are attached to a sourcing event, the proforma contract can be
downloaded by suppliers bidding on the event. During the question and answer process,
suppliers review, edit and return the proforma document to the event manager. The event
manager can use the document as part of the overall evaluation process. Once the award has
been determined and it is time to create a contract, the proforma document can be used in the
contract creation process.

Best Practice: Draft Proforma Contracts

We recommend that you create a dedicated proforma contract Work Group and keep a set of
proforma contracts in indefinite Draft status for use with sourcing events. For systems using the
authoring feature, you can also use templates to create proforma contracts.

The Proforma Contract Process from Start to Finish

Note: The event manager must be a contract manager explicitly named on the draft contract
OR be an administrator on the Work Group.

1. (optional) A dedicated Proforma Work Group is created with a set of proforma contracts.

2. When an event manager creates a sourcing event, there is an option to include a proforma
contract with the event as a question type. The event manager can attach a draft proforma
contract from the system or upload their own file. Event managers can make completion of
the proforma contract required.

3. Suppliers bidding on the event download the proforma contract, make the additions and
changes (redline), then upload the redlined document and send it with their response.

4. The event manager reviews the redlined document submitted by the supplier as part of the
evaluation process.

5. If the supplier is awarded the bid, when a contract is created from the event, the redlined
proforma contract can be used as the first draft of the official contract.

Create a Sourcing Contract with a Proforma Document as First Draft

You must have the permission Permissions > Sourcing > Initiate Contract Process. You must
also have the appropriate Contracts permissions, and to be added as users on the Contract
Users tab of the appropriate Sourcing Work Group.

The event must be in Under Evaluation status with a saved scenario.
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1. Log into JAGGAER ONE.

2. In the left menu, navigate to Sourcing > Search Events. The Search Events page
displays.

3. Search for and select the event you want to create a contract for. The event must be in
Under Evaluation status with a saved scenario.

4. Under the Supplier Responses heading, click the Load Saved Scenario button. The Load
Saved Scenario window opens.

5. Click the Load button to the right of the scenario you want to create a contract for. The
scenario opens.

6. Click the Scenario Breakdown tab.

7. Click the Finalize Award button. The Create Contract link appears. Note: The Create
Contract link is only available after you click Finalize Award and if you have the
appropriate permissions. If you click the Remove Finalize Award button, the link will
disappear.

8. Click the Create Contract link next to the Supplier Total field on the right side of the
screen. The Create Contract wizard opens.

9. Complete the following fields for the contract header:

l Contract Name – The name of the sourcing event automatically populates the field
by default. Change the name of the contract if needed.

l Contract Type – Select a contract type and click Save Changes.

l Work Group - Select a Work Group.

l If your system has language settings enabled, select a Contract Language.

l Access and Visibility – Select Normal to define access to the contract fromWork
Group settings and user permissions. Select Confidential to select each user who
can access the contract.

10. Click Next.

11. In the Template field, select Upload Supplier Returned Proforma to use the document
redlined by the supplier as the Main Document on the contract. A list of redlined
documents returned by the supplier is displayed.

12. Select the document that you want to use as the Main Document on the contract.

13. Click Next.

14. If your system requires that you enter contract numbers manually, enter a contract
number.
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15. (optional) Enter a Time Zone, Start Date and End Date and click Next. Note: You can
leave these fields blank and complete them later.

16. Under Items to Include in Contract, select one of the following options:

l None – You may choose to create a contract with no items.

l All Items to be Awarded to this Supplier – Select to create one contract that
contains all items from the event.

l Let Me Pick – Select to create multiple contracts for the event, each contract
containing one or more items that you choose. As items are added to a contract,
they are removed from selection, so that an item from an event can only be included
once in a contract.

17. If you have chosen Let Me Pick, select the checkbox next to each item you want to add to
the contract.

18. Click Create Contract. Once created, the contract number and status are displayed
underneath the appropriate item.

19. (optional) If you have chosen Let Me Pick, repeat the steps above to create more
contracts for the event.

20. Click on the contract number to open the contract from the sourcing event.

21. Click Go to Contract. The contract opens. You can view the uploaded supplier document
by selectingOpen Main Document in the left menu or by clickingMain Document on the
Attachments page.

22. Complete the remaining contract information and submit it for approval.

Review Redlined Proforma Contract as an Event Manager

1. Open the sourcing event with the proforma contract question.

2. Click View Responses.

3. Click the View Response button next to the supplier with the submitted response.

4. ClickQuestions in the left menu.

5. Click the link to the redlined document attached by the supplier. It will appear
underneath the original proforma contract link sent with the event.

6. In the REVIEW ribbon, make sure All Markup is selected.

7. Review supplier changes.
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Review and Redline a Proforma Contract as a Supplier

1. As a supplier, open the event.

2. ClickQuestions in the left menu.

3. Under the proforma question, click the proforma contract link and download the
document to your local drive.

4. Open the document and click Enable Editing.

5. Click REVIEW in the top ribbon and make sure Track Changes is turned on.

6. Revise text and add comments, then save the revised file.

7. Return to theQuestions page in the event, and under the same question that you
downloaded the document from, click Upload.

8. Click Choose File, search for and select the redlined proforma contract on your local drive,
then click Save Changes. The document is uploaded and appears as a link underneath the
proforma question.

9. Continue creating your response. Once it is complete, click Review & Submit in the left
menu.

10. Click the checkbox next to "I certify that the statements and information in this response
are true and correct to the best of my knowledge and belief".

11. Click Submit Response.

Initiating Contract Manager Repository Contracts from
Sourcing
If your system is integrated with Contract Manager Repository (CMR), you can create contracts
from an event. You must have the permission Permissions > Sourcing > Initiate Contract
Process. Users must also have appropriate Contracts permissions, and to be added as users on
the Contract Users tab of the appropriate Sourcing Work Group.

1. In the left menu, navigate to Sourcing > Sourcing Events > Search Events. The event
search page opens.

2. Search for and select the event you want to create a contract for. The event must be in
Under Evaluation status.

3. Under the Supplier Responses heading, click the Load Saved Scenario button. The Load
Saved Scenario window opens.
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4. Click the Load button to the right of the scenario you want to create a contract for. The
scenario opens.

5. Click the Scenario Breakdown tab.

6. Click the Finalize Award button. The Create Contract link appears. Note: The Create
Contract Process link is only available after you click Finalize Award and if you have the
appropriate permissions. If you click the Remove Finalize Award button, the link will
disappear.

7. Click the Create Contract link next to the Supplier Total field on the right side of the
screen. The Create Contract wizard opens.

8. Complete the following fields for the contract header:

l Contract Name – The name of the sourcing event automatically populates the field
by default. Change the name of the contract if needed.

l Contract Type – Select a contract type and click Save Changes.

l Access and Visibility – Select Normal to define access to the contract fromWork
Group settings and user permissions. Select Confidential to select each user who
can access the contract.

l Click Next.

l Select aWork Group for the contract and click Next.

l Select a template or upload a document that will be used as the main contract
document and click Next.

l Complete the contract number, Time Zone, and start and end date fields, and
click Next.

9. Under Items to Include In Contract, select one of the following options:

l All Items to be Awarded to this Supplier – Select to create one contract that
contains all items from the event.

l Let Me Pick – Select to create multiple contracts for the event, each contract
containing one or more items that you choose. As items are added to a contract,
they are removed from selection, so that an item from an event can only be included
once in a contract.

l None – You may choose to create a contract with no items.

10. If you have chosen Let Me Pick in step 10, select the checkbox next to each item you want
to add to the contract.

11. Click Create Contract.
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12. (optional) If you have chosen Let Me Pick in step 10, repeat steps 9 to 12 to create more
contracts for the event.

Sourcing Management

Event Workflow

Overview
When an event is first created but has not yet been submitted for approval, it is considered to be
in Draft status. At this stage changes can still be made to the event:

l Update an event (add items, suppliers, change information, etc.)

l Delete an event.

Once an event is complete and all required elements have been added to it (for instance, Items
added to a Request for Quote), that event is ready to be submitted for approval. Users with
permission to do this task can click Submit for Approval on the Review and Submit page. The
event is now Pending. At this stage, the event is still not finalized, so all the changes to the event
noted above can still be made.

The event must be approved before it can be Released to and Open for responses from suppliers.
Who performs which workflow actions will depend on how roles/permissions and workflow
processes are configured for your organization. See "Sourcing Workflow " on page 331 for more
information on workflow configuration.

Once an event is in a state of Pending, any user with access to approve events will see an option
to Approve or Assign to Myself. Once the Event is assigned to you, you have different options
depending on your user permissions.

l Approve - Approves the current step and moves the event to the next workflow step. If
this is the final step in workflow, the event will be released to suppliers upon the Release
Date.

l Forward to - Select another approver to forward the event to for review.

l Put on Hold - This keeps the event assigned to the current user and cannot be modified by
any other approver.
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l Reject - This action rejects the event and it will not move further in workflow. The event
will not be released to suppliers.

l Return to Shared Folder - This returns the event to the appropriate shared folder where
another user can assign it or take action. It will no longer show in your My Approvals folder.

l Return to Draft - This returns the event to a Draft status so that updates can be made.

Once an event passes beyond the Pending status in event workflow, only the suppliers invited to
the event can be edited. A user may Amend an event if other changes must be made while it is
Open. An event can be Canceled before it is released to suppliers or withdrawn after it is available
to suppliers.

An event remains in an Open status until it reaches the Close date/time or is closed early by a user
with permissions to do so. In a Closed state, the event enters Evaluation Workflow where it will be
Awarded by users with appropriate permissions.

Note: Approvers DO NOT automatically have the ability to edit an event that is in an assigned
approval folder. If the approver is an Event Creator on the event, they can edit the event during
the approval process. If the approver is not listed as an Event Creator for the event, the user can
only take approval actions but cannot edit the event.

Ad Hoc Approvals for Sourcing Workflow
The Ad Hoc Approver feature allows an evaluator to send a sourcing event request to a user who
is not in the regular workflow for a one-time approval. The ad hoc approver can approve the
request to send it to the next workflow step or return it to the evaluator. The ad hoc approver
feature can be used to add, edit, and delete ad-hoc approver steps anywhere in these workflows.

The organization must be configured to allow ad hoc approvals for sourcing event requests. Also,
users involved in this process must have permission to assign an ad hoc approver and/or
permission to complete an ad hoc approval. See Enabling Ad Hoc Approvals for Sourcing Events
in "Sourcing Workflow " on page 331 for additional information about configuration.

Add an Ad-Hoc Approval Step
1. Navigate to a sourcing event that is in the midst of a workflow process:

l For approvals workflow, navigate to a Sourcing event that is in Pending status and
click on Tools > Approvals in the left navigation bar.

l For evaluation workflow, navigate to a Sourcing event that is in Under Evaluation
status and click on Tools > Approvals in the left navigation bar.
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2. Expand theWorkflow Actions drop-down in the top-right corner of the Approvals page
and select Add Ad-Hoc Step:

3. An Ad-Hoc Step screen overlay appears. Search for the appropriate approver name in the
Ad-Hoc Approvers drop-down.

4. Optionally, add instructions or context in the Comments box. This text will be visible to the
approver.

5. Click Save to close the screen overlay.

The new ad-hoc approval step is added immediately after the currently active workflow step.
When the current approval step is completed, the new ad-hoc step is activated.

l To edit an ad-hoc approver step that has not yet occurred:

1. Expand the Request Actions dropdown and select Edit Ad-Hoc Step.
2. Select the Ad-Hoc Step to edit from the dropdown.
3. Edit the Ad-Hoc Approvers, if needed.
4. Edit the Comments, if needed.
5. Click Save.

l To delete an ad-hoc approver step that has not yet occurred:

1. Expand the Request Actions dropdown, and select Delete Ad-Hoc Step
2. Select the Ad-Hoc Step to delete from the dropdown.
3. Click Save.

Perform an ad-hoc approval
1. Ad-hoc approvers receive an email notification alerting them that an event requires their

approval. Approvers can access the approval page through the link contained in the email,
or by navigating to Sourcing > Sourcing Events > Souring Events Home and clicking
My Sourcing Events to Approve.
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2. Access event Settings and Content through the left navigation bar within the Sourcing
event. To ensure that ad-hoc approvers have the necessary information to carry out their
approvals, they have access to all relevant event pages.

3. Expand theWorkflow Actions drop-down on the event's Settings and Content page and
select Approve. For additional options, select Assign to Myself.

4. If evaluators click Assign to Myself, additional options become available for them in the
Workflow Actions drop-down:

l Approve

l Close Without Awarding

l Create New Quick Quote Stage

l Create New Stage

l Put on Hold

l Return to Evaluator

l Return to Shared Folder

Note: Ad-hoc approvers cannot forward the approval responsibility to another
ad-hoc approver.

l If the ad-hoc evaluator returns the Sourcing event to the evaluator, the ad-hoc step is
removed from the workflow.

l Ad-hoc evaluation steps are documented in the event's Event History. Click the History
link in the top-right corner of a Sourcing event page to view this log.

Search for Ad-Hoc Approvals
It is possible to search for events that contain ad-hoc approval steps:

1. Navigate to Sourcing > Sourcing Events > Search Events.

2. Click the link for Advanced Search (located below the search box).

3. Scroll to the Status Flags section of the search page.

4. Select the checkbox forWith Ad-hoc Approvals.
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Manage Events

Amend an Event
Users can edit an event in Draft status. Once an event has been approved and has been Opened
or Released, any changes to the event must be made by Amending the event. Examples may be
to add or remove a user to an event or to add an item to the products or services list.

A user must have Create/Own Events orManage Work Group Events permission in order to
have the ability to amend the event. The user must also have the ability to edit the event as an
Event Owner or an Event Manager.

1. Search for and select an event that has been Opened or Released from the search results.

2. Expand theWorkflow Actions drop-down and select Amend.

3. A text box appears in which users can add an amendment reason.

4. Note that the Event Type,Work Group, and Currency cannot be edited. Custom fields
can be edited.

5. Edit values for the event as appropriate.

6. On each page, click Save Progress to save your changes.

7. Click Confirm to amend the event.

Once you confirm to amend the event:

l The event is placed in Draft status. A message shows at the top of an Amended Event
indicating the event is being amended.

Note: If the only change to an amended event is the Target Price for one or more
items, the event is not placed in Draft status, emails are not sent to suppliers, and the
audit log for the event indicates that an amendment was completed.

l If changes to any event prerequisites, questions, items, or additional item fields have been
made, supplier responses to the modified fields are removed. Changes to other fields,
including custom fields, do not affect supplier responses.

l Emails are sent to suppliers, notifying them that the event is being amended.

l The audit log for the event captures the configurations for the amendment from the original
event.
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Once the amended event is created, you will see it in search results with an Amended icon .
You can also continue to access the original event.

When approving an Amended event, you will receive an Alert: This event is currently being
reconciled for an amendment. Please try again in a few minutes. After reconciliation with the
original event has occurred, the amendment is considered completed.

Once the amended event is approved and reconciled with the original event, you will only see one
(the updated) instance of the event in search results. Since it has been approved and reconciled,
it is no longer considered an Amended event.

You may select to enable the notification when an event has completed the Amendment approval
process. "Notifications" on page 20 for details. If enabled, suppliers associated with the event will
receive an Amendment Completion email and the amendment reason will be included in the Email
Template for this email, so long as the amendment reason placeholder field has been added to
the amendment email template.

Cancel an Event
An event may be canceled if it has been approved but has not yet reached the Open or Release
date (is not visible to suppliers). A user must have the permission to Approve/Reject Sourcing
Events in order to see the Cancel action.

1. Search for an Event with a status of Approved; one that is not yet visible to suppliers.

2. Select theWorkflow Actions drop-down, then select Cancel Event.

3. The event is canceled. The action is captured in the audit log and is available by selecting
the History hyperlink.

4. The event will not be made available to suppliers. You may choose to Archive the event so
it will not be visible in event search results by default.

Formulti-stage events, if an event stage is canceled before it is released, the previous stage
becomes active.

Note: Once the event is visible to suppliers, the Cancel Event action is no longer available.
At that point, the user can choose toWithdraw the event instead (with the appropriate
permission).

Withdraw an Event
An event may be withdrawn if it has been approved and is Opened or Released (visible to
suppliers). A user must have theWithdraw Events permission to see theWithdraw action.
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When an event is Withdrawn, the supplier will see that the event has been canceled and they
cannot respond to it.

1. Search for an Event and select an event that has been Opened or Released.

2. From theWorkflow Actions button dropdown, selectWithdraw Event.

3. A message displays asking you to confirm that you would like to withdraw the event. Click
Yes to confirm.

4. The event is now withdrawn and suppliers do not have access to respond.

5. Changes are captured in the audit log for the event, and can be viewed by selecting the
History hyperlink.

Close an Event Early
Once an event is Open, you may choose to close an event early if the event is no longer valid. A
user must have Close Events Early permission in order to have the ability to close the event.

When the event is Closed Early, the supplier will see that the event has been canceled and they
cannot respond to it.

1. Search for and select an Open event.

2. From theWorkflow Actions button dropdown, select Close Event Early.

3. A message displays asking you to confirm that you would like to close the event. A textbox
is available for documenting the reason for the early closure. Note: It is recommended that
you document the reason.

4. Click Yes to confirm.

5. The event is now closed. Suppliers receive an email alerting them to the event status
change. Suppliers may view the event, but they do not have access to respond to it.

6. Changes are captured in the audit log for the event, and can be viewed by selecting the
History hyperlink.

Extend an Event
Once an event has been approved and has been Opened or Released, you may edit some of the
event dates by choosing to Extend the Event. A user must have Create/Own Events orManage
Work Group Events permission in order to have the ability to Extend the event. The user must
also have the ability to edit the event as an Event Owner or an Event Manager.
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Note: You cannot extend an amended event. The event must first complete the amendment
before Extend Event is available.

1. Search for and select an event that is Opened or Released and for which you are the Event
Owner or an Event Manager.

2. From the Event Actions drop-down, select Extend Event.

3. An Extend Event overlay displays with the option to change the following:

a. Close Date - You may select a different close date and time.

b. Sealed Bid Open Date - This option is available if your event is configured to use
Sealed Bids. Select to edit the date and time, or to be the same as close date for the
event.

c. Q&A Submission Close Date - You may extend the event without updating this
date. If desired, you may select a different date and time, or you can choose to
assign the same date as the close date for the event.

Note: You may select to enable the notification when event dates have been
extended. See "Notifications" on page 20 for details.

4. Click Save Changes.

5. The updated dates are reflected in the event.

6. Changes are captured in the audit log for the event, and can be viewed by selecting the
History hyperlink.

Reopen an Event
Once an event is Closed or Under Evaluation, you may choose to modify the close date by
selecting to Reopen Event. Users must have the Reopen Events permission in order to have the
ability to perform this action. Users must also have the ability to edit the event as an Event Owner,
Event Manager or Event Awarder.
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1. Search for and select an event which has a status of Closed or Under Evaluation and to
which you have edit rights as Event Owner, Event Manager or Event Awarder.

2. From theWorkflow Actions drop-down, select Reopen.

3. An Extend Event overlay displays with the option to change the following:

a. Close Date - You may select a different close date and time.

b. Sealed Bid Open Date - This option is available if your event is configured to use
Sealed Bids. Select to edit the date and time, or to be the same as close date for the
event.

c. Q&A Submission Close Date - Select a different date and time, or to be the same
as the close date for the event.

Note: You may choose to enable the notification when events have been
reopened. See "Notifications" on page 20 for details. Suppliers and users
associated with the event are sent notifications that the event has been
reopened.

4. Click Save Changes.

Archive an Event
An event may be archived if you do not want it to show in search results by default. An event that
has been Canceled, Withdrawn, Awarded, or Closed Without Awarding (when an event is rejected
in Evaluation Workflow) may be archived. A user must have the Archive Events permission in
order to see the Archive button on an event.

1. Search for an event that has been withdrawn, canceled, or awarded.

2. Select the event to view details.

3. Select theWorkflow Actions drop-down and select Archive.

4. The page refreshes and the event is now archived. The archive action is captured in the
audit log and available by selecting the History hyperlink.

5. To remove the event from archive, click the Restore from Archive button on the event.

You can view archived events by choosing to Include Archived Events in advanced search of
sourcing events. You can select Restore from Archive if you want the event to be visible by
default to users.
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Delete an Event
An event may be deleted if it is in a Draft status, the user has the appropriate permission, and is
an Event Owner for the event.

The goal of this task is to delete a draft event.

1. Search for and select an event from search results.

2. From the Event Actions drop-down, select Delete.

3. A confirmation message is displayed. It contains the question: Are you sure you want to
delete this event. Select Yes.

4. The page is refreshed and the user is returned to the Sourcing Events Home page. The
event has been deleted.

Managing Multi-Stage Events
The multi-stage event functionality allows customers more options in the supplier selection
process. If the work group for the event is configured to allow multi-stage events, buyers can
initiate a new stage for an event before it is awarded. Most event content is carried to the next
stage. Questions, prerequisites, and attachments are not copied. Panel Questionnaire questions
can be optionally carried over.

Buyers can choose which suppliers are included for subsequent stages. If an event contains
multiple stages, a View Event Stages hyperlink displays in the left event navigation. You may not
award the event from the previous stage once you create a new stage. However, if you cancel a
current stage (before it is approved to be released to suppliers), you may award from the previous
stage.

The buyer has the ability to choose analysis options (questionnaire, auto score, and cost analysis)
from the different event stages that they want to use in the evaluation using the Evaluation
Calculation Options in Event Navigation. See "Evaluation Calculation Options" on page 199 for
more information.

Suppliers will have visibility into the multiple event stages only if they are invited to participate in
those stages. On a customer public site, previous stages of events will show as Closed, but the
initial event stage PDF will continue to be available. Suppliers will have the ability to respond only
to the current stage of an event if they are selected to advance and bid on it. Previous stages will
display for suppliers as read only.
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External Event Stages
When you create a new stage, you may tag suppliers for the next stage on the Supplier
Responses page. You may also choose to refine the supplier list after the next event stage is
created.

When you create a new stage, the Create New Stage overlay opens with the following options:

l Stage Title - If the initial stage title was left blank, you will be prompted to add a stage title
for the previous stage. Note that once saved, the initial stage title cannot be changed.

l Internal Stage - Default is No. If you would like the new stage to be an internal stage,
select Yes. You are able to incorporate an internal evaluation / review stage into the course
of a multi-stage event, so that an event round can be conducted that requires no direct
input from eligible suppliers.

l Event Type - An event type is crafted with varying content and collateral sections. It is
constructed based on the set of objectives for which the event type is being created.
Collateral sections that can be optionally integrated into an Event Type are prerequisites,
attachments, questions, and items.

l Create from Template - Templates are used to efficiently create events of the same
construct, so you don't have to manually enter common information for each such event
created.

l Transfer PQ Questions to New Stage? - Select whether or not to transfer panel
questionnaire questions to the next stage of the event.

Once you confirm the action to create a new stage, you are navigated to the setup page of the
new stage. Here are some details regarding what is populated and what may be edited for the
new event stage:

l Event Number remains the same as in the original event.

l Stage Title is now required.

l View and navigate to all the event stages from the View Event Stages hyperlink in the left
navigation pane.

l Commodity Codes - The Reporting and Additional Commodity codes may not be edited in
subsequent stages. However, the item level commodity codes may be edited. If an item
with a commodity code is added in a subsequent stage of a multi-stage event, the supplier
count will not be updated and new supplier invitations will not be issued automatically for
that event.
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l Bid and Evaluation - The settings for responding by proxy, sealed bid, alternate items,
panel questionnaire, auto score and cost analysis use, and allowing partial quantity awards
may not be changed.

l A Stage Descriptionmay be entered on the Description page, providing additional
information about the new, specific stage. You may choose to alter the Description for the
original event as well.

l Event usersmay be altered for the current stage. Users from the initial stage may be
removed and new users may be added; however, inherited users from the work group may
not be removed.

l Prerequisites and Buyer Attachments are not copied to the next stage, but new
prerequisites and attachments may be added to those sections as appropriate.

l Questions are not copied to the new stage. You may enter new questions appropriate for
the stage.

l Additional Item Fields are copied to the next stage. You may add, edit, or delete
additional item fields for the current stage.

l Items are copied to the next stage. You may edit the specifics for an item, delete items, or
add new items for the current stage.

l The Suppliers page shows a tab to Add Suppliers to Stage, in order to add new suppliers
specific to this event stage. You may only select from suppliers who submitted a bid in the
previous stage. You may also remove suppliers/contacts that were tagged from the
previous event stage.

Internal Review Stages
You are able to incorporate an internal evaluation / review stage into the course of a multi-stage
event, so that an event round can be conducted with no direct input from eligible suppliers. An
internal stage can be used to determine event award recipients, or to simply eliminate suppliers
from award consideration.

The initial stage of an event is excluded from being designated an internal stage. Additionally, the
following differences appear on an internal stage:

l On the Setup page:

l The Stage Title field is required.

l The Open and Close date fields are displayed with non-editable dashes as these
settings are not required for an internal stage.

l The sealed bid option is set as read-only, with the value set to No.
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l TheQ&A Submission Close Date is still required. The Same as Close Date option is
removed.

l On the Description page, the event description is maintained from the previous stage, and
stage description is required.

l Fields on theQuestions, Items, and Additional Items pages are maintained and displayed
as read only.

l Identified Suppliers are still a requirement for an internal stage. Only previous stage
suppliers (suppliers that submitted a bid) are available for inclusion within these stages.

l As an internal stage does not need any supplier responses or bids, the status and progress
on the Supplier Responses page is replaced by the text "N/A" for all suppliers. The only
formal content taken into account for evaluation during an internal stage is responses
gathered from panelists via the Panel Questionnaire.

l Event Copy and Copy As Templateworkflow actions are not available.

l Since an internal stage does not require any direct supplier input, there is no need to flow
through all of the usual event states. After the draft version of an internal stage has been
approved, the event immediately enters the Under Evaluation state.

l On the supplier portal, all the sourcing event sections are hidden even if the sections were
populated in the previous stage, except Summary,Q&A Board, andMy Exports and
Imports.

l When a supplier chooses to export an internal stage event, the only content that is
included in the generated PDF is the Summary page information and theQ&A Board
activity content.

Adding an Event Stage
1. Search for an event that is not closed and navigate to the Supplier Responses page.

2. To select suppliers to proceed to the next stage, select check boxes for the appropriate
suppliers and choose Tag Suppliers for Next Stage (x) from the Evaluation Actions
dropdown.

a. You may also do this after the next stage has already been created. Only suppliers
from the previous stage may be added to subsequent stages.

b. You may choose to Show Tagged Suppliers Only on the Supplier Responses page
for a view of only those suppliers.
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3. Select Create New Stage from theWorkflow Actions dropdown.

a. If a Stage Title has not been entered for the initial stage, you will be prompted to
enter an initial stage name before proceeding to subsequent stages. Stage Title is
required for each stage in the event.

b. Select Yes or No for Internal Stage. The default is No.

c. Select the Event Type for the stage. By default, the previous event type is selected,
but the type can be changed by searching for and selecting another event type. This
field is hidden if you have chosen to create an internal stage.

l If you use an event type that includes items, and then change the event type
in a following round to one that does not include an items section, the items
will not be brought forward.

l If a follow-on stage of the event then allows items again, the original items
being sought by the multi-stage event can be reintroduced to the latest stage
using options available on the Items page of the event:

l Select the Add Item from Previous Stage option from the Add
Product Line Item drop-down selection list.

l Select the Import from Previous Stage option from the Add or Import
drop-down selection list.

d. Optionally, select a template for the stage using the Create from Template field.
This field is hidden if you have chosen to create an internal stage.

e. Select whether or not to transfer panel questionnaire questions to the new stage
using the Transfer PQ Questions to the New Stage? field.

f. Once you have selected to save the stage, you will be navigated to the new event
stage.

4. Complete the event configuration for the next stage. The following information may be
edited for a new external stage:

a. Stage Title is required.

b. Enter an optional Stage Description on the Description page, providing additional
information about the new, specific stage. You may choose to alter the Description
for the original event as well.

c. Event usersmay be altered for the current stage. Users from the initial stage may
be removed and new users may be added; however, inherited users from the work
group may not be removed.
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d. Add Prerequisites and Buyer Attachments for the new event stage. Prerequisites
and attachments from the previous stage(s) are not copied.

e. EnterQuestions for the current stage.

f. Edit the Additional Item Fields for the current stage. You may edit additional item
field settings that were copied from the previous stage, remove additional item field,
or add new additional item fields.

g. Edit the Items for the current stage. You may edit item settings that were copied
from the previous stage, remove items, or add new items.

l You can import items from previous stages of the event by clicking the Add or
Import dropdown and selecting Items Group or Individual Items from Import
From Previous stage, or by clicking an Add Product Line Item dropdown
and selecting Add Item from Previous Stage.

h. The Suppliers page shows a tab to Add Suppliers to Stage, in order to add new
suppliers specific to this event stage. You may only select from suppliers who
submitted a bid in the previous stage. You may also remove suppliers/contacts that
were tagged from the previous event stage.

5. View and navigate to all the event stages from View Event Stages in the left menu.

Add a Quick Quote Event Stage
When a multi-stage event is Under Evaluation, an option called Create New Quick Quote Stage
appears in theWorkflow Action drop-down.

If you choose to Create New Quick Quote Stage, an overlay containing the following fields will
open:

l Previous Stage Title (Required) - This field appears only if it was not configured during the
previous stage.

l New Stage Title (Required)

l Event Type (Required)

l Create from Template (Required)

The following action buttons appear on the Create New Quick Quote Stage overlay:
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l Create New Stage - The new stage is created and the user is presented with a draft
version of the newly-created stage.

l Create & Submit - The new stage is created and immediately submitted into the Quick
Quote Approval workflow. The user is presented with a draft version of the newly-created
stage.

l Close - No new stage is created. The user returns to the previous stage of the event.

Note - If your organization does not have a Quick Quote workflow configured, you will
receive an error message informing you that a Quick Quote workflow is needed. Contact
your administrator for assistance.

Notifications Related to Multi-Stage Events
You may choose to configure notifications for suppliers related to multi-stage events, and also
enable notification preferences for users/roles.

l In General Sourcing Settings, you may enableMulti-Stage Notification Emails. Select
the option for Supplier does not Advance Notifications if you want suppliers who are not
selected for a subsequent stage to be notified. You can manage the text of this email in the
Administer > Email Management > System Emails page.

l A system email is automatically sent for Sourcing Supplier Advancing to Next Stage for
any supplier who is invited to a subsequent stage of an event. The text of the email is
managed in the Administer > Email Management > System Emails page.

l A system email is automatically sent for Internal Evaluation Event Stage Available for
Review for any supplier who is invited to an internal stage of an event. The text of the email
is managed in the Administer > Email Management > System Emails page.

l A user may choose to enable the notification preference in their user profile (or a user
administrator may enable it for a role) for Evaluation Calculation Options Change, which
may occur for multi-stage events.

Multi-Stage Workflow Options
When viewing the workflow approvals for an event, the workflow steps will show for the current
stage. Therefore, you may see some steps are 'skipped' because they do not apply to the current
stage.

Advanced Dynamic Workflow options are available for both Sourcing Approvalworkflow and
Sourcing Evaluationworkflow:
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l You may configure workflow based on whether an event is multi-stage or not.

l You may configure workflow based on the event stage number.

l While an administrator may configure ADW rules for use in their workflow process, new
workflow rules are NOT ENABLED by default, and you must contact JAGGAER to update
your workflow to include any new workflow rules.

Managing Reverse Auctions

The Auction Console
Once an auction event is approved through an organization’s event approval workflow, buyers are
able to monitor and administer the auction phase of the event via the Auction Console interface.

Suppliers are not required to complete all event collateral before they are allowed to enter an
auction and place bids. Only specifying an “intend to bid” and completing the required
prerequisites are needed to be completed before a supplier can join an auction and place bids.

As long as no Initial Bid Required Time is specified, suppliers are able to enter an auction at any
point once it has begun. Additionally, the end of reverse auctions is decoupled from the end of
their events. Auction event owners are able to define the end of an auction and the end of an
event separately, which allows suppliers time to complete their bids after the end of the auction.

Selecting the Launch Auction Console button will open a new window where the buyer can view
bidding activity. In the Auction Console, buyers can perform the following actions:

l The Control Panel tab displays data on the number of suppliers that intend to bid, the
number of active suppliers, number of items, number of items with bids, number of bids,
and savings. The following features can be found on the Control Panel:

l Auction Activity Bar - This feature appears across the top of the console.

l Heat Map - A simplified view of a heat map displays bid activity per supplier/item.
Users can see hot spots and areas of little or no activity. Clicking the heat map takes
users to the Bid Graph page, which contains an expanded heat map.

l Bid Graph - Selecting an item and time displays a bid graph for the selected criteria
that can be toggled to show cost or savings. Clicking it takes users to the Bid Graph
page, which contains an expanded heat map.
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l From the Bid Graph tab, buyers can access the following features:

l A collapsible detailed heat map appears at the top of the page. This heat map can
show bid count, percent from historic price, and percent from reserve price. Options
are available to show all items or just those that have bids.

l Total Cost and Savings graphs include a slider to control timeframe, and totals are
displayed if historic data has been uploaded.

l Drilling down to individual items shows bidder details, cost, and savings
information.

l Reserve and historic prices can be displayed on the graph for reference. The
last bid price for the item is also displayed as a quick reference.

l If the auction has lots configured, the lots may be selected for this view as
well. If they are, the last bid price becomes a stacked chart showing the
breakdown of each item in the lot.

l From the Proxy Bidding tab, buyers can submit proxy bids on behalf of suppliers.

l Buyers and suppliers can communicate directly from within the Auctions console using the
Chat tab that appears in the lower right of the screen. Buyers can communicate with all
suppliers, either through messages to selected suppliers or through group blast messages
to all suppliers included in the event. Suppliers can only communicate with the buyer.
Messages can still be sent when a recipient is offline. They will appear when the recipient
returns to the Auction console.

l Buyers can download the chat logs for an event. Suppliers can also download the chat logs
in which they themselves participated.

l Buyers can initiate a new phase for auctions that have ended by clicking the New Phase
button which appears in the lower right of the screen. Clicking this button will open a pop-
up where start time, duration, and extension policy options can be entered.

Once an auction has opened, settings are locked down and cannot be amended. Suppliers are
unable to withdraw bids once an auction begins.

When an auction closes, supplier bid information is passed to the event and is used for evaluation
and reporting purposes.

Monitoring an Auction
Once an auction event is approved through an organization’s event approval workflow, buyers are
able to monitor and administer the auction phase of the event via the Auction Console interface.
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Selecting the Launch Auction Console button will open a new window where the buyer can view
bidding activity.

1. Navigate to an auction event and click the Launch Auction Console button.

2. The Control Panel tab opens. Data on the number of suppliers that intend to bid, the
number of active suppliers, number of items, number of items with bids, number of bids,
and savings is displayed.

3. Selecting an item and timewill display a bid graph for the selected criteria, and a bid
history of the auction.

4. Click the Bid Graph tab. Select an item and time for a more detailed bid graph. You can
toggle on and off the legend, plot lines, minimum price, maximum price, reserve price, and
target price for display on the graph by clicking the sliders along the left.

5. Click the Bid History tab to view a list of the submitted bids for the auction, with sortable
columns for supplier, bid time, price, status, reason for rejection, item name, item
description, item quantity, and unit of measure.

6. Click the Proxy Bidding tab to submit bids on behalf of suppliers.

a. Select the supplier you would like to submit a proxy bid for from the Supplier
dropdown.

b. Enter the bid in the New Bid column and click the gavel icon.

c. Click the Submit Bids button to submit the entered bids.

7. If your auction has ended, you can initiate a new phase by clicking the New Phase button
to open the Schedule New Phase pop-up.

a. Enter a Start Date/Time for the phase.

b. Enter a duration for the phase, and select hours or minutes in the dropdown.

c. Enable extensions if desired. If enabled:

i. Select if New Best Bid or Any New Bid as the Trigger Rule.

ii. Enter Extension Trigger Period in minutes.

iii. Enter Extension Duration in minutes (maximum 30).

iv. Select if there will be a maximum number of extensions or not. If yes, enter the
maximum number of extensions.

v. Click Save Changes.
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Export Event Information
Users with access to view an event have the ability to export event information into a PDF file.
The user may select to export all or only parts of the event. Any user with access to view or edit
an event will see an option to Export Event as PDF. The option is available:

l from event search results, in theManage Events dropdown

l when viewing an event, in the Event Actions dropdown

Note: If Confidential Pricing is enabled for an event and you are not included in the Event
Price Viewers access group for the event, you will see the word Confidential anywhere a
price would be displayed. If a supplier uploads a confidential attachment, you will see the
attachment file name, but a link to open the attachment will not be available. This includes
PDF and evaluation exports you perform.

Export an Event PDF File
1. Navigate to an event in any status.

a. From event search results, select theManage Events dropdown, and the Export
Event as PDF option.

b. When viewing an event, select Event Actions, then Export Event as PDF.

2. An Export Event overlay displays:

a. The Event to Export is listed as read-only for your confirmation.

b. The File Name is provided based on the event number and date of the request. You
may edit the File Name.

c. You may provide an optional Export Description.

d. For single stage events, Select the Content to Export:

i. All Event Sections, Responses and Attachments.

ii. Let me pick. If you select this option, you will be presented with sections of
the event. Select which sections you want to be exported.
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e. For multi-stage events, select the Content to export:

i. Current Stage: All Sections, Responses and Attachments. With this
option, only the current stage information will be exported.

ii. Event: All Stages, Sections, Responses, and Attachments. With this
option, all of the event stages will be exported. The information for each stage
will display in separate folders in the zip output file.

iii. Customize Export. Choose this option to select specific stages and/or
specific event sections to include in the export request. Additional options will
display as listed in step 2d.

f. You may select to receive an email when the export is ready. The checkbox will be
enabled (or not) according to your selection for the Sourcing - Exports Notification
Preference in your user profile, but can be changed for this export request. Select
theWhat's This hyperlink in the overlay for more information.

g. Click Submit to request the export.

3. An overlay displays with confirmation that your export was requested. You can select to Go
to Page: Download Export Files or Close the overlay.

4. To access the export files, navigate to Sourcing > Sourcing Events > View Exports,
and select the Events tab. You will only see exports for events to which you have view or
edit access.

a. The status of the export request displays. If it has not completed, the user may
select the Refresh this Page option to see an updated status.

b. When available, select to download or open the file.

c. You may select to manually delete an export by selecting the row and clicking
Delete Selected Exports link.

The Exports Page

Exports are provided on the Events tab of the View Exports page located at: Sourcing >
Sourcing Events > View Exports > Events. A user with access to view events can navigate to
this page but they will only see exports for those events to which they have access based on the
rules above.

Information on the View Exports > Events page includes:
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l Status: The status of the export request displays. If it has not completed, the user may
select the Refresh this Page button to see an updated status.

l File Name. Click on the file to open or download the zipped file.

l Description. If a description was entered for the export request, it will display here.

l Event Number. The Event Number that was exported, along with a link to view the event.

l Export Date and Time. The date and time the export was requested. This can let you
know if the most recent information for the event was exported.

l Exported by. The user who requested the export.

l A message displays indicating the number of days before the file will be deleted from the
page. The default value is 7 days, but your organization may configure a different value in
the General Sourcing Configuration settings.

l You may also select to manually delete an export by selecting the row and clicking Delete
Selected Exports link.

Visibility of Export Files
User access restrictions to event export files ensures that these documents are managed with
the required level of confidentiality. User access to targeted event export files is based on the
following rules:

1. Users can always access their own exports.

2. A user can view other users' event exports if the user is a member of at least one of the
event or work group relationships listed below:

l Event > Settings and Content > Users > Creator

l Event > Settings and Content > Users > Owner

l Event > Settings and Content > Users > Stakeholder

l Event > Settings and Content > Users > Contact

l Work Group > Event Users > Event Manager - By user assignment, assigned role,
business unit, or department

l Work Group > Event Users > Stakeholder - By user assignment, assigned role,
business unit, or department

3. If the event has Confidential Pricing activated, users must have a relationship outlined
above and they must also be a member of the Event > Settings and Content > Users >
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Event Price Viewers group.

4. If the Hide Event Prices option has been activated in the event, users cannot view other
users' event export files.

The Export File Format
The file is exported in zip format, with folders for the various sections of the event. as was
requested in the export.

l Event folder contains the PDF file with the event information except for attachment and
supplier response details. This folder also contains the audit history file for the event.

l Attachments folder contains the attachments for the event, organized by the page on
which they are included.

l Supplier Responses folder contains the details for each supplier that has submitted a
response.

If the request is for multiple stages, the zip file will contain a folder for each of the stages.

Public Event Exports
An event export is available for transporting public event data from the Sourcing module to
external systems. With this export, for example, customers can expose their public sourcing
events on third-party websites, while administering the events within the Sourcing platform.
Please contact your system administrator to determine if the feature is enabled for your
organization.

If activated, a standard system email notification is available to notify you when public event
exports fail. An in-app notification can also be displayed in the UI banner. You can turn on this
Sourcing Event Document Export Failure Notice in theMy Profile > Notification Preferences
> Administration & Integration area.

Notification messages contain links to a Find and Fix Errors page for users with theManage
Integration Export Failures permission. On this page, you can view errors, re-queue errors for
export, delete export errors, and view the last 20 successful exports.

The Find and Fix page can also be accessed by navigating to Administration > Find and Fix
Errors > Sourcing Event Document Export Queue.
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Note: Your IT personnel should work with your JAGGAER Technical Consultant to configure
your site with the required connection details, the run schedule of the associated export
Job, and establishment of the appropriate event export triggers, based on your
organization's needs.

For more information about enabling public event export notifications, administrators should
see "Public Event Export Notifications" on page 327.

Access & Export Event History
Event history is accessed by selecting the History hyperlink at top right when viewing the event.

The history is displayed in a pop-up, organized into the following tabs:

l Event History - The log of changes to event configurations and values.

l Email History - The log of emails sent related to the event. If more than one person
received the email, a hyperlink toMultiple Recipients generates an Excel file where you
can view all email addresses for recipients of the email.

l Supplier History - The log of response actions by a supplier user for the event. Actions
related to Prerequisites, Intent to Bid, and Submitting the Response are logged. You
may filter the results by searching by start date, end date, action, section, or supplier. You
may also select the Export CSV link to export the history on this page.

Event History
When viewing an event in Draft status, history for the current section shows by default. When
viewing an event not in Draft status, history for all sections of the event shows by default. The
information logged includes:

l Date - The date and time the edit was made.

l User - The user who made the change. For some actions, the system actually made the
change.

l Action - The action that was done as part of the edit.

l Section - The section of the event that the edit was made.

l Subsection - The subsection of the event where the edit was made.

l Context - Additional information of where the action occurred, such as a workflow step.
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l Field - The field that changed.

l Old Value - If applicable, the previous value for the field.

l New Value - The changed value for the field, as a result of the action.

l Note - If there was an opportunity to include a note for the action, it will display here.

To filter the results by specific criteria, select the Filter History hyperlink. You have the option to
filter by:

l Start Date and/or End Date - To see history before or after a certain date.

l Action - Filter to see entries for specific actions, such as created, deleted, etc.

l Section - Filter to see only entries for a specific section of the event.

You may also sort the history results by selecting the column heading. You may sort by Date,
User, Action, Section, Subsection, or Context.

The Event History may be exported as a single file. On the Event History tab, select the Export
CSV link. The file may be opened or saved immediately.

Email History
Email History includes the following information:

l Email Display Name - The name of the email that was sent. You can refer to these emails
in the Email Management section of your application.

l From- Who the email originated from. System emails will show as being sent by the
organization.

l Recipient- The email address for the recipient of the email. If there was more than one, a
link forMultiple Recipientswill show. When selecting the link, you will be given the
opportunity to view or save an Excel file containing the recipient email address and
date/time the email was sent.

l Date- The date the email was sent.

To filter the results by specific criteria, select the Filter History hyperlink. You have the option to
filter by:

l Start Date and/or End Date - To see history before or after a certain date.

l Email Display Name- Filter to see entries for a specific email.

You may also sort the history results by selecting any of the column headings.
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Supplier History
Supplier History includes the following information:

l Date - The date and time the edit was made.

l Supplier - The supplier for which the edit was made.

l User - The supplier user who made the change.

l Action - The action that was done as part of the edit.

l Section - The section of the event that the edit was made. Only Intent to Bid and
Prerequisite sections are logged. A Response Submitted action is considered part of the
Intent to Bid section.

l Subsection - The subsection of the event where the edit was made.

l Context - Additional information of where the action occurred, such as a workflow step.

l Field - The field that changed.

l Old Value - If applicable, the previous value for the field.

l New Value - The changed value for the field, as a result of the action.

To filter the results by specific criteria, select the Filter History hyperlink. You have the option to
filter by:

l Start Date and/or End Date - To see history before or after a certain date.

l Action - The action that was performed by the supplier.

l Section - The section of the event in which the action was performed.

l Supplier - Enter a search term for the suppliers on the event to filter entries for a specific
supplier.

You may also sort the history results by selecting the column heading. You may sort by Date,
Supplier, User, Action, Section, Subsection, or Context.

Sealed Events: The Supplier History tab is not available for sealed events until the sealed bid
open date has been reached.

View and Export Event History
The goal of this task is to view and export the history of changes for an Event.
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1. You may navigate to search for and select an event by any of the following ways:

a. Navigate to Sourcing > Sourcing Events > Search Events. Enter search criteria
and select an event from the result set.

b. From the Sourcing Events Home, select the type of event (i.e. Active, Draft,
Pending, etc.) to view those event results. Select an event from the result set.

c. From the Sourcing Events Home, select an event number from the list of events in
Upcoming Key Events Dates.

2. Select the History hyperlink on the event. The history overlay opens.

3. View the Event History tab to see changes related to the Event.

a. Select the Filter History hyperlink above the history log to see filter criteria.

i. Enter a Start Date to see history after a specific date.

ii. Enter an End Date to see history before a specific date.

iii. Select from the Actions drop-down to see history for a specific type of event
action.

iv. Select from the Sections drop-down to see history for a specific section in
the event.

b. Sort the history results based on result values. You may sort by Date, User, Action,
Section, Subsection or Context.

c. Select a different Result per page from the drop-down, if appropriate.

d. Select to paginate through results by selecting the left or right arrow buttons for
Page x of x.

e. Select the Export CSV hyperlink to open an Excel file of the history log. View the file.

4. View the Email History tab to see an audit log of emails sent to the supplier for this event.

a. Select the Filter History hyperlink above the history log to see filter criteria.

i. Enter a Start Date to see emails sent after a specific date.

ii. Enter an End Date to see emails sent before a specific date.

iii. Select from the Email Display Name drop-down to see a specific email sent.

b. Sort the history results based on result values. Click on any column heading to sort
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by that value.

c. Select a different Result per page from the drop-down, if appropriate.

d. Select to paginate through results by selecting the left or right arrow buttons for
Page x of x.

5. View the Supplier History tab to see changes made by supplier users for the Event. (Note:
The Supplier History tab is not available for sealed events until the sealed bid open date
has been reached.)

a. Select the Filter History hyperlink above the history log to see filter criteria.

i. Enter a Start Date to see history after a specific date.

ii. Enter an End Date to see history before a specific date.

iii. Select an Action to limit results to a particular type of action performed by the
supplier.

iv. Select a Section to see history related to a particular section of the event.

v. Enter a search term in the Supplier field to see changes by a specific supplier.

b. Sort the history results based on result values. You may sort by Date, Supplier, User,
Action, Section, Subsection or Context.

c. Select a different Result per page from the drop-down, if appropriate.

d. Select to paginate through results by selecting the left or right arrow buttons for
Page x of x.

e. Select the Export CSV hyperlink to open an Excel file of the history log. View the file.

Sourcing Configuration

Libraries
Sourcing customers can configure Libraries for use in creating Sourcing Events. A Library is made
up of collateral, which are specific sections of a sourcing event that you may use over and over...
such as a series of questions, prerequisite materials, or items.
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A user must have the permission to Create Templates and Libraries and be assigned as a
Template and Library Manager for a work group. A user can only create Libraries for work groups
to which they are assigned specifically as a Template and Library Manager. For example, if a user
is an Event Creator but not a Template and Library Manager, the user will be able to create events
for that work group, but not manage a library or template for that work group.

Add a New Library
Permission(s) required:Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. Click the Add Library button. The Add Library overlay shows.

3. Enter a Library Name.

4. Enter an optional Description for the library.

5. AssociateWork Group(s) to the Library by selecting the Edit button.

a. Only work groups to which you are assigned as a Template and Library Manager will
display.

b. View child work groups by selecting the expand icon.

c. Select one or more work groups for the library. This will allow events for the selected
work groups to use the library contents.
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i. If you select a parent work group, the library will also be applied to all child
work groups.

ii. You may select a child work group without selecting the parent.

d. When finished selecting work groups, click Done.

6. Accept the default Currency selection or choose a different currency from the drop-down
list.

l The default selection for this required field is the organization's default currency. If a
default currency is not set for the organization, the organization's base currency is
used instead. The base currency is the currency that was selected for the
organization when its JAGGAER account was created.

l Once the Currency is selected and saved in a template or library, it cannot be
changed.

7. Event Types - Select if you want the library available for All Event Types or Selected Event
Types.

a. If Selected Event Types, choose from your organization's configured event types.

b. This will allow events of the selected (or all) event types to use the library contents
(for associated work groups.

8. Status - Select if you want this library to be Published so that it can immediately be used
on the designated event types and work groups or kept in Draft (Hidden) status until you
have finalized the collateral.

9. Click Save Changes.

10. The library is created and you are navigated to the Library Settings page. Here, you may
edit the Work Groups, Event Types, or Status for the Library.

11. Add collateral as appropriate. For each section, click Save Changeswhen finished. Add as
many collateral items as is appropriate for the library, considering the different events that
may be entered for the associated work group and event types.

12. Descriptions - Click Add Description to create descriptions that may be used from this
library.

a. Enter a Name for the description, to make it easily recognizable for future selection.

b. Enter the Description Content, using the formatting tools available, if desired.

c. Click Save Changes for each description added.
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13. Prerequisites - Click to Add New Prerequisite to create prerequisite text or information
that may be used from this library.

a. Enter Instructions to supplier to show on the Prerequisites page, to let the supplier
know more about the prerequisite.

b. Select how you would like to display your Prerequisite Content:

i. Enter text directly (or copy and paste) - the supplier will see the text
directly on the Prerequisites page. If this option is selected, an Edit button
shows in order to enter the appropriate text.

ii. Attach a file from my computer - the supplier will select to open/download
the attachment from the Prerequisites page. If this option is selected, an
Upload button displays in order to attach the file. The maximum upload file
size is 25MB.

c. Select the Type of Prerequisite:

i. Optional - The supplier is not required to view this prerequisite in order to
view or bid on the event.

ii. Required to View Event - The supplier will be required to certify they have
reviewed this prerequisite in order to view the event.

iii. Required to Enter Bid - The supplier will be required to certify that they have
reviewed this prerequisite in order to bid on the event. They are not required
to review the prerequisite simply to view the event details.

d. Enter Certification Text. Default text is provided, but you may edit as appropriate
for your organization.

e. Select the option for Supplier Must Also Upload a File if appropriate.

f. Click Save Changes.
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14. Attachments - Click to Add New Attachment to add an attachment that may be used
from this library.

a. If selecting File as the Attachment Type:

i. Select the Upload button.

ii. Enter a Title for the attachment.

iii. Select Browse and select the appropriate file.

iv. Click Save Changes.

b. If selecting Link as the Attachment Type:

i. Enter an optional Name for the link.

ii. Provide the URL for the link.

c. If more than one attachment is listed, you may choose the display order for any new
attachments.

15. On theQuestions page, you may add questions to a Draft event individually in the UI, or in
bulk via an Excel import file.

a. Add a new page by selecting:

i. Draft event: Add or Import button, then Add Question Page. Enter a Page
Title and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, thenQuestion Page. Enter a Page
Title and choose a display order. Click Save Changeswhen done.

b. Add a new group by selecting:

i. Draft event: Add or Import button, then Add Question Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, thenQuestion Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

c. To enter questions into existing groups, select the Add New Question button within
the group, or selectManage Group and:

i. Add New Question - To add a question to this group of questions.

ii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iii. Delete Group - To remove the group of questions.

d. When selecting to Add New Question:
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i. Enter the Question Text. This is displayed to suppliers.

ii. Select a Response Type for the question (the format of the answer). See for
more details on the types of responses.

iii. Indicate if a Supplier Response is Required.

iv. Select the Upload button if you would like to attach a file to the question.

v. Once more than one question is provided, indicate the Display Order for the
question.

vi. Select Save Changes to add the question to the page.

16. On the Items page, you may add product and/or service line items to a Draft event
individually in the UI, or in bulk via an Excel import file.

a. Add a new group to the Product Line Items or Service Line Items page by
selecting:

i. Draft event: Add or Import button, then Add Item Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, then Item Group. Enter a Group Name
and choose a display order. Click Save Changeswhen done.

b. To enter items into existing groups on the Product Line Items or Service Line
Items page, select the Add New Item button within the group on the appropriate
page, or selectManage Group and:

i. Add New Item - To add an item to this group.

ii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iii. Delete Group - To remove the group of line items.

c. When selecting to add a new item to the Product Line Items page, you will be given
the option to provide the following information: (Required fields are indicated with an
asterisk *):

i. Enter a Name for the item.

ii. Enter a Description for the item.

iii. Enter a Catalog Number for the item, if known.

iv. Enter aQuantity of the item needed.

v. Select a Unit of Measure for the item from the drop-down.
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vi. Select from the followingOptions (these may be changed for individual event
items):

l Select if a Unit Price is Required for this item. If selected, the supplier
cannot submit a bid response without entering this information.

l Select if an Estimated Delivery Date is Required for this item. If
selected, the supplier cannot submit a bid response without this
information.

vii. If you would like to associate a Commodity Codewith the item, select the
Edit button and choose from your organization's commodity codes. Only one
commodity code may be selected for each item.

viii. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

ix. Enter the Historical Unit Price for the item.

Note: If the event currency does not match the Historical Unit Price currency
set for a library or template item, the Historical Unit Price is automatically
converted to the event currency using the organization's default exchange
rate when the item is added to an event. If no default exchange rate has been
set for the currency, the Historical Unit Price is not transferred for that item.

x. Select a Display Order, if appropriate.

xi. Click to Save Changes.

d. When selecting to add a new item to the Service Line Items page, you will be given
the option to provide the following information: (Required fields are indicated with an
asterisk *):

i. Enter a Name for the item.

ii. Enter a Description for the service.

iii. Enter aQuantity for the service item.

iv. Enter a Unit of Measure for the item.

v. Select if a Unit Price is Required for this item. If selected, the supplier cannot
submit a bid response without this information.

vi. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

vii. Click to Save Changes.
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Managing Libraries
Libraries are managed on the Sourcing > Templates and Libraries > Manage Libraries
page. When managing libraries, users have the ability to:

l Create and edit collateral

l Group collateral

l Use collateral to create a template

l Select collateral when creating events

Users with theManage Templates and Libraries permission can view and edit all libraries for
work groups in which the user is assigned as a Template and Library Manager. If the user is
assigned as a work group Administrator but not a Template and Library Manager, the user can
view the library but not make edits.

On theManage Libraries page, the user can search for a library by name, the event type
associated with the library, or work group associated with the library. A More Options link
provides the user with the ability to search by:

l Collateral Type - Search by Any Collateral type or click Selected Collateral types and
choose one or more values.

l Work Groups - Click the Edit button and choose from work groups (that you have access
to) to see libraries associated with a specific work group.
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l Event Types - Search by Any Event Type or click Selected Event Types and choose one or
more values.

l Status - Search for libraries that are Draft (Hidden) or Published.

Library results include:

l Library Name - This is the default sort for the library list.

l Contents - A list of all the contents of the library. Select an item to navigate to that part of
the library.

l Description - The description of the library.

l Last modified - The last date the library contents were modified. Library results can be
sorted by date.

l Status - If the library is Published, it can be used for templates and events. If it is Draft
(Hidden), it is not visible for templates and events. Library results can be sorted by Status.

l Actions - A button for actions displays depending on the user's access to the library's work
group:

l View - This button displays if the user has access to the work group but is not
assigned as a Template and Library Manager. The user can view the library contents
but cannot edit.

l Edit - Select Edit to edit the contents of the library.

l Publish - Displays for libraries that are in Draft (Hidden) status, and makes the
library Published so it can be used for templates and events.

l Hide Library - Displays for libraries that are Published and removes the library from
view so it cannot be used for templates and events.

l Delete Library - Removes the Library and its contents.

Edit an Existing Library
Permission(s) required:Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To delete a library, select the Edit button drop-down, then Delete Library.

3. To publish a draft library, select the Edit button drop-down, then Publish Library.

4. To hide a published library, select the Edit button drop-down then Hide Library.
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5. To edit the Library settings such as the name, description, work groups, event types or
status, select the Edit button for the library.

a. Make edits to the Library Settings as required.

b. Once changes are made, click to Save Changes.

6. To edit specific collateral in the library, select the content link for the collateral to be
edited. For example, if you want to edit Attachments for a library, click the Attachment
hyperlink to navigate directly to that content page of the library.

7. Changes to the library are captured in an audit log, viewed by selecting the History
hyperlink for the library.

Add/Edit Library Descriptions
You may include one or more descriptions in a library from which you can select when creating an
event. The Description is required in an event and should give good basic information about the
service or products you need.

To add a new description to the library, select Add Description. You will enter a name for the
description, and then enter the description content. Note the formatting tools that allow you to
format text, insert a link or image, create a bulleted list and more.

Permission(s) required: Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To edit an existing Library Description, select the Descriptions hyperlink for the
appropriate Library. Alternatively, select the Edit button for the library, then navigate to the
Descriptions page.

3. When creating a new Library, navigate to the Description page.

Add/Edit Library Prerequisites
You may include one or more prerequisites in a library from which you can select when creating
an event. You may choose to add Prerequisite information to an event if it is important to you that
a supplier reviews information about your company and/or the event prior to proceeding with
their response. For example, you may want the supplier to certify they have reviewed your Non-
Disclosure Agreement or payment terms.

Permission(s) required:Manage Templates and Libraries.



JAGGAER 281 www.JAGGAER.com

1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To edit an existing Library Prerequisite, select the Prerequisites hyperlink for the
appropriate Library. Alternatively, select the Edit button for the library, then navigate to the
Prerequisites page.

3. When creating a new Library, navigate to the Prerequisites page.

4. Click to Add New Prerequisite to create prerequisite text or information that may be used
from this library.

a. Enter Instructions to supplier to show on the Prerequisites page, to let the supplier
know more about the prerequisite.

b. Select how you would like to display your Prerequisite Content:

i. Enter text directly (or copy and paste) - The supplier will see the text
directly on the Prerequisites page. If this option is selected, an Edit button
shows in order to enter the appropriate text.

ii. Attach a file from my computer - The supplier will select to open/download
the attachment from the Prerequisites page. If this option is selected, an
Upload button displays in order to attach the file. The maximum upload file
size is 25MB.

c. Select the Type of Prerequisite:

i. Optional - The supplier is not required to view this prerequisite in order to
view or bid on the event.

ii. Required to View Event - The supplier will be required to certify they have
reviewed this prerequisite in order to view the event.
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iii. Required to Enter Bid - The supplier will be required to certify that they have
reviewed this prerequisite in order to bid on the event. They are not required
to review the prerequisite simply to view the event details.

d. Enter Certification Text. Default text is provided, but you may edit as appropriate
for your organization.

e. Select the option for Supplier Must Also Upload a File if appropriate.

f. Click Save Changes.

5. To remove a prerequisite from the library, select the Edit button, and select Delete.

6. To edit a Prerequisite, select the Edit button and select Edit. Make the appropriate
changes, and click the Save Changes button to save your edits.

Add/Edit Library Attachments
You may include one or more attachments as files or URL links in a library from which you can
select when creating an event. An attachment may be a building design or layout, detailed
specifications related to products or services, an addendum for the event, etc. When you select
to Add New Attachment, you will be prompted to select File or Link, and upload the file or enter
the URL appropriately.

Permission(s) required:Manage Templates and Libraries.
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1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To edit an existing Library attachment, select the Attachments hyperlink for the
appropriate Library. Alternatively, select the Edit button for the library, then navigate to the
Attachments page.

3. When creating a new Library, navigate to the Attachments page.

4. When selecting Add New Attachment:, you may select to upload a file or include a link.

a. If selecting File as the Attachment Type:

i. Select the Upload button.

ii. Enter a Title for the attachment.

iii. Select Browse and select the appropriate file.

iv. Click Save Changes.

b. If selecting Link as the Attachment Type:

i. Enter an optional Name for the link.

ii. Provide the URL for the link.

c. If more than one attachment is listed, you may choose the display order for any new
attachments.

5. To remove an attachment from the Library, select the Edit button, and select Delete.

6. To edit the Description, select the Edit button and select Edit. Click to upload a new
attachment, or remove the current attachment. Click the Save Changes button to save
your edits.

Add/Edit Library Questions
You may include one or more questions in a library from which you can select when creating an
event. You may organize questions pages, and in groups on each page.

To add a new question to the library, select Add New Question in the selected group. You may
create new groups by selecting the Add or Import button (Draft events) or Add New hyperlink
(Published Events). You also have the ability to import questions in bulk within Draft libraries, and
export questions from any library.

The following displays a Library in Draft status, therefore allowing the user to import questions in
bulk via an Excel file.
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The following displays a Library in Published status. Questions may be added through the UI
only, by selecting Add New or Add New Question. The option to Import is not available for
Published libraries.

When selecting to Add New Question, you will enter the question text and response type. Some
additional criteria for the question may be configured specifically on the event when the question
is added to the event, such as auto scoring or cost analysis options.

Permission(s) required:Manage Templates and Libraries.
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1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To edit an existing Library Question, select theQuestions hyperlink for the appropriate
Library. Alternatively, select the Edit button for the library, then navigate to theQuestion
page.

3. When creating a new Library, navigate to theQuestions page.

4. On theQuestions page, you may add questions to a Draft event individually in the UI, or in
bulk via an Excel import file.

a. Add a new page by selecting:

i. Draft event: Add or Import button, then Add Question Page. Enter a Page
Title and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, thenQuestion Page. Enter a Page
Title and choose a display order. Click Save Changeswhen done.

b. Add a new group by selecting:

i. Draft event: Add or Import button, then Add Question Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, thenQuestion Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

c. To enter questions into existing groups, select the Add New Question button within
the group, or selectManage Group and:

i. Add New Question - To add a question to this group of questions.

ii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iii. Delete Group - To remove the group of questions.

d. When selecting to Add New Question:

i. Enter the Question Text. This is displayed to suppliers.

ii. Select a Response Type for the question (the format of the answer).

iii. Indicate if a Supplier Response is Required.

iv. Select the Upload button if you would like to attach a file to the question.

v. Once more than one question is provided, indicate the Display Order for the
question.

vi. Select Save Changes to add the question to the page.
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5. To remove a question from the library, select the Edit button, and select Delete. You may
delete multiple questions by selecting the checkbox on the right side of the question and
choosing the hyperlink Delete Selected Question(s).

6. To edit a question, select the Edit button, and select Edit. Make the appropriate changes.
Click the Save Changes button to save your edits.

To manage Library questions via import/export

1. Request an Export of current questions or open the template:

a. To Export Questions:

a. Select the Export Questions button. An Export Questions overlay displays.

b. Enter a Description for the export request.

c. Select if you want to receive an Email When Export Is Ready or not.
Depending on the selection for the Sourcing - Exports Notification
Preference in your user profile, Yes or No will be selected for you, but can be
changed for this export request. Select theWhat's This hyperlink in the
overlay for more information.

d. Click Submit.

b. To get theQuestions Template:

a. Select the Add or Import button, then select Import from File > Get
Template. A Get Template overlay displays.

b. Enter a Description for the requested template.

c. Click Submit.

2. A confirmation displays that the request has been submitted, and the user is navigated to
the Exports and Imports page of the library.

3. The requested file status will display. You may select to Refresh this Page until the status
is Completed.

4. Select the File name to open or download the file. Best practice is to save the file to your
computer/network.

5. Click the Delete link for the file if you would like to remove it from the page.

Prepare the file
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6. Open the questions Export file or Questions Template.

7. Select the Enable Editing button in the spreadsheet.

8. Review and follow the instructions on the Import Instructions page of the file.

9. You may edit the Page Name. For example, instead of "Page: 1", you may enter "Page:
Legal Information".

10. Add a new group by selecting Group as the Type on the appropriate page and entering the
group title in the Group Title or Question Text column.

11. To modify a group, edit the group title in the Group Title or Question Text column.

12. To add a new question:

a. Select the valueQuestion from the options in the Type column.

b. Enter the question text in the Group Title or Question Text column.

c. Indicate Yes or No for Response Required for this question. If Yes, a supplier must
respond to the question in order to submit a response to the event.

d. Select the type of response you expect for this question, such as a date, numeric
value, option list, etc.

e. If you selected a response type that involves a list (Dropdown List or Multiple
Choice), configure the options below the question.

i. Select the valueOption from the selections in the Type column.

ii. Enter the option value in theOptions Suppliers Can Pick From column.

iii. Continue adding options as appropriate.

f. Auto Score and Cost Analysis options in theOptional Questions Section should be
provided at the event level.

13. When all questions have been entered, save the file in .xls or .xlsx format. Note that the
information in the file will completely replace any questions information currently in the
event.

Validate / Import the file
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14. Navigate to theQuestions page of the library.

15. Select the Add or Import button, then Import from File > Import. An Import Questions
overlay displays.

a. Select an Import Action. Import is the default action and it will import the questions
into the library if there are no errors in the file. You may choose to Validate only,
which will simply check the file for errors and will not import the file.

b. Browse and select a File Name.

c. Enter an optional Description for the import.

d. Select if you want to receive an Email When Import Is Ready or not. Depending on
the selection for the Sourcing - Imports or Sourcing - Validate Notification
Preference in your user profile, Yes or No will be selected for you, but can be
changed for this request. Select theWhat's This hyperlink in the overlay for more
information.

e. Click Submit to import (or validate) the file.

f. A confirmation displays, reminding the user that the file information will replace all
existing data in this section of the library. Click Yes to confirm.

1. A confirmation message display that the questions have been submitted for import, and
the user is navigated to the Exports and Imports page of the library.

2. The requested file status will display. You may select to Refresh this Page until the status
is Completed. If there are any errors, you may download and open the file to review. If
there are no errors, you will simply see the request completed.

3. Once the request completes the import process, you may view the updated questions in
theQuestions section of the library.

4. Event History captures new and edited questions.

Add/Edit Additional Item Fields in the Library
You may include one or more additional item fields in a library which you can select when creating
an event.

When adding additional item fields from a library to a sourcing event, conditional visibility
settings are carried to the sourcing events they are added to, however, note the following:
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l When adding additional item fields from a library to a sourcing event, scoring and cost
adjustment values for response options must always be configured within the sourcing
event.

l When adding a set of additional item fields with conditional visibility settings from a library
or template to a sourcing event, only the top-level additional item fields (parents) are
available for selection, but all fields in the hierarchy (child and grandchild) are added to the
event when the parent is added.

Permission(s) required:Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Event Libraries.

2. Choose one of the following options to open the Additional Item Fields page:

l To edit an existing Library Additional Item Field - Select the Edit button for the
library, then navigate to the Additional Item Fields page.

l If creating a new library - Click Add Library, complete fields in the Add Library
window, then navigate to the Additional Item Fields page.

3. Choose one of the following options to create or modify an additional item field:

l Create an additional item field - Click the Additional Item Fields button and select
Create Additional Field.

l Create an additional item field with conditional visibility settings - Choose this option
to create a field that is only displayed when a specified value is selected in its parent
field. Click the Additional Item Fields button and select Create Conditional Follow
Up from the drop down menu, then select the additional item field that will be
immediately above the field you are creating in the conditional visibility hierarchy.

l Modify an additional item field - Click Edit next to the additional item field you want
to change.

4. Complete the following fields:

a. If you are creating or editing a conditional field, in the Conditional Upon Value field,
select the value from the parent field that will cause the field you are creating to be
displayed.

b. Enter a Name for the field. This is the question you expect a supplier to answer by
completing the field.

c. Enter an optional Description for the field.

d. In the Applicable To field, select if the field is applicable to product line items,
service line items, or both. If you are creating a conditional field this will be a read-
only field that displays what has been selected on the parent field.
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e. In the Supplier Can Respond field, select Yes or No to indicate whether or not
suppliers are able to respond to the field. If you are creating a conditional field,
choose Yes. Additional checkboxes are displayed depending on your selection:

l Visible to supplier - Displayed if you select No. Select to enable suppliers to
view the field even when response is disabled. If not selected, only internal
users can view and edit the field.

l Supplier response is required - Displayed if you select Yes. Select the
checkbox to make it mandatory that suppliers complete the field before they
can submit a bid.

f. Select a field type:

Note: The following field types support auto-scoring, cost analysis, and
disqualifying responses: Numeric Text Box, Yes/No, Dropdown List (Pick One),
Multiple Choice (Pick One), Multiple Choice (Pick Many), Date.

l Text (Single Line) - The supplier response is a single line of text, up to 100
characters.

l Text (Multi-Line) - The supplier response is text and is entered into a text
box that can accept up to 2000 characters.

l Numeric Text Box - The supplier response must be a number.

l Yes/No - The supplier response is to select Yes or No for the question.

l Dropdown List (Pick One) - You will configure several different values for
the supplier response, the supplier will access the options via a dropdown list.
The supplier can select one option from the list.

l Multiple Choice (Pick One) - You will configure several different values for
the supplier response, and the supplier may select only one of the values as a
response. The choices are displayed as radio buttons.

l Multiple Select (Pick Many) - You will configure several values for the
supplier response, and the supplier may select multiple values as a response.
The choices are displayed as checkboxes.

l Date - The supplier response is a date.

g. The Set Disqualifying Response checkbox is displayed if Yes is selected for
Supplier Can Respond and the appropriate Field Type is selected. Enable this
option if you want to configure a response to an item-level question that, if selected,
will disqualify a supplier. The disqualifying response is defined under Response
Options.
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h. Select the following checkboxes to configure auto-scoring or cost analysis for the
field:

l Use Response in Auto Score - Select to use supplier responses to additional
item fields for auto-scoring. If selected, scoring values are added to each
response in the Response Options section.

l Use Response in Cost Analysis - Select to use supplier responses to
additional item fields for cost analysis. If selected, cost adjustments are
added to each response in the Response Options section.

Note: These checkboxes are displayed if auto-scoring and cost analysis
have been enabled for the event and set to be applied at the individual
line level, and the field type chosen supports auto-scoring and cost
analysis.

i. If you have selected a field type that requires Response Options to be defined,
enter each response that can be selected for the field and assign auto-score and
cost analysis values, and identify disqualifying responses.

Note: The fields displayed in this section will vary based on the field type. For
example, you will see different fields for the Date and Yes/No field types.

You will also see different columns displayed if the Auto Score, Cost Analysis,
or Set Disqualifying Response checkboxes have been selected. If the Use
Response in Auto Score checkbox is selected, a Score column is displayed
and can be used to assign auto score points to a response option. If the Use
Response in Cost Analysis checkbox is selected, a Cost Adjustment column
is displayed and can be used to assign cost adjustment values to a response
option.

j. If more than one additional item field is provided, indicate the Display Order for the
field.

k. Click Save Changes.

5. To remove an additional item field from the library, select the Edit button, then select
Delete.

Add/Edit Library Items
You may include one or more items in a library from which you can select when creating an event.
You may organize items in groups for product line items and service line items.
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The following displays a Library in Draft status, therefore allowing the user to import items in bulk
via an Excel file.

The following displays a Library in Published status. Questions may be added through the UI only,
by selecting Add New orManage Group > Add New Item. The option to Import is not available
for Published libraries.
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When selecting to Add New Item, you will enter information about the product or service. Some
additional information for the items may be configured specifically on the event when the item is
added to the event, such as requested delivery dates.

Permission(s) required:Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Manage Libraries.

2. To edit an existing Library Item, select the Items hyperlink for the appropriate Library.
Alternatively, select the Edit button for the library, then navigate to the Items page.

3. When creating a new Library, navigate to the Items page.

4. On the Items page, you may add product and/or service line items to a Draft event
individually in the UI, or in bulk via an Excel import file.

a. Add a new group to the Product Line Items or Service Line Items page by
selecting:

i. Draft event: Add or Import button, then Add Item Group. Enter a Group
Name and choose a display order. Click Save Changeswhen done.

ii. Published event: Add New hyperlink, then Item Group. Enter a Group Name
and choose a display order. Click Save Changeswhen done.

b. To enter items into existing groups on the Product Line Items or Service Line
Items page, select the Add New Item button within the group on the appropriate
page, or selectManage Group and:

i. Add New Item - To add an item to this group.

ii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iii. Delete Group - To remove the group of line items.
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c. When selecting to add a new item to the Product Line Items page, you will be given
the option to provide the following information: (Required fields are indicated with a
star .)

i. Enter a Name for the item.

ii. Enter a Description for the Item.

iii. Enter a Catalog Number for the item, if known.

iv. Enter aQuantity of the item needed. Alternatively, you can make the Quantity
field a vendor-supplied field using the following checkbox:

l Make Quantity a Supplier Response Field - Selecting this option
allows suppliers to enter an amount in the Quantity field. You will be
prevented from entering data in the Quantity field if you make Quantity
a supplier response field.

v. Select a Unit of Measure for the item from the drop-down.

vi. Select from the followingOptions (these may be changed for individual event
items):

l Select if a Unit Price is Required for this item. If selected, the supplier
cannot submit a bid response without entering this information.

l Select if an Estimated Delivery Date is Required for this item. If
selected, the supplier cannot submit a bid response without this
information.

vii. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

viii. Select a Display Order, if appropriate.

ix. Click to Save Changes.

d. When selecting to add a new item to the Service Line Items page, you will be given
the option to provide the following information: (Required fields are indicated with a
star )
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i. Enter a Name for the item.

ii. Enter a Description for the service.

iii. Enter aQuantity for the service item. Alternatively, you can make the
Quantity field a vendor-supplied field using the following checkbox:

l Make Quantity a Supplier Response Field - Selecting this option
allows suppliers to enter an amount in the Quantity field. You will be
prevented from entering data in the Quantity field if you make Quantity
a supplier response field.

iv. Enter a Unit of Measure for the item.

v. Select if a Unit Price is Required for this item. If selected, the supplier cannot
submit a bid response without this information.

vi. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

vii. Click to Save Changes.

5. To remove an item from the library, select the Edit button, and select Delete. To delete
multiple items, select the checkbox for the items and click the link Delete Selected Item
(s).

6. To edit an item, select the Edit button, and select Edit. Click the Save Changes button to
save your edits.

To manage Library items via import/export

1. Request an Export of current items or open the template:

a. To Export Questions:

i. Select the Export Items button. An Export Items overlay displays.

ii. Enter a Description for the export request.

iii. Select if you want to receive an Email When Export Is Ready or not.
Depending on the selection for the Sourcing - Exports Notification
Preference in your user profile, Yes or No will be selected for you, but can be
changed for this export request. Select theWhat's This hyperlink in the
overlay for more information.

iv. Click Submit.

b. To get the Items Template:
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i. Select the Add or Import button, then select Import from File > Get
Template. A Get Template overlay displays.

ii. Enter a Description for the requested template.

iii. Click Submit.

2. A confirmation displays that the request has been submitted, and the user is navigated to
the Exports and Imports page of the library.

3. The requested file status will display. You may select to Refresh this Page until the status
is Completed.

4. Select the File name to open or download the file. Best practice is to save the file to your
computer/network.

5. Click the Delete link for the file if you would like to remove it from the page.

Prepare the file

6. Open the items Export file or Items Template.

7. Select the Enable Editing button in the spreadsheet.

8. Review and follow the instructions on the Import Instructions page of the file.

9. Worksheets show for Product Line Items and Service Line Items. Note: All Item columns
display, but some are not utilized for libraries. Any information entered in these fields is
ignored.

10. Add a new group by selecting Group as the Type on the appropriate worksheet and
entering the group title in the Name column. To edit a group, simply edit the Name.

11. To add a new item to Product Line Items:

a. On the Product Line Itemsworksheet, select the value Item from the options in the
Type column.

b. Enter a Name for the item.

c. Enter the following information as appropriate for the product:

i. Description

ii. Catalog Number

iii. Quantity

iv. Unit of Measure
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d. Note that the following information should be configured at the event level. Any
information imported into the library for these fields will be ignored:

i. Commodity Code

ii. Target Price

iii. Alternates Allowed

iv. Requested Delivery Option

v. Requested Delivery Date

vi. Requested Delivery Days

e. If the supplier must enter a unit price for the item, select Yes for Unit Price
Required?.

f. If the supplier must provide an estimated delivery date for the item, select Yes for
Delivery Date Required?.

12. To add a new item to Service Line Items:

a. On the Service Line Itemsworksheet, select the value Item from the options in the
Type column.

b. Enter a Name for the item.

c. Enter the following information as appropriate for the service item:

i. Description

ii. Quantity

iii. Unit of Measure

Templates
Sourcing customers can configure templates for use in creating Sourcing Events. Templates can
be created with or without selecting pieces of collateral from a Library. To assist with streamlining
the event creation process, Event Creators have the ability to create a Sourcing Event from a
Template or populate the event using Collateral from a Library.



JAGGAER 298 www.JAGGAER.com

A user must have the permission to Create Templates and Libraries and be assigned as a
Template and Library Manager for a work group. A user can only create templates for work
groups to which they are assigned specifically as a Template and Library Manager. For example,
if a user is an Event Creator but not a Template and Library Manager, the user will be able to
create events for that work group, but not manage a library or template for that work group.

Add a New Template
Permission(s) required:Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Event Templates.

2. Click the Add Template button. The Add Template overlay shows.

3. Enter a Template Name.

4. Enter an optional Description for the template.

5. Select the Event Type for which this template will be available.

6. AssociateWork Group(s) to the template by selecting the Edit button:

a. Only work groups to which you are assigned as a Template and Library Manager will
display.

b. View child work groups by selecting the expand icon.

c. Select one or more work groups for the template. This will allow events for the
selected work groups to use the template.



JAGGAER 299 www.JAGGAER.com

i. If you select a parent work group, the template may also be applied to all child
work groups.

ii. You may select a child work group without selecting the parent.

d. When finished selecting work groups, click Done.

7. Accept the default Currency selection or choose a different currency from the drop-down
list.

l The default selection for this required field is the organization's default currency. If a
default currency is not set for the organization, the organization's base currency is
used instead. The base currency is the currency that was selected for the
organization when its JAGGAER account was created.

l Once the Currency is selected and saved in a template or library, it cannot be
changed.

8. Select if you would like to Protect Template. If enabled, Event Creators can choose to
protect all fields or to protect select specific field content that cannot be removed or
edited in events created from the template. If it is not enabled, Event Creators may remove
parts of the template content for the event.

a. Expand the Protect Template drop-down located under the Event Access
Settings For This Template header and select Let Me Choose.

b. Click Save Progress.

c. Navigate to an area of the template containing a field that will be protected or
unprotected within the template.

d. Select the checkbox(es) beside the applicable field(s). Alternatively, an entire group
of fields may be selected at once by marking the checkbox above the group of
fields.

e. Expand the Available Actions drop-down and select the applicable option to
protect or unprotect the selected fields:

f. Click Yes on the Confirmation overlay to commit the changes and close the overlay.
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g. When adding attachments, selecting the Protected checkbox on the Add
Attachment overlay will protect the document. Existing attachments can be
protected by expanding the Actions drop-down beside the relevant attachment,
choosing Edit Properties to access the Edit Attachment screen overlay, and
selecting the Protected checkbox.

Note: Protected templates and protected fields within templates can be

identified by the shield icon that appears beside their name.

9. On the Status field choose whether you want this template to be Published so that it can
immediately be used on the designated event type and work groups or kept in Draft
(Hidden) status until you have finalized the template.

10. Click Save Changes. The template is created and you are navigated to the Template
Settings page. Here, you may edit the Template Name, Description, Event Types, Work
Groups, Protected setting, or Status. If any edits are made, click Save Changes.

11. Add information to the template as appropriate. Sections display according to the Event
Type you selected for the template.

12. On the Description page, enter a description for the template, or click to Copy from
Library. If you Copy from Library, an overlay displays allowing you to select a Library, and
then Description text.

13. On the Prerequisites page, click Add Prerequisite and then select Add New Prerequisite
or Add from Library.

a. For each new Prerequisite added:

i. Enter instructions for the supplier.

ii. Select how you want to enter content - by attaching a file or entering the
content directly.

iii. Select if this prerequisite is Optional for the supplier to view, Required for the
supplier to view the event, or Required for the supplier to bid on the event.

iv. Edit the Certification text, if appropriate.

v. Select if you want the Supplier to Upload a File for this prerequisite.

vi. Click to Save Changes.

b. When selecting to Add from Library, select the library, the prerequisite(s), then
click Add Selected Prerequisites.

c. Click the Edit button to choose to Edit or Delete the Prerequisite.
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14. On the Buyer Attachments page, click to Add Attachment and then select Add New
Attachment or Add from Library.

a. For each new Attachment added:

i. Choose File or Link for the type of attachment.

ii. Browse and upload the file or enter the URL information as appropriate.

iii. Click Save Changes.

b. If selecting to Add from Library, select the library, the attachment(s), then click Add
Selected Attachments.

c. Click the Edit button to choose to Edit or Delete the Attachment.

15. On theQuestions page, click to Add Question and then select Add New Question or Add
Questions from Library.

a. If you would like to group your questions, selectManage Group and select to:

i. Add New Question - To add a question to this group of questions.

ii. Add Questions from Library - To add questions from a library.

iii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iv. Delete Group - To remove the group of questions.

b. When selecting to Add New Question:

i. Enter the Question Text. This is displayed to suppliers.

ii. Select a Response Type for the question (the format of the answer). See for
more details on the types of responses.

iii. Indicate if a Supplier Response is Required.

iv. Select the Upload button if you would like to attach a file to the question.

v. Once more than one question is provided, indicate the Display Order for the
question.

vi. Select Save Changes to add the question to the page.

c. When selecting to Add from Library, select the library, the page and/or group, the
specific questions, then click Add Selected Questions.

d. You may select to Add New to create a new group or new page of questions visible
to the supplier.
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e. You may delete multiple questions by selecting the checkbox on the right side of the
question and choosing the hyperlink Delete Selected Question(s).

f. Click the Edit button to choose to Edit or Delete a question. To delete multiple
questions, select the checkbox for the items and click the link Delete Selected
Question(s).

16. On the Additional Item Fields page, choose to Create Additional Field, Add Field From
Library or Create Conditional Follow Up (to create a field that is displayed when a
specific value on the parent field is selected):

a. For each new additional item field added:

i. Enter a Name and Description for the field.

ii. In the Applicable To field, select if the field is applicable to product line items,
service line items, or both. If you are creating a conditional field this will be a
read-only field that displays what has been selected on the parent field.

iii. In the Supplier Can Respond field, select Yes or No to indicate whether or
not suppliers are able to respond to the field. If you are creating a conditional
field, choose Yes. Additional checkboxes are displayed depending on your
selection:

l Visible to supplier - Displayed if you select No. Select to enable
suppliers to view the field even when response is disabled. If not
selected, only internal users can view and edit the field.

l Supplier response is required - Displayed if you select Yes. Select
the checkbox to make it mandatory that suppliers complete the field
before they can submit a bid.

iv. Select a field type.

v. The Set Disqualifying Response checkbox is displayed if Yes is selected for
Supplier Can Respond and the appropriate Field Type is selected. Click the
checkbox if you want to configure a response to an item-level question that, if
selected, will disqualify a supplier. The disqualifying response is defined under
Response Options.
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vi. Select the following checkboxes to configure auto-scoring or cost analysis for
the field:

l Use Response in Auto Score - Select to use supplier responses to
additional item fields for auto-scoring. If selected, scoring values are
added to each response in the Response Options section.

l Use Response in Cost Analysis - Select to use supplier responses to
additional item fields for cost analysis. If selected, cost adjustments are
added to each response in the Response Options section.

Note: These checkboxes are displayed if auto-scoring and cost analysis
have been enabled for the event and set to be applied at the individual
line level, and the field type chosen supports auto-scoring and cost
analysis.

vii. If you have selected a field type that requires Response Options to be
defined, enter each response that can be selected for the field, assign auto-
score and cost analysis values, and identify disqualifying responses.

viii. If more than one additional item field is provided, indicate the Display Order
for the field.

ix. Click Save Changes.

b. If selecting Add From Library, select the library, then the additional item fields, then
click Add Selected Item Fields.

c. If selecting Create Conditional Follow Up, select the additional item field that will
be immediately above the field you are creating in the conditional visibility hierarchy
and complete these fields:

i. In the Conditional Upon Value field, select the value from the parent field
that will cause the field you are creating to be displayed.

ii. Enter a Name and Description for the field.

iii. The Supplier Can Respond field must be set to Yes. Select the Supplier
response is required checkbox to make it mandatory that suppliers complete
the field before they can submit a bid.

iv. Select one of the following Field Types: Yes/No, Dropdown List (Pick One),
Multiple Choice (Pick One), Multiple Choice (Pick Many).

v. Choose whether to use supplier responses for scoring and cost analysis by
selecting the Use Response in Auto Score or Use Response in Cost
Analysis checkboxes.
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vi. Click the Select Disqualifying Response checkbox if you want to configure a
response to an item-level question that, if selected, will disqualify a supplier.

vii. If you have selected a field type that requires Response Options to be
defined, enter each response that can be selected for the field, assign auto-
score and cost analysis values, and identify disqualifying responses.

viii. If more than one additional item field is provided, indicate the Display Order
for the field.

ix. Click Save Changes.

17. On the Items page, you may add product and/or service line items for the supplier's
response.

a. If you would like to group your line items, selectManage Group and select to:

i. Add New Item - To add an item to this group.

ii. Add New Item from Library - To add an item from the library.

iii. Edit Group - To change the name of the group or to add user instructions for
the questions that are presented in the group.

iv. Delete Group - To remove the group of line items.

b. When selecting to add a new item to the Product Line Items page, you may select
theManage Group > Add New Item link, or the Add New Item button for the group
(required fields are indicated with a star ):

i. Enter a Name for the item.

ii. (optional for Product Line Items only) If the Brand option is enabled for your
organization, type a brand name in the field. The system will check to see if
the name matches brands in the system. If there is a match, the name is
added to the Brand field. If it does not match, the message Try Searching
Again is displayed.

iii. Enter a Description for the Item.

iv. Enter a Catalog Number for the item, if known.

v. Enter aQuantity of the item needed.

vi. Select a Unit of Measure for the item from the drop-down.
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vii. Select from the followingOptions these may be changed for individual event
items):

l Select if a Unit Price is Required for this item. If selected, the supplier
cannot submit a bid response without entering this information.

l Select if an Estimated Delivery Date is Required for this item. If
selected, the supplier cannot submit a bid response without this
information.

viii. If you would like to associate a Commodity Code with the item, select the
Edit button and choose from your organization's commodity codes. Only one
commodity code may be selected for each item.

l When the Let Me Choose template protection option has been
selected, new flags are available to prevent event creators and owners
from deleting template-level commodity codes. Template
administrators may choose to apply the following flag conditions:

l Protect Reporting Commodity Code
l Protect Additional Commodity Codes

Note: Item-level commodity codes are not subject to these
protection features.

ix. Enter the Historical Unit Price for the item.

Note: If the event currency does not match the Historical Unit Price currency
set for a library or template item, the Historical Unit Price is automatically
converted to the event currency using the organization's default exchange
rate when the item is added to an event. If no default exchange rate has been
set for the currency, the Historical Unit Price is not transferred for that item.

x. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

xi. Click to Save Changes.
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c. When selecting to add a new item to the Service Line Items page, you may select
theManage Group > Add New Item link, or the Add New Item button for the group
(required fields are indicated with a star ):

i. Enter a Name for the item.

ii. Enter a Description for the service.

iii. Enter aQuantity for the service item.

iv. Enter a Unit of Measure for the item.

v. ForOptions, select if a Unit Price is Required for this item. If selected, the
supplier cannot submit a bid response without this information.

vi. If you would like to associate a Commodity Codewith the item, select the
Edit button and choose from your organization's commodity codes. Only one
commodity code may be selected for each item.

vii. You may attach a file to the item by selecting Upload, entering a title for the
file, and selecting the appropriate file to attach.

viii. Click to Save Changes.

d. When selecting to Add from Library, select the library, the line items group and the
questions will display. Select the appropriate questions, then choose the item group
to show them in the template, as well as the display order. Then click Add Selected
Items.

e. Click the Edit button to choose to Edit or Delete items. To delete multiple items,
select the checkbox for the items and click the link Delete Selected Item(s).

Create a Quick Quotes Template
Quick Quote Template settings enable buyers to apply default selections to key event control
parameters such as eventOpen, Close andQ&A Submission Close date settings. You also have
the option to set a preferred award scenario within a Quick Quote Template for immediate
application when an event closes. Other Quick Quote Template controls that can be applied
during event construction include the invitation of a selected Supplier Group and the automatic
distribution of Award notification emails.
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1. AQuick Quote Template checkbox appears on the Template Settings page. When users
select this checkbox, aQuick Quote Settings section appears at the bottom of the
template page. The Quick Quote Settings section contains the following required fields:

l Open Date/Time Offset (Offset from Event Creation) - applied in either hours or
minutes

l Close Date/Time Offset (Offset from Open Date/Time) - applied in either days,
hours, or minutes.

l Default Award Scenario - usually targets an award based on the lowest bid price.
You can choose between single awards and split awards.

2. If the Event Type selected for the template is Auction and the Quick Quote Template
checkbox is selected, the following additional required fields will appear:

l Auction Open Date/Time Offset (Offset from the event Open Date/Time)

l Auction Close Date/Time Offset (Offset from the auction Open Date/Time)

3.  The settings also include non-required fields that dictate the Award Notification email
strategy and a field to identify Supplier Groups whose members will receive event
invitations:

a. A checkbox selection determines if award notification emails will be automatically
sent by the system following event awarding.

b. A Supplier Group can be selected as a means to default an event's supplier invitee
list.

Copy a Template
Event administrators can copy an event template and modify it to their specifications, saving
them the time required to enter similar information for each event template.

Permission(s) required: Manage Templates and Libraries.

1. Navigate to Sourcing > Templates and Libraries > Event Templates.

2. Click the Edit button next to the event template you want to copy, then select Copy
Template. The Copy Template window opens.

3. Enter a name for the new template in the Template Name field.

4. (optional) Enter a description of the new template in the Description field (256 character
limit).
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5. Click Save Changes. A copy of the original template is created and displayed with the new
name and description. Access settings for the new template are copied from the original
template.

6. Modify settings on the new template as needed and continue with the creation of the
template.

Manage Event Templates
Templates are managed on the Sourcing > Templates and Libraries > Manage Templates
page. When managing templates, users have the ability to:

l Create and edit templates

l Copy templates

l Group templates

l Associate templates to work groups (to which the user has access)

l Event creators can create events using templates associated with the work group for the
event.

All users with the Manage Templates and Libraries permission have access to see templates for
work groups the user is assigned as a Template and Library Manager. When creating a template,
the user can only associate the template with work groups to which the user is a Template and
Library Manager.

A user may also create an event based on a template directly from theManage Templates page.
The user must have access to the work groups assigned to the template and have the permission
to create events.

Sourcing Request Templates
Sourcing Request Templates are created separately from Event templates and are used for the
Sourcing Request process. The Create Templates and Libraries permission (Permissions >
Sourcing) is required for creation and administration of Sourcing Request templates.

Request Templates that are in Draft status can be edited, copied, or deleted. Request Templates
that are Finalized can be viewed, copied, archived, or edited as a draft version.

Create a Template
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1. Navigate to Sourcing > Requests > Event Request Templates.

2. Click the Create Sourcing Event Request Template button. The Create Sourcing Event
Request Template overlay opens.

3. Enter a Template Title.

4. Accept the default Currency selection or choose a different currency from the drop-down
list.

l The default selection for this required field is the organization's default currency. If a
default currency is not set for the organization, the organization's base currency is
used instead. The base currency is the currency that was selected for the
organization when its JAGGAER account was created.

l Once the Currency is selected and saved in a template, it cannot be changed.

5. Click Create. The overlay closes and you are brought to the template creation wizard.

6. Complete the Template Setup, Instructions, Attachments, Questions, Product Line Items,
Service Line Items, and Suppliers steps of the wizard.

7. When the template is complete, navigate to the Review and Finalize step on the wizard,
and click the Finalize Template button.

Copy a Template

You can copy a template in order to create a new template with similar settings.

Permission(s) required: Manage Templates and Libraries.

1. Navigate to Sourcing > Requests > Event Request Templates.

2. Click the Actions dropdown button next to the request template you want to copy, then
select Copy. A confirmation message displays. Click Yes to proceed, or No to cancel.

3. The page refreshes with a default Template Title of Copy of XXXX.

4. Edit the Template Name and proceed with the template creation as explained above,
modifying copied information as appropriate.
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Sourcing Email Templates
Sourcing email templates are available to give customers flexibility with the award notifications
that they choose to send to suppliers for sourcing events. A Sourcing Email Templates page is
available to add and edit email templates.

A user must have theManage Sourcing Email Templates permission to access the Sourcing

Email Templates page located at Sourcing > Templates and Libraries > Sourcing Email
Templates. In order to create new templates, the organization must be configured to send award
notifications. For information on award notification configuration, see "Award Notifications" on
page 176.

Only organization sourcing email templates are displayed on the Sourcing Email Templates
page. Default sourcing email templates are not available on this page, but are located and
editable at Administer > Email Management > System Emails. The default emails are also
available for selection and editing on individual events.

To create a new template, users will click the Add Sourcing Email Template button on the page.
Create the template by providing:

l Email Name: This will display for selection when choosing an email to send for an event's
award notification.

l Type: The email will be sent to this type of supplier. Choose from:

l Awarded suppliers - those suppliers who have been awarded all or a portion of an
event.

l Participating suppliers - suppliers who responded to the event but did not receive
an award.

l Non-participating suppliers - Suppliers who were invited to the event but did not
respond.

l Status: If you select Published, the email will be displayed for selection in sending award
notifications on the event. If you select Draft (Hidden), the email will not be available for
selection on events.

l Subject: Provide a subject for the email.

l Attachment(s): You may provide up to three attachments that will be sent with the email.

l Message: Use the formatting tools to compose your message.

Existing Sourcing Email Templates



JAGGAER 311 www.JAGGAER.com

Adding a Sourcing Email Template

Manage Sourcing Email Templates
Sourcing email templates may be configured to use when sending award notifications to
suppliers for sourcing events.

Permission(s) required:Manage Sourcing Email Templates.

1. Navigate to Sourcing > Templates and Libraries > Sourcing Email Templates.

2. Click the button for Add Sourcing Email Template.

3. Enter a Name for the email. This will display for selection when choosing an email to send
for an event's award notification.

4. Select a Type for the email: Awarded Supplier Email, Participating Supplier Email, or Non-
Participating Supplier Email.

5. Select a Status. If Published, it will display for selection for award notifications in the
event. If Draft (Hidden), it will not be available for selection on events.
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6. Enter a Subject for the email.

7. If applicable, select Upload to provide up to 3 file attachments.

a. Select to Browse and select the appropriate file.

b. Select Save Changes in the Upload overlay.

8. Using the formatting tools, compose the email message text.

9. When finished, select Save Changes. A confirmation message displays and the template
shows on the Sourcing Email Templates page.

10. To edit the email, select the Actions drop-down, and select Edit. Make the appropriate
edits and select Save Changes.

11. To delete the email template, select the Actions drop-down and select Delete.

Custom Fields
Users can add custom fields to events. This enables them to capture and report on additional
information that is unique to their business and to their event administration process. Content
within these fields is available to support the routing of events within the workflow process. It can
be used to logically categorize their sourcing events and to search for specific events.

The custom fields appearing on a sourcing event are determined by their integration into the
event type used to construct the event. On the Custom Data tab of Event Types, users are able to
set display order, grouping, and whether or not the custom fields are required.

Users with permission to define custom fields are able to set the custom field name and response
type. Depending on the response type selected, users are further able to choose response
options, and whether the field can be used to search for events via the Advanced Search
function. Users are also able to add help text on custom fields if they so choose.

The available response types are:

l Text (Single Line)
l Text (Multi-Line)
l Numeric Text Box
l Yes/No
l Dropdown List (Pick One)
l Multiple Choice (Pick One)
l Multiple Select (Pick Many)
l Date
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If a custom field or event type is edited, changes will appear on new sourcing events. Existing
events do not have their custom fields changed.

Create/Edit a Custom Field
Required permission(s):Manage Sourcing Custom Fields.

1. Navigate to Sourcing > Templates and Libraries > Custom Fields.

2. To create a new custom field, click the Create Custom Field button. To edit an existing
custom field, click the Edit button beside the listed field.

3. Enter a Field Name for the custom field.

4. Enter an Internal Name for the custom field.

5. Select a Response Type for the custom field:

l Text (Single Line) - Users enter a single line of text.

l Text (Multi-Line) - Users enter multiple lines of text (2000 character limit).

l Numeric - Users enter a number. Numbers can be positive or negative, with up to 2
decimal places.

l Yes/No - Users choose Yes or No.

l Dropdown List (Pick One) - Users select one option from a dropdown list of
options you create.

l Multiple Choice (Pick One) - Users select one option from a list of options you
create.

l Multiple Select (Pick Many) - Users select multiple options from a list of options
you create.

l Date - Users enter a date.

6. If the Dropdown List, Multiple Choice, or Multiple Select response types are selected, you
will also be prompted to enter options for those response types. Enter the option in the
field provided and click the Add Option button. The option will appear below the field.
Click the Remove button beside the option to remove it.

l Continue to add options as required.

7. Optionally, select Yes beside Add Help Text. A text field is displayed where you can add
and format help text for the field.
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8. Optionally, you can select Yes beside Show on Advanced Search to make the field
searchable on Advanced Search.

9. Select the appropriate option for Active:

a. If you want to begin using the custom field immediately, select Yes (this is the
default selection).

b. If you want additional time to configure the custom field and would not like it used
immediately, select No.

10. Optionally, click Add/Edit Validation Rules, which appears beside the Field Validation
option. Note: Tooltips for configuring validation can be accessed by clicking the question

mark icon located beside the Field Validation option:

l A screen overlay opens to enable administrators to configure the validation rules
specific to the format of the Response Type selected for the custom field.

l Validation can be applied to the following types of custom field formats:
l Dates

l Defines an acceptable date range
l Defines acceptable dates that are less-than or greater-than a custom date

l Text
l Min Length - Defines the minimum number of characters that can be entered
in the field.

l Max Length - Defines the maximum number of characters that can be
entered in the field.

l Regex (Regular Expression) - Enables users to define a pattern of
characters that must be matched by the data entered in the custom field.

l Customized Pattern - Defines the pattern of data characters
that can be entered into this custom field. Note: Click the

question mark icon to access tooltips for configuring Regex
fields.

l Customized Pattern Message - Contains the text of the error
message that will appear onscreen if invalid data is entered into
this custom field.

l Numeric
l Defines the decimal precision of the number
l Defines the acceptable numeric range

11. Click Save to save the custom field and close the wizard.

The custom fields that are displayed on a sourcing event are determined by their integration into
the event type used to construct the event. See "Event Types" on page 52 for more information.
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General Sourcing Settings
When configuring your organization for sourcing, you will select an Event Number wheel, and
other options for work groups and events such as sealed bids, proxy bids, and manually inviting
suppliers. You will also configure the settings for your organization's Public Site, if desired. Many
of these configurations will inherit to the work group level, where you can configure options for all
work groups or by event.

Sourcing Event Type
Choose to optionally allow Restricted User Access. Enabling this option will allow organizations
to decide whether or not all event creators can use any active event types during event creation.
See "Event Types" on page 52 for more information.

Event Number Wheel
Number wheels are used to automatically assign a numbering schema to your events. You may
choose to use dynamic prefixes that use the work group code or event type from the new event.
Once you configure the different number wheels, you may select from the configured number
wheels for:

l Default number wheel for all work groups and events.

l Default number wheel for a work group grouping.

The actual number that is populated for an event may be edited if appropriate.

Assign Default Event Number Wheel

Permission(s) required: Sourcing Configuration

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Assign an Event Number Wheel section, select from your configured Number
Wheels in the dropdown.

3. Upon selection, you will see an example of a current event number using the selected
configuration.

4. In the Event Number Editing setting, choose whether the Event Number can be edited by
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users, by Sourcing administrators only, or if the value in this field cannot be altered.

5. Click Save Changes.

6. The selected number wheel will now be the default for all work groups/events.

Configure Event Number Wheel

Permission(s) required: Sourcing Configuration

1. Navigate to Sourcing > Sourcing Administration > Manage Event Number Wheels.

2. To create a new Event Number Wheel, click the Add Event Number Wheel button.
Proceed to Step 4.

3. To edit an existing Number Wheel, click the Edit button or Name hyperlink for the
appropriate Number Wheel. Proceed to next step.

4. Enter/Edit the Name for the Event Number Wheel. This is what you will see for selection for
the organization default and work group groupings.

5. Enter the information to Customize Event Number Prefix (all fields optional). Whatever is
entered here will be appended BEFORE the actual number.

a. Enter free-form text and/or select from the drop-down for Event Type or work group
Code as appropriate to 'build' the sequence of characters for the prefix.

b. Leave a field blank if you do not want to use it in the prefix.

c. As information is entered in the sequence, see Preview Event Number at the
bottom.

6. Select options to Customize Numeric Portion of the number wheel:

a. If you select Yes to Pad with Leading Zeros, you will be given the option to select a
Number of Digits for your numeric portion. This is the total number of digits you want
the numeric portion to be. As an example, if you have selected 4, and your Event
Number is 2, the numeric portion will be 0002. If your Event Number is 12, the
numeric portion will be 0012.

b. The Starting Number is the numeric value that should be on the first event that
uses this number wheel. Once saved, this value cannot be edited.

c. You may see how the numeric portion will display in the Preview Event Number
section at the bottom.
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7. Enter the information to Customize Suffix Portion (all fields optional). Whatever is entered
here will be appended AFTER the actual number.

a. Enter free-form text and/or select from the drop-down for Event Type or work group
Code as appropriate to 'build' the sequence of characters for the suffix.

b. Leave a field blank if you do not want to use it in the suffix.

c. As information is entered in the sequence, see Preview Event Number at the
bottom.

8. When finished, click Save Changes. The number wheel may now be selected for work
groups.

9. Event number wheel configuration edits are captured in an audit log, which is displayed
when selecting the History hyperlink.

Best Practice: Add a separator character such as a dash or slash for the free-form prefixes so
that the dynamic portions have a visual separator and it is visually separate from the numeric
sequence.

Supplier Invitation

Forced Supplier Invitation by Commodity Code

Organizations that utilize commodity codes may choose to associate one or more codes with a
sourcing event, or to items on the event. When inviting suppliers, a user may choose to search for
suppliers to invite based on commodity code for the supplier and add the supplier to the sourcing
event. The customer may also choose to enable a setting that will force supplier invitations based
on commodity code. This setting can be enabled at the organization, work group and event level.

Permission(s) required: Sourcing Configuration.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Supplier Invitations section, select an option for Forced Supplier Invitation by
Commodity Codes

a. Optional - This option will allow the setting to be configured at the work group level.
If the work group keeps theOptional setting, the Forced Supplier Invitation by
Commodity Code option will show on all events, but will be optional for use.

b. Required - All events must force supplier invitation by commodity code. The setting
inherits to all work groups and events and cannot be changed.

c. Disabled - No events can force supplier invitation by commodity code. The setting
inherits to all work groups and events and cannot be changed.
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3. Click to Save Changes.

4. Changes to the Forced Supplier Invitation by Commodity Code are logged in history,
available by selecting the History hyperlink on the page.

When an item that has been configured with a commodity code is added to a Sourcing event, the
commodity code is automatically transferred to the event along with the other item information. If
the Forced Supplier Invitation by Commodity Codes setting has been activated and the event
is in Draft status, the supplier count will be updated automatically to reflect the addition of the
commodity code to the Sourcing event.

l If the library item is added to a Sourcing event through the amendment process, the
amendment reconciliation process must finish running before the supplier count is updated
automatically and new supplier invitations are issued.

l If the library item is added in a subsequent stage of a multi-stage event, the supplier count
will not be updated and new supplier invitations will not be issued automatically for that
event.

Manually Invited Suppliers

Customers may configure the organization and sourcing work groups to allow manually inviting
suppliers who are not currently in the supplier master database. With this feature enabled, buyers
may invite new suppliers to a sourcing event without creating a record for that supplier until the
supplier responds to the invitation. If the supplier never responds, the supplier master database is
not polluted with the new supplier information.

Permission(s) required: Sourcing Configuration.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Supplier Invitations section, select an option forManually Invited Suppliers
Setting:

l Optional - work groups may allow manually invited suppliers. This option allows
the Manually Invited Supplier setting to be configured at the work group level. If the
work group keeps the Optional setting, the Manually Invite Suppliers option will show
on all events, but will be optional for use.

l Required - All work groups must allow manually inviting suppliers. The Manually
Invite Suppliers option will always be enabled for work groups and cannot be
disabled at the work group or event level. It will still be optional for use on each
event.
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l Disabled - work groups do not allow manually invited suppliers. The Alternate
Items option will never be enabled for any work groups and it cannot be enabled at
the work group or event level. No events will show the option to allow manually
invited suppliers.

3. Click to Save Changes.

4. Changes to theManually Invited Suppliers Setting are logged in history, available by
selecting the History hyperlink on the page.

Include/Exclude Tax ID Inputs for Manually-Invited Suppliers

Customers may configure the organization and sourcing work groups to exclude US-based Tax
ID inputs for manually-invited supplier users to Sourcing events. This setting affects only the
initial supplier Create Account action for Sourcing registration. It does not impact any other
supplier registrations.

Permission(s) required: Sourcing Configuration.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Supplier Invitations section, select an option for Enable Tax Input for
Registration:

l Yes (default) - The Tax ID Number field is included in the information collected from
newmanually-invited suppliers when they register for participation in a
JAGGAER Sourcing event.

l No - The Tax ID Number field is not included in the information collected from new
manually-invited suppliers when they register for participation in a
JAGGAER Sourcing event.

3. Click to Save Changes.

4. Changes to theManually Invited Suppliers Setting are logged in history, available by
selecting the History hyperlink on the page.

Bid Settings

Sealed Bids

Sealed bids enable an organization to manage sourcing events with heightened integrity. If an
event uses a sealed bid process, the evaluators cannot see the responses as they are individually
received, but will have the ability to see those responses at one time on the designed date when
bids are unsealed.
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Permission(s) required: Sourcing Configuration

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Sealed Bid Setting section, select an option:

l Optional - Events may be sealed or unsealed: This option will allow the Sealed Bid
option to be configured at the work group level. If the work group keeps the Optional
setting, the Sealed Bid Setting may be configured at the event level.

l Sealed - All events are sealed. The option cannot be changed for work groups or
events.

l Not Sealed - No events are sealed. The option cannot be changed for work groups
or events.

3. Click to Save Changes.

4. Changes to the Sealed Bid Setting are logged in history, available by selecting the History
hyperlink on the page.

When an event is configured to use the sealed bid process, you will see an envelope icon for the
event in search results. You will also have the opportunity to configure the Sealed Bid Open Date
and have the option to show that date to suppliers.

Allow Proxy Bid on Sealed Events

Proxy Bids allow the organization greater flexibility in receiving bid responses from suppliers. An
event with proxy bid enabled allows suppliers to mail, email or phone in a bid to the buyer. The
buyer will see the sourcing event as a supplier would see it in their portal, thereby making it easier
to complete the bid information online on the supplier's behalf.

Proxy Bids are configured asOptional for organizations by default, meaning that Proxy Bids can
then be enabled at the work group and/or event level. In order for a customer user to enter the
proxy bid on the supplier's behalf, the user must be an Event Owner, and have the Create Proxy
Bid permission.

Permission(s) required: Sourcing Configuration.
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1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Proxy Bid Setting section, select an option:

l Optional - work groups may allow proxy bid. This option will allow the Proxy Bid
option to be configured at the work group level. If the work group keeps the Optional
setting, the Proxy Bid Setting may be configured at the event level.

l Required - All work groups must allow proxy bid. The Proxy Bid option will always
be enabled for work groups and cannot be disabled at the work group or event level.

l Disabled - No proxy bids allowed. The Proxy Bid option will never be enabled for
any work groups and it cannot be enabled at the work group or event level.

3. Click to Save Changes.

4. Changes to the Proxy Bid Setting are logged in history, available by selecting the History
hyperlink on the page.

Confidential Pricing

Select to allow or disable the ability to restrict the set of users who may view prices on events.
When Confidential Pricing is set toOptional on the General Sourcing Settings page, a new
setting, Confidential Pricing, displays on the Setup page of an event. Selecting Yes for this
option adds a new access group, Event Price Viewers, to the Users section of the event.

Allow Event 'Open Dates' to be Past Dates

Define whether users can select past dates in Draft eventOpen Date fields (Yes), or if entries in
this field must be future dates (No). Default is Yes to allow entry of past dates.

Show Supplier's Award Summary Page

Gives all suppliers that have been awarded any part of an event access to the Your Award
Summary page within the event after awarding was completed. Default is Yes. When No is
selected, the Your Award Summary page is hidden from suppliers within the supplier user
interface of each event after the event is awarded.
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Evaluation Settings

Cost per Quality Point

Cost Per Quality Point (CPQP) is an evaluation method that combines quality and price for an
event. CPQP can be configured at the organization, work group, and event level.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Event Evaluations section, select an option for Cost Per Quality Point:

a. Optional - All work groups are allowed to use Cost per Quality Point in event
evaluation. You will have additional configuration options at the work group level.

b. Disabled - No work groups are allowed to use the Cost Per Quality Point in event
evaluation. No options are available to configure at the work group level.

3. Click to Save Changes.

4. Changes to the Cost Per Quality Point Setting are logged in history, available by
selecting the History hyperlink on the page.

When configured at the event level, the Cost Per Quality Point is calculated using the Total Bid for
required items and the average panel questionnaire rating.

When set asOptional or Allowed at the work group level, an option for Cost Per Quality Point
will display under the Bid and Evaluation section of Event Setup page.

l Yes - If yes is selected, the system will calculate CPQP for each supplier's submitted
response, using the Total Bid for required items and the average panel questionnaire rating
for the supplier.

l No - CPQP will not be calculated for the event.

If the work group setting is set to always use CPQP, the setting will show as Yes on the Event
Setup and cannot be changed. If the work group setting is set toOff, the CPQP option will not
display.

Best Value

Permission(s) required: Sourcing Configuration
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1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings

2. In the Event Evaluations section, select an option for Best Value Setting:

a. Allow - All work groups are allowed to use the Best Value calculation in event
evaluation. You will have additional configuration options at the work group level.

b. Disallow - No work groups are allowed to use the Best Value calculation in event
evaluation. No options are available to configure at the work group level.

3. Click to Save Changes.

4. Changes to the Best Value Setting are logged in history, available by selecting the
History hyperlink on the page.

Alternate Items Setting

Customers may allow alternate items to be submitted by suppliers when responding to sourcing
events. Alternate Items may be configured at the organization, work group, and event level. If
enabled, each item is configured to allow or not allow alternates.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Alternate Items Setting section, select an option:

l Optional - Work groups may allow alternate items. This option will allow the
Alternate Items Setting to be configured at the work group level. If the work group
keeps the Optional setting, the Alternate Items Setting may be configured at the
event level.

l Required - All work groups must allow alternate items. The Alternate Items
Setting option will always be enabled for work groups and cannot be disabled at the
work group level or event level. The option for Alternate Items are Allowed is
available for configuration when adding items to events.

l Disabled - Work groups do not allow alternate items. The Alternate Items option
is disabled for all work groups and it cannot be enabled at the work group or event
level.

3. Click to Save Changes.

4. Changes to the Alternate Items Setting are logged in history, available by selecting the
History hyperlink on the page.
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Notification Emails

Multi Stage Notification Emails

Select if your organization does not want to send notifications to suppliers who do not advance to
subsequent event stages. See Notifications Related to Multi-Stage Events in "Managing Multi-
Stage Events" on page 253 for additional information.

Award Notification Emails

Standard and system email notifications are available for use in communicating with suppliers
through the application. For sourcing events, customers have the ability to configure and send
custom award notification emails to event suppliers. Organizations enable the types of award
emails they want to have the ability to send on an event. When the event is awarded, users will
then have the option to send the award notifications to affected suppliers.

Permission(s) required: Sourcing Configuration

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. In the Award Notification Emails section, select the award notification emails that you will
have the option of sending:

a. Winner Award Notifications - These emails are sent to awarded suppliers.

b. Participant Award Notifications - These emails are sent to suppliers who
responded to the sourcing event, but were not awarded any portion of the event.

c. Non-Participant Award Notifications - These emails are sent to suppliers who
never responded to the sourcing event before the closing date.

3. Click to Save Changes.

4. Changes to the Award Notification Emails are logged in history, available by selecting the
History hyperlink on the page.

When any of these notifications are enabled, an Award Notifications page will display in the Tools
section of the Event navigation. From this page, the user can select which of the enabled
notifications, if any, to send for the event.

The Award Notifications page contains a Public Site Award Attachments section when a Public
event has closed and is under evaluation. If a pdf document or webpage link is configured and
published in this section, it is available to suppliers when they access the Public event. This
option allows users to publish award documents from any stage of such an event once the stage
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has closed and is under evaluation. With this functionality, clients can announce planned award
strategies in advance of a formal award. This, in turn, allows suppliers to review these strategies
in a timely manner and provide feedback to the buyer prior to the actual award.

If no notifications are selected in the General Sourcing Settings, the Award Notifications
section will not show for events. For information about configuring new sourcing email templates,
see the section called Sourcing Email Templates in "Templates" on page 297.

Restrict Buyer Notifications

With this option enabled, an access group called Notification Recipients will appear on events,
and only users included in that group will receive system-generated buyer notifications. If
Optional is selected, users will need to specify on the work group level to restrict system-
generated event buyer notifications. If Required is selected, all sourcing events will include
restricted buyer notification delivery.

Import/Export
Select the number of days that import or export files will be retained in the system. The default
value is 7 days.

Public Site Setting
A Public Site is a branded site where customers can publicly display sourcing bid opportunities
without specifically inviting suppliers through the application. Customers can determine what
parts of the bid collateral and award data will be displayed on the Public Site. Any supplier may
search and view publicly posted events.
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You must contact JAGGAER to enable the ability to configure Public Site for your organization.

Once enabled, you will configure whether or not you want to always, never, or have the option of
making an event public. You'll also configure the parts of the event that you want a user to see in
the PDF available for download from the public site. You'll also choose whether or not you want to
display any awarded event information on the public site.

Permission(s) required: Sourcing Configuration.

1. Navigate to Sourcing > Sourcing Administration > General Sourcing Settings.

2. Scroll to the Public Site Setting section.

3. Visible to Public - The default setting isOptional. This will allow you to choose at the
event level if you want that event to be made public or private. If you choose the Required
option, all events will be made public. If you select the Disabled option, no events will be
made public.

l If you select Disabled, no additional settings in this section are required.

l If you selectOptional or Required, you will have additional options to configure.
continue to Step 4.

4. Select to enable or disable the following Event Sections that will be visible via the public
site:

a. Description

b. Prerequisites

c. Attachments

d. Questions

e. Items

5. Select to enable or disable the following Award information to be visible on the public site:

a. Award Status

b. Awarded Supplier

c. Awarded Bid Value

6. Select to enable or disable public site event filtering byWork Group.

l If Yes is selected, the link Select Work Groups to include as Filterswill appear.
Clicking this link opens an overlay listing your organization's work groups. Select the
work groups to include as filters and click Save Changes.
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7. Select to enable or disable public site event filtering by Business Unit.

8. Select to Save Changes.

9. Changes to settings are captured in History, accessed by selecting the History link at the
top of the page.

Public Site Branding
If you selectedOptional or Required for the Visible to public setting, you will configure how
your public site will look and the type of information that will be available.

1. Note the Public Site URL. This is the URL you should provide to suppliers in order to
access the public events.

2. Public Site Header Image: Select to manage the image that will show on the Public Site. If
you do not have an image loaded, follow the instructions to upload an image, and then
select the image. If you already have an image loaded into your system, select the
appropriate image for the Public Site Header Image.

3. URL Display Name: Enter the name for the link that will display on the Public Site. For
example, if the user enters "Supplier Portal," the link on the Public Site will display "Back to
Supplier Portal.

4. URL: This is the actual URL that the user is taken to when clicking the "Back to" link on the
Public Site. For example, if the URL Display Name is "Supplier Portal" and you want the user
to be directed to the Supplier Portal Login for your organization, enter that URL here.

5. Public Site Welcome Message: This message will display on the public site as a general
welcome message to suppliers. Enter in appropriate text using the formatting tools
available.

6. Select to Save Changes.

7. Changes to settings are captured in History, accessed by selecting the History link at the
top of the page.

Public Event Export Notifications
An event export is available for transporting public event data from the Sourcing module to
external systems. With this export, for example, customers can expose their public sourcing
events on third-party websites, while administering the events within the Sourcing platform. A
standard system email notification can be activated to notify users when public event exports fail.
An in-app notification can also be displayed in the UI banner.



JAGGAER 328 www.JAGGAER.com

Note: Your IT personnel should work with your JAGGAER Technical Consultant to configure
your site with the required connection details, the run schedule of the associated export
Job, and establishment of the appropriate event export triggers, based on your
organization's needs.

Set Up a New Document Export Setting for Public Events
1. Navigate to Setup > General Site Settings > Document Export Settings and select the
Connection Management tab.

2. Click the New Connections button, which is located above the list of existing connections.
3. Select the Supports Sourcing Event Export checkbox in the new Selected Connection

configuration options. A Sourcing Event Options drop-down is displayed under this field.
4. Select Public Events from the Sourcing Event Options drop-down.

5. If relevant, select the Include Attachments in Export checkbox, which is located below the
Sourcing Event Options drop-down.

6. Finish configuring the other fields and save the new connection.
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Schedule Exports for Public Events
1. Navigate to Setup > General Site Settings > Document Export Settings and select the
Scheduling Mgt tab.

2. Click the New Schedule button, which is located above the list of existing schedules, or
select an existing schedule from the list.

3. Expand the Doc Type drop-down and select Sourcing Event Export.
4. If more than one option appears under the Connections checkbox, choose the appropriate

option for Sourcing event exports:

5. Select the Transmit Frequency - Interval or Specific Times. Configure the appropriate
intervals or times on the resulting screen overlay.

6. Finish configuring the other fields and save the new connection.

Configure the Triggers to Control the Occurrence of Public
Event Exports

1. Navigate to Setup > General Site Settings > Document Export Settings and select the
Trigger Mgt tab.

2. Click the New Trigger button, which is located above the list of existing triggers.

3. Expand the Document Type drop-down and select Sourcing Event Export.

4. Expand the Event drop-down and select the appropriate trigger, such as event workflow
status change, event amendment, or event extension. Configure the specific changes
relevant to the selected trigger.



JAGGAER 330 www.JAGGAER.com

5. Click the relevant checkboxes to enable the Schedule and Connections relevant to the
Trigger.

6. Finish configuring the other fields and save the new connection.

Payment Terms

Configuring Payment Terms
You may configure payment terms which may be used on Sourcing Events to let suppliers know
your terms for payment for the event.

Note: If you do NOT want utilize payment terms and would prefer the option not appear on
events, you may hide the Payment Terms in field management.

Permission(s) required: Sourcing Configuration

1. Navigate to Sourcing > Sourcing Administration > Manage Payment Terms.

2. To create a new payment term, click the Add Payment Terms button. Proceed to Step 4.

3. To edit an existing payment term, select the appropriate value in the Payment Terms list.

4. Enter/Edit the Discount percentage, number of Days for the discount, and when the Net
amount is due if not paid by the discount days.

l Discount %: The discount amount that will be applied if payment is made before the
number of Days indicated.

l Days: The number of days before which the discount % can be applied. After this
number of days, the Net amount is due as indicated.

l Net: If payment is not made by the Discount Days, the net amount is due to the
supplier within this number of days.

5. Click Save for edits and Add for new payment terms.
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6. If you want to remove a payment term from the organization available list, select the
payment term and select Delete. A confirmation popup will display. Select Confirm to
proceed with deletion or Cancel to keep the payment term.

7. Configured payment terms are available to be selected in Event Setup for new events or
events in Draft status.

8. Changes to payment terms are logged in History, available by selecting the History tab.

Once configured, Payment Termsmay be selected in Event Setup.

Sourcing Workflow
The JAGGAER ONE Sourcing solution allows organizations to set up customized workflow rules
for:

l Event workflow - Used to approve a sourcing event to be released to suppliers. Workflow
rules check against the invited supplier list on the sourcing event.

l Evaluation workflow - Used to evaluate responses to the event and ultimately award the
event to a supplier. Workflow rules check against the suppliers who are marked Pending
Award in the Finalized Award Scenario.

l Form Request Workflow - Workflow to approve Sourcing Requests

l Quick Quote sub-type workflow - A sub-type workflow for Quick Quote events can be
configured for both Event workflow and Evaluation workflow to reduce the human
intervention needed to conduct Quick Quote events and to accelerate the pace at which
these events can be operated. These sub-type workflows operate outside of the standard
sourcing workflows and they eliminate the need for administrators to create specific
Advanced Dynamic Workflow routing triggers that are required when Quick Quote events
are conducted under standard workflows.

Note: Both a standard sourcing workflow and the sub-type Quick Quote workflow for
approvals and for evaluations can be active at the same time.

A user must have permissions to perform certain approval actions. See "Sourcing Permissions" on
page 21 for more information.
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Sourcing Request Workflow
Sourcing requests are sent through the Form Request workflow. There is only one Form Request
workflow option. Sourcing requests and quick quote requests are sent through the same
workflow.

Form Request Workflow will need to be enabled by JAGGAER. Once it has been enabled, you can
configure the workflow steps by accessing Setup > Workflow Setup > Form Request
Workflow Setup. For detailed information about the elements that can be used to create rules in
Advanced Dynamic Workflow or be configured in JAGGAER-managed workflow steps, see
Workflow Rule Options in the Administration and Configuration Handbook or online
searchable help.

Sourcing Workflow Process
The sourcing workflow process begins when a sourcing event is submitted and continues
through when the event is awarded to a supplier. The two major phases of sourcing workflow are
Event (Approval) workflow and Evaluation workflow. The design of an organization’s workflow
varies from simple to complex depending on the business needs and sourcing practices.

The goal of workflow is to make sure that all events sent to suppliers, and all events awarded to
suppliers, are valid. For example, workflow may involve work group level approvals. In other
cases, it may verify that items on the event with certain commodity codes are taken through a
specific approval process.

Workflow setup is rule-based, and JAGGAER Professional Services works with customers to
design these rules during the implementation process. Post implementation changes that cannot
be accomplished through the interface are performed by the JAGGAER Support Team.

Sub-Type Workflows for Quick Quote Sourcing Events
A sub-type workflow which operates outside of the usual sourcing workflow is available for Quick
Quote events. These sub-type workflows may be configured to reduce the amount of human
interaction needed to administer Quick Quote events and to increase the speed at which these
events can be managed. In these instances, fewer approvals may be necessary to conduct and
award a Quick Quote event. Please contact JAGGAER to activate these workflows.

Key Terms related to Workflow
Below are some definitions related to workflow setup and design.
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l Workflow Folders – Workflow folders represent a step in the workflow process and may
be referred to as workflow queues. When a requisition or workflow arrives at a step, the
individual(s) assigned to the workflow folder are notified. Workflow folders are shared,
meaning that more than one user can be assigned as an approver in a step. Shared
workflow folders are each labeled on the approvals screen in the case that a user is
assigned to more than one folder.

l My Approvals – The contents of theMy Approvals folder are sourcing events that require
the user's specific attention. A user must move an event from a shared folder to their folder
before action can be taken on the event.

l Static Workflow Rules – These are rules that do not change. For example, “If the sourcing
response is from a supplier with the Small Business diversity classification, route the
sourcing event to John Doe Approver". JAGGAER manages this type of workflow rule. 
However, the organization manages limits and assigned approvers through the interface.

l Advanced Dynamic Workflow Rules – Advanced Dynamic Workflow (ADW) allows
administrators to manage highly complex workflow rules through the application or through
the import process. JAGGAER manages the process that allows for the ADW rules, but the
organization configures the rules and sets approvers.

Sourcing Workflow Triggers and Steps
Rules are events or “things” that trigger a step in the workflow process. For example:

l A specific commodity for a supplier

l An estimated or finalized value for the event

l A specific supplier that has been invited to or has responded to the event

l A specific diversity classification for a supplier

Types of Workflow Steps:

l Manual Approval Step – This type of workflow step requires human intervention in order
for the step to be completed. One or more approvers must review the event and choose an
appropriate action.

l Automated Approval and Rejection – This type of step evaluates a certain set of criteria
and the system determines whether or not the event should be approved or rejected. This
step requires no human intervention. For example, an automated step may look to see if
the sourcing event value exceeded a commodity code criterion and if so, the order is auto-
rejected.
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l Automated (System) Step – This type of step performs a certain action in the system and
requires no human intervention. This type of workflow step is not evaluating criteria for
action, but instead is moving the event along in the process. An example is the external
supplier check that sends supplier profile information to the customer for external
validation.

l Notifications – This type of workflow step evaluates certain criteria and sends a
notification to the users that may be interested in the information. For example, an
organization may not require its Diversity team to approve events for/from diverse
suppliers, but want them to “know” about these events, so a notification is sent. The user
can view the information, but they are not required to take action on the event before it
moves to the next step in the process.

Rules can be written requiring manual approvals, automated approvals, automated rejections,
and notifications.

Viewing the Workflow Steps

There may be times when you have questions about an event’s behavior as it moves through
workflow. An event may stop in a particular step and you need to know why. Or, conversely, an
event may move through that same step without stopping. The workflow inspector tool allows
you to view the data that caused the behavior of document in a workflow step.

Workflow steps can be viewed in the system by viewing the sourcing event and looking at the
Approvals page under the Tools section. Two tabs are available for Sourcing Event Approval
Workflow and Sourcing Event Evaluation Workflow. By selecting a workflow rule, the Workflow
Inspector displays the details about the step and if the criteria for the step is present in the event.

Users with workflow configuration permissions may also view the details of the process on the
Workflow Process tab when viewing Approval Workflow setup or Evaluation Workflow setup.
You may click on a workflow step to see details about the activity, folder, and approvers.

Configure Advanced Dynamic Workflow Rule for Sourcing
Event
Advanced Dynamic Workflow is advanced functionality that allows administrators to manage
highly complex workflow rules through the application or through the import process. You must
have the Advanced Dynamic Workflow permission to configure these types of workflow rules.

Details of Advanced Dynamic Workflow:
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l Administrative screens are available to manage dynamic workflow for sourcing event or
sourcing evaluation approval.

l Workflow rule elements and data combinations can be managed by the system
administrator. For example, you can set up a rule to say that if the sourcing event is for a
particular work group, then “trigger” the step. Below are some of the data elements you
may configure for sourcing advanced dynamic workflow:

l Diversity classification

l Event dates

l Commodity code values (event or supplier)

l NAICS code values

l Estimated or finalized value

l work group

l Event Type

l User

l Multi Stage information

l Event Target Price

l Supplier Class

l Number of Suppliers

l Finalized Award Scenario

l You must set up Rule Groups, and then configure rules in the groups.

l You may import or export rule groups and modify them in bulk.

l Rule elements may be combined. For example, you may have a rule that looks at a specific
work group AND above a specified value.

The generic steps below apply to ADW rule setup for both Sourcing Event and Sourcing
Evaluation approvals.

Permission(s) required: (different for event or evaluation) Sourcing Configuration

1. For Event Workflow setup - Navigate to Setup > Workflow Setup > Sourcing Event -
Approval Workflow Setup.

2. For Evaluation Workflow setup - Navigate to Setup > Workflow Setup > Sourcing
Event - Evaluation Workflow Setup.
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3. Select the Advanced Dynamic Workflow tab.

4. On the Rule Group Management tab, if you do not have an existing rule group for the new
rule, select to Create new rule group:

a. Enter a Rule Group Display Name that will show to users viewing the approval
steps.

b. Enter a Rule Group Internal Name for use with importing/exporting rules.

c. Enter an optional Rule Group Description.

d. Select Save.

5. When you have the appropriate rule group created, select the Rules Management tab.

6. To add a new rule, select the Add Rule button.

a. In the Rule Info section, select the edit hyperlink to make changes.

b. Enter an appropriate Display Name for the rule.

c. Select the appropriate Rule Group from the dropdown.

d. Enter an optional Rule Description.

e. Select Active if you want the rule to be active immediately. Note: For the rule to
apply, it must have associated approvers and the rule must be configured in the
organization's workflow process.

f. Select Savewhen you have made all modifications.

7. Add approvers for the rule in the Approvers section.

a. Select the Add Approver... button.

b. In the overly, enter criteria to search for users with permission to approve steps in
this type of workflow.

c. Click the [select] link to add the name to the list of approvers in the overly.

d. When finished selecting approvers, select Add Selected Users button. The overlay
will close and the approvers display.

8. Create document-level rules.

a. Select the appropriate criteria for the Add a new rule for a field. Click Go.

b. Depending on your criteria selection, follow the directions in the Edit Dynamic Rule
Element overlay. In some cases, you will have a specific list from which the criteria
may be defined. In other cases, you may enter in text values to define the criteria.
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c. When finished configuring the rule, click Save.

d. You may select to edit or remove the rule.

Viewing Workflow Steps
There may be times when you have questions about an event’s behavior as it moves through
workflow. An event may stop in a particular step and you need to know why. Or, conversely, an
event may move through that same step without stopping. The workflow inspector tool allows
you to view the data that caused the behavior of document in a workflow step.

Workflow steps can be viewed in the system by viewing the sourcing event and looking at the
Approvals page under the Tools section. Two tabs are available for Sourcing Event Approval
Workflow and Sourcing Event Evaluation Workflow. By selecting a workflow rule, the Workflow
Inspector displays the details about the step and if the criteria for the step is present in the event.

Users with workflow configuration permissions may also view the details of the process on the
Workflow Process tab when viewing Approval Workflow setup or Evaluation Workflow setup.
You may click on a workflow step to see details about the activity, folder, and approvers.

Viewing the Workflow Steps in the Sourcing Event
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Viewing the details for a particular step

Viewing the Workflow Steps in the Workflow Process Tab

Viewing details for a particular step
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Enabling Ad Hoc Approvals for Sourcing Events

Settings

Administrators must enable the setting Allow users to add ad-hoc approvers for Sourcing
located in the Setup > Workflow Setup > General Workflow Settings: Workflow Options
section. This setting enables ad hoc approvals for all Sourcing workflows.

Permissions

The following permissions are related to Sourcing configuration. They are available when the
Allow users to add ad-hoc approvers for Sourcing setting is enabled and they can be
assigned to roles or on an individual basis.

l Approval Workflow permissions (User Profile > Permission Settings > Sourcing Event
Approvals section):

l Add Ad-Hoc Approver for Sourcing Approvals - Users with this permission can
add ad-hoc approval steps and approvers to Sourcing Events in the associated
Sourcing workflow.

l Perform Ad-Hoc Approve/Reject/Return of Events (for Approval Workflow) -
Users with this permission can be set as an ad-hoc approver in the associated
Sourcing workflow.

l Evaluation Workflow permissions (User Profile > Permission Settings > Evaluation
Workflow Approvals section):

l Add Ad-Hoc Approver for Sourcing Approvals - Users with this permission can
add ad-hoc approval steps and approvers to Sourcing Events in the associated
Sourcing workflow.

l Perform Ad-Hoc Approve/Close Without Awarding Sourcing Events (for
Evaluation Workflow) - Users with this permission can be set as an ad-hoc approver
in the associated Sourcing workflow. These users are not responsible for awarding
the associated Sourcing event.

Notifications

Notifications related to this feature: Sourcing Event Approval - Workflow Pending Ad-Hoc
Approval
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